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Предисловие  
 
Altium Designer представляет собой систему автоматизированного проектирования, 

отладки и выполнения комплектной документации для электронных изделий. Эта система 
интегрирует систему проектирования на уровне печатной платы и на уровне ПЛИС 
(программируемых логических интегральных схем), редактирования и изготовления изделия 
в пределах единой проектной среды.  Эти система в комбинации с современными 
возможностями управления проектными данными, позволяет принимать законченные 
проектные решения при разработке электронных средств. 

Каждый специалист в области проектирования и изготовления электронной техники, 
нуждается в возможности концентрации на задачах проекта, по возможности не выходя из 
использемой среды проектирования. Понимая всю важность данного обстоятельства 
разработчиками и была создана система Altium Designer. Все задачи по редактированию 
выполняются как единая прикладная работа, которая позволяет легко переключаться между 
различными редакторами для выполнения различных этапов процесса проектирования. 

Для успешной работы с такой мощной и всесторонней системой, а также для 
реализации полного контроля над ней, необходимо преодолеть трудности по обучению, 
чтобы знать с чего начать и как использовать максимум возможного от программного 
обеспечения системы. Данная система построена таким образом, чтобы постоянно оказывать 
пользователю интерактивную помощь в работе с ней, предоставляя достаточно много легко 
доступной справочной информации и обеспечивая возможность подробного изучения 
возможностей системы. 

Одновременно с набором печатных руководств, Altium Designer предоставляет 
динамичные и исчерпывающие учебные ресурсы, непосредственно встроенные в систему. 
Подобно системе Altium Designer, эти ресурсы постоянно совершенствуются для отражения 
самых свежих технологий проектирования и возможностей. Компания Altium, имеющая 
обширный опыт в разработке програмного обеспечения постоянно пополняет и расширяет 
учебные ресурсы, при этом дополнительные материалы автоматически передаются при 
каждом обновлении системы Altium Designer. Этим обеспечивается постоянное обновление 
системы знаний и синхронизация с постоянно развивающимися методами и возможностями 
техники. 
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Введение  
 
Документация, поставляемая с программным обеспечением Altium Designer, содержит 

набор статей, которые позволяют понять возможности Altium Designer, ознакомиться с   
вариантами работы с системой и научиться основам работы с различными редакторами. Эта 
книга содержит основные руководства, которые дают возможность изучить процесс 
проектирования на простых, рабочих проектах. 

При знакомстве с данным руководством следует иметь в виду, что более полную 
информацию всегда можно получить из набора статей в формате pdf, находящихся в 
директории Altium Designer. Некоторые статьи доступны из исчерпывающей оперативной 
справочной системы, поставляемой вместе с программой и доступной при работе с Altium 
Designer. В составе этой оперативной справочной библиотеки можно обнаружить тысячи 
страниц дополнительной информации, которые затрагивают процесс разработки 
электронных проектов с помощью Altium Designer.  

 

Панель Knowledge Center 
Наиболее эффективный путь обучения – изучать процессы и свойства программного 

обеспечения во время практической работы в системе, получая соответствующие подсказки 
на каждом, конкретном этапе работы с проектом. Именно для этих целей и создана панель 
Knowledge Center.  Отобразить эту панель можно с помощью нажатия кнопки Help в правом 
нижнем углу рабочей области Altium Designer. Если эту панель сохранять открытой при 
работе в системе, вы будете автоматически обеспечиваться информацией о командах,  
открывая необходимый диалог или рабочую панель, на которой вы работаете. 

Knowledge Center является ссылкой в библиотечные просторы справочных сведений о 
системе Altium Designer, доступные при нахождении в среде системы. Эта панель 
обеспечивает доступ ко всей информации, необходимой для изучения системы и повышения 
продуктивности работы в ней. 

Верхняя часть панели динамически обновляется в процессе использования Altium 
Designer для доступа к контекстно зависимой информации о свойствах и о процессах  с 
которым вы взаимодействуете. При необходимости можно получить доступ  к более 
детальной информации о специфических аспектах редактора или панели, с которой ведется 
работа в данный момент. 

В нижней части панели Knowledge Center имеется навигационная система, которую 
можно использовать для просмотра всех воникающих вопросов. Здесь можно получить 
прямой доступ к более чем 160 файлам, которые содержат приблизительно 10 тысяч страниц 
информации. Также возможно получить доступ к оперативной видео информации – новый 
увлекательный подход для самостоятельного изучения системы.         

С помощью клавиши Help в правой нижней части рабочей области Altium Designer 
также можно активировать динамическую панельПопулярные потребности Shortcuts, в 
которой предоставлена о всех комбинациях горячих клавиш, доступных в текущем 
редакторе.  Подобно панели Knowledge Center, эта панель контекстно чувствительна и даёт 
вам исчерпывающий список клавиатурных команд, которые доступны в текущем редакторе 
или к выполняемым операциям. 

С помощью панелей Knowledge Center и Shortcuts, открытых при работе, пользователь 
получает оперативный доступ к информации, в которой нуждается для более быстрой 
адаптации и увеличения производительности в среде Altium Designer. 

 
Knowledge Center в Altium Designer предоставляет доступ к библиотеке всей онлайн-

документации, поставляемой и установленнной вместе с САПР. С помощью этой 
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библиотечной документации вы найдёте исчерпывающую информацию по системе и по 
процессу разработки электронного проекта. 

В общих чертах информация разделена на две категории – информация по применению 
и ссылочная информация. Информация по применению отвечает на вопросы: “Как создать 
компонент?”; “Как запрограммировать ПЛИС”; “Что необходимо знать о проектах?”.  
Ссылочная информация отвечает на вопросы:  что делает команда Smart Paste; как 
использовать корпус компонента; что делает определённая команда  DelphiScript. 

Другими словами, информация по применению поясняет, как  выполнить некоторый 
процесс проектирования или решить задачу в Altium Designer, а ссылочная информация 
детализирует выполнение команд, доступных в системе. Комбинация обеих типов 
информации в библиотеке документов позволяет не только изучить свойства системы, но и  
использовать имеющиеся свойства для увеличения эффективности и производительности 
процесса проектирования. 

Документированная библиотека собрана в виде готовых к распечатке файлов PDF, 
идеально приспособленных  для просмотра на экране и на бумаге, и может быть обнаружена 
через панель Knowledge Center.  

 
Независимо от уровня вашего опыта проектирования и знакомства с программным 

обеспечением, всегда имеется возможность дальнейшего совершенствования знаний. Одним 
из лучших путей совершенствования ваших знаний является взаимодействие с другими 
разработчиками плат и ПЛИС, изучение их опыта и совместное использование  специальных 
знаний. 

Посетите сайт Altium www.altium.com и просмотрите страницы Community. Здесь вы 
получите доступ к большому числу коротких вопросов и ответов в базе знаний (Knowledge 
Base), узнаете об аккредитованных тренировочных программах, ознакомитесь с форумом 
пользователей Altium, и многое другое. 

Форум пользователей Altium Designer необходим для покупателей этой системы. Он 
активен ежедневно 24 часа в сутки, а технический штаб Altium Designer, разработчики и 
прикладные инженеры участвуют в обсуждении проблем с пользователями. Здесь можно 
получить оперативный ответ на специфические проблемы или принять участие в 
обсуждении насущных промышленных тем с вашим коллегами. Если вы когда-либо 
встретились с проблемой и думаете “несомненно, кто нибудь уже разрешил её…”, вы 
вероятно правы. И решение проблемы может быть обнаружено на форуме или в базе знаний.  

Общность ресурсов сайта Altium дополняется изобилием знаний, доступных в 
программном обеспечении системы Designer, и гарантирует получение запасных вариантов, 
в которых вы нуждаетесь для успеха в разработке электронных проектов с помощью Altium 
Designer. 
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Что нового в Altium Designer 6.0  
  
Altium Designer 6.0 содержит ряд существенных усовершенствований в процессе 

проектирования плат и ПЛИС. Почти все компоненты программного обеспечения 
усовершенствованы  и дополнены. 

Обновлена физическая платформа проекта для поддержки плат высокой плотности и 
высокочастотных излучений, обнаруженных в современных проектах.  Дифференциальные 
пары и трассировка для шариковых выводов в BGA компонентах, поддержка сваппирования 
выводов и секций компонентов с динамической перепривязкой цепи, упрощает и улучшает  
процесс трассировки.  

Расширена поддержка программируемых проектов, с увеличением разновидности 
программируемых устройств и процессоров, а интеграция проекта на физическом уровне 
значительно улучшена. Поддержка всех устройств периферийного сканирования при 
тестировании по стандарту JTAG на вашей плате, объединённая с развитым JTAG Device 
Viewer реального времени (Joint Test Action Group – Объединённая группа Института 
инженеров по электротехнике и электронике по тестированию), дающее возможность 
мониторинга состояния выводов, усовершенствовало контроль функционирования платы. 
Новый конфигурируемый от 8 до 64 бит LAX со встроенным мультиплексором и 
возможностью деассемблирования кода, существенно усилил процесс проектирования 
ПЛИС. 

Настоящая версия системы значительно облегчила интеграцию Altium Designer с 
компаниями, производящими  технические и коммерческие системы диспетчеризации и 
управления,  обычно обнаруживаемых в средних и крупных проектных организациях. 
Размещайте компоненты непосредственно из базы данных вашей компании с помощью 
новой Библиотеки  Компонентов, на  основе управляемой базы данных, при этом вы можете 
включать информацию из базы данных непосредственно в спецификацию на изделие.  

В систему включено немало новых свойств и команд,  которые  придают этой версии 
системы Altium Designer немалые достоинства. В данной главе ознакомимся с новыми и 
улучшенными технологиями разработки электронных изделий в Altium Designer 6.0. 

 
Обычно говорят, лучше один раз увидеть, чем сто раз услышать. Обучение с помощью 

наблюдения и выслушивания является идеальным способом изучения программного 
обеспечения. Если вы хотите узнать больше, прочитать о системе Altium Designer, а также 
просматривать короткие видео сюжеты о некоторых нестандартных свойствах системы, 
тогда посетите на сайте разработчика страницу What’s new in Altium Designer. Для этого 
обратитесь по адресу в Интернете    http://www.altium.com/WhatsNewin6/

 

Вспомогательная информация (Board Insight) 
 
Многослойная печатная плата является таким объектом, который достаточно сложно 

представить для отображения в рабочей области экрана.  Новая система Board Insight 
облегчает просмотр и понимание объектов платы.  Эта система представляет собой 
интегрированный набор свойств, разработанных для удовлетворения нужд по управлению 
просмотром. Для этого система Board Insight содержит Вспомогательную Линзу, 
Вспомогательную информацию (плавающее отображение данных), сопровождающую 
курсор, плавающий графический визуализатор, явную подсветку цепи и 
усовершенствованную индикацию меток объектов. 
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Вспомогательная линза 
Новая вспомогательная линза облегчает работу по детальному просмотру фрагментов 

платы. В то время как рабочая область имеет низкий уровень масштабирования, возможно 
тщательно просматривать малейшие детали на плате, увеличивая нужное место линзой. С 
помощью собственного краткого меню для выбора масштаба и слоя платы, работа с такой 
линзой станет вскоре совершенно необходимой. Включайте и отключайте линзу в меню 
просмотра (View) и изменяйте её конфигурацию в диалоге Preferences на вкладке PCB – 
Board Insight Lens. 

  
Рис. 1. Использование линзы для тщательного просмотра платы. 

Оперативное отображение координатных данных 
Постоянное отображение данных представляет информацию о свойствах объектов, 

оказавшихся под курсором в рабочей области. Такое отображение может быть настроено и 
может содержать позицию курсора, информацию о приращениях координат относительно 
предыдущей позиции (последнего щелчка клавиши мышки), имя текущего слоя платы и 
установленную дискретную сетку. Одновременно с содержательной информацией имеется 
возможность изменения шрифта и расцветок, которые также можно оперативно зменять. 

Плавающее оперативное отображение данных можно  зафиксировать в любом месте 
экрана, с помощью горячих клавиш Shift+G и возобновить подвижность оперативных 
данных с помощью этих же клавиш. Это позволяет вам перемещать эти данные вместе с 
курсором или позиционировать эти данные в любом месте экрана в фиксированной позиции. 

 

 
Рис.2. Оперативное отображение  координат курсора 
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Отображение дополнительных данных 
Если вы приостановите процесс перемещения курсора, оперативное отображение 

координат курсора будет дополнено некоторой краткой справочной информацией  в 
специальном режиме (в виде всплывающей информации). В этом режиме отображается  
обобщающая, доступная краткая информация, данные о нарушениях конструктивных 
установок, имя цепи, детальные данные о компоненте и примитиве. 

 
Рис.3. Специальный режим индикации данных с дополнительной информацией 

 
В диалоге Preferences можно конфигурировать состав данных в специальном режиме 

индикации на вкладке PCB – Board Insight Modes. 
 

Режим всплывающего меню 
Новая система для работы с платой – всплывающее меню выбора – является 

превосходным инструментом для запроса данных, находящихся  под курсором на различных 
слоях платы. Щелчок клавиши мышки вызывает появление на экране выпадающего меню, 
которое содержит список всех объектов под курсором и представляет графическое 
представление текущих выбранных объектов в списке. Из этого списка вы можете 
отредактировать, выбрать и масштабировать любой из объектов. 

  

 
Рис. 4. Нажатие клавишу мыши для появления  всплывающего меню распознавания. 
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Список элементов меню выбора может содержать примитивы объектов, такие как 
контактные площадки и трассы, а также сами объекты, такие как компоненты и отметки мест 
нарушения, установленных правил в  проекте. Список имеет иерархическую структуру, 
позволяя опускаться ниже по иерархии для выяснения деталей на объектах, имеющих 
нарушения. 

Используйте клавиши Shift+Х для вызова плавающего меню с информацией о любых 
цепях и компонентах под курсором. Прокручивайте колесо мышки для просмотра этого 
диалога с перечнем всех объектов под курсором. 

 

Режим панели 
Специальная информационная панель выбора предоставляет такую же информацию, 

как и всплывающее меню выбора, но не требует нажатия клавиш для обновления её 
содержимого. Когда вы перемещаете курсор над компонентом, цепью или метками 
нарушений, они будут появляться на панели, где возможно их отредактировать, изменить 
условия выбора и просмотреть.  В нижней части панели, появляется информация с обзором 
области платы, находящейся под курсором. 

 Специальная панель выбора работает подобно любой другой панели –  можно 
изменить её размеры, зафиксировать в одном месте или сделать плавающей по рабочей 
области проекта. Информация на такой панели обновляется при кратковременной остановке 
курсора, после чего эта информация сохраняется вплоть до следующей остановки курсора в 
другом месте. 

Вы можете оперативно отредактировать объекты, изменить установку условий их 
выбора  и удалять их из этого режима. 

  

 
Рис. 5. Информационная панель выбора детализирует элементы платы под текущим 

курсором. 
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Расширенный визуальный выбор объектов из списка 
Многослойная печатная плата конструируется для плотных, насыщенных 

компонентами проектов, которые, как правило, перекрывают друг друга на различных слоях.  
Расширенный визуальный выбор объектов (Visual PickList) упрощает выбор объектов. При 
попытке выделить объект, появится список множества объектов под курсором в виде списка, 
при этом вы сможете указать курсором элемент списка для его выбора, после чего он будет 
представлен в формате плавающего порта, позволяющего точно идентифицировать этот 
элемент. Объекты в таком списке распознавания дополнительно отсортированы по слоям 
платы. 

 
Рис. 6. Визуализация списка элементов под курсором облегчает выбор текущего 

объекта в перегруженной данными рабочей области. 
 

Динамическое выделение цепи подсветкой 
Подсветка цепи является одним из тех специальных свойств печатной платы, которую 

используют постоянно. Нажатие левой клавишей мыши с нажатой Ctrl на такой цепи и все 
элементы на экране, которые не принадлежат указанной цепи, исчезнут, оставляя хорошо 
видимыми трассы цепи по всему полю рабочей области проекта.  

Ориентация в сложных проектах плат значительно облегчается с помощью свойства 
динамического выделения цепи подсветкой. Просто наведите курсор мыши на цепь при 
нажатой комбинации клавиш Ctrl+Alt и данная цепь будет подсвечена. 

  

 
Рис. 7. Нажматие CTRL+Alt и наведение курсора на  цепь позволяет  

подсветить ее на плате. 
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Индикация имени цепи на трассе 
Как часть новой системы распознавания платы, каждая трасса теперь содержит имя 

цепи, которой она принадлежит, что является весьма удобным для работы с проектом. 
Включить данную настройку можно на вкладке Preferences>PCB>Board Insight Display 

 

 
Рис. 8.  Наличие имён цепей на трассах является одним из свойств экономии времени. 

 
 
Работа в режиме одного слоя 
 Одной из популярных возможностей редактора РСВ в Altium Designer является режим 

отображения одного слоя. Нажатие клавиш Shift+S погасит все  слои, кроме текущего, что 
позволит сосредоточиться только на объектах текущего слоя. 

Режим одного слоя усилен дополнительными двумя опциями, позволяющими вам 
сохранять индикацию данных на других слоях без расцветки в виде монохромного 
изображения или в прозрачном виде.  Преобразование цветов всех других слоёв в серый или 
монохромный цвет позволяет вам сохранять информацию о пространственном 
расположении других объектов проекта, не мешая работе с объектами выделенного слоя. 

Обе новые опции реализует новый слайдер регулировки интенсивности серого цвета 
(регулирующий движок) в виде кнопки Mask Level в нижней левой части рабочей области 
редактора плат. 

Поведение системы в режиме единственного слоя регулируется на странице PCB –
Board Insight Display  в диалоге Preferences, обеспечивающей все три режима отображения 
единственного слоя, означающего, что вы будете циклически обходить их при нажатии 
Shift+S.  Для переключения режимов всех этих опций, которые вы хотите видеть при 
нажатии клавиш Shift+S, используйте управляющие флажки в диалоге Preferences. 

Режим единственного слоя поддерживает также глухие и внутренние межслойные 
переходные отверстия, обеспечивая их корректное их отображение на активном слое. При 
работе в режиме одного слоя переключение между слоями можно осуществлять по вкладкам 
слоев в нижней части рабочей области редактора, или комбинацией клавиш 
Ctrl+Shift+Scroll, при этом колесо мыши прокручивает слои проекта.  
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Рис. 9. Отображение одного слоя в режиме тусклого серого цвета. 

 

Детальное описание контактных площадок и переходных отверстий  
Altium Designer теперь представляет значительно больший контроль над индикацией 

цепи и рядом деталей, касающихся КП (Контактных Площадок) и ПО (Переходных 
Отверстий). С помощью диалога Preferences на вкладке PCB – Board Insight Display можно 
изменять шрифты, цвет и уровень прозрачности цвета при работе с расцветкой элементов в 
рабочей области проекта. 

Строки текста автоматически представляются хорошо-читаемыми, выровненными в 
направлении, которое максимизирует доступную для их индикации зону. 

  

 
Рис. 10. Настройки видимости атрибутов контактных площадок и переходных 

отверстий. 
 

Зеркальное отображение  и редактирование платы  
Теперь вы можете работать на нижнем слое платы также легко, как и на верхнем. 

Используйте команду View>Flip Board для переключения между этими слоями, и это 
происходит  так, будто вы поворачиваете плату в руках. При этом поддерживаются все 
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стандартные действия по редактированию, такие как прокладка трасс, размещение 
компонентов и позиционирование текстов. Для возврата на другой слой просто выберите 
указанную выше команду. 

Координатное пространство логически не меняется, за исключением того, что начало 
координат платы перемещается из левого нижнего угла в правый нижний, и поэтому текущая 
позиция курсора увеличивается при перемещении мышки справа налево, в отличие от 
стандартного варианта слева направо. Любые генерируемые выходные данные, 
генерируемые при флиппировании (зеркальном преобразовании) платы, будут установлены 
как корректные, просматриваемые координаты при их просмотре со стороны верхнего слоя. 

 Последовательность вывода слоя также изменено, используя процесс сваппирования 
логических пар. Это означает, что TopOverlay будет заменён на позиции текущего слоя 
BottomOverlay, Слой Top  на слой Bottom, внутренний слой 1 на  внутренний слой 30, 
внутренняя панель 1 на внутреннюю панель 16 и т.д. Последовательность вывода 
механических слоёв не изменяется.  

Состояние просмотра автоматически восстанавливается для стандартного восходящего 
просмотра, если файл закрывается или переоткрывается. 

  

Интелектуальные инструменты 
 
Любому инженеру хорошо известно, что обычно на плате или схеме имеется большое 

число однотипных или одноименных объектов, которые должны быть размещены и 
взаимосвязаны при реализации проекта. Общим способом ускорения этого процесса является 
копирование наборов подобных объектов, которые уже были созданы, помещение их в 
нужное место и последующая модификация их набора  при необходимости. 

Схемный редактор с новым свойством Smart Paste выводит этот подход на совершенно 
новый уровень – используя “интелектуальную вставку” вы можете действительно 
трансформировать копии выбранных объектов в другие объекты, как будто вы соединяете 
их. Например, выбранные Метки Цепей (Smart paste)  могут стать портами, когда они 
соединены, или выбранные входные элементы  Листа Схемы (Sheet Entries) могут 
становиться Метками Порта+Проводник+Цепь, с помощью единой операции вставки из 
буфера. 

  

 
Рис. 11. Элементы листа схемы преобразованы в группу  Метки 

Порта+Проводник+Цепь, при использовании интелектуальной вставки. 
 
Разработчик имеет полный контроль над объектами в выбранной группе, которую 

необходимо вставить – но необходимо более тщательно обходить те провода, которые были 
указаны как порт, просто очистив флажок состояния для исключения  проводов, которые 
были выбраны для интелектуальной вставки. 

Другое удобное свойство – это допущение соединять выбранные цепи как графику. 
Такое использование позволяет легко включать графические  секции цепи в другой лист 
схемы и изменять его размер при необходимости. Укажите Edit>Smart Paste для 
трансформации объектов в буфере обмена при их вставке.  
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Параметрическое иерархическое проектирование 
 
Иерархическое проектирование является одним из основных направлений Altium 

Designer, которое позволяет структурировать проект  на логическом или  смысловом уровне. 
Возможности иерархического проектирования в Altium Designer затрагивают не просто 
структурирование проекта, они являются основой многоканального проектирования, и, 
кроме того, делают его очень удобным для повторного использования схемных секций в 
различных вариантах электронных проектов. 

Проблема повторного использования секций проекта, например ввода   символа листа в 
текущий проект, для  схемы источника питания, состоит в том, что значения компонентов не 
всегда фиксированы от одного проекта к другому. Новая поддержка для решения этой 
проблемы для параметрического иерархического проекта – позволяет передавать 
спецификации значений компонентов из полного листа схемы в единственный  символ 
листа, на который ссылается этот лист. Это возможность также может быть успешно 
использована в многоканальном проекте (в проекте, где фрагменты схемы повторно 
используются), позволяя назначать различные позиционные обозначения компонентам для 
каждого канала. 

  

 
Рис. 12. Графический эквалайзер с различными конденсаторами в каждом канале. 

 
Например, графический эквалайзер может иметь одинаковые схемы, повторяющиеся 

несколько раз, с единственным различием между каналами, содержащими значения 
компонентов. Таким образом, конденсатор может получать значения 0.12, 0.056 и 0.033 
микрофарад в различных каналах.  Выполнение этого в Altium Designer теперь упрощено, так 
как можно специфицировать эти значения в схеме на листе ссылками на каждый канал, 
исключая необходимость введения нескольких подобных схемных решений, задавая только 
различные значения компонентов. 

Параметрическая иерархия не ограничивается значениями компонентов; вы можете 
параметризовать ссылки на любой параметр компонента или на метку любого текста на 
листе схемы. Другим мощным свойством системы является возможность ссылаться на 
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параметры из символа, который имеет много листов в верхней иерархии;  система будет 
просматривать иерархию, пока не обнаружит искомый параметр. 

 

Разумная интерактивная трассировка 
Так называют в Altium Designer новый усовершенствованный  режим интерактивной 

трассировки. Этот режим, называемый Smart Route, работает интуитивно с пользователем, 
пытаясь закончить трассу выбором соединения минимальной длины с использованием 
горизонтальных, вертикальных или диагональных сегментов, с автоматическим обходом 
любого возникшего препятствия. Smart Route будет автоматически выполнять прокладку 
всего соединения, если оба соединяемых вывода компонента находятся на одном и том же 
слое, с соблюдением любых установленных правил проектирования. 

 
Рис. 13. Набор соединений, выполненных Smart Route, простым щелчком для генерации 

трассы. 
Так как разумная трассировка является интерактивным инструментом прокладки трасс, 

управление которой ведется с помощью курсора и встроенных горячих клавиш. 
Например, нажатие клавиши А переключает режим автозавершения трассы (включён 

или выключен). Этот режим (Auto Complete) индицирует проложенные сегменты трасс 
сплошной линией, а предполагаемые для прокладки далее в виде точечных контуров трассы. 
Если вы согласны проложить трассу далее этим путём, просто нажмите и удерживайте 
клавишу Ctrl при щелчке, и вы получите завершённую трассу для этого соединения. 

Если вы намерены использовать Smart Route в режиме трасса-к-курсору, просто 
нажмите А для отключения автозавершения трассы и Smart Route будет тщательно искать 
путь для трассы от точки соединения до трассы, обходя препятствия на своём пути.     

Вы можете контролировать плотность обхода препятствия, используя мышку для  
раздвижки зазора между трассой и препятствием. Отключите Обход (WalkAround) или 
нажмите горячую клавишу W и укажите другое соединение, сохранив выбранную КП, после 
чего нажмите клавишу С.  

Нажмите клавишу тильды (~) в режиме Smart Routing для отображения функций 
горячих клавиш. 

  

Улучшенная поддержка JTAG 
 
Периферийное сканирование с целью опроса тестовых ячеек на логической границе 

цифровых устройств (широко известное как тестирование по стандарту JTAG), было 
разработано как система для тестирования интегральных микросхем, установленных на 
печатной плате после установки компонентов и для тестирования межсоединений, 
реализованных как трассы на плате. Altium Designer 6.0 предоставляет этот уровень JTAG-
тестирования для среды разработки – то, что необходимо для собственного проекта платы. 
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Altium Designer предоставляет законченную JTAG коммуникационную систему, а при 
реализации версии 6.0 она была доработана для поддержки JTAG совместимых компонентов. 
При включении в состав системы файлов в стандарте BSDL (boundary scan description system 
– язык описания цифровых устройств при периферийном опросе для интерфейса JTAG), 
поддерживающих каждый компонент JTAG, пользователи получают доступ к выводам 
каждого компонента в проекте, с помощью доработанного обозревателя реального времени 
JTAG. 

Система поддерживает даже ситуацию, когда файл в формате BSDL недоступен для 
компонента, поэтому достаточно просто обнулить оператор длины в файле для этого 
устройства, после чего система JTAG продолжит работу с другими компонентами в цепочке. 

     

 
Рис. 14. Выбор файла BSDL и библиотеки для использования 

 любого компонента JTAG. 
 

Улучшенный обозреватель устройств реального времени JTAG 
 
Компоненты поверхностного монтажа с высокой плотностью установленных 

контактных площадок, такие как BGA (Ball Grid Arrays – матрица шариковых выводов), 
представляют собой корпус, физический доступ к выводам которого с помощью пробника 
просто невозможен - является существенной трудностью  при необходимости отладки 
проекта. Включение в систему Altium Designer  усовершенствованного  обозревателя 
приборов JTAG – сразу же облегчило решение этой  проблемы. 

Обозреватель JTAG использует коммуникационный стандарт JTAG для опроса 
состояния выводов любого совместимого с JTAG устройства в проекте, и не только для 
устройств с ПЛИС. Он представляет состояние каждого вывода, и включает индикацию как 
вида компонента на схеме, так и изображение его посадочного места, способствуя  анализу и 
отладки вашего проекта. 
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Рис. 15. Контроль состояния выводов для любого JTAG совместимого компонента в 

вашем проекте. 

Просмотр операций для платы 
Поддержка отладки проекта также усовершенствована в части проектной 

документации. Первоначально Altium Designer поддерживал индикацию состояния вывода 
на схеме, а в реализации версии 6.0 можно видеть состояние выводов на проекте платы, что 
идеально способствует реализации проекта. 

 
Рис. 16. Мониторинг состояния выводов компонента на РСВ. 
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Поддержка дифференциальных пар 
 
Дифференциальные межсоединения быстро становятся предпочтительным методом 

передачи сигналов, при значительном увеличении скорости передачи. Структура ПЛИС 
идеально подходит для высокочастотных проектов и для этого разработчики ПЛИС 
включают возможности дифференциальной передачи сигналов (LVDS – метод), начиная с 
дешёвых устройств и заканчивая  высококачественными  приборами с множеством вентилей 
и с более чем 1500 внешних выводов. 

Altium Designer 6.0 имеет мощную поддержку для реализации дифференциальных пар 
при передаче сигналов – от задания пары на схеме, до интерактивной трассировки 
дифференциальных пар на плате. Трассировка платы имеет полную поддержку в части 
своппинга пар, используя новое динамическое свойство определения цепи, которая может 
своппировать не только неразведённые пары, но частично трассировать пары цепей, 
позволяя  использовать все преимущества возможности реконфигурирования проекта с 
ПЛИС в процессе трассировки. 

 
Передача дифференциальных сигналов, является такой системой, когда сигнал 

передаётся в одном направлении двумя связанными проводниками, один из которых 
передает прямой сигнал, а второй передаёт такой же, но инвертированный. Принцип 
дифференциальной пары был разработан для реализации устройств, где нет возможности 
соединения аналоговой земли и цифровой. Дифференциальная передача сигналов является 
по своей природе невосприимчивой к обычному режиму электрического шума,  в 
большинстве обычной интерференции, появляющейся в электронном изделии. Другим 
важным преимуществом дифференциальной пары является минимизация электромагнитной 
интерференции, излучаемой сигнальной парой. 

Трассировка дифференциальной пары является методом проектирования, используемом 
при создании сбалансированной передающей системы для реализации передачи 
дифференциальных сигналов на печатной плате. Обычно такая дифференциальная трасса 
будет взаимодействовать с внешней дифференциальной передающей системой, такой как 
соединитель и кабель. 

Важно отметить, что коэффициент степени парности проводников, достигаемый в 
витой паре дифференциального кабеля может быть выше 99%, чем в случае 
дифференциальной пары, созданной трассировкой на плате, коэффициент парности которой 
обычно меньше чем 50%. 

В настоящее  время имеется мнение, что задача трассировки платы не может 
обеспечить достижение указанного дифференциального импеданса, что до известной 
степени является объективным, для установки желательных свойств, требуемых обеспечения 
успеха в обеспечении хорошего условия для работы устройства. 

Успешная дифференциальная передача сигнала не требует работы определенным 
дифференциальным импедансом. Для этого требуется: 

• Установить каждый импеданс сигнальной трассы равный половине импеданса 
дифференциального кабеля. 

• Каждая из двух сигнальных линий будет подобающим образом ограничена своей 
собственной характеристикой импеданса на приемнике. 

• Обе линии должны иметь равную длину, в пределах допусков логического семейства. 
Обычно допускается различие по длине в пределах 500 мил (около 12 мм). 
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Задание дифференциальных пар на схеме 
Пары можно задавать на схеме с помощью указателя Differential Pair (Place> 

Directive). Пара цепей должна иметь имя с суффиксами _N и _P. Определения 
дифференциальных пар затем передаются в плату в процессе синхронизации. 

  

 
Рис. 17. Размещение директив на схеме для задания дифференциальных пар. 

 

Задание дифференциальных пар на плате 
В некоторых особых случаях, когда дифференциальные пары (ДП) невозможно задать 

на схеме, объекты ДП могут быть заданы в редакторе плат. Для создания ДП  в редакторе 
плат и определения двух цепей, необходимо либо указать эти цепи в графическом их 
представлении с помощью команды Place>Differential Pair, либо щёлкнуть кнопку Create 
From Nets на панели редактора плат, установив новый режим Differential Pair Editor. 

Просмотр и управление парами 
ДП можно просматривать и управлять ими через панель PCB, установив режим  

Differential Pair Editor. Рис. 18 показывает пары, которые принадлежат классу All 
Differential Pairs (все ДП).  Пара D_V_TX1 подсвечена, цепями этой пары являются V_TX1N 
и V_TX1P.  Значки – и +, расположенные рядом с каждым порядковым номером в имени 
цепи, являются системными указателями, отображающими положительное или 
отрицательное значение номера пары.  

  

Необходимые конструкторские установки 
Имеется 3 правила проектирования, которые необходимы для трассировки 

дифференциальных пар: 
• Ширина трассы (Routing Width) – задаёт ширину трасс, которые требуются для 

обеих цепей в паре. Установите границы этого правила для указанных объектов, которые 
являются элементами ДП. 

• Зазор между проводниками в ДП (Differential Pairs routing) – задаёт расстояние 
между цепями в паре, допустимый зазор, и общую длину непарности (пара считается 
непарной, когда зазор между цепями больше установленного максимума (Max Gap)). 
Установите ограничения этого правила для указанных объектов, которые являются ДП. 

• Подгонка длины цепи (Match Net Length) -  задаёт величину разницы в длинах 
трасс для двух цепей в паре. Отметим, что это правило также используют для настройки 
образа трасс при выдаче команды на прогон Equalize Net Length (выровнять длины цепей).  
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Рис. 18. Дифференциальные пары можно просматривать и управлять ими 

 через панель PCB, выбрав Differential Pair Editor. 
 
Установка области действия правил проектирования 
Область действия правил проектирования определяет набор объектов, к которым 

необходимо применить правила. Так как ДП является объектом, вы можете использовать 
запросы, подобные запросам в следующих примерах, для назначенных ДП: 

• InDifferentialPairClass(‘All Differential Pairs’) – все дифф. пары. 
• InDifferentialPair(‘D_V_TX1’) – под названием D_V_XT1. 
• InAnyDifferencialPair  - любые объекты в ДП. 
• IsDifferentialPair And (Name Like ‘D*’)) – все объекты ДП, имена которых 

начинаются с буквы D. 
 

Использования мастера  ДП для задания правил 
Щёлчок на кнопке Rule Wizard в панели PCB (При выбранной опции Differential Pair 

Editor) открывает мастер создания правила проектирования для ДП. Область действия 
правила при создании мастером, будет зависеть от выбора, сделанного при обращении к 
кнопке Rule Wizard – если была выбрана одна пара, то правила будут применены к этой паре 
и её цепи, но если был выбран класс ДП, тогда правила будут применены ко всем цепям и 
парам этого класса. 
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Рис. 18. Мастер задания правил для ДП 

 

Трассировка дифференциальных пар 
ДП трассируется как пара, т.е. трассируются две цепи одновременно. Для трассировки 

ДП выберите команду Place>Differential Pair Routing из меню. При этом появится 
предупреждение о выборе одной из цепей в паре, после чего необходимо щёлкнуть в любом 
месте для запуска трассировки. Рис. 19 показывает трассы ДП. Чтобы легче рассмотреть 
линии связи для пары, Нажатие на паре в редакторе ДП. Это приведёт к маскированию всех 
других цепей в проекте. 

 
Рис. 19. Обе пары в ДП трассируются одновременно, нажмите «~»  

для просмотра горячих клавиш 
 
ДП трассируются при использовании нового режима в Altium Designer – Smart Routing, 

который был описан выше. Стандартные горячие клавиши трассировки сохраняются, такие 
как нажатие клавиши «*» на цифровой клавиатуре для переключения между трассируемыми 
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слоями. Для вывода списка всех доступных горячих клавиш для трассировки ДП, нажмите 
клавишу тильды «~». 

 

Полная поддержка ДП для проекта с ПЛИС, включая свопинг выводов в паре 
Современные ПЛИС, даже очень низкой стоимости, имеют значительное число 

выводов, которые могут рассматриватьсч как ДП. Для облегчения этого, Altium Designer 6.0  
содержит полную поддержку для интеграции ДП на базе ПЛИС, как для проекта ПЛИС, так 
и для проекта платы.  

В проекте ПЛИС можно присвоить единственную цепь для стандартного 
дифференциального ввода-вывода, такую как LVDS, и она  будет переопределёна в пару 
физических цепей на уровне проекта платы. Этот процесс реализуется при постоянном 
управлении ПЛИС  с помощью Signal Manager.  

Компилятор проекта может также решить, использованы ли выводы в ДП на уровне 
проекта  платы,   и как  их корректно переопределить в доступные пары в устройстве ПЛИС. 

  

 
Рис. 20.  Поддержка дифференциальных пар из проекта ПЛИС в проект платы. 

 

Поддержка целостности сигнала для дифференциальных пар 
Анализатор целостности сигналов в Altium Designer обеспечивает полную поддержку 

моделирования ДП.  При этом используется корректная модель целостности сигнала для 
выводов, при использовании стандарта LVDA с ПЛИС. 
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Сваппирование выводов и секций компонента 
 
 
Новые возможности по сваппированию выводов сходны с новыми возможностями 

трассировки  ДП и трассировки стрингеров для корпусов BGA. Эти свойства не только 
сохраняют все достоинства традиционных систем сваппирования выводов, но также 
различают внутреннюю сущность цепи в проекте, существующее в Altium Designer, для 
перевода сваппирования выводов на более высокий уровень. В процессе операций по 
сваппированию выводов, система анализирует привязку цепи к выбранному выводу и 
производит  динамическую перепривязку цепи к любой из подходящих трасс. 

Функционально этот означает, что частично протрассированная цепь и предварительно 
проложенные стрингеры для многослойной плате из сложных компонентов на базе BGA, 
теперь могут быть своппированы. Также могут своппироваться и ДП, используя данные о 
дифференциальных парах на уровне секции компонента типа ПЛИС. 

На уровне платы система содержит мощный автоматический оптимизатор, который 
использует эту информацию для динамической перепривязки цепей с целью оптимизации 
процесса трассировки. Например, система может выполнять переназначение связности для 
многих устройств, для которых проведено формирование стрингеров для многослойных 
плат. Это переназначение производится на основе сравнения проложенных стрингеров на 
слоях, сокращения манхэттенских длин трасс и минимизации числа пересечений на каждом 
слое. 

  

 
Рис. 21. Двухэтапный автоматический оптимизатор минимизирует длину соединений и 

число пересечений. 
   
Дополнительный свопинг частично разведённых цепей, совместно с автоматическим 

оптимизатором даёт возможность выбирать иерархическую и итеративную стратегию 
трассировки, начиная с формирования стрингеров для компонентов, с последующей 
трассировкой по границе данной зоны и окончательным совместным соединением этих 
секций. В любой момент, автоматический своппинг может быть выполнен повторно и 
повторно оптимизирован, на базе новой информации, полученной от частично 
протрассированных цепей. 

Настройка сваппирования выводов и секций компонентов 
Настройка сваппирования выводов может быть выполнена в редакторе схем или плат. 

Установки возможности сваппирования для выводов и секций компонента задаются при 
создании УГО компонента (символа), в то время как возможности сваппирования в 
определённом компоненте могут быть доступны только в редакторе плат. 

Указание команды Configure  в подменю редактора РСВ Tools>Pin/Part Swapping, 
откроет Swap manager, как это показано на рисунке 22. Swap Manager выводит список всех 
используемых в проекте компонентов и их текущие установки для сваппирования. 

Swap Manager содержит мощное меню для ПК мышки, позволяя легко копировать 
установки от одного компонента в другому или позволяя/запрещая манипуляции с набором 
компонентов одним щелчком. 
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Рис. 22. Использование Swap Manager  для настройки  и управления сваппированием 

выводов для всех компонентов в проекте. 
  
Двойной щелчок на компоненте откроет диалог Configure Pin Swapping, как показано на 

рисунке 23. Здесь можно установить значения эквивалентности для выводов и секций 
компонента. 

 
Рис. 23. Настройка  эквивалентности выводов и секции компонент. 

 
 
 

 25



Трассировка стрингеров для BGA корпусов 

 
Altium Designer имеет превосходный инструмент формирования стрингеров для 

компонентов поверхностного монтажа. Он был усовершенствован добавлением поддержки 
стрингеров BGA. Алгоритм формирования стрингеров будет пытаться вывести каждую КП 
за границу компонента – облегчая последующую прокладку трасс на плате. 

  

 
Рис. 24.Трассировка стрингеров для BGA корпусов. 

 
Рис. 24 демонстрирует отводы трасс от КП размером в 1 мм для BGA. Задействованные 

в схеме внутренние КП вначале подключаются к переходному отверстию (ПО) с 
использованием  традиционных стрингеров (коротких отводов от КП с ПО в конце) для 
доступа к выводу BGA  на другом слое, а затем от этого ПО трассируется отвод на границу 
посадочного места микросхемы, располагаемый на одном из доступных сигнальных слоёв, 
пока не будут подключены таким образом все задействованные КП. 

Нажатие ПК на BGA и выберите команду Action>Fanout Component из контекстного 
меню. Будет выполнена  трассировка в соответствии с установленными правилами 
проектирования.  

 

Поддержка объемных шрифтов (TrueType) 
Редактор плат теперь имеет полную поддержку шрифтов TrueType. Это даёт доступ ко 

всем шрифтам этого типа, имеющихся на компьютере пользователя, включая набор 
символов Unicode, таких как японские.  

 
Все строки текста в плате могут быть представлены в одном из трёх встроенных 

шрифтов, или как шрифт TrueType, доступный на компьютере. Также как Bold  или Italic, 
строка этого типа шрифта может быть инвертирована для случая вывода строки на плату в 
виде металлизированного изображения. 

Шрифты могут быть встроены в файл платы с помощью опции Embed TrueType fonts 
в диалоге Preferences. Если же TrueType шрифт не доступен при переоткрытии файла на 
другом компьютере, то вместо него будет использован альтернативный системный шрифт. 
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Символы TrueType воспроизводятся как региональные объекты при формировании 
файлов в формате Gerber или ODB++, предоставляя тем самым полную их поддержку при 
изготовлении платы. 

  
Рис. 25. Используйте новую поддержку TrueType шрифта для представления 

 текста в желаемом виде. 
 

Сохранение углов трасс при их перетаскивании 
При проектировании платы часто возникает необходимость смещения проложенных 

трасс. Этот процесс в Altium Designer значительно упрощён для перемещения сегментов 
трасс под любым углом, кратным 45 градусам с сохранением смежных сегментов трасс и 
качества трассировки. Эта возможность доступна через использование опции Restrict to 
90/45  на главной странице РСВ диалога Preferences. 

 
Рис. 26. Сохранение углов при перемещении сегмента трассы. 
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Интеграция с пользовательскими базами данных  
 
Библиотеки компонентов теперь могут быть созданы со всеми ссылками на символы, 

связаны с моделями и параметрической информацией, сохраненными в стандарте ODBS 
(open database connectivity),   на основе базы данных  ADO, или в виде широкоформатных 
таблиц Excel. Каждая запись в базе данных представляет компонент, сохраняя все его 
параметры и ссылки на модели. Записи могут содержать ссылки на инвентарные ведомости 
или другие корпоративные информационные докуметы.  

При таком подходе компоненты схем используются только как символы УГО  
(условные графические обозначения) с моделями (посадочное место, 3D-модели и данные 
для моделирования), сохраненные в стандартных библиотечных файлах символов, 
библиотечных файлах корпусов и т.д. 

Компоненты извлекаются из базы данных установкой нового DBLib документа  в 
панели Library, с помощью DBLib  документ может конфигурироваться для ссылки на базу 
данных компонента. 

 
Рис. 27. При размещении компонентов из BDLib вся необходимая информация 

поступает непосредственно из базы данных. 
 
Постоянным запросом является предоставление возможности размещения компонентов 

непосредственно из базы данных. Теперь это возможно с помощью нового инструмента 
Database Library.  Новая база библиотек *.DBLib добавляется в систему, подобно любой 
другой библиотеке через панель Libraries Altium Designer  - можно просматривать список 
компонентов, проверять символы компонентов и их модели, и размещать компоненты. 

Помимо того, что DBLib, которую вы просматриваете на панели Libraries, 
представляет базу данных, каждый компонент в панели соответствует записи в базе данных.  
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Дополнительно к типам данных компании, таким как стоимость или инвентарный 
номер, база данных также специфицирует схемный символ, посадочное место и другие 
модели, которые являются частью компонента. При щелчке кнопки Place  на панели 
Libraries, символ извлекается из специфицированной схемной библиотеки и свойства 
компонента, такие как посадочное место и другие параметры добавляются на своё место на 
лист. 

DBLib является документом, который можно редактировать в Altium Designer. Связь с 
базой данных можно установить различными путями, от простого просмотра и выбора 
Access базы данных или таблиц в формате Excel, до использования Data Link File (*.UDL). 

 
Рис. 28. Укажите базу данных компонентов, и записи будут связаны с параметрами. 

Использование базы данных для формирования спецификации 
Для компонентов, которые были извлечены из библиотеки в формате БД, генератор 

спецификации (ВОМ) способен непосредственно выделить любые другие записи для 
описания информации о компоненте и включить их в отчет ВОМ. Например, если не нужно 
включать информацию о поставщике в схемные данные, но необходимо включить ее в 
спецификацию –можно сделать это с помощью средств Database Library.  
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Облегчение проектирования сложных изделий 
 
Одной из трудных задач всегда был перенос проекта электронного изделия из одной 

среды проектирования в другую. Если разработчик одновременно работает с другим 
програмным инструментарием проектирования, либо получает проект от сторонних 
разработчиков, то необходимо иметь возможность импорта схемы или проекта платы в 
систему Altium Designer. 

В Altium Designer унифициран процесс импорта проектов, выполненных с помощью 
других систем проектирования.  Новый помощник импорта (Import Wizard) поэтапно 
проходит по процессу импорта, манипулируя как схемами, так и платами проекта, сохраняя 
отношения между ними. 

Структура нового помощника импорта построена так, чтобы упростить добавление 
новых компонентов без трудоемких затрат разработчика, использующего систему. 

С помощью мастера можно реализовать импорт следующих типов проектов: 
• Проектные базы данных Protel 99 SE 
• Схемы и библиотеки CircuitMaker 
• Схемы, платы и библиотеки P-CAD  
• Схемы, платы и библиотеки OrCAD 
• Проекты плат и библиотеки PADS  

 
Рис. 29. Выбор типа импортируемого проекта 

  

Использование фрагментов законченных проектов 
Если в проекте часто используются фрагменты схемы, применяемые в других проектах, 

то можно использовать возможности панели Snippets (фрагментация). Простая и лёгкая в 
применении процедура позволит сохранить любые выбранные фрагменты схемы на 
единственном листе схемы или платы, в том числе компоненты и трассы. 

Выбранные схемные фрагменты или фрагменты платы сохраняются как образцы на 
панели Snippets и при щелчке ПК мышки на панели они вводятся в текущий проект как 
дополнительный элемент. 
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Такие фрагменты могут быть помещены в стандартные папки Windows в локальной 
сети и достаточно щелкнуть кнопку Snippets Folders для добавления существующей папки в 
список доступных папок на панели Snippets. Каждый фрагмент запоминается в стандартном 
файле схемы или платы. 

 
Рис. 30. Нажатие ПК мышки на передней панели для добавления фрагмента. 

Слияние объектов 
Нередко возникает необходимость работать с секцией проекта в блочном виде, 

например, при реструктуризации проекта. Усовершенствованное свойство Union (слияние) 
идеально подходит для этой цели, используя которое можно легко создавать группы любых 
объектов как их объединения. 

Такие объединения создаются автоматически для объектов в фрагментах проекта, и 
имеется возможность выбрать любые объекты схемы или платы и задать их как Union.  При 
выборе и  удерживании одного из объектов объединения в процессе перемещения, будут 
перемещаться все объекты  этого объединения. 

Используйте команды  ПК в подменю Unions для создания и модификации 
объединения. 

 
Рис. 31. Нажатие ПК в рабочей области для доступа к меню Union. 
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Вставка картинок на листы схемы 
Редактор схем Altium Designer 6.0 поддерживает буфер обмена с внешними 

программами. Это означает, что можно выполнять копирование объектов в виде картинок в 
любую прикладную программу Windows, например PowerPoint, Excel, Visio или другие 
графические системы, а также вставлять картинки из указанных редакторов в схему. 

При этом сохраняются все шаблоны и форматирование в прикладных программах, что 
существенно улучшает качество документации. 

 
Рис. 32. Вставка графической информации из буфера обмена в схему 

из различных внешних приложений. 
 
Данные в буфере обмена могут быть либо в формате метафайла (для сохранения 

графической информации, такой как в Excel) или в текстовом виде, готовыми для вставки 
как примечание или как текст в рамке, или даже для вставки набора портов или меток цепей, 
с помощью свойства Smart Paste. 

Менеджер посадочного места – управляет всем проектом платы 
В схемный редактор Altium Designer теперь включён мощный менеджер посадочного 

места (Footprint manager). Запускаемый из меню Tools, он позволяет просматривать все 
посадочные места компонентов в проекте. Это легко выполняется при  обзоре и поиски 
проблем в части посадочных мест компонентов в проекте, что особенно полезно при работе с 
транслированным проектом или с проектом из другой организации. 

Поддержка многих функций облегчает анализ посадочных мест для множества 
компонентов, изменения его связей или введения других изменений в использованные 
компоненты, связанные с различными вариантами посадочных мест. Проектные изменения, 
проводимые с помощью стандартной системы ECO в Altium Designer, касаются как схем, так 
и плат. 
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Рис. 33. Работа по управлению посадочными местоми компонентов 

  

Сравнение и обновление РСВ компонентов из библиотек 
Altium Designer вводит новое свойство Update from PCB Libraries, которое дает  

полную уверенность, что посадочное место на плате точно соответствует текущему в 
библиотеке. Оно выполняет полный анализ и сравнение всех объектов на плате и в 
библиотечной версии каждого посадочного места, а также детализирует различия. Для 
каждого посадочного места, которое не сходится с библиотечной версии, можно произвести 
индивидуальный выбор, если она была обновлёна. 

 
Рис. 34. Новая функция обновления из библиотек выполняет полное сравнение каждого 

посадочного места на плате и в библиотеке. 
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Отчёты о плате в XML или HTML 
Отчёт о плате может быть сформирован в различных форматах, включая оригинальный 

текстовый формат, HTML (hypertext markup language – стандартный язык описания 
структуры гипертекста) и XML (extensible markup language – расширяемый язык разметки 
гипертекста). Откройте страницу Reports в диалоге Preferences для настройки  отчёта. В 
действительности все отчёты вначале формируются в XML, а затем выполняется 
соответствующая XSL (Extensible Stylesheet Language – расширяемый язык 
широкоформатных таблиц) трансформация для создания выходного файла в требуемом 
формате. В диалоге Preferences  вы можете выбрать свой собственный XSL 
трансформируемый файл, и использовать эту возможность для представления отчёта в 
желаемом формате для вашей компании. 

  

 
Рис. 35. Отчёт на базе HTML показывает информацию о плате. 

 

Информационная поддержка Altium Designer 
 
Документация по Altium Designer может быть реорганизована и реструктурирована для 

большей доступности. Она доступна с помощью панели Knowledge Center. Панель  
Knowledge Center  представляет собой справочную информацию для работы с программой 
Altium Designer. Она отмечает команды, диалоги, объекты или панели, которые находятся 
под курсором и загружает данные для справки - задержитесь на секунду и в панели появится 
нужная информация.  

Knowledge Center является порталом, от краткой справки, отображаемой в верхней 
части панели имеется связь со ссылками на данные в формате PDF и на прикладные 
документы. Нижняя секция панели имеет дерево навигации, используйте его для просмотра 
документации на основе PDF и открытия интересующего документа.  

Knowledge Center содержит мощные возможности по поиску данных, доступные в 
нижней области панели. Открываются страницы, содержащие слова в строке запроса (за 
исключением таких общих слов, как и, или и т.п.).  Пределы поиска определяются текущей 
позицией в навигационной структуре. 
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Рис. 36. Используйте Knowledge Center для обучения или для просмотра и поиска 

расширенной библиотеки документации на основе формата PDF. 
 

Быстрый доступ к горячим клавишам 
Возможно, единственное, что можно сделать для увеличения продуктивности своей 

работы – это использование горячих клавиш. Нажатие клавиши более эффективно, чем 
тщательное позиционирование мышки на кнопке или поиск по многоуровневым меню, и 
после изучения горячих клавиш их использование становится определяющим. В среде 
многих редакторов, как это есть в Altium Designer, может быть, трудно запомнить горячие 
клавиши, особенно клавиши специального назначения, которые доступны при запуске 
команд. Для помощи в этом, были добавлены новые краткие меню, которые можно 
использовать со всеми интерактивными командами в схематике или редакторе плат. При 
выполнении команды, например, интерактивной трассировки, можно нажмить клавишу 
тильды (~) и появится меню, с перечнем всех доступных горячих клавиш для этого этапа 
интерактивной команды.  

Также имеется новая панель горячих клавиш (Shortcuts), которая отображает горячие 
клавиши, доступные в Altium Designer. Панель контекстно опознаваема, она не только 
обновляется при переходе от одного редактора к другому, но также обновляется при выборе 
команды, демонстрируя доступные внутрипроцессорные горячие клавиши. Это выглядит 
идеально для проектировщика, который переходит вперёд и назад между прикладными 
приложениями и испытывает трудности в запоминании таких клавиш. Клавиши для 
отдельных процессов также доступны при нажатии клавиши тильды. 

 35



 
Рис. 35. Панель горячих клавиш и выпадающее меню горячих клавиш для 

интерактивной трассировки. 
  

Обновление  через интернет 
Применение нового свойства обновления в сети позволяет легко сохранять 

программное обеспечение Altium Designer, библиотеки и обновлённую документацию. 
Сохранение установок для системы до настоящего времени выполняется легко с 

помощью свойства Web Update. Так же как и контроль доступных изменений на сайте 
Altium, можно также их конфигурировать для контроля размещения в сети, что идеально, 
если компания имеет несколько установленных версий Altium Designer. 

  

Рис. 36. Защита установленных и поиск новых обновлений через интернет. 
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Новые возможности 

Автоматическое добавление вывода листа 
Удобным инструментом в Altium Designer является автоматическая опция Place Sheet 

Entries.  С помощью этой опции возможен автоматически определяемый ввод в схему 
элементов, когда вы прокладываете провод к краю листа схемы. Имя будет получено из 
существующего идентификатора цепи (размещённого на цепи) и направления набора ввода-
вывода, для установки соответствия любого подключённого вывода, порта или ввода 
данных. 

Редактирование мультитрасс 
Если несколько параллельных проводников совместно используют координаты их 

конечных вершин, то после щелчка и перетаскивания  одной вершины проводника, все 
другие указанные проводники также будут перемещены, сохраняя их упорядочение. 

В Редактор плат также добавлена возможность увеличения набора объектов. Выбрав 
несколько сегментов трасс, укажите Move/Resize Tracks из подменю Move и Нажатие для 
изменения размера помеченных сегментов. 

 
Рис. 37. Перетащите и отпустите одну вершину, и все выровненные вершины 

 переместятся и останутся выровненными. 
  
Переключение направления порта 
Направление порта теперь могжет быть зеркально отображено при нажатии по парвой 

кнопке. Имеется возможность выбрать один или несколько портов и отобразить их 
направление зеркально. 

 
Рис. 38. Команда Toggle Selected Ports отображает зеркально направление выбранных портов.
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 Выделение элементов на схеме с помощью 
стрелок 

Объект Линия теперь поддерживает различные 
стрелки и изображения завершения линий, что 
идеально подходит для оформления 
конструкторской документации. Также доступны 
настройки штриховых и точечных линий, для линий 
разной ширины. 

  

Редактирование размещения текста 
Текст, представленный в примечаниях к схеме 

или в штампах листов схемы можно редактировать 
непосредственно в редакторе схем (без 
дополнительных диалоговых окон), ускоряя процесс редактирования и позволяя вам увидеть 
предварительный вид напечатанного текста. 

Рис. 39. Настройки линии для 
отображения штриховых линий и 

разных видов стрелок. 

 

   
Рис. 40. Редактирование текста непосредственно на листах схемы 

Имена портов силовых цепей 
Имя  порта силовой цепи может теперь отображаться или отсутствовать для всех стилей 

силовых портов, в том числе такие стили как Power Ground, Signal Ground, Earth. 

Удаление петель при интерактивной трассировке 
Редактор плат Altium Designer имеет поддержку перетрассировки существующих трасс, 

выполните команду Place>Interactive Routing и прокладываете существующую трассу по 
новому пути – как только завершите трассировку, все старые сегменты трассы, которые 
стали дублирующимися, будут удалены автоматически. Данная возможность называется 
Удаление петель (Loop Removal), и включается в настройках интерактивной трассировки 
PCB Editor>Interactive Routing в группе Interactive Routing Options. 

Встречаются случаи, когда ожидаемый результат такой замены, противоречит 
задуманному, например, при трассировке силовых цепей. Имеется возможность 
заблокировать удаление петель для любой выбранной цепи, щёлкнув на имени цепи в панели 
PCB и убрав флажок Remove Loops в диалоге Edit Nets. 

Улучшенная навигация по слоям 
При нажатии Ctrl+Shift во время вращения колёсика мышки происходит перемещение 

между включенными слоями платы. Горячие клавиши также добавлены в диалог Board 
Layers and Colors, что позволяет при открытом диалоге иметь определенные клавишы 
переключения отображения состояния сигнальных, экранных и взаимозаменяемых слоёв. 
Клавиша ускорения показывается в скобках, рядом с каждым слоем, например (T)  
переключает слой Top в активное или пассивное состояние. Диалог Board Layers and Colors 
может быть открыт нажатием клавиши L. 
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 Перемещение с помощью задания координат 
Текущая позиция объекта в схемном редакторе 

или в редакторе плат может быть смещена по 
направлению осей координат с помощью команды 
Edi>Move>Move Selection By X,Y. 

Раздельные файлы сверления для 
металлизированных и неметаллизированных 
отверстий 

Отдельный файл сверления в формате ASCII 
автоматически формируется для всех 
металлизированных и неметаллизированных отверстий, упрощая подготовку файлов для 
изготовления платы. 

 
Рис. 41. Задайте смещение по осям 
Х и Y в диалоге Move Selection. 

Усовершенствованный интерфейс DXF/DWG 
DXF и DWG являются популярными форматами файлов для обмена данными между 

различными системами автоматизированного проектирования. Экспорт DXF/DWG улучшен 
вводом нового контроля, который позволяет экспортировать выбранные объекты с линиями 
нулевой ширины, идеальными для данных, являющихся частью размерных цепочек в 
механических слоях. Импорт данных форматов также улучшен, теперь имеется возможность 
применить масштабирование, задавать ширину линий по умолчанию и выбрать позицию 
чертежа для импорта. 

  
Рис. 42. Окно, показывающее доступные опции для импорта AutoCAD. 
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Улучшенный обмен данными MCAD 
Экспорт проектов в IGES (Международный стандарт обмена графической 

информацией) и IDF значительно улучшен. Экспортируемые файлы теперь являются 
сравнительно небольшими, облегчая их импорт в среду MCAD (системы 
автоматизированного проектирования механических устройств). 

Улучшенный интерфейс Excel BOM 
Интерфейс создания отчета Bit of Materials (BOM - спецификации на плату в формате 

Excel) обновлен и добавлены новые шаблоны в формате Excel, облегчая представление 
необходимых данных. 

 
Рис. 43. Включайте информацию из базы данных, когда используются компоненты из 

библиотеки базы данных. 

Включение документов и параметров проекта в спецификацию 
Параметры являются универсальным свойством Altium Designer, вы можете добавлять 

их в проект, в документ, в компонент, фактически почти в любые объекты. Параметры 
проекта и документа теперь можно выделять из проекта и включать в спецификацию. 
Параметры документа, включённые в каждый компонент, теперь можно извлечь из этого 
документа, а проектные параметры могут быть переопределены в предварительно заданные 
текстовые поля в вашем шаблоне Excel. 

  

Поддержка моделей Pspice 
Формат моделей для работы в системе Pspice охватывает большое число 

производителей устройств. Программа моделирования схем в Altium Designer теперь 
поддерживает модели для Pspice. Эти модели поддерживаются в точности так, как модели 
Spice 3f5, необходимо их загрузить в графический редактор Model Sim и запустить процесс 
моделирования. Также имеется расширенная поддержка функций Pspice. 
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Рис.45. Работа с моделями Pspice осуществляется также, как с моделями Spice 3f5. 

Поддержка глобальных параметров и уравнений 
В программу моделирования добавлена поддержка глобальных параметров и 

уравнений. Глобальные параметры в уравнении и уравнения используются в атрибуте Value 
компонента на схеме. С другой стороны, можно задать уравнения, как глобальные параметры 
и затем ссылаться на глобальные параметры из атрибутов компонента. 

Введите выражение или наименование параметра в фигурные скобки, когда же 
программа моделирования определит их, она попытается их вычислить, проверяя страницу 
Global Parameters моделирования из диалога Analyses Setup, для определения любой части 
выражения, которое нельзя немедленно обработать. Пример создания глобальных 
параметров добавлен в папку Examples\Circuit Simulation\PSpice Examples\Global Parameters 
для демонстрации поддержки глобальных параметров и уравнений. 

Исключение части компонента из моделирования 
Одной из сильных сторон системы моделирования компонента в Altium Designer 

является поддержка моделирования одной части компонента, которая может быть 
использована на всех этапах проектирования, включая захват схемы, шаблона платы, 3D – 
модели, анализ целостности сигналов и программе моделирования смешанных цепей в 
SPICE. 

Моделирование смешанных схем SPICE также улучшено введением новой опции - 
Exclude part from simulation option, теперь можно выбрать любую секцию 
многосекционного компонента для его исключения из процесса моделирования, что 
особенно полезно, если проектируются компоненты с выводами питания в выбранной 
секции. Эти выводы по-прежнему требуются в списке цепей Spice, но когда секция помечена 
как удаляемая, её выводы автоматически появляются в списке выводов схемы для всех 
других секций компонента. 
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Рис. 46. Возможность исключения секции компонента из моделирования позволяет 

игнорировать эту секцию, но добавить выводы питания в другие секции. 

Синхронное выделение вывода на символе и контактной площадки 
Процесс предполагает, что выводы символа корректно соответствуют контактным 

площадкам (КП) посадочного места компонента и, что можно упростить выделение с 
помощью нового автоматического синхронного выделения. Указав необходимый вывод на 
символе в библиотеке, соответствующая КП посадочного места автоматически будет 
выбрана в окне предварительного просмотра посадочного места в нижней части рабочей 
области редактора библиотеки. 

Выбор соответствия Вывод-КП (pin/pad) также поддерживается на панели Libraries, 
облегчая быстрое подтверждение соответствия вывода и КП, на любой стадии процесса 
проектирования. 

 
Рис. 47. КП на посадочном месте компонента выбрано после выбора вывода на символе 

компонента. 
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Настройки автомасштабирования в библиотеке символов 
С помощью нового свойства автомасштабирования можно управлять изменением 

масштаба при переходе от одного библиотечного компонента к другому. Имеется 
возможность выбора трех вариантов: отключить изменение масштаба при переходе между 
компонентами, сохранять последний используемый масштаб компонента или задать 
определенное значение масштаба, используемое в дальнейшем по умолчанию. 

  

 
Рис. 58. Установка свойств автомасштабирования в редакторе библиотеки символов  

 Настройки функционирования кнопок мыши 
Altium Designer поддерживает стандартное поведение мышки с колёсиком, облегчая её 

перемещение из Altium Designer в другие прикладные окна. Признавая, что каждый 
разработчик имеет свои предпочтения и стиль, Altium Designer теперь поддерживает 
изменение настроек функционирования мышки, предоставляя возможность переопределения 
комбинации Scroll-Click, для индивидуальных предпочтений пользователя. 

 

 
Рис. 49. Перенастраиваемые стандартные комбинации колёсика и клавиш мышки. 

 

Улучшение панели Favorites  
Процесс проектирования большого или сложного изделия требует огромного числа 

переключений между документами и выполнения операций масштабирования. Панель 
Favorites помогает справиться с этими задачами, тем, что может запоминать позиции 
просмотра текущих документов и уровни масштабирования для повторного использования. 
Двойной щелчок на кнопке View в панели Favorites откроет документ, восстановит вид и 
уровень масштабирования в точном соответствии с последними установками, предоставляя 
идеальный вариант для перемещения между различными областями проекта, или для 
движения туда и обратно от секции схемы в её представление на плате. 
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 Используйте панель Favorites для 
осуществления обмена проектными 
решениями между участниками 
разработки проекта.  Другой разработчик 
может теперь открыть проект и прочитать 
комментарии и операции с иконками, 
чтобы понять вариант решения проектного 
вопроса.  

 Сохраненные виды могут 
сохраняться с проектом, или их можно 
сохранить в папке Favorites View, делая их 
доступными, независимо от открытого 
проекта. 

Улучшение управлением 
вариантами  проекта 

Система управления вариантами 
(VCS – version control systems) быстро 
становится стандартным методом 
управления данными электронных 
проектов. Она не только обеспечивает  
экономию памяти системы, но также 
позволяет команде разработчиков работать 
с одним набором проектных файлов, зная, 
что они не будут перекрываться или пересекаться с при взаимной работе. В Altium Designer 
6.0 добавлен новый инструментарий для помощи для облегчения получения преимуществ от 
поддержки со стороны системы управления вариантами. 

 
Рис. 50. Поддержка является идеальным 

средством работы для команды разработчиков. 
 

 
Рис. 51. Создавайте информационный архив и выполняйте стандартные контрольные 

функции из Altium Designer. 
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Также как существует поддержка любой системы управления вариантами, такими как 
Source Code Compliant Interface (SCCI)  и популярной Concurrent Version System (CVS) 
Altium Designer осуществляет теперь сильную поддержку Subversion (SVN), другой 
популярной системы управления версиями. 

Функции управления вариантами, такие как Commit  и Update могут быть реализованы 
из панели Project с более совершенными функциями, такими как сравнение различных 
вариантов, собранных из панели Storage Manager.   

Управление документами 
Altium Designer 6.0 содержит ряд небольших, но полезных усовершенствований для 

работы с документами проекта. Эти опции доступны на странице View вкладки System в 
диалоге DPX Preferences. 

 
Усовершенствованное переключение между документами 
Имеется возможность использовать клавиатуру для переключения вперёд и назад 

между документами, при этом используются горячие клавиши Ctrl+Tab. При этом 
запоминается порядок работы с последним документом, поэтому, при нажатии Ctrl+Tab 
происходит переключение обратно к документу в этом порядке. 
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Знакомство с платформой Altium Designer 
 
Altium Designer предоставляет широкие возможности для разработки электронных 

устройств, охватывая все этапы программного проектирования, в том числе: 
• Схемное проектирование 
• Проектирование печатных плат 
• Разработка на базе ПЛИС 
• Разработка специального программного обеспечения 
• Смешанное аналогово-цифровое моделирование 
• Анализ целостности сигналов для цифровых схем 
• Технологическая подготовка к производству печатных плат 
• Осуществление сквозного проектирования и отладка ПЛИС (при работе с 

соответствующей стендовой платой для ПЛИС, такой как Altium NanoBoard). 
 
Все эти области различных этапов проектирования присущи разделам одной, 

объединяющей системе, встроенной в интегрированную платформу Design Explorer (DXP) 
функциональные возможности которой зависят от специфики приобретенных лицензий. 

Интегрированная платформа DXP, лежащая в основе Altium Designer, запускается 
одновременно с любыми из редакторов и программными процедурами  Altium Designer.  
DXP, по сути, представляет интерфейс пользователя со всеми программными инструментами 
и редакторами. 

Среда Altium Designer полностью настраивается под конкретного пользователя или 
специфику предприятия разработчика, позволяя сформировать удобную среду для 
проектирования. Возможность постоянного выбора и редактирования документов в 
различных приложениях, позволяет легко и плавно переключаться между различными 
проектными задачами в пределах единой системы  Altium Designer. 

Altium Designer предлагает уникальную среду проектирования для решения всего 
спектра задач разработчика – от ввода исходных данных до генерации выходной 
информации для изготовления печатных плат; от разработки прикладных специальных 
программ до подготовки данных и загрузки проекта в ПЛИС – и всё это в одной среде при 
поддержке интегрированной платформы DXP. 

На рис. 1 представлены основные элементы интерфейса системы Altium Designer, 
которые возможно настроить под каждого конкретного пользователя. Настройка интерфейса 
начинается с включения необходимых панелей, расположения их в рабочей области, 
фиксации и т.д., и заканчивается назначением горячих клавиш, которых в данной системе и 
без этого очень много (информацию о горячих клавишах можно узнать из панели Shorcuts 
или при нажатии клавиши ~ во время выполнения команды). 

Следующая глава содержит подробное описание этих и некоторых других важных 
свойств и функций, которые входят в системы. 
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Рис. 1. Интерфейс Atium Designer 6 

Системное меню 
Установка настроек 
системы, выбор 
лицензий и 
обновление через 

Вкладки документов 
Позволяют переключаться 
между открытыми 
документами, как 
одноименных, так и различных 
приложений. При нажатии 
правой кнопки мыши можно 
выборочно закрывать 
документы 

Меню/Панели инструментов 
Набор инструментов для 
редактирования документов

Панель Navigation 
Позволяет быстро открывать 
документы, переходить назад к 
предыдущим документом, а также 
имеется кнопка для перехода на 
домашнюю страницу Altium 

Главное окно проекта 
В данном окне можно 
просматривать и редактировать 
открытые документы 

Используемые панели 
Отображаются активные панели. Имеется 
возможность фиксировать положение 
панели, либо скрывать их. В нижней 
части вкладки, предназначенные для 
переключения панелей. Доступные панели 

Вкладки панелей, доступные 
для активного редактора.  

 

Работа с документами 
 
В системе Altium Designer каждый вид документа открывается и обрабатывается 

соответствующим редактором. Например, схемные документы открываются и 
обрабатываются в редакторе схем (Schematic), библиотеки посадочных мест – в редакторе 
библиотек (PCB Lib) и так далее. При создании нового документа или открытии уже 
существующего, соответствующий редактор для этого типа документа становится активным 
редактором. 

Создание нового документа 
Новый документ можно создать одним из 

следующих способов: 
• Выбрав требуемый тип документа из File>New 
• Выбрав нужный элемент в секции New на 

панели Files. Если эта панель не 
открыта, нажмите кнопку 
System в нижнем правом углу 
окна и выберите Files в 
появившемся выпадающем 
меню 
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Если один или несколько проектов 
открыты на панели Projects то новый документ 
будет добавлен как активный проект. С другой 
стороны, для добавления нового документа 
непосредственно в открытый проект, 
независимо от того, является ли он открытым 
или нет, Нажатие правой клавишей мышки (ПК) 
на названии проекта в панели Projects и 
укажите тип документа из подменю Add New to 
Project. Меню содержит перечень исходных 
документов, обычно добавляемых для проектов 
такого типа. 

Открытие и отображение документов 
 Когда вы открыли документ, он 

становится активным документом в главном 
прикладном окне проекта. Несколько 
документов можно открыть одновременно. 
Каждый открытый документ имеет собственную вкладку в верхней части окна, но только 
один документ является активным в этом окне. Рис. 2 показывает три открытых  документа – 
одну плату и две схемы – при этом активной является плата. 

 
Рис. 2. Несколько открытых документов в главном проектном окне. 

 
Активный документ выделен подсветкой его вкладки. Для того чтобы активировать 

другой открытый документ, нужно просто щёлкнуть его вкладку. С другой стороны, можно 
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использовать горячие клавиши Ctrl+Tab и Ctrl+Shift+Tab для циклического обхода вперёд 
или назад всех отрытых документов.  

Скрытые документы 
Для компиляции исходных документов необходимы различные средства и, при 

необходимости, компиляция выполняются автоматически. Чтобы это можно было 
выполнить, все такие документы необходимо предварительно открыть. В зависимости от 
проекта, число документов для компиляции может быть различным. Чтобы сделать все 
документы открытыми, как документы со своими вкладками, в главном окне проекта можно 
создать рабочую область с произвольным размещением её элементов. С этой целью в 
системе предусмотрена возможность скрывать документы.  Они полностью отвечают 
требованиям к открытым документам, таким как возможность компиляции, перекрёстных 
ссылок, но не показаны на экране в главном окне проекта. 

Любой открытый документ можно сделать скрытым, выполнив: 
• Нажатие ПК его вкладки и выполнить команду Hide 
• Нажатие ПК на этом компоненте в панели Projects и выбрать команду Hide. 
 
Скрытые документы перечислены в выпадающем меню рядом и правее панели 

Document, которое содержит вкладки для этих документов (Рис. 3). 

 
Рис. 3. Доступ к скрытым документам 

Щелчок на компоненте в списке отменит состояние невидимости документа, и он 
повторно появится в виде вкладки для этого документа в главном окне проекта. Главное 
меню Window и документы меню от ПК мыши на панели Projects также содержат команды 
для  отмены невидимости документа. 

Отображение статуса документа 
 Как часть опций General для панели Projects  

можно активировать отображение иконки с 
отображением статуса “открыт/модифицируется”. Это 
позволяет быстро понять, какие документы открыты, 
скрыты или были изменены (Рис. 4). 

 Для облегчения рассмотрения такие иконки 
показаны ниже. Записи в скобках показывают 
текстовую подсказку, появляющуюся при наведении 

 иконку. курсора на

- Док т  
Документ открыт и был 

изме
- Проект был изменен (требуется 

) 
цируемый документ, проект или группа 

прое

помечается звёздочкой внутри соответствующей вкладки в главном окне проекта. 

 

 
Рис. 4. Отображение иконки 
статуса документа 

 - Документ открыт в этой сессии 
умент скры  в этой сессии 

- 
нен (требуется сохранение) 

сохранение
Модифи
ктов, которая должна быть сохранена, также 

помечаются звёздочкой рядом с записью элемента в 
панели.   Модифицируемый документ также 
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Управление окнами открытых документов 

прос
Имею а , 

он. 

туп к различным командам 
упра

главного окна 
проекта на горизонтальные или вертикальные 
фраг

откр врем м о и
р ак бы самостоятельные окна.  

 Altium Designer не ограничен в 
мотре и работе с одним документом. 

Рис. 5. Команды управления  
документами 

тся различные ком нды позволяющие 
эффективно управлять открытыми 
документами и менять различные варианты 
положения ок

Нажатие ПК на вкладке документа 
обеспечивает дос

вления отображением окон открытых 
документов. К ним относятся команды Close 
(закрыть), Save (сохранить), Hide (скрытия), а 
так же команды управления отображением 
всех открытых документов в пределах 
главного окна проекта (Рис. 5). 

 
Команды для разделения 

менты (Split Vertical и Split Horizontal), 
могут оказаться удобными при 
необходимости сравнения, например, схемы и 
платы, ыв их одно енно в одно кне (Р

При таком разделении экрана, документы п
с. 6). 
оекта имеют к

 
Рис. 6. Фрагментация главного окна проекта 
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Кроме этого имеются команды Tile All и Merge All, которые позволяют располагать все 
открытые окна документов в виде мозаики и сворачивать все окна, возвращаясь к работе с 
одним окном. 

При необходимости, имеется возможность открыть документ в отдельном проектном 
окне. Для этого нужно нажать ПК на вкладке и выполнить команду Open in New Window. 
Или же нажать ЛК на вкладке документа и перетащить его в область экрана, вне пределов 
главного прикладного окна  проекта.   Затем появляются доступные команды в главном 
меню Windows>Arrange All Windows Horizontal (Vertical) для расположения окон 
горизонтально (Рис. 7) или вертикально. 

 

 
Рис. 7. Горизонтальное размещение документов Altium Designer на рабочем столе 

Увеличение рабочей области – работа с двумя мониторами 
Altium Designer поддерживает два 

монитора с рекомендуемым разрешением 
1280*1024. Для использования второго 
монитора, необходимо в настройках 
экрана выбрать опцию «Расширить 
рабочий стол на второй монитор». После 
этого можно будет использовать один 
монитор для работы с Altium Designer, а 
второй для остальных приложений. 
Также, имеется возможность открыть 
разные приложения Altium Designer на 
двух экранах, наиболее применимое 
использование – открыть на одном 
мониторе схему, а на другом плату. 
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 Сохранение конфигурации рабочего стола 
Altium Designer поддерживает понятие конфигурирования рабочего стола, т.е. 

включение/выключение необходимых панелей, работа с отображением окон и т.д. Это 
свойство позволяет компоновать прикладные окна документов, рабочие панели и панели 
инструментов вокруг рабочей области проекта, как это необходимо и затем сохранить эту 
конфигурацию в файле. Таким образом, множество пользователей могут быстро 
приспосабливать рабочую область под свою манеру проектирования посредством загрузки в 
систему предварительно подготовленных шаблонов (Desktop Layouts, *.TLT). 

Команды для сохранения и загрузки шаблонов, содержащие шаблон по умолчанию, 
доступны из подменю View>Desktop Layouts. 

Хранение документов 
Altium Designer сохраняет все документы проекта и формирует выходные файлы на 

жёстком диске в виде отдельных файлов, и имеется возможность использовать Windows 
Explorer для их поиска. Документы проекта будут, как правило, содержаться в проектах, как 
для управления, так и для доступа к определённым операциям над проектом, таким как 
верификация, сравнение и синхронизация. Файл проекта содержит ссылку на документацию, 
а также на любой другой уровень проекта (При использовании иерархии). 

Типы проектов 
Altium Designer позволяет создавать и редактировать следующие типы проектов: 
• Проект платы (*.PrjPcb) 
• Проект ПЛИС (*.PrjFpg) 
• Проект ядра  (проект процессора с системой команд – ядро) (*.PrjCor) 
• Встраиваемый проект (*.PrjEmb) 
• Пакет библиотек (*.LibPkg) 
• Проект скрипта (*.PrjScr) 
 
Новый проект, какого либо из перечисленных типов можно создать одним из трёх 

следующих способов: 
• Указанием требуемого проектного типа 

из подменю File>New>Project 
• Выбором необходимого проекта из 

списка в секции New панели Files.  Если эта 
панель не открыта, Нажатие кнопку System в 
правом нижнем углу главного прикладного 
окна и укажите Files из появившегося 
выпадающего меню. 

 

• Выбрать ассоциированную ссылку на тип 
проекта в секции Pick A Task (View>Home), а затем 
доступную запись для создания нового чистого 
проекта. 
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После того, как был открыт существующий проект или создан новый,  его название 

появится в панели Projects. Любые существующие документы, которые являются частью 
проекта, и любые новые добавленные проекты 
будут появляться в процессе работы, в 
определенных вспомогательных папках в 
соответствии с их целью и/или типом. 

Рис. 8.  Панель управления 
документами проектов (Progects) 

 
 
Управление файлами проекта 
Для организации большего контроля по 

управлению файлами в проектах, Altium Designer 
содержит усовершенствованный Storage Manager, 
представленный как рабочая панель, которая 
может быть доступна после нажатии клавиши 
System в нижней части прикладного окна и 
указанием Storage Manager из появляющегося 
выпадающего меню. После открытия, панель 
Storage Manager представляет папку и файлы 
документации активного проекта (Рис. 9). 
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Рис. 9.  Панель управления  проектами (Storage Manager) 

Группа проектов 
Так как имеется возможность открывать и редактировать несколько проектов в Altium 

Designer одновременно, то предусмотрена возможность сохранять несколько открытых 
проектов как группу проектов (Design Workspace *.DsnWrk). Данная возможность может 
оказаться высоко эффективной опцией при работе с множеством проектов, которые связаны 
некоторым образом, например, входят в один функциональный блок. Можно иметь проект 
платы, который содержит одно или несколько устройств ПЛИС. Целью такого проекта  
может быть включение памяти процессора, внутри которого будет обрабатываться 
встроенное программное обеспечение. Вместо того чтобы  запоминать и открывать  
индивидуальные встроенные проекты (плату, ПЛИС), все эти проекты могут быть 
сохранены, открыты и использованы как единая группа проектов. 

Управление локальными версиями 
Работая с панелью Storage Manager, внутренняя система управления историей версий 

позволяет отслеживать изменения в документе, без использования внешней системы 
контроля версий. Управление историей документов имеет возможность для просмотра 
различий – на физическом и логическом уровнях, а также,  возвращение к предварительно 
сохраненным версиям документа. 

Управление локальной историей документа работает в соответствии с установленным 
контролем версий (Version Control System). Каждый разработчик может индивидуально 
отслеживать свои собственные изменения, используя систему локальной истории, совместно 
с VCS, которая обеспечивает полную систему управления документами, создаваемыми 
группой разработчиков. 

Методом работы системы локального управления историей проекта является 
копирование файлов каждый раз при выполнении команды Save, с сохранением копий в 
папке истории проекта History. Папка истории проекта создаётся автоматически в той же 
папке, где и остальные файлы проекта. Если проект содержит документы, сохраненные в 
поддиректориях, тогда в структуре поддиректории будет добавлена папка истории проекта. 

Имеется возможность использовать центральный информационный архив для истории 
всех проектов, который необходимо подключить на странице Version Control – Local 
History (Рис. 10) в диалоге DXP>Preferences. В данном окне задается интервал времени, в 
течении которого будет храниться локальная история сохранений и изменений файлов 
проекта. 

 54



 
Рис. 10. Опции для свойств локальной истории 

 
Нижняя часть панели Storage Manager показывает локальную историю для выбранного 

файла, при этом каждая история будет иметь название «Version X», где х – порядковый 
номер сохранения. Нажатие ПК на сохранённой версии и выбор Applay a Label, позволит 
создать метку этой версии для создания последующей ссылки. 

Нажатие ПК на файле в списке истории позволяет открыть его для работы (Open) или 
вернуться к указанной версии (Revert to). Выбор нескольких файлов одновременно 
осуществляется нажатием ЛК с нажатой клавишей CTRL на каждом, а сравнение двух 
выбранных версий – выполнением команды Compare, из под ПК (Рис. 11). 

 
Рис. 11. Сравнение двух вариантов документа 

Управление сетевыми версиями 
Контроль версий становится предпочтительным методом управления электронными 

документами во многих компаниях.  Но не только системы контроля версий обеспечивают 
надёжное и контролируемое хранение  и восстановление ценной документации, они также 
обеспечивают лёгкое восстановление старых версий документов и, с помощью  удобных 
методов сравнения, обеспечивают определение и проверку изменений в документах. 

Использование опций, доступных на вкладке General>Version Control в диалоге 
DXP>Preferences, позволяет выбрать один из вариантов контроля версий, например SCCI или 
интерфейс CVS или SVN с указанием директории хранения резервных файлов. 

Если файлы проекта уже были сохранены в системе контроля версий и 
проконтролированы в данной рабочей папке, то можно установить начальное соответствие 
между проектом Altium Designer и контролируемым VCS проектом. Для установки такой 
связи, необходимо нажать ПК на файле проекта в панели Storage Manager  и выбрать Add 
Project To Version Control. При этом не будет создана другая копия проекта в VCS, это 
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просто позволит убедиться в корректности соответствия файлов VCS и конфигурации 
установок, так что при любом изменении в этом проекте в будущем, Altium Designer 
предупредит, что файлы находятся под контролем и корректно отражают состояние 
документов. Если проект не находится под контролем версий, тогда можно использовать 
этот процесс для добавления проектных файлов (в текущую папку) в хранилище 
информации. 

После выполнения описанной настройки, можно модифицировать файлы и 
контролировать изменения (Check In или Commit) относительно хранилища данных с 
помощью панели Storage Manager. Если ведется работа с системой CVS или 
SVN напрямую, то секция VCS Revisions на панели Storage Manager представит 
ревизионную информацию для активного файла (Рис. 12). 

 
Рис. 12.  Доступная ревизионная информация в панели Storage Manager 

Редактор ресурсов документа 
Каждый редактор документов связан с набором ресурсов по умолчанию – меню, панели 

инструментов и горячие клавиши – настройки которых хранятся в соответствующих 
ресурсных файлах (*.rcs).  Эти файлы можно найти в установочной папке \System. 

При редактировании различных типов документов в главном окне проекта, ресурсы, 
связанные с этим редактором документов будут загружены автоматически. 

Любые ресурсы для редактора могут быть изменены или добавлены при 
необходимости, давая возможность приспособления рабочей среды для индивидуальных 
нужд и предпочтений. Доступ к необходимому приспособленному диалогу для  
редактирования, можно выполнить одним из следующих способов: 

1.Нажать ПК на панели меню или панели инструментов и выбрать Customize из 
появляющегося выпадающего меню 

2.Дважды нажать на пустой зоне меню, или панели инструментов 
3.Выполнить Customize из главного меню DXP 
Для дальнейшей информации по индивидуальной настройке среды проектирования, см. 

руководство Customizing the Altium Designer Resources.pdf. Это руководство включает в себя 
реорганизованные существующие меню и панели инструментов, добавленные или 
удалённые команды панели инструментов или меню, созданные новые выпадающие меню и 
таблицы работы с горячими клавишами. 

Работа с панелями 
Панели рабочей области являются основным составным элементом среды Altium 

Designer. Будут ли эти панели специфически настроены в определённом редакторе 
документа или используются на более глобальном уровне, они представляют информацию и 
контролируют повышение производительности и позволяют выполнять проекты большого 
масштаба. 

Доступ к панелям 
При первом запуске программного обеспечения, ряд панелей будет открыт сразу. 

Некоторые из панелей, такие как Files или Projects, будут появляться группами с лева от 
главного окна проекта. Другие, такие как панель Libraries, представляются в выпадающем  
режиме и появляются в виде кнопок на правой границе главного окна проекта. 
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 В нижней части прикладного окна имеется ряд кнопок, которые обеспечивают 
быстрый доступ к имеющимся панелям рабочей области, в зависимости от используемого 
редактора документа.  Каждая кнопка помечена именем 
категории панелей, к которой возможен доступ. При 
нажатии по такой кнопке, появляется выпадающее меню 
указанной категории категории. 

 

Рис. 13. Доступ к панелям 
рабочей области 

Для того чтобы открыть необходимую панель, 
необходимо нажать на имени панели в выпадающем 
меню. Символ птички используется для индикации 
открытия панели и её визуализации в рабочей области. 
Если панель открыта, но не видима, например не 
активная панель в группе установленных панелей или 
она находится в выпадающем режиме, открыть ее можно 
нажатием на имени панели в выпадающем меню (см. 
рис. 13). 

Все текущие доступные панели рабочей области 
могут также быть доступны из подменю 
View>Workspace Panels. 

Управление панелями 
В зависимости от активного текущего редактора определённого документа, ряд панелей 

может быть доступен или открыт в любой момент времени. Для облегчения компоновки и 
использования множества панелей в рабочей области, предназначены различные режимы 
представления панелей и управления их свойствами. 

В Altium Designer поддерживаются три различных режима представления панелей: 
• Docked Mode – в этом режиме панель можно поместить горизонтально или 

вертикально в пределах главного прикладного окна. Нажатие ПК на заголовке панели и 
выбор Allow Dock из выпадающего меню позволяют выбрать возможности размещения 
панели – горизонтально или вертикально. 

При вертикальном размещении, панель будет помещена справа или слева в главном 
окне проекта. При горизонтальном размещении, панель будет помещена выше или ниже 
главного окна проекта (но ниже панелей инструментов) или ниже главного окна проекта (но 
выше строки статуса). 

 

Вертикально зафиксированная панель 

Вертикально зафиксированная панель 
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• Pop-out Mode – Этот режим по существу расширяет стандартный режим размещения. 
Размещённая панель может быть использована в этом режиме щелчком на символе вывода  
рядом с крестиком закрытия панели. Символ вывода будет изменяться для указания режима: 

 - Панель в исходном режиме размещения  
- Панель теперь в выпадающем режиме  

В этом режиме, панель будет появляться как кнопка на границе рабочего окна. Если 
поместить курсор на кнопке панели, то это приведёт к переносу панели за эту границу. 
Перемещение  курсора с панели вызовет её перемещение обратно. Нажатие на кнопке панели 
вызовет расширение панели без сдвига. В этом случае Нажатие ПК вне панели для возврата 
её обратно. 

 

Кнопка переключения режима 
обычный/всплывающий 

Кнопки вызова 
скрытых панелей 

Вызванная 
скрытая панель 

• Floating Mode – В этом режиме панель можно поместить где угодно, внутри или вне 
среды  Altium Designer. Это стандартный режим для открытия панелей, если они не были 
предварительно в режиме размещения или выпадающем. 

Плавающая панель, помещённая 
поверх зоны редактирования в главном 
окне проекта, будет представлена в 
полупрозрачном режиме, что позволяет 
производить интерактивные операции в 
главном окне, в соответствии с опциями, 
заданными на странице System – 
Transparence диалога DXP>Preferences. 

 
Группировка панелей 
 
Панели могут быть сгруппированы 

посредством перетаскивания и фиксации 
одной панели поверх другой. Результат 
отображения группы зависит от того, где 
точно вы зафиксировали добавленную 
панель. Поддерживаются два режима 
группировки панелей: 
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• Стандартная группировка вкладок – Этот 
режим отображает набор панелей как группу 
вкладок, при этом видима только одна панель в 
группе. 

Для группирования панелей в этом варианте 
используйте следующие методы: 

Перетащите  нужную для добавления  панель 
в центр выбранной панели (или существующей 
группы) и зафиксируйте. Оранжевая стрелка 
позиционирования появится в правой части 
вкладки выбранной панели, указывая, в какое 
место панель будет добавлена в группу, в качестве 
другой вкладки. Голубой полутоновый цвет также 
указывает, куда будет добавлена панель 
относительно выбранной панели. Перетаскивание 
панели в центр вызовет то, что выбранная панель 
или группа становится серой. 

Перетащите желаемую панель для добавления 
региона, содержащего вкладки в выбранной панели 
(или существующей группе).  Вся выбранная панель/группа будет серой и появится 
оранжевая  стрелка позиционирования, указывая, что панель будет добавлена в группу как 
другая вкладка.  

 

 

 
Используйт

для изменения в
группе видимой 

Порядок ра
нажатием на вк
Появится стр
последовательно

• Фрактал
фрактальное гру

Этот режи
открытого окна –
эффективно совм

Фрактально
панельные вклад
добавляемой пан
существующей 

 

Метка для стандартной
группировки панелей 
е маленьк
идимости
и активно
змещения
ладке пан
елка по
сти, в кот
ьное гру
ппировани
м аналоги
можно пр
ещая их. 
е группи
ки. В это
ели в вер
группы) и
Метки для фрактальной 
группировки панелей
 

ую стрелку – вниз в правом верхнем углу панели группирования 
/активности панели. С другой стороны, сделайте другую панель в 
й панелью, щёлкнув прямо на её вкладке. 
 панелей в группе вкладок может быть изменён в любой время, 
ели и перемещением её правее или левее, по необходимости. 
зиционирования, маркирующая позицию в групповой 
орой будут расположены панели при отпускании клавиши мышки. 
ппирование – Этот метод отображает набор панелей как 
е, когда несколько панелей в группе видимы одновременно. 
чен горизонтальному или вертикальному покрытию черепицей 
осто перетащить панель для закрепления её внутри другой панели, 

рование может содержать индивидуальные панели и/или другие 
м варианте группа панелей создаётся простым перетаскиванием 
хнюю, левую, правую или нижнюю часть целевой панели (или 

 фиксации её.  Выбранное направление определяет место новой 
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панели относительно основной (на панели при перемещении позиция новой панели будет 
показано метками верх, низ, право, лево – как на рисунке выше). 

 
При перемещении панели поверх основной, затемнение будет очевидно – используйте 

это для помещения панели в требуемое место. Убедитесь, что оранжевая стрелка 
позиционирования не отображается при добавлении панели, иначе она будет добавлена как 
дополнительная вкладка панели (стандартным способом). 

 
Чтобы во фрактальной группе сделать панель активной просто Нажатие на ней. Если 

требуемая панель окажется частью группировки вкладок в пределах перекрываемой 
фрактальной структуры, просто сделайте её видимой и активной, нажатием на 
соответствующей вкладке. 
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Перемещение панелей 
  Одна плавающая или фиксированная панель перемещается с помощью щелчка на 

заголовке панели и перетаскиванием её в новую позицию. Одиночная панель, которая была 
вызвана из скрытого режима, может быть также перемещена щелчком на соответствующей 
кнопке в прикладной границе и транспортировкой панели в нужное место. 

Когда панели сгруппированы (любым из вышеописанных способов) нажатие на 
заголовок панели и перетаскивание затронет все панели в группе. Для перемещения одной 
панели, необходимо выделить её из группы, нажатием и тащите панель за её заголовок (или 
её вкладку, если она доступна). 

Для выделения панели из фрактальной группы (где она была представлена как 
черепица) и возврата её в стандартный режим вкладок, просто перетащите черепичную 
панель за её заголовок в другую панель или перетащите  существующую группу вкладок до 
появления оранжевой стрелки позиционирования и затем отпустите – панель будет 
добавлена в группу вкладок. 

При перемещении панели вблизи другой плавающей панели, их края будут защёлкнуты 
вместе. Подобным образом, перетаскивание панели навстречу края рабочей области, 
захватит панель на краю области. Это свойство “захвата с притяжением” позволяет легко 
размещать плавающие панели в рабочей среде. 

 
Закрытие панели 
Панель можно закрыть щелчком ПК в строке заголовка (или на вкладке, если она 

доступна) и выбором Close из последовательности выпадающих меню. 
Используйте “крестик закрытия” в правой части заголовка панели для закрытия 

одиночной панели. Однако если панель является частью группы (фрактальной или 
стандартной из вкладок), используйте этот крестик для закрытия всех панелей группы. 

 
Минимизация/восстановление панелей 
 
В плавающем режиме панель может быть максимизирована щелчком ПК на строке 

заголовка (или на доступной вкладке) и выбором команды Maximize из последовательности 
выпадающего меню. Для возврата максимизированной панели к её прежнему размеру, 
выполните нажатие ПК на строке заголовка или на вкладке и укажите команду Restore из 
выпадающего меню. 

Также, можно дважды щёлкнуть на строке заголовка для переключения между 
состояниями максимизации и восстановления. 
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Вспомогательные опции  
 
Altium Designer является рационализированной средой проектирования в части 

редактирования всех документов и различного сервиса, посредством централизации опций в 
едином, контекстно-зависимом диалоге DXP>Preferences (Рис.14). Особенность 
навигационной древовидной структуры этого диалога не только позволяет быстро и 
эффективно устанавливать набор общесистемных установок, но также загружать и 
запоминать базовые установки, предоставляя больший контроль над всей средой разработки. 

  

 
Рис. 14. DXP>Preferences – централизация команд настроек среды 

 
Доступ к этому диалогу выполняется указанием команды Preferences из главного меню 

DXP. Из любого редактора возможен доступ к данному диалогу, используя индивидуальную 
команду Preferences (например, Tools>Schematic Preferences из главного меню схематики). 

Навигация 
Для целей навигации по документам проекта, Altium Designer  предоставляет хорошо 

проработанную панель инструментов Navigation (Рис. 15), которая доступна из любого 
прикладного редактора. 

  
Рис. 15. Инструменты навигации по документам 
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Прямая навигация по документам 
Левое поле в строке навигации доступно для перемещения к любому документу или 

документам в сети или в локальной памяти, так же как и к любой странице в Интернете. 
Необходимо ввести или вставить адрес пункта назначения и нажать клавишу Enter. 
Директория пункта назначения или документа будет открыта для активного просмотра в 
главном проектном окне. 

Адресация пункта назначения для директории или папок на локальном или сетевом 
носителе имеет следующую форму: 

File://Корневая директория:/путь/документ 
Адресация пункта назначения для документа в Интернет имеет стандартную форму 

URL: 
HTTP://WebAddress 
Все поддерживаемые Altium Designer страницы навигационной поддержки имеют 

формат: 
DXP://Имя документа 
Поле для ввода адреса пункта назначения на самом деле является выпадающим 

списком, который содержит историю всех предыдущих адресов (верных или неверных), 
которые ранее вводились с клавиатуры. Эта история не охватывает различные сессии 
проектные. Она очищается при выходе из программы. 

При просмотре документов кнопки стрелок влево и вправо в панели Navigation 
позволяют эффективно перемещаться вперед и назад по документам, которые были 
предварительно открыты для просмотра в главном окне проекта. Выпадающие стрелки, 
размещённые справа от этих кнопок, показывают все документы, которые были 
последовательно открыты при просмотре в последней сессии. Нажатие на названии любого 
документа в списке открывает его для просмотра. 

Интегрированные навигационные страницы 

Нажатие кнопки  открывает страницу Home Page – которая является частью 
интегрированной навигационной поддержки. 

 
Рис. 16. Интегрированная навигационная страница Home Page 
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Эта страница высокого уровня, из которой могут быть доступны все возможные 
страницы навигационной поддержки. Каждая страница поддержки обеспечивает помощь при 
выполнении общих задач (например, создание проекта или документов) (Рис. 17). 

 

 
Рис. 17. Доступные страницы поддержки 

Локализация иностранных языков 
Altium Designer обеспечивает поддержку китайского, японского, немецкого и 

французского языков установки.   Все элементы меню и большая часть текстовых диалогов 
доступны либо как подсказки на одном из данных языков поверх английского текста, или же 
в виде самостоятельных переведенных формах и  меню. 

Локализация включается на странице System>General диалога DXP>Preferences. 
  

 
Рис. 18. Установка опций локализации 

Импорт файлов 
Altium Designer поддерживает широкий ряд форматов импорта документов, позволяя 

без ограничений использовать проекты, полученные из предшествующих версий 
программного обеспечения или из редакторов альтернативных программных пакетов. 
Импорт подобных файлов выполняются при использовании диалога Choose Document to 
Open (Рис. 19), доступного при выборе команды Open из главного меню File. 
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Рис. 19. Импорт документов разных типов с помощью команды Open 

 
Имеется возможность импорта следующих документов, не принадлежащих Altium 

Designer: 
o Protel 99SE Design Database  (*.DDB) 
o Схемы P-CAD V16 или V17 ASCII (*.sch) 
o Библиотеки P-CAD V16 или V17 ASCII (*.lia) 
o Платы P-CAD V16 или V17 ASCII (*.pcb) 
o Файлы PDIF P-CAD (*.pdf) 
o Проекты CircuitMaker 2000 (*.ckt) 
o Пользовательские библиотеки CircuitMaker 2000 (*.lib) 
o Схемы OrCAD (*.max) 
o Библиотеки OrCAD (*.llb) 
o Платы OrCAD (*.dsn) 
o Библиотеки посадочных мест OrCAD (*.olb) 
o Платы PADs (*.asc) 
o Платы трассировщика Specctra (*.dsn)  
o и др. 
Для более удобной реализации процесса импорта файлов, в Altium Designer имеется 

пошаговый помощник импорта проектов различных систем проектирования – Import Wizard.  
Помощник охватывает весь процесс импорта, работая как со схемами, так и с проектами 
платы, а так же имеет возможность описания соотношениями между ними. 

Мастер импорта может быть использован  для тех же типов проектов, которые были 
перечислены выше для команды Open. 
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Рис. 20. Импорт из различных САПР с помощью помощника импорта 

 

Экспорт файлов проекта 
Файлы проекта (например, схемы и платы) или проекты сами по себе могут быть 

экспортированы в различные форматы – включая предварительные версии данной САПР или 
альтернативные пакеты. Экспорт таких файлов выполняется с помощью диалога Save As 
(Рис. 21), доступного посредством выбора команды Save из главного меню File. 

  

 
Рис. 21. Экспорт платы с использованием команды Save As. 
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Документация и справка 
Документация по Altium Designer доступна через панель Knowledge Center, которая 

представляет собой интерактивную справочную информацию, появляющуюся во время 
работы. Эта информация сопровождает команды, диалоги, объекты и панели, которые 
находятся под курсором и загружает справку о них.  При необходимости возможно 
“заморозить” содержимое панели на текущем загруженном предмете, выполнив нажатие  
кнопки Auto update для отмены автозагрузки. Дополнительно можно использовать F1 для 
загрузки содержимого справки с запретом автоматического обновления. 

Панель Knowledge Center является переходным этапом от краткой обобщенной 
информационной справки, через которую осуществляется связь с файлами документации в 
формате PDF. 

В нижней части панели присутствует дерево навигации, его можно использовать для 
просмотра интересующих документов. Панель Knowledge Center содержит мощное средство 
поиска по PDF, доступное в нижней части панели. Страницы, содержащие все слова в 
поисковой строке, представляются как результат поиска (за исключением таких общих слов, 
как и, или и т.п.). Область поиска определяется текущим расположением в навигационной 
структуре.  

 
Рис. 22. Используйте Knowledge Center для поиска справки в PDF файлах 

документации. 

Доступ к горячим клавишам 
Возможно, единственный элемент, который можно сделать для увеличения 

продуктивности работы опытных пользователей – это использование горячих клавиш на 
клавиатуре. Нажатие клавиши более эффективно, чем тщательное позиционирование мышки 
на кнопке или поиск команды через иерархию выпадающих меню, и после изучения горячих 
клавиш их использование становится незаменимым. Во многих системах, также как и в 
Altium Designer, довольно трудно запомнить комбинации горячих клавиш, особенно 
клавиши специального назначения, которые доступны при выполнении команд. Для помощи 
в этом, были добавлены новые краткие меню, которые можно использовать со всеми 
интерактивными командами в редакторе схем или плат. При выполнении команды, 
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например, интерактивной трассировки, нажмите клавишу тильды (~) и появится краткое 
меню, с перечнем всех горячих клавиш для данного этапа интерактивной команды.  

 Также имеется новая панель горячих 
клавиш (Shortcuts), которая отображает горячие 
клавиши, доступные в Altium Designer. Панель 
контекстно-опознаваема, то есть не только 
обновляется при переходе от одного редактора к 
другому, но также обновляется при выборе 
команды, демонстрируя доступные 
внутрипроцессорные горячие клавиши. Это 
идеально подходит для разработчика, который 
переходит вперёд и назад между различными 
приложениями и испытывает трудности в 
запоминании таких клавиш. Горячие клавиши 
для отдельных процессов также доступны при 
нажатии клавиши тильды.  

Рис. 23. Быстрый доступ к горячим 
клавишам доступен в интерактивном 
процессе 

 
Используйте меню для обновления памяти 

о доступных горячих клавишах или используйте 
традиционное сенсорное меню для выбора 
требуемой опции с помощью мышки. 

Для сохранения видимости панели 
Shortcuts, можно быстро повторно использовать 
доступные для горячие клавиши, в зависимости 
от стиля работы. Например, простое открытие 
документа схемы покажет различные горячие 
клавиши для схемного редактора. 

  

Рис. 24. Панель Shortcuts – увеличение производительности работы с клавиатурой 
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Подсказка «Что это?» 
Используйте подсказку для получения подробной информации о каждой отдельной 

опции, доступной в диалоге. Для появления вспомогательной информации о данной области 
или опции нажмите кнопку ? в верхней правой части окна, а затем нажатие на области или 
опции, о которой нужно получить справку. 

  

 
Рис. 25. Кнопка подсказки для доступа к динамичной справочной информации 

 

Обновление с сайта 
Возможность обновления с сайта обеспечивает упорядоченное хранение программного 

обеспечения Altium Designer, библиотек и обновлённой документации. Для запуска процесса 
обновления необходимо выполнить DXP>Check For Updates. 

 

Рис. 26. Обновление с сайта обеспечивает сохранность целостности установленных 
элементов 

 
Одновременно с контролем доступных обновлений на сайте Altium, имеется 

возможность конфигурировать настройки доступа к сети – что позволяет производить 
обновления Altium Designer с сетевого ресурса, т.о. однажды скачанное обновление можно 
использовать на других системах предприятия. Кроме описанного имеется возможность 
активировать автоматическую проверку доступа обновлений. Все конфигурации 
сохраняются вне системы  на вкладке System>Altium Web Update диалога DXP>Preferences. 
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Рис. 27. Настройка поиска обновлений в сети 

Интегрированная платформа Design Explorer (DXP) и установленные компоненты 
 
Платформа DXP обеспечивает верный путь к интеграции различных проектных 

инструментов в единой среде Altium Designer. Как элемент такой интеграции, её назначение 
обеспечить единый пользовательский интерфейс и улучшить переносимость инструментария 
проекта. 

Помимо такой интеграции, платформа DXP также приспособлена для реализации 
широкого ряда свойств, таких как  общие пересекающиеся инструменты, которые сохраняют 
одинаковые применения нескольких свойств и, тем самым, ускоряют процесс разработки.  

Внешне, платформа представляет собой все элементы, с которыми взаимодействует 
пользователь – меню, панели инструментов, панели и горячие клавиши. Внутренне, это есть 
платформа, на базе которой запускается один из компонентов системы. Когда запущен какой 
либо компонент, он сообщает платформе, какие функции (или процессы) он содержит и 
передаёт перекрывающие определения во все меню, панели инструментов и горячие 
клавиши. Когда пользователь выбирает элемент меню, DXP передаёт сообщение в 
соответствующий компонент, информируя, какой процесс реализует этот компонент. 

 
В повседневном языке общения компьютера и пользователя, компонент является 

модулем, который запускается на базе платформы DXP, для добавления функциональности 
проектной среде. Он может содержать ряд комплектных редакторов документов, таких как 
редактор схем, до сложных программ анализа, таких как программы смешанного 
моделирования, заканчивая простой утилитой, которая подсчитывает все отверстия на 
печатной плате. 
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С точки зрения программного обеспечения, каждый компонент в Altium Designer 
является файлом DLL (библиотекой динамической связи). В системе Microsoft Windows 
DLL является библиотекой функций и процедур, которые могут использоваться  любым 
приложением и другими DLL. Microsoft разработал EXE/DLL модели, для повторного 
использования программного обеспечения. Функции программного обеспечения, которые 
могут быть использованы в более чем одном приложении, запоминаются в этих библиотеках, 
которые могут быть вызваны, когда приложение нуждается в этой функции. Структура  
операционной системы Windows такова, что использование функций из DLL является 
быстрой и лёгкой, настолько, как использование функций в самих приложениях. 

Altium Designer (через платформу DXP) расширяет эту модель, делая функции и 
процедуры в пределах каждого компонента DLL доступными пользователю непосредственно 
через меню, панели инструментов и горячие клавиши. 

Одновременно с расширением функциональности компонента для пользователя через 
меню, панели инструментов и горячие клавиши, каждый компонент расширяет свою 
функциональность по отношению к другим, через интерфейс прикладного 
программирования (API). Также как разрешение программного доступа к одним и тем же 
функциям, которые пользователь может получить из ресурсов, в API содержатся более 
мощные функции, которые поддерживают прямое управление информацией в документах 
проекта, при открытом текущем редакторе. Примером может быть пакет Schematic – когда 
он имеет открытый документ для редактирования, система смешанного моделирования 
может проверить содержимое этого документа прямо через API. Используя этот механизм, 
DXP может выделить информацию об объектах на схеме, требуемых для моделирования и, в 
конце концов, для генерации анализа формы волны. 

Просмотр установленных компонентов 
Список текущих установленных компонентов (например, входящих в интегрированную 

платформу DXP) можно просмотреть в диалоге EDA Servers (Рис. 28). Доступ к этому 
диалогу выполняется запуском System Info из главного меню DXP. 

  
Рис. 28. Отображение списка установленных компонентов 

 
Компоненты могут быть сгруппированы в три категории: 
• Редактор/Обозреватель документа – это компоненты представляющие окна 

редактирования или просмотра документов. Примерами могут быть редакторы схем или 
плат. 

• Помощники – это компоненты появляющиеся как помощники, где можно пошагово 
переходить через ряд страниц и отвечать на вопросы. Примерами могут быть Помощник 
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создания печатных плат (Board Wizard -PCBMaker) и Помощник создания компонентов 
(Component Maker Wizard - CompMake). 

• Утилиты – эти компоненты работают с одним из пакетов редактирования документа. 
Обычно они добавляют элементы в меню редактора документа для доступа к их свойствам. 
Примерами могут быть пакет смешанного моделирования (SIM) и редактор обработки 
отверстий (HSEdit). 

Используйте команды доступные из меню диалога на рисунке 28 (по правой клавиши) 
для просмотра информации о компоненте, выбранном из списка. При этом открывается 
диалог Server, из которого доступна информация о любом редакторе документа, который 
обслуживается компонентом и список работающих процессов (Рис. 29). 

  

 
Рис. 29. Запрос свойств компонента 
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Типы проектов в Altium Designer 
 
Начальной точкой каждого конструктивного решения в Altium Designer является 

проект. Проект представляет собой набор документов, чьи данные могут трактоваться 
однозначно. Например, схема и плата в проектных данных представляют собой набор файлов 
для изготовления единственной печатной платы, в то время как схема и текст HDL в 
проектных данных для ПЛИС представляют собой набор файлов,  необходимых для 
программирования единственной ПЛИС. 

Комплект документов, которые создают проект, формируются совместно с файлом 
проекта. Файл проекта содержит все установки, включая связи с каждым документом в 
проекте и все проектно-зависимые опции. Каждый документ в проекте записывается как 
отдельный файл, который связан с проектом через относительные ссылки к файлам на одном 
и том же логическом устройстве  или абсолютные ссылки на файлы на различных 
логических устройствах. Выходные данные, генерируемые из проекта, также ссылаются на 
проектный файл. 

Точный набор сохранённых опций будет зависеть от типа проекта. Он будет содержать 
эти опции, конфигурированные в диалоге Option for Projects, такие как: 

• Установки контроля ошибок компилятора 
• Установки синхронизации проекта 
• Местонахождение выходных файлов 
• Установки влияния многоканальности 
Другие проектные установки, сохранённые в проектном файле, содержат: 
• Установки схемных описаний 
• Установки выходных данных, такие как отчёты, распечатки, Gerber и т.д. Отметим, 

что они являются выводными установками, доступными через меню схемного редактора или 
РСВ редактора, но не выводными установками, заданными в документе OutJob. 

 
Altium Designer поддерживает различные типы проектов. Ниже кратко рассмотрены все 

возможные типы проектов. 

Проект платы (*.PrjPcb) 
Набор документов, необходимых для изготовления печатной платы. Электронная схема 

вводится в редакторе схем, создаваемая из библиотечных символов, которые размещаются 
на листе и соединяются проводниками. Проект передаётся в редактор плат, где каждый 
компонент представляется как посадочное место (корпус) и проводники на схеме 
преобразуются в соединительные линии от вывода к выводу. Определяется окончательный 
вид платы, совместно с физическими слоями платы. Описываются правила проектирования 
для изготовления фотошаблона, такие как ширины проводников и зазоры. Компоненты 
размещаются в пределах контура платы и соединяются линиями связей, которые затем 
заменяются трассами, вручную или автоматически. Когда проект закончен, генерируются 
выходные файлы в стандартных форматах, которые можно использовать для изготовления 
платы, установки компонентов  на сборочной машине и т.д. 

Проект ПЛИС (*.PrjFpg) 
Набор документов, которые могут быть обработаны для программирования ПЛИС. 

Проект создаётся с помощью редактора схем и (или) программированием на языке HDL 
(VHDL или Verilog). Добавляются файлы ограничений в проект для описания требований 
проекта, таких как программируемое устройство, внутреннее распределение выводов для 
цепей и устройств, требований к быстродействию цепи, определения частот на выводах и т.п. 
Синтез проекта транслирует исходные данные в набор вентилей низкого уровня, в 
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стандартный формат файла, известный как EDIF. Инструментарий производителя устройства 
затем обрабатывает данные EDIF и пытается разместить и трассировать проект таким 
образом, чтобы встроить данные в указанное предназначенное устройство, производя 
программный файл устройства. Проект затем может быть применён в предназначенном 
устройстве, установленном в подходящей разработанной плате и проект можно тестировать. 

Встроенный проект (*.PrjEmb) 
Набор документов, необходимых для производства прикладного программного 

обеспечения, которое может быть применено в части управляющего процессора в 
электронном устройстве. Исходный проект формируется на языке С и (или) ассемблере. 
После завершения кодирования, все части исходных файлов компилируются в формат языка 
ассемблера. Ассемблер затем конвертирует этот текст в машинный язык (объектный код). 
Объектные файлы затем связываются вместе (компонуются) и размещаются в пространстве 
оперативной памяти, формируя единый, целевой выходной файл. 

Проект для ядра (*.PrjCor) 
Набор документов, необходимых для изготовления представления EDIF (модели) 

функционального компонента, который может быть реализован в ПЛИС. Проект содержит 
схему и (или) код HDL (VHDL или Verilog). Файлы ограничений добавляются в проект для 
описания целевого устройства. Символ компонента выполняется для представления 
компонента на листе схемы, который затем рассматривается как его описание в формате 
EDIF. 

Интегрированная библиотека (*.LibPkg) & (*.IntLib) 
 Условные графические отображения и посадочные места компонентов формируются в 

редакторе библиотек для создания интегрированной библиотеки. Символы компонентов для 
схемы вычерчиваются средствами библиотечного редактора символов, и для них 
определяется модельное представление. К символу могут быть добавлены четыре типа 
моделей, например описание посадочного места компонента на плате, данные для схемного 
моделирования, моделирования целостности сигналов и трёхмерные модели. Файлы, 
содержащие модели, добавляются в Integrated Library Package (*.LibPkg) или определяются 
пути поиска для идентификации их расположения. Исходные схемные библиотечные 
символы и требуемые модели затем компилируются в единый файл, называемый 
интегрированной библиотекой. 

Проект скрипта (*PrjScr) 
Набор документов, в которых сохраняются один или несколько сценариев Altium 

Designer. Набор инструкций, которые интерпретируются каждый раз при управлении в 
Altium Designer. Инструкции создаются и отлаживаются в одной и той же среде. Имеются 
два типа инструкций – script units (сценарные блоки) и script forms (сценарные формы). 

Script unit могут быть использованы DXP прикладным программным интерфейсом 
(API) для модификации проектируемых объектов в документах проекта. Script form 
управляют контролем, а также и использованием DXP API для обеспечения сценарного 
диалога, который воздействует на документы проекта, открытые в Altium Designer.   
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Панель Projects 
 
Эта панель, возможно наиболее часто используемая панель в Altium Designer. Панель 

Projects представляет обзор структуры и документов проекта. При открытии проекта его 
документы отображаются, как показано на рис. 1. 

  

  
Рис. 1. Дерево связанных документов  проект 

в панели Projects 
 
Позволяя открывать несколько документов для редактирования, эта среда также 

поддерживает открытие многих проектов одновременно. Ими могут быть не связанные 
проекты и документы, или они могут быть связанными, как показано на рис. 1. Здесь имеется 
3 связанных проекта – проект платы, который содержит ПЛИС, проект для этого ПЛИС, 
который содержит программно-описанный процессор и встроенный проект для 
программного обеспечения, который работает на процессоре в ПЛИС. 
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Внесение изменений в проект 
Редактируемый текущий документ рассматривается как  активный  документ, 

подсвечиваемый на панели. Можно отметить, что на рис. 1 проект подсвечен как активный 
документ, потому, что это активный проект. Любые изменения, выполненные в меню 
Projects  будут касаться активного проекта. 

Когда же имеется множество открытых проектов для редактирования, простой путь для 
выполнения команд касающихся документов в выбранном проекте – это использование 
нажатия ПК на имени проекта в панели Projects. При этом, появится контекстно-
чувствительное меню, где можно выполнять действия над документами проекта независимо 
от того, принадлежит ли проектный документ к этому проекту или нет. Рис. 2 показывает, 
что документ, принадлежавший встроенному проекту, является активным, но проект платы 
был открыт на отображение в контекстно-зависимом проектном меню. 

  

 
Рис. 2. Нажатие ПК на имени проекта в панели Projects  позволяет выполнять операции 

над этим документом 
 

Опции отображения панели  Projects 
Для панели Projects имеются несколько опций отображения. Режим отображения по 

умолчанию показывает документы проекта, сгруппированные в различные папки, такие как 
Source Document, Libraries, Settings и т.д. Имеется также и ряд других режимов отображения 
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для сгруппированных документов проекта, таких как сетка отображения, поведение клавиш 
мышки, как представлять папки проекта при открытии проекта и т.п. 

   

 
Рис. 3. Управление представлением панели Projects. 
 
Эти опции устанавливаются на вкладке System>Projects Panel  диалога 

DXP>Preferences. Быстрый способ доступа к этой панели выполняется нажатием ПК на 
кнопке в верхней части панели, как это показано на рис. 3. 

Отметим, что папки, показанные в панели Projects не представляются как папки на 
жёстком диске. Они только осуществляют помощь в представлении документации проекта в 
удобном виде. 

Последовательность документов в проекте 
Документы в группе (например, Source Documents) отображаются в последовательности 

добавления в проект (который так же отображается в порядке создания). Для изменения 
порядка документов в отображаемой папке, нажмите ЛК, перетащите и зафиксируйте 
документ в новой позиции. После завершения создания проекта, исходные документы 
отображаются в порядке  иерархии проекта. 

Отметим, что невозможно построить иерархию посредством перемещения документов 
в проекте. Отношения между главными и подчиненными документами в проекте определено 
позицией символа листа в структуре главного листа.  

 

Рис. 4. Панель управления отображением. 

Отображение панелей проекта 
Если панель Projects  не является 

активной и видимой, ее можно открыть 
нажатием кнопки System в нижней 
правой части рабочей области и выбрать  
Projects из появившегося меню, как это 
показано на рис. 4. 

 
 
 
 
 
 

 77



Работа с проектами 
 

Создание проекта 
Используйте опции в подменю File>New>Projects  для создания нового проекта, как 

показано на рис. 5. Отметим, что проектный файл существует только в памяти при 
первичном создании, поэтому используйте команды Save или Save As  для сохранения его с 
необходимым названием на жестком диске.  Имена файлов для проектов FPGA, Core и 
Embedded не должны содержать  пробелы. 

  

 
Рис. 5. Выбор типа проекта в выпадающем меню File>New>Projects при создания 

нового проекта. 
 

Добавление и удаление документов в проекте 
После создания проекта и сохранения его в нужном месте, возникает необходимость 

добавления документов в проект. Самый простой способ добавления новых или 
существующих документов в проект – это нажать левую кнопку мыши на названии проекта в 
панели Projects и выбрать из выпадающего меню Add New to Projects (Добавить новый 
документ в проект) или Add Existing to Projects (Добавить существующий документ в 
проект). 

Кроме создания внутри программных файлов, также имеется возможность добавлять в 
проект другие проектно-связанные документы, такие как файлы Words или Adobe PDF. При 
добавлении их обычным путем (Add Existing to Projects), в диалоге Choose Document to Add 
необходимо установить тип файлов (File Type) для просмотра в All Files (*.*). 
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Рис. 6. Добавление в проект других типов документов. 
 

Установка опций проекта 
Настройки проекта устанавливаются в диалоговом окне Options for Projects, которое 

доступно из меню Projects в панели главного меню или при нажатии правой кнопки мыши 
на названии проекта в панели Projects. 
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Более подробно настройки каждого типа проекта будут описаны в соответствующих 
главах. Кроме данного руководства, описание настроек каждого типа проекта можно найти в 
исходной документации Altium, в соответствующих файлах:  

1. Для опций проекта платы, см. руководство  Getting Started with PCB. 
2. Для опций проекта ПЛИС, см. руководство Getting Started with FPGA. 
3. Для опций проекта для ядра, см. руководство Creating Core Component. 
4. Для встраиваемых проектов руководствуйтесь Using Embedded Tools для 

каждого конкретного процессора,  
a. Для TSK3000, см. Using the TSK3000 Embedded Tools. 
b. Для TSK51x/TSK52x, см. Using the TSK51x TSK52x Embedded Tools. 
c. Для TSK165x, см. Using the TSK165x Embedded Tools. 
d. Для TSK80x, см. Using the TSK80x Embedded Tools. 
 
Управление документами проекта 
Представление документов в панели Projects не отражает того, как они в реальности 

размещены на жёстком диске. Дело в том, что панель Projects отражает логическое 
представление проекта. Для разработчика важна организация хранения документа, поэтому 
можно иметь проектную документацию на общем сервере компании, не совпадающую с 
конкретным представлением о файлах проекта на персональном компьютере пользователя. 
Конечно, можно использовать Altium Designer с системой управления версиями, 
проверяющую документацию проекта на компьютере пользователя с данными основного 
хранилища на сервере. 

 Распределение документов между проектами  
 Поскольку каждый отдельный документ привязан к проекту, то можно распределить 

документы между несколькими различными проектами. Это могут быть листы схемы для 
стандартного источника питания, которые используются в различных проектах, или могут 
быть разделы проекта, которые необходимо моделировать отдельно. 

Сохранение проектных документов с новым именем 
Имеется специальная команда Save As, которая позволяет сохранять документы с  

новым именем. Заметьте, что это не процесс отличен от переименования, и после него на 
жёстком диске будут сохранены как старые, так и новые документы. Выполнение команды 
Save As  применительно к документу будет также обновлять проект – убедитесь, что 
документ сохраняет часть проекта. Если необходимо создать запасную копию документа без 
влияния на проект, то используется команда Save Copy As. 

Если документ с новым именем, принадлежит двум проектам, и, при этом, оба проекта 
открыты, тогда отображение имен документов будет обновлено для обоих проектов, чем 
обеспечивается сохранение целостности обеих проектов. 

Отметим, что не возможно переместить проект, выполнив команду Save As над 
документом проекта и сохранив его в новом месте – данное действие только сохранит 
документ проекта в этом месте. Это также обновит все связи в документах, которые 
содержатся в проекте, организуя связи с новыми документами проекта на старом месте, где в 
действительности сохранены документы проекта. Кроме того, панель Projects не 
предназначена для управления файлами, для выполнения данной задачи необходимо 
переместить документы проекта средствами операционной системы, через проводник. 
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Использование Storage Manager для управления документами проекта  
 

 
Рис. 7. Использование Storage Manager для переименования и удаления документов 

проекта. 
 
В то время как панель Project представляет логическую структуру проекта, Storage 

Manager представляет собой интерфейс управления файлами управлять файлами. Панель 
Storage Manager представляет документы активного проекта и отображает путь хранения 
выбранного документа под списком документов. Нажатие правой кнопки мыши на названии 
документа позволяет выполнять задачи управления, такие как сохранение или удаление, как 
это показано на рис. 7. 

Для подробностей об использовании Storage Manager нажмите F1, когда курсор 
расположен поверх панели. Кроме этого информацию по взаимодействию с системой 
контроля см. руководство Working with a Version Control System. 

 

Объединение связанных проектов – Группа проектов 
Нередко имеются проекты, которые являются связанными, например, изделие может 

содержать несколько печатных плат или возникает необходимость сгруппировать вместе 
различные версии проектов плат. Такое объединение проектов возможно посредством 
создания группы проектов (Design  Workspace). 

В действительности панель Projects  отображает текущую группу проектов – либо одну 
по умолчанию, либо ту, которая создана или открыта. Для сохранения текущего открытого 
набора проектов в виде группы проектов следует нажать кнопку Workspace в верхней части 
панели Projects или использовать соответствующие команды в меню File (например, Save 
Design Workspace As – сохранить группу проектов и Open Design Workspace – открыть 
группу проектов). 

Прежде чем создать новую или открыть существующую группу проектов, должна быть 
закрыта текущая группа проектов, при этом будет получено предупреждение о закрытии 
всех не сохраненных ранее документов, проектов или изменений в текущей группе проектов. 
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Рис. 8. Сохраните набор связанных проектов в Рабочей области. 
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Основы работы с редактором схем (Schematic) 
 
 
В данной главе будет дан общий обзор приемов размещения и редактирования объектов 

в редакторе схем. Более детально будут рассмотрены вопросы размещения и редактирования 
некоторых наиболее сложных объектов, таких как проводники и секции компонентов. 

Сетки и курсоры 
Перед размещением объектов в редакторе схем для облегчения размещения необходимо 

установить сетку.  Altium Designer предлагает три типа сетки: Visible grid - видимая сетка 
для навигации по схеме, Snap grid – сетка для размещения объектов и Electrical grid - 
электрическая сетка для создания соединений. Сетки являются опциями документа, поэтому 
они сохраняются в индивидуальном виде для каждого проекта, т.о. установленные сетки 
могут отличаться в одной схеме от другой. Устанавливаются текущие значения сеток в 
диалоге Design>Document Option. 

Видимая сетка появляется каждый раз при 
масштабировании, что позволяет выполнять 
эффективное размещение, при отображении любых 
линий или точек. Сетка типа Snap (с захватом) 
определяет шаг перемещения курсора, при размещении 
объектов на листе схемы. Перекрытием этой сетки  
являются  электрические  сетки, которые позволяют 
линиям соединений располагаться вне сеток. При 
перемещении электрического объекта в рабочей области, в случае, если он попадает на сетку 
другого электрического объекта, который не позволяет соединиться с ним, он будет захвачен 
фиксированным объектом и появится красное перекрестье. Электрическая сетка должна 
быть установлена несколько ниже, чем текущая сетка (Snap grid), иначе она станет 
неудобной для позиционирования электрических объектов, в другой сетке. 

Сетки можно быстро модифицировать или переключаться между активной и 
неактивной с помощью клавиатуры или мышки, например, нажмите G  для циклического 
переключения между различными сетками. Также для этого можно использовать 
выпадающее меню View>Grids или выбор значения после нажатия кнопки Grids. 
Используйте вкладку Schematic>Grids диалога Preferences (Tools>Schematic Preferences)  
или горячие клавиши [T,P] для установки метрических или дюймовых значений для сеток. 

    
При необходимости можно менять тип курсора в группе настроек Cursor на вкладке 

Schematic>Graphical Editing в 
диалоге DXP>Preferences. Например, 
большой 90-градусный крест, который 
расширен до краёв проектного окна 
(опция Large Cursor) может быть 
удобен при размещении и 
выравнивании проектных объектов. 

 

Размещение объектов схемы 
Основные шаги при размещении объектов схемы описаны ниже: 

1. Укажите тип размещаемого объекта. Это можно сделать выбором типа объекта из 
меню Place (например, Place>Wire) или выбором одной из иконок на панели инструментов 
размещения. Также доступны горячие клавиши для размещения (например, P,W для 
размещения проводника). Для размещения компонентов (или их секций) нужно нажать на 
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кнопку Place в панели Library, или выбрать название компонента из списка активной 
библиотеки в панели Library и перетащить его в документ. 

2. Когда объект выбран для размещения, курсор принимает вид перекрестья, указывая 
режим размещения и, если это уместно, объект привязывается к плавающему курсору. 

3. Нажмите клавишу TAB  для редактирования свойств объекта перед его размещением. 
Это откроет диалог Properties  для определённого объекта, позволяя изменить различные 
опции. 

 
После завершения установки свойств, нажмите ОК для возврата в режим размещения. 
Преимуществом редактирования в процессе размещения является то, что объекты, 

имеющие цифровые идентификаторы, такие как позиционное обозначение (ПО) будут иметь 
автоматическое приращение. Изменения, сделанные в этот период, становятся значениями 
по умолчанию для данного типа объекта. Любые изменения, сделанные в свойствах объекта 
в период размещения будут вызывать обновление свойств объекта по умолчанию, только в 
том случае если выключена опция Permanent  на странице Schematic>Default Primitives  
диалога Preferences [T,P]. 

4. Позиционируйте курсор и нажмите левую кнопку (ЛК) мыши или Enter для 
размещения объекта. Для комплексного объекта, такого как проводник или полигон, 
необходимо продолжать позиционирование и нажимать ЛК (или Enter)  для размещения всех 
вершин объекта. 

Примечание: Если активировано автопанорамирование, то можно обходить документ 
простым перемещением курсора от края до края окна редактирования в выбранном 
направлении, при этом положение окна будет следить за перемещением курсора, в 
зависимости от выбранного режима автопанорамирования. Установить стиль и скорость 
автопанорамирования можно в группе Auto Pan Options на вкладке  Schematic>Graphical 
Editing диалога DXP>Preferences. 

Опция Auto Pan на странице 
Schematic>Graphical Editing  контроли-
рует состояние отображения схемы, при 
перемещении курсора за область 
видимости. В выпадающем списке  Style 
(см. рис.) имеется три режима: 

- Auto Pan Off – автопанорами-
рование выключено; 

- Auto Pan Fixed Jamp – 
фиксированное автопанорамирование, после чего ниже указывается скорость и шаг; 

- Auto Pan Re Center – автопанорамирование с выравниванием по центру, здесь также 
указывается скорость и шаг. 
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Кроме этого, для удобства размещения объектов, можно настроить параметры 
автофокусировки на вкладке Schematic>AutoFocus диалога DXP>Preferences. 

Другие опции масштабирования или панорамирования доступны при использовании 
сочетания клавиш и колёсика мышки. Установить настройки поведения мыши можно на 
вкладке Schematic>Mouse Configuration диалога DXP>Preferences. 

5. После размещения объекта курсор остается  в режиме размещения (на что указывает 
его вид - перекрестье), что дает возможность размещать другие объекты такого же типа. 

6. Для завершения режима размещения, нажмите ПК или Enter. В некоторых случаях, 
таких как размещение полигона, необходимо сделать это дважды; после завершения 
размещения объекта и после выхода из режима размещения. Покинув режим размещения, 
курсор  принимает прежний вид, вид по умолчанию. 

Для детальной информации о специфики размещения отдельных объектов проекта 
нажмите F1, когда курсор позиционирован поверх объекта в редакторе схем, информация об 
объектах будет появляться в панели Knowledge Center. 

Редактирование объектов схемы во время размещения 
Редактирование во время размещения, позволяет выполнять вторичные операции, 

используя горячие клавиши без завершения текущей операции. Например, нажатие клавиши 
Space (Пробел) при размещении компонента будет поворачивать объект, без остановки 
процесса размещения. После размещения текущего объекта компонента, следующий объект 
появится под курсором, повернутым на угол, согласно предыдущему. 

Другим примером, когда редактирование во время размещения может оказаться очень 
полезным,  является ситуация, когда идет процесс размещения проводника, который нужно 
подключения к еще не установленному на схеме порту. Здесь нет необходимости покидать 
режим размещения проводников; просто нажмите горячие клавиши команды Place>Port 
(P,R), нажмите Esc для выхода из режима размещения порта и затем соедините проводник и 
порт. 

Размещение объектов на листе схемы. Графические и электрические объекты 
Объекты схемы подразделяются на две группы: графические и электрические. 
Для размещения графических объектов, т.е. объектов, не несущих 

никакой логической связанности, таких как линии, дуги и текст, 
используется панель инструментов Drawing Tools (доступная из панели 
инструментов Utilities, которая включается View>Toolbars>Utilities). 
Функции черчения могут быть также доступны из меню Place>Drawing 
Tools, за исключением вставки массива (Edit>Paste Array). 

     

Размещение электрических объектов 
Электрические объекты схемы определяют физическую сущность, которую формирует 

разработчик устройства. Такие объекты содержат компоненты (секции) и соединяющие 
элементы, такие как проводники, шины и порты. Используйте меню Place или панель 
инструментов Wiring (View>Toolbars>Wiring) для размещения электрических объектов. 
 
  

  
Следующий раздел подробно описывает размещение наиболее широко используемых 

типов объектов – секций (компонентов) и проводников. 
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Размещение секций компонентов 

Когда выбрана команда Place>Part (P,P) или нажата кнопка  в панели 
инструментов, отображается диалог Place Part. В окне Place Part нужно ввести имя 
компонента в поле Physical Component или нажать кнопку Browse (…) для выбора секции 
компонента из библиотеки. При нажатии кнопки History, можно обнаружить 
предварительно размещённые секции. 

 
Секции компонента могут также размещаться с помощью кнопки Place на панели 

Library или в редакторе библиотеки символов. Для размещения компонента через панель 
Library, выберите имя компонента в панели Library и перетащите его на документ, где он 
появится плавающим с курсором, готовый для размещения. Повторным нажатием ЛК 
завершите процесс размещения компонента. 

При размещении секций компонентов, используйте сетку Snap Grid, при этом концы 
выводов будут попадать в узлы сетки. Помните, что при нажатии клавиши G происходит 
циклическое переключение сеток. 

Размещение проводников 
Проводники предназначены для представления электрических соединений между 

выводами компонентов. Для размещения проводников используется команда  Place>Wire. 
Команда Place Wire также доступна из меню и из списка, появляющегося после нажатия ПК 
в произвольном месте схемы, а также с помощью панели инструментов Wiring. 

    
Окончание  проводника должно попадать в точку подключения электрического объекта 

для его соединения, например, проводник должен попасть на горячий конец вывода для 
соединения с ним.  После размещения проводника, когда проводник попадает на узел сетки 
другого электрического объекта, курсор будет захвачен фиксированным объектом и 
появится горячая точка (красный крестик). Этот крестик сообщает, что подключение верно, 
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и автоматически захватит курсор в точке электрического подключения. Размещение 
проводника будет завершено автоматически, когда он заканчивается на горячей точке. 

Если размещаемый проводник ещё не подключён к другому электрическому объекту, 
то, для приостановки размещения нажмите ПК (или клавишу Esc).  

Режимы размещения проводников 
При размещении проводников, нажатие SHIFT+Space производит циклическую смену 

режимов размещения проводников. Доступными являются такие режимы: 
• 90 Degree – под прямым углом 
• 45 Degree – под углом 45 градусов 
• Any Angle – под произвольным углом 
• Auto Wire – Авторазмещение 
Режим определяет создаваемый угол при размещении проводника и разрешенный угол 

его расположения. Кроме четырех режимов у первых двух имеются подрежимы. Нажмие 
клавиши Space (пробела) для переключения между подрежимами (при режимах 45 или 90 
градусов) или между  режимами Any Angle и Auto Wire (когда активен любой из этих 
режимов). 

Режим Auto Wire является специальным режимом, который позволяет размещать 
автоматические соединения между двумя точками на схеме. Он будет автоматически 
прокладывать маршрут проводника с обходом препятствий. При нахождении в этом режиме, 
нажмите клавишу TAB  для установки опций для этого режима в диалоге Point to Point 
Router Options. 

Узловые точки подключения 
Проводники имеют свойство Auto Junction, которое автоматически вводит узлы 

подключения (точку), если проводник начинается или заканчивается на другом проводнике 
или проходит через вывод компонента. Отображение, размер узла и цвет узловой точки, и 
ручной ввод такого узла может контролироваться на вкладке Schematic>Compiler  в диалоге 
DXP> Preferences. Установить обход проводником другого проводника и конвертировать 
существующие проводники для формирования элемента пересечения можно с помощью 
опций на странице Schematic>General. 

Приемы редактирования объектов схемы 
Любые объекты, размещенные на схеме можно модифицировать различными путями. 

Объекты можно передвигать по всему документу, а также вырезать, копировать и вставлять 
внутрь или между документами. Также можно редактировать свойства объектов в части 
цветности, позиционных обозначений или меток цепей и прочее. У некоторых объектов, 
например имеющих признаки полилинии (шины, проводники, полигоны и линии), можно 
изменить графический вид после их размещения. 

Имеется возможность изменять один объект или применять изменения ко всему 
проекту с помощью мощных приемов редактирования, таких как запросы. Некоторые другие 
полезные инструменты помогают работать с группами объектов одновременно, 
включенными в диалог Find Similar Objects, в панелях List и Inspector. См. главу Глобальное 
редактирование  для большей информации. 

Размещённые компоненты и посадочные места могут быть отредактированы с 
помощью диалогов или изменены в редакторе библиотек и обновлены на схеме. Выводы 
можно отредактировать с помощью редактора Component Pin, который доступен из схемного 
диалога Component Properties (кнопка Edit Pins). См. главу Создание библиотек для 
дополнительной информации о создании или редактировании частей и посадочных мест с 
помощью редакторов библиотек. 
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Редактирование графики размещенных объектов 
 
Редактирование изображения объектов в рабочей области легче выполнять графически. 

Для этого сначала необходимо выделить объект (объекты), одним нажатием ЛК на его 
графике. 

После выбора объекта, его можно переместить или отредактировать графические 
характеристики. Нажмите ЛК на объекте для выделения до появления 
его меток или вершин. Для изменения графики выбранного объекта, 
нажмите ЛК на метке и не отпуская переместите ее в сторону. Это 
точка на объекте будет привязана к курсору, поэтому просто 
переместите мышку в новую позицию и отпустите для изменения 
размера. Щёлкните где-нибудь на выбранном объекте для его 
перемещения или нажмите клавишу Delete  для его удаления. 

Редактирование проложенных проводников 
Для такого редактирования имеется несколько способов – перемещение вершины, 

перемещение сегмента, перемещение всего проводника или удлинение проводника. 
Возможно, также  отредактировать, добавить или удалить вершины с помощью вкладки 
Vertices в диалоге свойств проводников. Для подробностей см. справочный файл Editing 
Vertices from the Properties. 

Перемещение вершины проводника 
Для такого редактирования нажмите ЛК на проводнике и выделите его. Наводите 

курсор на вершину, которую необходимо переместить, до тех пор, пока курсор не будет 
имеет вид двойной стрелки. Затем нажмите ЛК и перетащите вершину в новое место, как 
показано ниже. 

 

Перемещение сегмента проводника 
Отредактировать проводник можно смещением его сегмента. Выделите проводник и 

наводите курсор на сегмент, пока он не примет вид квадратной стрелки. Затем щёлкните и 
переместите сегмент в новое место, как показано ниже. 

 

Перемещение всего проводника 
Для перемещения всего проводника без его модификации – без выделения, просто 

нужно нажать ЛК на проводнике и передвигать мышку. 

 88



 

Удлинение проводника 
 Размещённый проводник можно удлинить или добавить. Выделите проводник, после 

чего наводите курсор на его окончание, которое вы 
хотите удлинить, пока курсор не примет вид двойной 
стрелки. Нажмите ЛК на конечной точке и тащите этот 
конец сегмента в новое место, после чего нажмите ЛК 
для завершения. Во время перетаскивания можно 
изменять режим размещения комбинацией клавиш 
SHIFT+SPACE. Для удлинения сегмента только в том 
же направлении при перемещении конечной точки 
держите нажатой клавишу ALT.  

Разрыв проводников 
Используйте команду Edit>Break Wire для разделения сегмента проводника на две 

части. Эта команда доступна также из выпадающего меню при нажатии ПК, когда курсор 
находится на проводнике. На месте разрыва проводника появляется отображение 
прямоугольника выреза. Вырезаемая секция маскируется как показано 
ниже. Длина выреза – это пространство между двумя сегментами. 
Нажмите клавишу пробела для циклического обхода трёх режимов 
задания длины выреза (вырез сегмента, вырез нескольких элементов сетки 
или вырез фиксированной длины). Нажмите TAB для установки фиксированной длины 
выреза или любую другую опцию выреза. Нажатие ЛК заканчивает разрыв проводника.  

Нажмите ПК или клавишу ESC для выхода из режима разрыва. Опции разрыва 
проводника также можно установить на странице Schematic>Break Wire диалога 
DXP>Preferences. 

 
Заметим, что возможна установка опции Components Cut Wires  на странице 

Schematic>General диалога DXP>Preferences. При активации этой опции и опции Optimize 
Wires and Buses, можно разместить компонент на проводнике и он будет разорван этим 
компонентом на два сегмента, которые автоматически будут подключены к двум выводам 
компонента. 
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Мультипроводник 
В редакторе схем поддерживается режим редактирования нескольких проводников 

одновременно. Если несколько параллельных проводников имеют одинаковую координату 
концов, то можно, выделив все эти проводники, нажать ЛК и перетаскивать для 
перемещения конец одной вершины, а концы вершин всех других выбранных проводников 
также будут перемещаться, сохраняя выравнивание. 

   
Перетащите и отпустите одну вершину и все выровненные вершины будут сдвинуты 

для сохранения выравнивания. 

 

Сдвиг и перемещение объектов схемы 
Сдвиг объекта в Altium является изменением его положения, без учёта его связей с 

другими объектами. Сдвиг объекта, например, не затрагивает какие-либо связанные с ним 
проводники. Но перемещение компонента, сохраняет его связность, т.е. проводники. Для 
таких операций с сохранением связности, активируйте опцию Always Drag на странице 
Schematic>Graphical Editing в диалоге DXP>Preferences. 

Сдвиг объектов 
Возможно сдвинуть единственный, не выбранный объект, или множество выбранных 

объектов, с помощью мышки – выполнив нажатие ЛК и перемещение курсора. Также можно 
использовать команду Edit>Move, в особенности, если необходимо переместить объекты 
относительно других размещённых объектов. 
При этом не нужно сначала выделять объекты для перемещения по листу схемы. Просто 
нажмите ЛК и удерживайте клавишу до появления маркера горячей точки и затем 
перемещайте компонент или объект в новую позицию. Курсор будет находится вблизи 
горячей точки, например, рядом с выводом. Опция по умолчанию, располагать горячую 
точку в точке привязке (Object’s Electrical Hot Spot) и альтернативный вариант – 
захватывать за геометрический центр объекта (Center of Object) устанавливаются на вкладке 
Schematic>Graphical Editing в диалоге DXP>Preferences. 
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При сдвиге объектов, можно воспользоваться горячими клавишами: 
• Нажмите SPACE (пробел) для вращения объекта. Оно производится против часовой 

стрелки с шагом 90 градусов. Для вращения по часовой стрелке нажмите SHIFT+SPACE. 
• Нажмите клавиши Х или Y для зеркального отображения объектов относительно 

соответствующих осей. 
• Нажмите и удерживайте клавишу ALT для ограничения направления перемещения 

относительно горизонтальной или вертикальной осей. 

Перемещение объектов 
Команда Edit>Move>Drag позволяет сдвигать любые объекты, например, компонент, 

порт, проводник или шину, и, при этом, любые соединяющие проводники будут сдвигаются 
вместе с объектом, сохраняя связность. При этом курсор принимает вид перекрестья, 
который нужно установить на перемещаемом объекте и нажать ЛК или Enter. Переместите 
объект в нужную позицию и снова нажмите ЛК. Продолжите перемещение других объектов 
или нажмите ПК (ESC) для завершения режима транспортировки. 

Для транспортировки множества выбранных объектов с сохранением связности 
используйте команду Edit>Move>Drag Selection. 

С другой стороны, можно перетаскивать объекты с помощью горячих клавиш. Выделив 
объекты, просто удерживайте клавишу CTRL после захвата, удерживайте ЛК и двигайте 
мышку. Затем можно отпустить клавишу CTRL,  после начала транспортировки. Напомним, 
что использование этой клавиши временно выключает установленную опцию Always Drag  в 
диалоге Preferences. 

В процессе транспортировки объекта: 
• Для изменения режима проводников при перетаскивании нажмите SPACE или 

SHIT+SPACE. 
• Нажмите CTRL+SPACE  во время перетаскивания для вращения объекта против 

часовой стрелки с шагом 90 градусов. 
• Нажмите клавиши Х или Y для зеркального отображения объектов относительно 

соответствующих осей. 
• Нажмите и удерживайте клавишу ALT  для ограничения направления перемещения 

относительно горизонтальной или вертикальной осей. 
• Нажмите клавишу SPACE при перемещении для переключения режима 

ортогональности для любых присоединённых к объекту проводников. 

 

Копирование и вставка объектов 
В редакторе схем можно копировать и вставлять объекты как внутри, так и между 

документами, например компонент из одной схемы можно скопировать в другую. Это 
копирование выполняется через  буфер обмена операционной системы. Можно также 
копировать строки текста. Причем напрямую копировать или вставлять данные табличного 
вида из другого приложения, например, Microsoft Excel, или из любых данных сеточного 
типа в пределах Altium Designer. С помощью свойства Smart Paste можно выполнять более 
совершенные операции по копированию и вставке. 

Выделите нужные для копирования объекты, выполните Edit>Copy (CTRL+C) и 
установите  базовую точку объекта, нажатием ЛК, которая будет использована для точного 
позиционирования объекта при его вставке. Напомним, что для получения предупреждений 
о вводе необходимых данных о базовой точке выполняется только при активной опции 
Clipboard Reference, на вкладке Schematic>Graphical Editing в диалоге DXP>Preferences. 
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Использование интеллектуальной вставки (Smart Paste) 
Свойство интеллектуальной вставки в редакторе схем (Smart Paste) позволяет 

трансформировать копии выбранных объектов в другие объекты при их вставке. Например,  
скопировав выбранные метки цепи, можно с помощью Smart Paste трансформировать их в  
порты, или выбранные входы на листе могут быть вставлены как сборка объектов 
Проводник+Порт+Метка, одной операцией вставки. 

 

 
Входные метки листа копируются в буфер обмена и затем трансформируются в группу 

Wires+Ports+Net, так как они выполнены командой Smart Paste. 
Также можно осуществлять полный контроль над всеми выбранными объектами для 

предполагаемой вставки, просто зачищая флажки для игнорирования специфических типов 
объектов, которые будут выбраны Smart Paste. 

Другим заметным свойством является возможность вставки выбранных схем как 
графики. С помощью этого свойства вы можете легко включить графические секции схемы в 
другой лист и изменить их размер по необходимости. 

Редактирование текста на схеме 
Строка текста может быть отредактирована прямо на листе схемы. Выделите строку, 

рамку текста или примечания нажатием ЛК, затем нажмите ЛК второй раз для 
редактирования текста на листе (или нажмите F2). Такое поведение можно отменить 
выключением опции Enable In-place Editing  на вкладке  Schematic – General  диалога 
DXP>Preferences. 

Переномерация компонентов 
Как редактор схем, так  и редактор плат позволяют менять настройки номерации. 

Возможность переномерации компонентов схемы позволяет сравнить компоненты по 
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параметрам и выполнить контроль индексов позиционных обозначений и опции для 
суффиксов на листах схемы. 

Используйте команду Tools>Annotate для открытия диалога Annotate, с помощью 
которого изменяются присвоенные позиционные обозначения для всех секций компонентов 
в указанных листах текущего проекта, так что они станут уникальными и упорядоченными. 

 
Нажмите F1 при открытом диалоге Annotate  для получения дополнительной 

информации об этом процессе. 
Возможно, также, использовать команду Tools>Annotate Quiet для присвоения 

уникального позиционного обозначения для всех компонентов, которые в этот момент не 
имеет позиционного обозначения, без активации диалога Annotate. 

При необходимости можно использовать команду Tools>Reset Designator  для сброса 
всех позиционных обозначений компонентов в активном проекте, или сброса дублированных 
обозначений (Tools>Reset Duplicates). 

Для переименования всех позиционных обозначений компонентов в соответствии со 
позиционными номерами на схеме (плате), заданными в диалоге Annotate используйте 
команду Tools>Force Annotate. 

Обратная переномерация (Tools>Back Annotate) будет обновлять позиционные 
обозначения  компонентов в исходном листе схемы активного проекта, используя файл 
WAS-IS, генерируемый при каждой переномерации позиционных обозначений в документе 
платы. 

Редактирование свойств объектов 
Для просмотра или редактирования свойств любого объекта, необходимо открыть его  

свойства (окно Properties), одним из следующих способов: 
• Когда объект является прицеплен к курсору во время размещения, нажмите клавишу 

TAB для открытия диалога Properties. 
• Дважды щёлкните на размещённом объекте для открытия его диалога свойств. 
• Укажите Edit>Change  из меню для включения режима изменения объекта. Нажмите 

ЛК на объекте, который вы хотите редактировать. Нажмите ПК или клавишу ESC  для 
выхода из этого режима. 
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• Нажмите ЛК на размещённом объекте для его выбора, затем отредактируйте его 
свойства в панели List и Inspector, как будет описано в соответствующих главах по 
глобальному редактированию. 

 

Редактирование изломов через окно Properties 
Отредактировать координаты изломов для шины, полилинии и полигона можно с 

помощью вкладки Vertices диалога Properties. Например, диалог свойств Wire  имеет вкладку 
Vertices, где можно отредактировать каждый излом текущего выбранного проводника при 
необходимости. 

 
Главная часть вкладки перечисляет все точки излома, размещенные на проводнике. 

Можно добавить новые изломы на проводник, отредактировать координаты существующих 
точек или удалить выбранные вершины в целом. 

Нажмите кнопку Menu или щёлкните ПК в главном списке для доступа к выпадающему 
меню, в котором можно отредактировать, добавить или удалить вершины или копировать, 
вставить, выбрать или удалить элементы. Появится диалог Move Wire By, из которого вы 
можете ввести инкрементальное значение, применимое к каждой координате Х и Y. 

Редактирование объектов через панель Inspector 
Эта панель даёт возможность просматривать или редактировать свойства одного или 

нескольких объектов в текущем открытом документе. При использовании совместно с 
панелью Filter (F12) или с командой Find Similar Objects (SHIFT+F или нажатие ПК на 
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выбранном объекте и выбор Find Similar 
Objects), где можно изменить множество 
объектов одного типа. 

Выберите один или более объектов и 
нажмите F11 для отображения панели Inspector 
или выберите вкладку Inspector из списка 
панелей SCH. Если панель не видима, нажмите 
ЛК на кнопке SCH в строке статуса и укажите 
Inspector, или выберите View>Workspace Panels 
>SCH>Inspector. Можно также установить 
опцию  Double Click Runs Inspector  на вкладке 
Schematic>Graphical Editing диалога 
DXP>Preferences  для запуска панели Inspector 
вместо диалога свойств объекта при двойном 
нажатии на объекте схемы. 

Отметим, что панель Inspector  будет 
показывать только свойства, которые являются 
общими для всех выбранных объектов. Атрибуты 
в списке могут быть модифицированы через 
панели Inspector. Введите новый атрибут, 
включите опцию или выберите значение атрибута 
из выпадающего списка. Нажмите Enter  или 
нажмите ЛК на любом другом атрибуте для 
проведения изменений. 

   
Для получения большей информации о 

редактировании множества объектов, см. главу 
Глобальное редактирование объектов. 

Редактирование объектов из панели List 
Выберите объект (или объекты) и нажмите 

Shift+F12 для отображения панели List.  
При использовании совместно с панелью Filter (F12)  или с командой Find Similar 

Objects (SHIFT+F) можно назначить и отредактировать множество выделенных объектов. 
Из панели List можно изменять свойства объектов указанием Edit  из выпадающего меню 
View/Edit в верхней части панели. Для изменения положения секции компонента, например, 
укажите координаты Х и Y и введите новую позицию. Нажмите Enter  для установки 
изменения. 

 
Двойное нажатие на объекте в списке Object Kind в панели List запускает диалог 

Properties. 
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Глобальное редактирование 
 
Разработка проекта в САПР Altium Designer, это процесс формирования  логической 

связанности в виде схемы, с последующим представлением набора объектов в рабочей 
области платы. Даже на небольшой схеме может содержаться много компонентов, каждый с 
математическими моделями и параметрами. В процессе проектирования свойства этих 
компонентов могут нуждаются в модификации, так как конструктор работает в условиях 
противоречивых требований. 

 Для поддержки задачи редактирования нескольких объектов, предварительные версии 
Altium Designer содержали инструментарий, называемый Глобальным Редактированием  
(Global Editing). Основной подход к реализации этого инструментария состоял в 
редактировании одного объекта, а затем в применении этих изменений к другим объектам. В 
последних версиях программы для выполнения подобных операций предназначается группа 
инструментов (панелей). Работа по глобальному редактированию выполняется по 
следующему алгоритму: выделение объекта, определение группы объектов по заданным 
свойствам, модификация параметров и наконец, внесение изменений.  

 
Групповое выделение объектов 
 
На самом деле имеется несколько способов выбора объектов, например, можно 

использовать стандартные варианты выделения, используя Shift+Click. Такой подход 
рационален при выборе незначительного числа объектов или когда имеется несколько типов 
объектов, редактируемых одновременно, находящихся на одном листе.  

Для выделения нескольких объектов, которые могут при этом находиться на разных 
листах схемы, используется команда Find Similar Objects. Для открытия этого диалога 
щёлкните ПК на одном из объектов редактирования и выберите из контекстного меню Find 
Similar Objects. 

Рассмотрим данную процедуру на конкретном примере, взятом из директории 
C:\Program Files\Altium Designer 6\Examples под названием 4 Port UART and Line Drivers. 
Скажем, необходимо изменить имя цепи питания на схеме  с -12V на -5V. Это потребует 
изменения атрибута всех портов питания -12V на всех листах.  

 

1. Первым шагом необходимо обнаружить один из данных 
портов на схеме, выполнить щелчок ПК на нём и выбрать Find 
Similar Objects (рис.1), после чего появится окно, показанное на 
рисунке 2. 
 

Рисунок 1 
2. После выхода в окно Find Similar Objects необходимо создать запрос, т.е. указать 

критерии выбора объектов на схеме (плате). Данное окно имеет три столбца, в первом 
перечислены параметры, доступные для данного типа объектов (набор этих параметров 
значительно меняется от типа выбранного объекта),  во втором столбце указано текущее 
значение параметра для выбранного объекта, а в последнем столбце критерий выбора. Для 
каждого параметра объекта вы можете установить такие свойства сравнения, как Same 
(Одинаковый), Different (Другой) или Any (Любой).  В рассматриваемом примере нас 
интересуют порты питания -12V, таким образом в окне необходимо в строках Object Kind 
(тип объекта) и Text (текст) указать критерий выбора Same, в результате данный запрос 
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применим к портам питания (Power Object) со значением -12V (см. выделения на рис.2). Все 
остальные параметры имеют критерия Any, т.е. их значение не имеет значения. 

 
Рисунок 2 

После установки критерия выбора, необходимо указать область действия запроса и 
выбрать команду для запроса (при необходимости). В нашем случае указываем область 
действия Open Document (открытые документы, предполагается, что уже открыты все листы 
схем указанного проекта) и включаем опции Select Matching и Run Inspector (Выделить 
указанные объекты и запустить панель Inspector после выхода из окна Find Similar Objects). 
После выбора указанных настроек и нажатия клавиши ОК запускается панель Inspector (рис. 
3). 

 
Групповое изменение свойств объектов 
 
3. Оба редактора схемы и платы содержат панель Inspector. Основная задача панели 

Inspector – вывести список свойств выбранных объектов. Набор выбранных объектов может 
быть только одинакового типа, например на рисунке 3 показаны свойства пяти портов 
питания.  
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Рисунок 3 
Свойства идентичные для всех выбранных объектов получают отображение их 

значений, например, в данном случае показан цвет портов питания (Color), стиль порта 
питания (Power Object Style - Bar) и опция Show Net Name (Отображать название цепи). Для 
каждого свойства порта питаня, имеющего различные значения будет указано <…> 
(например, в позиции Х1). Это означает, что не все эти пять  объектов имеют одно и тоже 
значение для Х1. Кроме перечня свойств объекта панель Inspector имеет две опции по 
определению области действия панели: это опция Include – которая устанавливает 
ограничения на тип отображаемых параметров, и опция from – определяющая документы с 
которыми ведется работа. В нашем случае в опции Include имеется только один выбор - 
Power Object (так как панель Inspector была запущена из окна Find Similar Objects), а в опции 
from необходимо выбрать Open Document of the Same Project (Открытые документы данного 
проекта). В результате выполнения всех действий в строке состояния панели Inspector будет 
указано количество выбранных объектов и на скольких листах они находятся (см. рис. 3).  

Панель Inspector может быть использована и работы со свойствами единичных 
объектов, что более удобно, чем каждый раз заходить в свойства объекта двойным щелчком 
мыши, либо вызывать из контекстного меню по правой клавише. При запущенной панели 
Inspector, выбрав объект на схеме (плате), его свойства будут отображены в панели и 
доступны для редактирования, при этом не будет стандартного окна свойств объекта, 
которое к тому же закывает собой большую часть документа.  

4. Выбрав объекты и просмотрев их свойства можно перейти к редактированию 
необходимого параметра. В рассматриваемом примере устанавливаем указатель мыши в 
строку Text,  вместо -12V вводим новое значение -5V и нажимаем Enter. После проделанных 
манипуляций значение метки порта питания -12V сменилось на -5V на всех листах схемы. 

При последовательном выполнении описанных действий после смены имен портов все 
другие объекты на схеме маскируются (т.е. показаны более светлым цветом и не доступны 
для редактирования). Чтобы снять маскировку и продолжить работу с документом, 
необходимо нажать комбинацию клавиш Shift+C. 

 
Добавление нового параметра для группы объектов 
 
Редактирование, которое выполнялось выше относилось к примитиву, т.е. одному из 

базовых объектов, используемых в схемном редакторе. Более сложные объекты, такие как 
компоненты, называют составными объектами; они являются по существу набором 
примитивов.  
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Рассмотрим  пример типичного группового объекта, редактирование которого 
необходимо выполнить. Данный проект (4 Port UART and Line Drivers) содержит несколько 
конденсаторов 0,1uF, для которых необходимо добавить параметр Напряжение. Данную 
процедуру проделаем в несколько шагов:  

1. Выберем все конденсаторы данного типа 
2. Добавим новый параметр для конденсатора 
3. Установим видимость добавленного параметра 

 
Шаг 1. Выбор всех конденсаторов 0,1uF в проекте 

Находим на схеме конденсатор C4, который принадлежит редактируемой группе, 
нажимаем на нем правой кнопкой мыши и запускаем Find Similar Objects. Окно Find 
Similar Objects имеет несколько другой вид – пересень доступных свойств гороздо больше, 
чем при работе с примитивом. Зададим запрос на выделение параметров следующим образом 
(рис. 3) – ограничение на позиционное обозначение (С* - выбор только конденсаторов) и на 
комментарий (0,1uF – выделять только с данным напряжением). Включаем опции Select 
Matching и Run Inspector и указываем область выбора – все открытые документы. После 
нажатия кнопки ОК запускается панель Inspector. 

Рисунок 4 
Шаг 2. Добавление нового параметра 

Для составных объектов в панеле Inspector имеется вкладка Parameters (см. рис. 5), в 
которой перечислены все параметры назначенные для выбранных компонентов. Чтобы 
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добавить параметр Напряжение, устанавливаем курсор в поле Add User Parameter и вводим 
значение параметра 10V, после чего нажимаем Enter. После ввода значения параметра 
появляется запрос на ввод название самого пареметра, здесь необходимо ввести его название 
(здесь - Напряжение). После проделанных действий у выбранных компонентов появился 
новый параметр, однако на схеме он пока не отбражен. 

 
Шаг 3. Отображение видимости параметра компонента 

Для того, чтобы сделать добавленный параметр видимым, необходимо менять уже его 
свойства, а не свойства компонента. Чтобы перейти к свойствам параметра необходимо его 
выбрать в панели Inspector, после чего в этой же панели появляются свойства параметра, о 
чем свидетельствует надпись Parameter в строке Object kind, появившаясся вместо Part. 

Следующим действием нужно выключить опцию Hide (см. рис. 6), после чего на листе 
схемы появилось значение параметра (10V). Теперь чтобы от свойств параметра вернуться 
назад к свойствам компонента, выбрать строку Owner в панели Inspector (см. рис. 6). 

 
 

 
 

Рисунок 5 Рисунок 6 
 
Редактирование нескольких параметров различных компонентов 
 
При проектировании каждому типу объектов может быть назначено несколько 

параметров, информация о которых используется для оформления документации. Параметры 
документа используются для оформления чертежей схемы и платы, параметры компонента 
идут для оформления перечней и спецификаций. Все используемые параметры могут 
редактироваться индивидуально для каждого компонента, при высокой плотности 
современных устройств это бывает не рационально, а иногда невозможно. Как поменять 
параметры для одинаковых компонентов было показано в предыдущих разделах, здесь 
посмотрим как изменить параметры для разных объектов.  
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Для данной задачи используется окно управления параметрами, которое вызывается по 
команде Parameter Manager из меню Tools. После такого выбора появляется диалог 
Parameter Editor Option, в котором необходимо указать – с какими параметрами ведется 
работа. 

Рисунок 7 
В данном случае (рис.7) выбираем Parts – т.е. будем менять параметры компонента, 

причем желательно включать опцию Exclude System Parameters (Исключить системные 
параметры). После нажатия кнопки ОК откроется окно, показанное на рисунке 8, в котором 
можно поменять значение любого параметра. 

 
Рисунок 8 

Чтобы изменить значение группы параметров, необходимо щелкнуть правой клавишей 
на выделении и выбрать Edit, после чего можно ввести новый парамтр, который будет 
применен ко всей выделенной группе компонентов. Важной особенностью работы с данным 
окном является его взаимоподдержка с внешними таблицами (например Excel), т.е. можно 
копировать фрагменты таблицы в Excel и после редактирования вставлять обратно. Причем 
стоит отметить, что здесь же возможно и добавить новый параметр, используя кнопку Add 
Column.  
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Добавление параметра 
Для добавления параметра, который уже имеется у одного из компонента, укажите эти 

ячейки с помощью группового выделения ЛК или одиночного выделения Shift+ЛК. После 
этого следует нажать ПК и выбрать Add  из выпадающего меню (см. рис. 9). 

Рис. 9. Добавление параметра к выбранным компонентам 
 
После выбора Add, в каждой ячейке появился небольшой зелёный символ «+», который 

показывает, что добавлен новый параметр. 
Теперь, когда параметр добавлен, необходимо задать каждому компоненту его 

значение. Функционал редактирование таблицы параметров поддерживает стандартные 
команды редактирования таблиц. Используйте клавиши мыши для прохода по сетке 
таблицы, нажмите F2  для редактирования ячейки и нажмите Enter для сохранения 
изменений. Одновременно можно отредактировать несколько ячеек – выделите ячейки, 
нажмите ПК на выделении и выберите Edit  из выпадающего меню, далее введите новое 
значение параметра и нажмите Enter  для сохранения изменений всех указанных ячеек. 

 

 
Выделение группы ячеек и 
выбор команды Edit 

Изменение параметра Нажатие Enter для 
завершения редактирования 

Рис. 10. Изменение параметров нескольких компонентов 
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Внесение измененных параметров в проект 
Редактирование параметров, которое только что было сделано,  сохраняется в Таблице 

редактирования параметров, но они не затрагивают компоненты на листах схем. Для 
применения этих изменений к компонентам, необходимо сформировать файл ECO и затем 
применить ЕСО к проекту. 

После выполнения необходимого редактирования параметров, нажмите кнопку Accept 
Changes (Create ECO). Таблица редактирования параметров будет закрыта и появится 
диалог Engineering Change Order. 

 

 
Рис. 11. Система принимает уже сделанные изменения в диалоге ЕСО 
 

Нажмите кнопку Validate Changes для контроля проведённых изменений, затем 
нажмите Executive Change  для применения изменений параметров к компонентам. После 
применения изменений, закройте диалог Engineering Change Order, нажатием кнопки Close. 

 

Управление моделями компонента 
Условные графические обозначения (УГО) представляют компоненты на схеме. Затем 

проводники соединяют выводы компонентов для создания связности. В процессе создания 
связности схемы или структуры соединений на схеме, для трансляции данных в физическое 
представление на плате требуется другая информация. 

Возможность трансляции оригинальной схемы в другой формат, такой как шаблон 
платы или, возможно, описание для моделирования, обеспечивается моделями, которые 
подключаются к каждому компоненту. 

Поддерживаются различные типы моделей, содержащие топологическое посадочное 
место (ТПМ), PSpice-модели для моделирования, модели для анализа целостности сигналов 
(IBIS) и 3D – модели, для получения файлов сборок в механических САПР. Поскольку УГО 
заданы для листов схемы, они обычно определены в библиотеке компонентов. Для 
индивидуальных компонентов это наиболее простой путь добавления модели в компонент. 
Добавить модели можно в нижней части окна редактирования библиотеки УГО, как показано 
на рисунке 12. 
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Рис. 12. Редактор библиотеки УГО, с отображением зоны редактирования модели в нижней 
части главного окна 

Для более подробной информации о создании библиотеки компонентов и 
присоединении моделей, см. главу «Создание библиотек компонентов». 

Для добавления или редактирования моделей, касающихся нескольких компонентов, 
редактор библиотеки содержит окно управления моделями (Model Manager). Для открытия 
менеджера для текущей библиотеки выберите Tools>Model Manager  из главного меню. 
Будет открыт диалог Model Manager, который отображает компоненты в текущей библиотеке 
снизу слева, поэтому нажмите для выбора компонента и отображения списка моделей, 
связанных с текущим компонентом. 

Задачи, которые можно выполнить с помощью этого менеджера включают в себя: 
• Добавление новых моделей для одного или нескольких компонентов 
• Копирование модели из одного компонента и вставка её в один или несколько 

компонентов. 
• Удаление модели из одного или нескольких компонентов. 
• Редактирование модели, присоединённой к одному или нескольким компонентам. 
Все эти команды можно выполнить из выпадающего меню при нажатии ПК на модели в 

области списка моделей, а некоторые из них можно выполнить с помощью кнопок ниже 
области списка моделей. 

На рис. 13 показан редактор управления моделями с моделью посадочного места 
выбранного для копирования. После записи его копии он может быть вставлен во многие 
компоненты. Для этого, используйте Shift+ЛК для выделения нескольких компонентов из 
списка. После выделения требуемых компонентов нажмите ПК в зоне модели и укажите 
Paste из выпадающего меню. 
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Рис. 13. Используйте Менеджер Модели для управления моделями компонентов 

 
Важно, при выборе нескольких компонентов, помнить, что будут показаны только 

модели, которые являются общими для всех выбранных компонентов. Поэтому при вставке 
модели посадочного места в несколько компонентов, не удивляйтесь, если зона списка 
моделей будет пустой. После того, как был изменен только один выбранный компонент, 
текущие модели появятся в списке. 

Управление моделями (Footprint) внутри проекта 
Редактор схем Altium Designer содержит мощный редактор управления моделями ТПМ 

Footprint Manager. Запускаемый из меню Tools  редактора плат, этот менеджер позволяет 
просмотреть все посадочные места, ассоциированные с каждым компонентом  всего проекта. 
Поддержка многокомпонентного выбора делает это легким для редактирования ТПМ, 
привязанного ко многим компонентам, позволяет изменить  привязку компонента или 
изменить текущее присвоение ТПМ для компонентов, которые имеют несколько 
привязанных посадочных мест. Изменения проекта  передаются через стандартную систему 
ЕСО, обновляя при необходимости схему и плату. 

 

Использование запросов для поиска и редактирования групп компонентов 
 
Altium Designer имеет мощную встроенную систему запросов, которая используется для 

точного выделения объектов проекта. Запрос это точное упорядоченное, обычно сделанное 
по форме, описание всего того, что вы хотели бы обнаружить в данных проекта. 

Запросить проектные данные можно различными способами. Одним из них является 
оформление запроса через панель Filter. Когда формулируется запрос, то создается 
некоторый фильтр на всю базу данных объектов проекта. Каждый объект проверяется на 
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соответствие запросу и если он удовлетворяет требованиям, то добавляется в набор 
результата. 

На рис. 14 показана панель Filter редактора схем, с введённым запросом IsPin. При 
обработке этого запроса, проверяется каждый объект в открытом документе, так как выбрана 
опция Open Documents, и каждый объект, который является выводом, будет выделен (т.к. 
включена опция Select) и  добавлен в результат поиска. Все другие объекты будут условно 
отфильтрованы.  

 
Рис. 14. Использование панели Filter для запроса выводов в проекте 

 
Форма представления результата  задаётся опциями на панели Filter справа. На рисунке 

14 видно, что объекты, удовлетворяющие правилам запроса (в данном случае это выводы) 
будут выделены (Select) и вокруг них будет увеличен масштаб (Zoom), т.е. к ним применены 
опции Object passing the filter. Все другие не прошедшие фильтр объекты (Object not 
passing the filter), будут затенены (Mask Out) и с них будет снято выделение, если они были 
выделены (Deselect).  

Так как опция Select  активна, выводы будут загружены в панель Inspector. Inspector, по 
существу, выстраивает выбранные объекты, чтобы дать возможность увидеть их общие 
свойства, которые не столь уж необходимы для редактирования выводов (не беря в расчет, 
возможности изменить их длину). 

Выводы будут также представлены в панели List, которая выводит проектные данные в 
виде таблицы, где их удобно просматривать и редактировать. 

При применении фильтра с включенной опцией Mask out, объекты, которые не 
соответствуют требованиям запроса, станут обесцвеченными и не доступными для 
редактирования. Для удаления этого фильтра, нажмите кнопку «Clear» в нижней правой 
части рабочей области или нажмите комбинацию клавиш Shift+C для снятия маски. 

Отметим, что можно контролировать процесс фильтрации, вводя запрос в панель Filter, 
устанавливая опции в диалоге Find Similar Objects, который в действительности использует 
запрос “за сценой”, или, выбирая объекты на панели Navigation. Хотя панель РСВ не 
отображает данные подобно панели Navigation, она может также фильтровать данные в 
рабочей области платы. 

Каждый пользователь можете иметь доступ к отфильтрованным отображаемым данным 
в главном окне графического редактирования, с помощью панели Inspector (если включена 
соответствующая опция в настройках) или на панели List. 

Указания для записи запросов 
• Используйте Query Helper для ознакомления с доступными ключевыми словами 

запросов. Нажмите кнопку Helper  на панели Filter для отображения справки по данному 
вопросу. 

• Нажмите F1 поверх ключевого слова для отображения онлайн-справки для  
ключевого слова запроса. 
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• Используйте поле Mask внизу диалога Query Helper для поиска возможных ключевых 
слов. Если используется символ замены * в начале видимой строки, то будут найдены все 
ссылки на текст, содержащий данную строку (*  - замена нескольких символов, ? – замена 
одного символа). 

• Нажмите кнопку Check Syntax  перед закрытием диалога Query Helper, для проверки 
синтаксиса составленного запроса на правильность составления. 

• Введите кавычки вокруг переменной, например, ‘DIP14’. 
• Для ориентации в запросах, предусмотрена последовательность приоритетов, поэтому 

предусмотрите скобки для уверенности в применении корректной последовательности. 
 
Для полного обзора системы запросов читайте материал  Introduction to the Query 

Language, для детальной информации о записи запросов см. статью An Insiders Guide to the 
Query Language.  

Редактирование объектов через панель List 
На рисунке 15 показана панель List редактора библиотеки УГО с загруженными 

выводами. Отметим, что опция from в верхней части панели имеет текущую установку  
current Component, даже когда фильтр был настроен на их выбор из всех библиотек. Этим 

обеспечивается контроль отображаемых результатов панели List по аналогии с панелью 
Filter; это сделано для того, что можно было контролировать фильтрацию отдельно от 
отображаемых результатов. Это использовать, например, для обнаружения выводов в 
текущей библиотеке, затем переключится на обзор всех выводов или только выводов 
текущего компонента. 

 
Рис. 15. Выводы текущего компонента, представленные в панели List 

Сетка таблицы в этой панели идеально приспособлена для просмотра и редактирования 
объектов. После перевода списка в режим редактирования, выбором опции Edit слева в 
верхней части панели, можно использовать клавиши для обхода и редактирования установок. 
Например, используйте клавиши стрелок для перехода между ячейками таблицы, F2 или 
Space (Пробел) для редактирования выбранной ячейки, и Enter для сохранения изменений, а 
так же Space (Пробел) для переключения опции в активной ячейке и т.д. 

Панель List полностью настраивается под индивидуального пользователя. Для 
добавления или удаления колонок, или изменения порядка их расположения, нажмите ПК на 
строке заголовка панели и выберите Choose Columns  из выпадающего меню. 

Использование таблицы для редактирования 
Редактировать данные можно не только непосредственно через панель List, но также 

можно выбирать блоки ячеек и копировать их из панели List предварительно созданную 
таблицу в формате Excel, и из такой таблицы обратно в List. Например, создаётся новый 
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компонент и для него копируются данные всех выводов из таблицы PDF изготовителя  в 
таблицу Excel. Вместо того, чтобы вводить эти данные в редактор библиотеки УГО для 
каждого вывода по отдельности, можно: 

1. Поместить один вывод в новый компонент, скопировать его, затем использовать 
команду Paste Array для получения общего числа требуемых выводов. 

2. Использовать запрос IsPin на панели Filter для загрузки этих выводов в панель List. 
3. Настроить нужный столбец данных выводов, так, чтобы они соответствовали  

расположению строк в редакторе Excel. 
4. Переключиться в редактор таблиц, выбрать требуемый блок выводов и скопировать 

его. 
5. Переключиться обратно в панель List, выбрать требуемый блок ячеек, нажать ПК и 

выбрать Paste из выпадающего меню. 
Можно поступить обратным образом, т.е. скопировать всю таблицу из панели List в 

таблицу Excel, и уже в нем редактировать описание выводов, а потом вернуть 
отредактированную таблицу на место. Используя такой подход, можно быстро описывать 
довольно таки много выводов в новом компоненте. Следующий пример иллюстрирует эту 
последовательность: 

 
Рис. 16. Данные выводов в редакторе Excel, которые копируются в буфер обмена 

 
Рис. 17.  Выберите нужный блок элементов, нажмите ПК и выберите Paste 

 
Рис. 18. Панель List после вставки данных о выводах 
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Связанность и многолистовой проект 
 
Инженеры используют многолистовые проекты по различным причинам, в первую 

очередь из-за размеров схем; некоторые проекты просто слишком большие или сложные, 
чтобы разместить их на одном листе. Даже если проект не так уж сложен,  возможны 
преимущества в организации проекта на нескольких листах. Например, проект может 
включать элементы различных функциональных модулей. Организация этих модулей как 
самостоятельных документов может позволить нескольким инженерам работать над 
проектом в одно и тоже время. Другой причиной может быть то, что этот метод позволяет 
использовать малоформатные принтеры, такие, как лазерный принтер. 

В целом, имеется два решения по выполнению каждого многолистового проекта – 
структурные отношения между листами и метод употребления связности между 
фрагментами схемы на этих листах. Конкретный выбор будет варьироваться в зависимости 
от размера и типа каждого проекта и собственных предпочтений пользователя. 

Формирование структуры листа 
В то время как файл проекта связывает различные исходные документы в единый 

проект, отношения документа к документу и сквозная связность определяется информацией 
в самом документе. Многолистовой проект формируется как иерархическая структура 
логических блоков, где каждый блок может быть либо листом схемы, либо файлом в 
формате HDL (VHDL или Verilog). В заголовке этой структуры находится единственный 
главный лист схемы, более часто рассматриваемый как верхний лист проекта. 

Сама по себе структура листа формируется с использованием специальных символов, 
называемых символом листа схемы. Каждый из исходных документов, которые определяют 
проект, представляются на верхнем листе с помощью символа листа. Имя каждого символа 
листа ссылается на подчиненный файл схемы (или файл HDL), который он представляет 
графически. С другой стороны, подчиненная схема может также содержать дальнейшие 
символы листов, которые ссылаются на более низкоуровневые листы схем или файлы HDL. 
Таким образом, можно сформировать структурную иерархию исходных документов, которая 
может быть простой или сложной, в зависимости от необходимости задания. 

При компиляции многолистового проекта, реализуются логические отношения между 
модульными блоками проекта, и создаётся структурный каркас. Это древовидная структура, 
начинающаяся с листа схемы верхнего уровня и ветвей для отражения всех других 
подчиненных схем и файлов HDL на каждом из уровней. 

 
Рис. 19. Компилированные многолистовые проекты, показывающие иерархию. 

 109



 

Рис. 19 показывает 2 примера компилированной иерархии проекта. С левой стороны, 
находится структурная иерархия для компилированного проекта платы (*PrjPcb). С правой 
стороны находится структурная иерархия для компилированного проекта ПЛИС (*.PrjFpg). 

 

Создание иерархической структуры 
 
Среда проектирования содержит ряд свойств, которые позволяют быстро и легко 

сформировать многоиерархическую структуру проекта. Конкретные задаваемые свойства 
для применения зависят от персональной методологии проектирования – сверху вниз или 
снизу вверх. 

1. Проектирование «сверху вниз» 
Ниже приведены доступные команды для построения иерархии проекта в варианте 

«сверху-вниз»: 
Create sheet from symbol (Создание листа из символа) – используйте команду 

редактора схем для создания листа номинированного ниже как символ листа.  В 
подчиненный лист должны быть добавлены согласованные порты, готовые для прокладки 
проводников. 

Create VHDL file from symbol (Создание файла VHDL из символа) - используйте 
команду редактора схем для создания оболочки файла VHDL, с декларированными 
объектами, которые содержат определения портов для соответствия входам на лист в 
созданном символе. 

Create Verilog file from symbol (Создание файла Verilog из символа) - используйте 
команду редактора схем для создания  файла Verilog, с декларированными модулями, 
которые содержат определения портов для соответствия входам на лист в созданном 
символе. 

Push part to sheet (Вставить компонент в лист) -  используйте эту команду редактора 
схем для добавления  секции в новый подчиненный лист схемы, помещая оригинальную 
секцию на главный лист в виде символа листа, указывающего на новый подчиненный лист. 
Соответствующие порты будут добавлены и соединены проводниками к секции на 
подчиненном листе. Для доступа к этой команде нажмите ПК на компоненте. 

2. Проектирование «снизу-вверх» 
Следующие команды позволяют построить иерархию проекта в варианте «снизу-

вверх»: 
Create symbol from sheet or HDL (Создание символа листа из схемы или HDL) -  

используйте команду редактора схем для создания символа как номинированного листа 
схемы, VHDL или Verilog-описания. Создайте лист схемы, на который будет ссылаться 
символ листа активного документа перед запуском команды. 

Convert part to sheet symbol (Конвертировать компонент в символ листа) – 
используйте эту команду редактора схем для конвертации выделенного компонента в символ 
листа. Поле символьного обозначения вначале будет установлено в позиционное 
обозначение компонента, в поле Filename с установленным текстом комментария к 
компоненту. Измените имя файла для ссылки на необходимый подчиненный лист, измените 
входы на листе в соответствии с портами, заданными в подчиненном документе. Нажмите 
ПК на компоненте для доступа к этой возможности. 

Смешанная схемно-текстовая(HDL) иерархия документа 
При создании иерархии проекта можно использовать символ листа на родительском 

листе схемы для ссылки на подчиненный лист схемы низкого уровня. Эта иерархия может 
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быть расширена, когда для формирования проекта будут использованы сочетание из листов 
схем и листов описания на языках HDL. Подчиненные документы в виде VHDL или Verilog-
описания также ссылаются как подчиненные схемы, описывая имена подчиненных 
документов в символе листа, который их представляет. 

При ссылке на подчиненный документ VHDL связность формируется от символа листа 
к описанию объектов в файле VHDL. Для ссылки на объект с именем, которое отличается от 
имени файла VHDL, включите параметр VHDLEntity в символе листа, значением которого 
является имя объекта, описанного в файле VHDL. 

Аналогичным является процесс ссылки на подчиненный документ Verilog, где 
связность определяется от символа листа к модулю, описанному в файле Verilog. Для ссылки 
на объект с именем, которое отличается от имени файла Verilog, включите параметр 
VerilogModule в символе листа, значением которого является имя модуля, описанного в 
файле Verilog 

Рисунок 20 иллюстрирует пример такой смешанной иерархии, посредством которой 
один символ листа использован для ссылки на подчиненный лист схемы в одном примере 
проекта и на подчиненный документ VHDL в другом. В обоих случаях, подчиненный 
документ реализует одно и тоже физическое устройство (счетчик). 

Рис. 20. Иерархический документ создан размещением символа листа для представления 
документа нижнего уровня иерархии в виде схемы (слева) и в виде HDL (справа) 

 
После определения структуры иерархической многолистового проекта, необходимо 

выполнить установки в Altium Designer по указанию для компиляции и согласованию 
портов. 

 
Синхронизация портов схем и входов листов 
Символ листа является документом, синхронизованным с его ссылками на 

подчиненные листы нижних уровней иерархии, все входы этого листа должны совпадать с 
соответствующими портами на подчиненных листах – как по имени, так и по 
направленности. Используйте диалог Synchronize Ports to Sheet Entries (Рис. 21) для 
установки символа листа в соответствие с портами на ссылающихся схемах, для этого 
выберите Synchronize Sheet Entries and Ports  из меню Design. 
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Рис. 21. Обеспечение синхронизации входов листа и портов схем 
 
Для более подробной информации о процессе синхронизации см. файл оригинальной 

документации Synchronizing Sheet Entries and Ports. Эту тема так  же можно посмотреть в 
быстром доступе с помощью нажатия F1 во время, расположения курсора над размещённым 
символом листа. 

 
Переименование символа листа в подчиненный лист 
В процессе проектирования часто возникает необходимость в изменении имени 

подчиненного листа схемы, например, бывает необходимо изменить схему и задать другое 
название для более полного отражения функций листа. Вместо того, чтобы переименовывать 
схемы и затем вручную изменять ссылки на каждом символе листа, который ссылается на 
данный документ, проще воспользоваться командой Design>Rename Child Sheet. 

С помощью этой команды можно: 
• Переименовать подчиненный документ и обновить все действующие символы листов, 

данного документа в текущем проекте 
• Переименовать подчиненный документ и обновить действующие символы листов в 

текущей группе проектов (*.DsnWrk). 
• Создать переименованную копию подчиненного документа и обновить текущий 

символ листа для указания ссылки на него. 
Для более подробной информацией о процессе переименования, см. раздел Remain a 

Sheet Symbols’ Child Sheet  оригинальной документации.  

 

Поддержка многоканальности в проекте 
Altium Designer содержит специальные средства для поддержки проектов с 

повторяющимися фрагментами схемы. Также как единичное представление, когда одному 
символу листа, соответствует один подчиненный лист, можно создать структуру, где на один 
и тот же подчиненный лист ссылаются несколько раз. Данный тип реализации называется 
многоканальный проект. 

Имеется два подхода к многоканальному проекту, либо посредством ссылок на один и 
тот же подчиненный лист от множества символов листа, либо использованием одного 
символа листа с помощью ключевого слова Repeat. При компилировании проекта все 
повторяющиеся секции каналы автоматически повторяются указанное количество раз. 
Преимущество многоканального проекта состоит в том, что он позволяет установить один 
символ листа исходного канала, даже если проект был использован в ПЛИС или на плате. 
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Синтаксис, использованный для применения оператора Repeat в поле Designator 
(позиционное обозначение) символа листа имеет форму: 

Repeat(Описание, Первый канал, Количество), 
где Описание -  является базовым именем канала. Рисунок 22 иллюстрирует 

использование оператора Repeat для применения восьми входных каналов для аудио 
миксера.    

 
Рис. 22. Иллюстрация использования оператора Repeat, для создания многоканальности 

 
Когда проект создан, компилятор повторно использует канал указанное количество раз, 

так как он встроен во внутреннюю модель компилятора, используя выбранную схему 
нумерацию для уникальной идентификации каждого компонента в каждом канале. 
Подчиненные листы каждого канала не дублируются. Вместо этого после компиляции 
появляется отдельная вкладка в нижней части документа подчиненного листа в главном окне  
проекта для каждого канала на листе, пример которого показан на рисунке 23. 

  

 
Рис. 23. Пример повторяющихся каналов на одном подчиненном листе схемы 

 

 113



 

Статья оригинальной документации  Multi-Channel Design даёт более подробную 
информацию о том, как создать проект с повторяющимися секциями. 

См. руководство Creating a Multi-channel Design для пошаговых инструкций по 
созданию многоканального проекта. 

Освобождение пространства в схемах нижнего уровня 
Одним символом листа может быть представлено несколько подчиненный листов. Для 

этого нужно разделить отличные имена листов символом ‘;’ в поле Filename (см. рис. 24). С 
помощью эффективного использования межлистовых соединителей, помещённых на 
подчиненный листах, можно значительно расширить возможности проекта, не увеличивая 
количество листов, рассматривая имеющиеся листы, как один целый. Отметим, что  
использование межлистовых соединителей является единственно возможным способом 
реализации связанности для схем, ссылающихся на один и тот же символа листа.  

Рис. 24. Пример одиночного символа листа, ссылающегося на несколько подчиненных 
листов 
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Реализация глобальной связанности 
Единственным способом передачи сигналов между листами является использование 

идентификаторов цепей. Они являются объектами, которые создают логические соединения 
между различными объектами проще, чем это делают физические соединения (проводники). 
Идентификаторы цепи могут использоваться локально в пределах одного листа, как показано 
ниже, но главное предназначение данных объектов – это реализация глобальной связи 
внутри всего проекта. 

 

 
цепи метки цепей порты силовые порты 

Эти эскизы показывают, как могут быть реализованы проводники с помощью обычных 
цепей, меток цепей, портов и силовых портов, соответственно. Все эти объекты объединены 
общим названием идентификаторов цепей и будут рассматриваться подробно в этом разделе. 

Рисунки ниже иллюстрируют частую ошибку: идентификаторы цепей различных типов 
(такие как метки цепей и порты) будут логически связаны, если имеют одинаковые имена. 
Фактически это не так: различные типы идентификаторов цепей могут иметь разные имена, 
но по прежнему соединяться вместе для формирования единой цепи. 

 
Эти диаграммы затрагивают идентификаторы цепи, физически соединенные на одном 

листе, но они не могут показать то, что идентификаторы цепи дают возможность для 
передачи цепей между листами в многолистовом проекте. Как это происходит, зависит от 
идентификаторов цепей, используемых в проекте и установленных ограничений. 

Идентификаторы цепей 
Большинство идентификаторов цепей являются метками цепи. Их первичной 

функцией является отображения функционального назначения соединений проводников на 
листе. Пока имеются пути и обстоятельства, при которых метки цепи могут выполнять связь 
между листами, можно в основном использовать их для локальных и внутрилистовых 
соединений. 

 Порты, подобно меткам цепей, будут всегда соединять локально цепи в одном и том 
же документе. Но в отличие от меток цепей, порты специально спроектированы для 
межлистовых соединений. Они могут располагаться горизонтально или вертикально. 
Горизонтальность является широко применяемой опцией, так как она не чувствительна к  
многолистовой структуре и соединяет все порты с одинаковым именем на всём пространстве 
проекта в единую цепь. Вертикальные соединения более управляемы, так как они соединяют 
сигналы только между подчиненными и родительским листом. Вместо соединения порта с 
портом, вертикальные соединения выполняются между портом на подчиненном листе и 
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входом листа родительского документа. Этот вход листа должен быть размещён в пределах  
символа листа со ссылкой на специфический подчиненный лист. 

Межлистовые соединители обеспечивают среднее звено, позволяя создавать 
горизонтальные связи между выбранной группой листов в пределах проекта. Способом 
группирования этих листов является размещение имён множества листов в поле Filename 
единого символа листа, разделёнными точкой с запятой. Нужно поместить межлистовые 
соединители для этих сигналов так, чтобы они находились между этими группами листов 
(как на рис. 24). Межлистовые соединители будут соединены с одинаковыми межлистовыми 
соединителями, но только в пределах листов, сгруппированных вместе на родительском 
символе листа. Если же только один подчиненный лист представлен на символе листа, тогда 
его межлистовые соединители не будут соединены с однотипными соединителями, которые 
могут существовать в другом месте проекта. 

Силовые порты (называемые также силовыми объектами) полностью не 
чувствительны к структуре проекта и соединяют одинаковые силовые порты на всех 
связанных листах.  

Невидимые выводы  могут быть введены для символа в библиотеке и подключены к 
определенной цепи, посредством установки значений в поле Connect to (в диалоге Pin 
Properties). Если вы импортируете проект из Protel 99 SE или ранней версии, то любые 
невидимые выводы будут иметь имя цепи, размещённое в этом поле автоматически. 

 
Таблица 1. Набор различных идентификаторов цепей 

 Метка цепи 

Соединение по вертикали, если используется совместно 
с портами или символами листа, то применимы либо в 
рамках иерархии, либо внутри документа. По горизонтали 
объединяют все цепи с одинаковыми метками. 

 
Порт 

Соединение по вертикали, если оно использовано для 
входа листа на главном символе и применимы либо 
внутри иерархии, либо внутри документа. Он соединяет 
по горизонтали все одинаковые порты, либо ограниченные 
порты внутри указанного документа. 

 
Вход на лист Всегда соединяется вертикально вниз к порту на листе 

подчиненной схемы, указанном на символе. 

 
Межлистовой 
соединитель 

Горизонтальное соединение одинаковых межлистовых 
соединителей, но ограниченное по отношению к листам, 
указанным на одном, разделённом символе листа. 

 
Силовой 
порт 

Соединяет глобально все одинаковые силовые порты на 
всём пространстве проекта 

 Невидимый 
вывод 

Соединяет глобально все невидимые выводы проекта, 
которые имеют значение Connect to 

  
Для более подробной информации о метках цепей, портах, входах листов, межлистовых 

соединителях и Силовых портах, нажмите F1, пока курсор находится над одним из 
размещенных объектов данного типа. 

Инверсные идентификаторы цепи 
Если возникает необходимость в создании метки цепи, входа листа или порта с знаком 

инверсии (черта над текстом), это можно сделать двумя способами: 
• Введите символ «\» после каждого символа в имени цепи (например, 

E\N\A\B\L\E\) 
• Активируйте опцию Single ‘\’ Negation на вкладке Schematic>Graphical 

Editing диалога DXP>Preferences, затем введите один символ «\» в начале имени цепи 
(например, \ENABLE). 
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Установка ограничений идентификаторов цепей 
По умолчанию, все новые проекты плат используют автоматическое определение 

установок для ограничения действия идентификаторов цепей, то есть, будут ли они 
иерархическими или одноуровневыми. 

Если будет обнаружен хотя бы один вход листа, представленный в разработанной схеме 
проекта, то будут автоматически выбраны иерархические ограничения для вертикальной 
связности.  Метки цепей и порты будут использованы для локальной связи в пределах одного 
листа (как обычно), но порты будут иметь только межлистовые связи, если соответствующие 
входы листа на символе размещены на его главном листе. Когда иерархические границы 
определены, никакие порты, а также и метки цепи не получат логической связности с 
совпадающими идентификаторами цепей на других листах проекта. 

Если же схема проекта содержит порты, но нет ни одного входа листа, тогда 
устанавливается автоматическое определение глобальных ограничений для портов. Это 
означает, что порты получат горизонтальное подключение на всём проекте, не принимая во 
внимание многолистовую структуру и идентифицируя все совпадающие порты в одной и той 
же цепи. Метки цепи будут продолжать создавать только локальные соединения.  

Наконец, если схема проекта не содержит ни входов листа, ни портов, тогда 
автоматическое определение повысит метки цепей до глобального статуса. 

Межлистовые соединители, силовые порты и специальные невидимые выводы будут 
всегда управляться также, независимо от ограничений идентификаторов цепей. 

Altium Designer предоставляет полный контроль над ограничениями идентификаторов 
цепей (Net Identifier Scope). Контроль возможен на вкладке Options, доступной в диалоге 
Options for Project вызываемом последовательным выполнением Project>Project Option. 
Настройки на вкладке Options можно использовать для изменения автоматических 
установок и определения ограничений идентификаторов цепей в структуре всего проекта, 
независимо от его содержимого. Контроль предполагает ограничения, где идентификаторы – 
метки цепи и порты будут получать глобальную связность на всём проекте, приспосабливая  
наследуемые проекты,  подготовленные именно таким образом. 

 

Одноуровневая или иерархическая связность 
 
В терминах структуры документа, все многолистовые проекты организованы 

иерархически, даже если иерархия имеет всего два уровня (например, верхний лист, 
содержащий все листовые символы, которые ссылаются на подчиненные листы нижнего 
уровня). В терминах связности, проект может быть реализован либо одноуровневой, либо 
иерархической структурой. Основным различием между ними является то, что 
иерархические проекты переключают сигналы между листами, соответствующими 
созданной структуре, в то время как одноуровневые проекты не предполагают структурную 
организацию листов. 

Важно отметить, что при проектировании проекта ПЛИС, используемая модель 
связности обязательно должна быть иерархической. 

Одноуровневые проекты без листа высшего уровня 
Если разрабатываемый проект не иерархический – например, все листы схем находятся 

на одном и том же уровне, без символов листов, ссылающихся на дальнейшие подчиненные 
листы – проект является простым одноуровневым проектом. В этом случае, нет потребности 
в листе высшего уровня, который содержит только символы листов, ссылающиеся на такие 
листы ниже. Необходимость наличия листа верхнего уровня возникает при отсутствии файла 
проекта, а файл проекта программного обеспечения  зависит от символов листов на листе 
высшего уровня, для определения какие листы были в проекте. Для тестирования такого 
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проекта без листа высшего уровня, нажмите имя файла на панели Projects и укажите Remove 
from Project  из выпадающего меню. 

Одноуровневый проект, который уже содержит лист высшего уровня, будет, конечно, 
корректно компилироваться, но Altium Designer предоставляет возможность построения 
проекта без верхнего листа, по необходимости. 

Примеры проектов по типу связности 
Четыре следующие иллюстрации  показывают, как определять или выбирать 

ограничения идентификаторов, которые будут оказывать воздействие на связность 
одинаковых меток цепей и портов в иерархической структуре. Пятая показывает, как 
работают межлистовые соединители. В названии примера указана настройка ограничения 
действия идентификаторов, устанавливаемая в списке Net Identifier Scope на вкладке 
Options, доступной в диалоге Options for Project вызываемом последовательным 
выполнением Project>Project Option. 

 
Пример 1 – Hierarchical (Иерархический) 

 

Метки цепей 
локальные 

внутри каждой 
схемы 

 
Этот схемный проект будет автоматически определён как иерархический вариант, так 

как здесь имеют место входы листов в символах листов на главном листе. Метки цепей С1 и 
С2  на каждом подчиненный листе не будут подключены к соответствующим меткам цепей 
на другом подчиненный листе, но будут сохранены в пределах границ их локальных листов. 
Порты в этом примере имеют различные имена, но даже если они имели бы совпадающие 
имена, они не могли бы создать горизонтальные связи с другими портами подчиненных 
листов, при воздействии ограничений идентификаторов данного типа иерархии. Поэтому, 
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порты  создадут только вертикальное листовое соединение вверх к родительскому листу. 
Чтобы выполнить соединение, порт на подчиненном листе должен иметь одноименный вход 
листа внутри соответствующего символа листа.  

В этом примере, элементы входа на главном листе подключены к разным листам 
(отметим, что их имена не одинаковы;  это физическое подключение, а не логическое). В 
структурно проработанном проекте, эти сигналы прокладываются к портам и сравниваются 
по входам с другим символом листа на более высоком родительском листе. 

 
 Пример 2 – Flat (Глобальные порты) 

 

Метки цепей 
локальные 

внутри каждой 
схемы 

 
Для представления портов в этом проекте, совместно с отсутствием каких либо входов  

листов, используется вариант автоматического назначения глобальных портов. Это 
особенность одноуровневого проекта, так как порты являются связанными; они получают 
логические связи со всеми портами с совпадающими именами в любом месте проекта. Метки 
цепей не поддерживают такие же возможности; они будут локальными на отдельных листах. 

Так как этот проект одноуровневый, верхний лист можно удалить из проекта и проект, 
тем не менее, будет корректно откомпилирован. Отметим, что Altium Designer использует 
файл проекта для определения количества листов в проекте, что является важным свойством 
понятия проект и необходимым для одноуровневых разработок с ограничением 
идентификаторов типа Flat. 
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Пример 3 – Automatic (Глобальные метки цепей) 

 

Метки цепей 
глобальные для 
всего проекта  

 
Этот проект не имеет элементов входов листов и портов. Это тот единственный случай, 

в котором метки цепей получают автоматические глобальные подключения на всех схемах 
многолистового проекта. Эти метки цепей будут связаны с одноименными метками цепей в 
проекте, независимо от структуры проекта. 

Опять же, так как этот проект одноуровневый, то верхний лист можно удалить из 
проекта и проект будет корректно откомпилирован. 
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Пример 4 – Global (Глобальные  метки цепей и портов) 

 

Метки цепей и 
порты 

глобальные для 
всего проекта  

 
Этот вариант недоступен при автоматическом определении иерархии, но может быть 

применён в Altium Designer для поддержки наследуемых проектов. В нём как метки цепей, 
так и порты получают глобальные связи с соответствующими идентификаторами цепей по 
горизонтали в проекте. Единственным путём достижения этого типа связности является 
просмотр вкладки Option в диалоге Options for Projects и изменение  Net Identifier Scope  
на Global (Netlabels and ports global). 

Так как это однойровневый проект, верхний лист может быть удалён из проекта и 
проект тем не менее, будет корректно компилирован (файл проекта сам по себе содержит 
информацию о составе исходных документов, формирующих проект, как и в предыдущих 
двух примерах). 
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Пример 5 – Межлистовые соединители (OffSheet) 

 
 
В этом примере, верхний лист ссылается на 4 подчиненный листа с помощью только 

двух символов листов. Это выполняется с помощью ссылок на файлы нескольких схем в 
поле Name символов листов, разделённых символом точка с запятой. Межлистовые 
соединители создадут одноуровневые соединения между всеми сгруппированными листами 
в пределах одного символа листа - даже если другие листы в проекте используют 
аналогичную вертикальную связность. 

Сгруппированные листы не используют, каких либо других идентификаторов цепей, за 
исключением межлистовых соединителей. Отметим, что эти соединения устанавливаются 
только в пределах групп.  

Многие разработчики никогда не используют межлистовые соединители, которые 
первоначально были введены как средство импорта проектов, из других пакетов 
проектирования. Однако можно обнаружить ситуацию, когда они становятся удобными, 
Например, предположим, что имеется высокомодульный проект, в котором каждый лист 
представляет логический кусок проекта. Размещение символов листов будет не просто 
создавать желаемую связность, но будет обеспечивать другим участникам разработки 
проекта хорошее понимание всего проекта. Теперь представим себе, что схема внутри 
одного их таких функциональных блоков выходит за пределы возможностей размещения на 
одном листе. Чтобы поместить ее в иерархию,  необходимо разместить необходимое число 
меток цепей, которые должны переходить с листа на лист с портами, которые будут 
передавать их выше на соответствующие входы листа, которые должны быть соединены 
вместе проводниками. Это является трудно выполнимым, не принимая во внимание тот факт, 
что проект будет разделяться на два символа листа, которые логически неразличимы, а всё 
оттого, что размер лист был слишком мал.  Корректной альтернативой является такое 
размещение меток цепей, которое позволяет нормально создать связи этих частей проекта с 
помощью межлистовых соединителей. Группировка нескольких листов позволит сохранить 
блочную диаграмму потока данных проекта, согласованную с полной логикой проекта. 
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Использование шин 
Многие схемы содержат шины, которые символизируют сгруппированные проводники.  

Они выполняются с большей шириной, чем проводники, что делает их хорошо заметными на 
полях схемы. Такой графический вид шин может быть полезен сам по себе, но сигналы 
шины можно также передавать между листами, в соответствии с их первоначальной ролью 
связности, описанной ранее. 

Рис. 25. Пример графической и логической шин в проекте 

Логические 
шины 

Графические 
шины 

 
Пример схемы на рисунке 25, содержит 4 шины: две графические и две логические. 

Логические шины имеют присоединённые идентификаторы цепи (метки цепи и/или порты), 
которые определяют назначение шины. Для понимания этого синтаксиса, рассмотрим 
каждую из логических шин этого примера более тщательно: 

 
1. Здесь 8 узлов оказались подходящими для включения в 

шину, поскольку содержат метки цепей с одинаковым 
префиксом, за которым следует цифровой суффикс. Логическая 
шина создаётся меткой цепи с названием D[0..7], где D это 
общий префикс проводников, а цифры от 0 до 7 обозначают 
самое маленькое и самое большое число в суффиксе. В этом 
суффиксе можно использовать любое целое положительное 
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число, а их последовательность важна постольку, поскольку она отражает любые 
последовательные идентификаторы в общей шине. Например, можно изменить метку цепи с 
D[0..7] на D[7..0], при условии, что также изменили порядок присоединения портов и на 
входе листа они совпадут с верхним листом этого проекта. 

Отметим, что логическая шина создаётся с помощью метки цепи, а не с помощью 
примитива шина. Электрической функцией шины является соединение этих 
идентификаторов цепей.  Вспомним, что идентификаторы цепей различного типа не 
подключаются автоматически друг к другу, даже при наличии совпадающего имени. Это 
также действительно для синтаксиса  шины; цепь с именем D[0..7] не будет автоматически 
подключаться к порту с таким же именем. Шина требуется для них ручного соединения. 

Входы шины не имеют свойств связанности, но обеспечивают зазор вокруг шины, 
который может содержать проводники с любой стороны (два проводника, входящие в шину 
в одинаковой точке, считаются закороченными). 

Две шины на примере схемы, которые являются полностью графическими, не содержат 
какого либо идентификатора. В этом случае,  реальная связность будет организована между 
соответствующими метками цепей.  Удаление таких цепей 
абсолютно не влияет на связность листов (хотя это может  
создать определённые трудности для человека при прочтении 
схемы). 

Цепи в этом примере, фактически являются 
нежелательными для логической связности в шине, поскольку их 
имена не соответствуют требуемому синтаксису обозначения 
шины. Вспомним, что желательно, чтобы все цепи в одной шине 
имели индивидуальные метки с одинаковым префиксом и 
различались друг от друга только по их суффиксу. 

Для получения подробной информации по использованию шин в проектах ПЛИС, 
содержащих использование элементов объединения шин, см. оригинальное руководство 
FPGA Designer Quickstart. 
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Навигация в многолистовом проекте 
По завершении разработки схем проекта, нет необходимости генерировать список 

цепей  и выполнять перекрёстный контроль каждой цепи вручную. После компиляции вся 
информация о связанности отображается в панели Navigator, которая упрощает работу над 
проектом. 

Панель Navigator занимает 
центральное место в организации связности 
в проекте. Верхняя рамка организует листы 
проекта тремя способами: в виде перечня 
компилированных листов, в виде плоской 
иерархии и как структурное дерево. После 
компиляции многолистового проекта, 
нужно немедленно проверить дерево, 
чтобы убедиться в корректном определении 
структуры с помощью символов листов. 

Следующие две рамки в панели 
перечисляют компоненты и цепи/шины  в 
проекте. Они также представлены в виде 
дерева, поскольку символ листа может 
содержать множество входов на лист,  
компоненты могут содержать множество 
параметров, моделей и выводов. Таким же 
образом, логическая шина будет 
разветвляться на цепи, которые входят ее 
структуру. 

Содержимое последней рамки панели 
зависит от двух факторов: наблюдаемых 
объектов и объектов, которые установлены 
для отображения. Главный перечень 
объектов для отображения может быть 
доступен с помощью выпадающих опций, 
рядом с кнопкой Interactive Navigation, 
можете нажать ПК на панели и 
активировать или дезактивировать их 
индивидуально через подменю Show. 

При выборе листа в верхней рамке – 
нижняя рамка перечислит её порты. При 
выборе компонентов во второй рамке - 
нижняя секция представит данные о его 
выводах. Откройте дерево для этого 
компонента и нажмите на одном из его 
выводов и в нижней секции увидите этот и 
все другие выводы и метки этой же цепи. 
Такой же результат, вы получите при 
нажатии на любой шине или цепи в третьей 
рамке. 

Каждая рамка панели (каждая секция) будет переключаться на соответствующий 
элемент в ее списке, когда просматриваемый объект имеет к ней отношение. При этом стоит 
отметить, что обновляется рабочая область. При каждом нажатии ЛК на объекте в панели 
Navigator будет появляться отфильтрованный объект, представляя визуальный результат, 
который определяется коэффициентом опций подсветки. Эти и описанные ниже опции могут 

 125



 

быть доступны, и установлены либо из выпадающего меню, рядом с кнопкой Interactive 
Navigation, либо на странице  System>Navigation диалога DXP>Preferences. 

 

 
Рис. 26. Настройки панели Navigation 

 
• Zooming (Масштабирование) - при включении, отфильтрованные объекты будут 

масштабироваться и центрироваться (если это возможно) в главном окне проекта. 
Масштабирование – масштаб будет установлен средствами панели (Zoom Precision) или 
интерактивно внутри документа проекта – с помощью скользящей панели (слайдера). 
Увеличение масштаба достигается перемещением слайдера вправо (масштабирование не 
применимо, когда целевым объектом является порт и изменение производится в файле HDL). 

•  Selecting (Выделение) - при включении отфильтрованные объекты в рабочей области 
будут выделены, т.е. после этого к ним можно будет применить команды редактирования. 

• Masking (Маскировка) – при включении данной опции, все не отфильтрованные 
объекты будут показаны в затененном виде. 

• Connective Graph (Графы связей) - активация этой опции отображает связность 
между объектами (в главном окне проекта активного документа). Визуально такая связность 
имеет зелёный цвет при просмотре компонентов и красный при просмотре цепей. 
Активируйте дополнительную опцию Include 
Power Parts, если также необходимо иметь графы 
связности силовых объектов. 

 

Рис. 27. Пример графа связности при 
просмотре цепи в панели  Navigator 

 Рис. 27 показывает пример графа связности, 
при просмотре объектов цепей (шины, цепи, 
вывода, линии, проводника или метки цепи). Эта 
связь отображается линией красного цвета, 
показывая все объекты цепи связанные цепью, 
выбранной в панели Navigator для отображения. 
Если линия является сплошной, то это означает, что 
выводы имеют физическую связь, соответственно 
они могут иметь логическую связь, которая 
отображается точечной линией. 

Рис. 28 показывает пример графа связности 
при просмотре компонентов. Графы связи 
компонентов отображаются зелёной линией, 

 126



 

показывающей все компоненты, непосредственно подключённые к компоненту, который 
выделен в панели  Navigator. 

 

Рис. 28. Пример графа связности при 
просмотре компонента в панели  Navigator 

 Инструментарий навигации также 
применим к многолистовым структурам. 
Навигация по шине или цепи будет 
использовать опции подсветки на всех 
листах, где они обнаружены. В том случае, 
если в текущем окне проекта активен один 
документ, эти связи на других листах 
просмотреть не просто; для этого  удобно 
выбрать другой вариант расположения 
рабочих окон в проекте, например, в виде 
черепицы (Window>Tile). 

  
Для более подробной информации о 

панели Navigator, нажмите F1, пока курсор 
находится на данной панели.   

 

Пространственная навигация 
 В верхней части панели Navigator есть кнопка Interactive Navigation, нажатие ЛК на 

которой переключит вид курсора на прицельное перекрестье в активном документе схемы. 
Это предоставит пространственную альтернативу логического списка, представленного на 
самой панели. Нажмите ЛК на цепи в схеме для выделения всех объектов цепи, нажмите  ЛК 
на порт для мгновенного перехода на вход на листе, к которому он подключён и т.д. 
Содержимое панели Navigator будет обновлено в соответствии с выбранными в данном 
режиме объектами. Курсор останется в режиме навигации до нажатия ПК или нажатии 
клавиши ESC. 

Иерархическая навигация 

 Используйте команду Up/Down  Hierarchy, доступную при нажатии кнопки  для 
навигации по иерархии проекта. При выборе входа символа листа, будет показан 
одноименный порт на подчиненный листе, выполнив нажатие ЛК на символе листа, будет 
показан подчиненный лист полностью. Для навигации вверх по такой иерархии, нажатие ЛК 
на порте покажет ссылающийся на него вход в лист на родительском листе. 

Иерархия может быть просмотрена двойным нажатием ЛК, с зажатой  Ctrl, на порте,  
входе в лист или символе листа. 

Переключение между схемой и платой 
Так как проектирование платы от схемы является существенно итеративным процессом 

(много перемещений назад и вперёд по проекту на стадиях схемы и платы), панель Navigator  
позволяет также переключаться между документами схем и плат. При открытой плате, и 
удержании клавиши Alt при навигации по объектам на схеме – будут использоваться 
одинаковые опции выделения при работе с объектами схемы и соответствующими 
объектами платы. 

Можно заметить, что переключение с помощью панели Navigator незначительно 
отличается от использования перекрёстных команд такого же назначения с помощью меню 
Tools. Эти команды доступны как в редакторе схем, так и редакторе плат, в то время как 
инструментарий панели Navigator спроектирован изначально для схемной части проекта.  
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Концепции многоканального проекта 
 
Многие проекты содержат повторяющиеся блоки схемы. На одной плате могут 

несколько раз дублироваться одинаковые секции, или, например, она может содержать 4 
идентичных набора с количеством каналов до восьми в каждом. Разработчики  имеют 
значительные трудности выполнения “в плоскости” таких проектов на схемном уровне для 
исправления их совершенства на шаблоне платы. Хотя начальная кропотливая работа по 
копированию и вставке секций схем является относительно лёгкой,  коррекция и обновление 
проекта схемы впоследствии может быстро превратиться в не решаемую задачу. Altium 
Designer предлагает поддержку многоканальных проектов, что дает возможность ссылаться 
многократно на один лист схемы (текстового описания) в проекте. Требуемые изменения 
нужно будет делать только один раз;  повторная компиляция проекта затем распространяет 
изменения на каждый конкретный канал. Но Altium Designer не только поддерживает 
множество каналов, он разрешает выполнять их в виде вложенных структур. 

Рассмотрим схему, представляющую 16-ти клавишную клавиатуру. 
Данный проект может быть сформирован 

и соединён проводниками в редакторе схем за 
пару минут. Но предположим, что необходимо 
использовать разные символы для клавиш? Что 
нужно добавить к каждому из них параметр? 
Или требуется расширить проект от 4 на 4 до 10 
на 22? 

Даже с помощью инструментария 
глобального редактирования, эти задачи 
тяжелы для исполнения и чреваты ошибками. 
Предположим, разработчик представил всю 
схему с помощью двух компонентов, одного 
резистора и одного переключателя, каждый со 

своим собственным листом схемы. Оператор повтора (Repeat) внутри символа листа 
содержит инструкции компилятору Altium Designer для создания виртуальных клонов 
(каналов) из одного листа, как это показано в символе листа на рисунке 31. Лист резистора 
может ссылаться  на один и тот же лист переключателя 4 раза для создания ряда, затем 
верхний лист ссылается на лист резистора 4 раза, создавая 4 колонки. Множество каналов 
вкладываются внутрь множества каналов, и соответственно этим устанавливается матрица 
связности. 

Рис. 29. Типичная схема клавиатуры, 
содержащая только два различных 
компонента. 

Теперь задачи разработчика значительно облегчены. Любые модификации свойств 
переключателей или резисторов необходимо сделать только однажды, вместо того, чтобы 
делать это снова и снова. Любые расширения сети соединений можно выполнить просто 
модификацией  оператора повторения в пределах символов листа. 

Первое, чему надо научиться, для увеличения скорости  выполнения многоканального 
проекта, это алгоритм установки связности в таких проектах средствами Altium Designer. 

Многоканальная связанность 
В отличие от других многолистовых проектов, в данном случае нужно использовать 

локальные метки цепей и соединение листов посредством портов и входов листа; таким 
образом, необходимо выбрать Hierarchical (Иерархический) method, на вкладке Options, 
доступной в диалоге Options for Project вызываемом последовательным выполнением 
Project>Project Option. 

Сохранение этих установок как Automatic в диалоге Options for Project будет 
прекрасным вариантом, но это предполагает, что разработчик понимает, что единственный 
путь для коммуникации сигналов в повторяющемся листе происходит из входов на лист на 
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родительском листе вниз к одноименным портам на подчиненных листах. Причиной этих 
ограничений является то, что входы на лист, в отличие от портов или меток цепей, 
спроектированы для ручной установки каналов, созданных с помощью оператора Repeat 
(Повторение). 

Имеется два типа связности листов, доступных в многоканальном проекте: цепи, 
которые являются общими для всех каналов и цепи, уникальные для каждого. Оба этих типа 
продемонстрированы на примере клавиатуры 
выше.  Повторяющийся переключатель в каждом 
ряду имеет один вывод, подключённый 
непосредственно к резистору. Это общая цепь, 
означающая, что один и тот же узел в каждом 
канале  связывается с единственным узлом на 
родительском листе, и тем самым между собой. 
Визуально это может быть показано на рисунке 30. 

Рис. 30. Все переключатели в каждом 
ряду имеют общую цепь, подводящую 
к резистору. 

 
Это самый простой метод распределения цепи в многоканальном проекте в Altium 

Designer. Интуитивно выполняется сравнение имени порта на листе канала с именем входа 
на лист выше. 

Другой узел на листе переключателя, не является общим на уровне переключателя, 
здесь имеется уникальная цепь от каждого переключателя, которая затем подсоединяется к 
соответствующему переключателю в каждом ряду. Для реализации каждого соединения к 
каждому переключателю в ряду, оператор повторения указывается на входе на лист. Рис. 31 
демонстрирует оба типа связности. 

 
Рис. 31. Оператор Repeat  в каждом символе листа говорит о том, что подчиненный лист 

должен быть использован несколько раз, в нашем случае 4 раза. 
  
 Отметим различие между двумя входами на лист. Первый из них (Res) сравнивает имя 

соответствующего ему порта точно, а другой (Col) использует команду повторения  к 
соответствующему имени порта.  Этот синтаксис означает, что имеется 4 цепи в шине 
Col[1..4], и  каждая из этих цепей шины, переходит на каждый из четырёх листов 
переключателей.  

Это позволяет четырём индивидуальным цепям быть выделенными из 4-х 
повторяющихся листов, первым будет помеченный проводник, затем помеченная шина, как 
показано на рисунке 31. В этой точке сигналы являются свободными для подключения к 
отдельным узлам, при необходимости, или (как в этом случае), должны быть переданы далее 
к иерархической лестнице до портов. 
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Рис. 32.  Верхний уровень проекта, где за один раз оператор повторения вводит весь ряд из 4-

х объектов. 
 
После построения многоканального проекта в соответствии со структурой связности в 

Altium Designer, стоит обратить внимание на методы нумерации каналов и входящих в них 
компонентов. 

Обозначение каналов 
Каналы являются виртуальными листами и поэтому синхронизатор в Altium Designer 

будет подразумевать комнаты для каждого канала, в то время как это возможно для любого 
другого листа. Однако перед тем как это сделать, компилятор должен сформировать 
уникальные имена для каждого канала и далее для всех составляющих его компонентов.  Эти 
имена формируются через вставку Multi-Channel в диалоге Project Options, где интерактивная 
диаграмма показывает, как установленные настройки будут воздействовать на компоненты и 
название комнаты (Room), если используется вложенные каналы. 

В основном, имеется возможность выбора из двух вариантов. Первый использует 
плоские или иерархические соглашения по именованию для комнат или компонентов 
(Иерархия здесь ссылается на иерархию каналов, поэтому такое решение имеет смысл только 
если проект содержит вложенные каналы). Второй использует цифровые или буквенные 
индексы. (Эта опция на самом деле позволяет иметь оба варианта, но, опять в виде 
исключения, она различима только тогда, если именуются вложенные каналы). 

Настраиваемый формат для указателей компонентов может содержать имя 
канала/комнаты нужного стиля, но оно не использовано. Обычно, формат указателя может 
содержать как префикс, так и суффикс для каналов и для компонентов. Два из семи 
зарезервированных ключевых слов делают это автоматически: $Component и $RoomName. 

$Component является формой цепочки из $ComponentPrefix $Componentindex. 
Например, секция компонента, помеченная U3A, содержит префикс (U) и индекс (3А). 
Подобно этому, $RoomName состоит из префикса и суффикса канала, но его точная форма 
будет значительно зависеть от данного проекта и выбранного стиля имени комнаты. Если 
проект не содержит вложенные каналы, тогда иерархический вариант стиля не подходит и 
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только цифровая или буквенная часть имени будет альтернативой того, как $RoomName 
описывает различные каналы. Если же данный проект имеет вложенные каналы и 
используется иерархический стиль именования комнаты, $RoomNane не может быть просто 
заменён на $ChannelPrefix и выглядеть как либо $ChannelAlpha, либо как $ChannelIndex. Это 
объясняется построением специального, многоуровневого префикса из имён каналов, 
используемых в операторах Repeat в текущем проекте. 

Предположим, что в проекте клавиатуры, был выбран путь с цифровым именем в стиле 
именования комнат, использующий запятую для разделения, а для формата указателя просто 
выбран $RoomName. 16 кнопок после компиляции проекта будут пронумерованы, как 
показано на рисунке 33. 

 
Рис. 33. 16 переключателей, скопированные и вложенные в один лист для показа их 

позиционных обозначений. 
 
 Если бы вместо этого использовали путь с буквенным именем в стиле именования 

комнат, указатели имели бы вид RowA,PBA; RowA,PBB и т.д. Если бы был использован путь 
со смешанным именем, то указатели имели бы вид RowA,PB1; RowA,PB2 и т.д. Но если бы 
была выбрана плоская альтернатива (одноуровневая структура), ссылки на ряды каналов 
можно было игнорировать, и указатели имели бы простой ряд от PB1 до PB16, или PBA и 
PBP (цифровые или буквенные). Конечно, это не является обычной практикой не учитывать 
возможности любых ссылок на свои компоненты в поле Designator Format, и применимы 
только в случае, когда каждый канал содержит просто один компонент. 

Параметрический многоканальный проект 
Некоторые многоканальные проекты имеют повторяющиеся фрагменты схемы, но 

требуют, чтобы определенные компоненты имели различные значения в каждом канале. 
Такая возможность поддерживается системой и рассматривается как параметрический 
многоканальный проект. 

Параметрические компоненты определяются посредством объявления их значений как 
параметров символа на родительском листе и затем указанием, что это параметр символа 
листа используется в параметре компонента, на указанном компоненте в схеме канала, как 
это показано на рисунке 34. 

Отметим, что нельзя использовать единственный символа листа с оператором Repeat 
применительно к определению многоканальной структуры,  вместо этого нужно разместить 
символы листа для каждого канала (где все символы листов ссылаются на одинаковый канал 
листа схемы). Определения параметрического компонента затем специфицируются в каждом 
из этих листовых символов. 
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Рис. 6. Укажите значение 
параметрического компонента 
как параметр символа листа 
(как показано в диалоге Sheet 
Symbol справа), затем 
сошлитесь на этот параметр 
через параметр в целевом 
компоненте (как показано в 
компонентном диалоге выше). 

Комнаты в проекте платы 
Многоканальный проект выгоден каждому, а не только инженеру-схемотехнику. 

Выгода конструктору платы вытекает из возможности группирования компонентов канала в 
их перспективные зоны (комнаты) на этапе ввода контура платы. Новый мощный комнатно-
ориентированный инструментарий будет особенно уместен при формировании шаблона 
многоканального проекта. 

Автотрассировщик Situs в составе Altium Designer – понимает установки отдельной 
комнаты для трассировки всех связей в пределах границы такой комнаты. С другой стороны, 
инструмент отмены трассировки имеет опцию для комнаты. Соответствующим компонентам 
в каждом канале присваиваются одинаковые значения Channel Offset, означающие, что они 
могут быть выбраны совместно или отредактированы как группа. 

Более существенным, чем всё это, является  возможность копирования формата из 
одной комнаты в другую. Это позволяет вносить изменения в размещение компонентов в 
одной из комнат, а затем копировать комнатный формат в другие комнаты. Если комнаты-
источники и комнаты-приёмники принадлежат одному и тому же классу канала  (что 
означает, что они клонированы из одного участка схемы), тогда обновления могут 
затрагивать всех членов класса одновременно.  Копируемая информация может быть 
ограничена размерами и формой комнаты, или может быть применена для обработки 
посадочного места или даже трассировки. Дополнительный контроль позволяет определить, 
как далеко могут быть раздвинуты трассы, предварительно помещённые в такую комнату. 

Другой многочисленный инструментарий добавлен в редактор плат, который позволяет 
конструктору платы выполнить многоканальный проект. При использовании команды 
перемещения в подменю Design>Rooms, например, можно нажать клавишу L, которая 
перенесёт всё перемещаемое на противоположную сторону платы. Вся комната, включая 
элементы размещения и трассировки, сохраняется неповреждённой после перемещения. 

Результат перспективного многоканального проекта, что касается разработчиков платы 
и схемы, это то, что не нужно тратить на одно и тоже редактирование лишнее время. 

Для более подробного изучения преимуществ многоканальных и вложенных 
многоканальных проектов и ознакомьтесь с примерами таких проектов в папке Altium 
Designer 6\Examples\reference Design\, содержащей проекты: 

• LedMatrixDisplay 
• Multi-Channel Mixer 
• Peak Detector 
• PortSwitcher 
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Порядок создания многоканального проекта 
 
Многоканальный проект использует одинаковые каналы много раз. Каналы нужно 

только однажды ввести в виде отдельных подчиненных листов схем и включить в проект. 
Можно легко определить, сколько каналов используются в размещённых символах листов, 
которые ссылаются на один и тот же подчиненный лист, или содержат оператор Repeat в 
обозначении символа листа. 

Designator Manager создаёт и устанавливает таблицу канальных связей, которая 
запоминается как часть файла проекта. Многоканальный проект поддерживается на всём 
протяжении процесса проектирования, включая  изменение нумерации обозначений в 
файле проекта. 

В этой главе будет рассмотрен многоканальный проект Peak Detector – Multi 
channel.PrjPcb, расположенный в папке \Altium designer 6\Examples\reference Design. 

 
Проект имеет трехуровневую иерархию – родительский лист, набор листов и 

многоканальный лист. Родительский лист (Peak Detector.SchDoc) содержит символ листа 
для четырёх наборов (рассмотренных как один набор Bank.SchDoc 4 раза). Схемы Bank 
возвращают символа листа для восьми каналов в каждом наборе, создавая 32 канала. 
Вместо создания всех этих каналов как отдельных листов схем, используется команда 
Repeat и символ лист для ссылающийся на одну схему, Peak Detector - channel.SchDoc, для 
каждого требуемого канала. С помощью форматирования имён комнат и обозначений 
компонентов можно отобразить этот иерархический проект. 

Порядок создания многоканального проекта 
При создании такого проекта, сначала был создан файл проекта платы и три схемы, 

которые представляли уровни этого многоканального проекта, для чего были созданы, 
например, Detector.SchDoc (верхний или родительский лист), Bank.SchDoc (уровень набора) 
и Peak Detector - channel.SchDoc  (уровень каналов). Далее рассмотрим порядок создание 
данного проекта по шагам: 

1. Создайте схему, которая станет каналом на отдельном листе схемы, как показано 
ниже (Peak Detector - channel.SchDoc) и добавьте новую схему в проект платы. 
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2. Затем создайте схему для уровня набора (Bank.SchDoc). В Bank.SchDoc необходимо 

разместить символ листа для создания необходимого количества 
каналов, которые будут  ссылаться на Peak Detector - channel.SchDoc. 

3. Укажите Place>Sheet Symbol  и разместите символ листа. 
Дважды нажмите ЛК на новом символе листа для отображения 
вкладки Properties в диалоге Sheet Symbol. 

 
Имя обозначения символа листа используют для уникальной идентификации каждого 

компонента в каждом канале. В примере выше, обозначение символа листа – PD. Возможно 
использовать любое имя, но рекомендуется применять короткие имена символа листа для 
хранения короткого позиционного обозначения.  Это связано с тем, что  имя символа листа 
и нумерация канала будет добавлена к обозначению компонента при компиляции проекта, 
например, R1 станет R1_PD1. 

4. В поле Filename введите имя схемы канала, на которую будет ссылаться данный 
символ, например, Peak Detector - channel.SchDoc.  

5. Определите, сколько раз будет использована данная схема канала с помощью 
введения команды Repeat Channel в поле Designator, формат которой имеет вид: 

Repeat (sheet_symbol_name, first_channel, last_channel) 
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Поэтому, в данном примере, команда Repeat (PD,1,8) в поле Designator будет ссылаться 
на схему канала Peak Detector 8 раз (1,8) через символа листа с именем PD. 

6. Нажмите ОК для закрытия диалога Symbol Sheet и символ будет изменён для 
отражения множества каналов, которое он теперь представляет. 

 
7. Цепи, которые являются общими для всех подчиненный листов, соединены обычным 

образом. Цепи, которые соединены индивидуально для повторяющихся подчиненный 
листов, оформляются как шина, с одним элементом шины, подключённым к каждому 
подчиненный листу. 

В  примере выше, это показано с помощью размещения имени шины (не входящее в 
шинный ряд, например, Р) на проводнике и вход листа, содержащий ключевое слово 
Repeat. Когда проект будет откомпилирован, эта шина преобразуется в индивидуальные 
цепи (от Р1 до Р8) с одним присвоением к каждому каналу; Р1 соединён с подчиненный 
листом PD_1, P2 соединён с подчиненный листом PD_2 и т.д. 

8.  Создайте родительский лист Peak Detector.SchDoc и используйте команду 
Place>Sheet Symbol  для создания символа листа для представления следующего нижнего 
уровня схемы, Bank.SchDoc. 

 
В примере выше, обозначения символа листа – Bank. Поэтому, команда Repeat (Bank, 1, 

4) в поле Обозначения диалога Sheet Symbol  будет ссылаться на схему Bank 4 раза (1,4) 
символа листа Bank. 
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Отметим также, что метки цепей на проводниках в данном примере не содержат номера 
элемента шины, и символ листа содержит ключевой оператор Repeat. Когда проект будет  
откомпилирован, эта шина преобразуется в индивидуальные цепи (от OFF1 до OFF4) с 
одним присвоением к каждому каналу. 

Определение формата обозначений компонентов и комнат  
После того, как были созданы схемы, можно форматировать позиционные 

обозначения компонентов и имена комнат, которые будут определяться от единственного 
логического компонента на схеме до множества физических образцов на плате. 

Логические позиционные обозначения присваиваются компонентам исходной схемы. 
Физические позиционные обозначения присваиваются компонентам после их размещения 
на плате. При создании многоканальных проектов, логические позиционные обозначения 
для компонентов повторяющихся каналов могут быть одинаковыми, но компонент должен 
иметь уникальное физическое позиционное обозначение на плате. 

1. Укажите Project>Project Option. Нажмите вкладку  Multi-Channel в диалоге Option 
for Project для установки формата обозначения комнат и позиционных обозначений 
компонентов. 

  
2. Раскройте выпадающий список Room Naming Style для выбора формата 

обозначений, который требуется для 
комнат в проекте. Эти комнаты 
создаются по умолчанию, при переносе 
схемы в плату. Имеется пять 
доступных стилей – два 
одноуровневых и три иерархических. 

 
Форматы имени одноуровневой комнаты Форматы имени иерархической комнаты 
Одноуровневый цифровой с именами Цифровое имя пути 
Одноуровневый буквенный с именами Буквенное имя пути 
 Смешанное имя пути 
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Иерархические имена комнат формируются сочетанием позиционных обозначений всех 
символов листов каналов (ChannelOrefix + ChannelIndex) в иерархии канального пути. 

3. Как только был выбран стиль из списка, изображение на вкладке Multi-Channel  (см. 
ниже) обновляется для отображения обозначений в соответствии с тем, которое появится в 
проекте.  

 
Изображение дано для примера канального проекта 2х2. Большие по размеру 

заштрихованные регионы представляют 2 канала верхних уровней, а притемненные 
регионы внутри представляют каналы более низкого уровня (с двумя образцами 
компонентов, представленными в каждом). После компиляции проекта, создаются комнаты 
для каждого листа в проекте, содержащие каждая банк и каждый канал нижнего уровня. 
Для проекта размером 2х2 канала, показанного в этом изображении, будет создано всего 6 
комнат – по одной для каждого набора и по одной для каждого из 4-х каналов нижнего 
уровня. 

 В нашем примере Peak Detector будет создано 37 комнат – одна для листа схемы 
высокого уровня (1), одна для каждого из 4-х наборов (банков) (4) и по одной для каждого 
из 8-ми каналов в составе каждого банка (32). 

3. Используйте поле Level Separator for Paths  для выбора требуемых сочетаний 
Character/Symbol для разделения меток в строке обозначения, при использовании стилей 
иерархических именований, например, тех стилей, которые содержаться в пути.  

Примечание. Не существует ограничений на текстовые символы, используемые как 
разделитель уровня; однако одиночный символ, не относящийся к букве-цифре более 
удобен для читаемости. 

 
Для установки позиционных обозначений компонентов имеется несколько вариантов. 

Можно выбрать формат или определить собственный, используя допустимые ключевые 
слова. Задайте формат позиционных обозначений, для компонентов выбором из 
выпадающего списка Designator Format. Имеется 8 предопределённых форматов  - пять 
для одноуровневых структур и три, которые  можно использовать для иерархии. 

Форматы позиционных обозначений для одноуровневых структур 
$Component$ChannelAlpha 
$Component_$ChannelPrefix$ChannelAlpha 
$Component_$ChannelIndex 
$Component_$ChannelPrefix$ChannelIndex 
$ComponentPrefix_$ChannelIndex_$ComponentIndex 
Форматы позиционных обозначений для иерархических структур 
$Component_$RoomName 
$RoomName_$Component 
$ComponentPrefix_$RoomName_$ComponentIndex 
Форматы позиционных обозначений одноуровневых структур задаются для каждого 

компонента в последовательной линейной прогрессии, начиная с первого канала. 
Иерархический формат содержит имя комнаты (Room Name) в позиционных 

обозначениях для компонента. Если стилем именования комнаты выбран один из двух 
возможных для одноуровневых стилей, тогда стиль для позиционных обозначений 
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компонентов будет также одноуровневым. Однако если для обозначений комнаты выбран 
иерархический стиль, то позиционные обозначения компонентов будут также 
иерархическими, поскольку в формат будет включена информация пути. 

Задание пользовательского формата позиционных обозначений 
Имеется возможность задать пользовательский формат позиционных обозначений, 

напечатав его  непосредственно в поле Designator Format. Следующие ключевые слова 
могут быть использованы при создании формата строки. 

 
Ключевое слово Определение 
$RoomName Имя ассоциированной комнаты, как оно определено после 

выбора стиля в поле Room Naming Style 
$Component Логическое позиционное обозначение компонента 
$ComponentPrefix Префикс логического позиционного обозначения 

компонента (например, U для U1) 
$ComponentIndex 
 

Индекс логического позиционного обозначения компонента 
(например, 1 для U1) 

$ChannelPrefix Префикс логического позиционного обозначения символа 
листа (RD, для Repeat (PD,1,8) 

$ChannelIndex Индекс логического позиционного обозначения символа 
листа (1..8, для Repeat (PD,1,8) 

$ChannelAlpha Индекс канала, выраженный в буквенном виде. Этот формат 
полезен, если проект содержит менее чем 26 каналов, или 
если используется иерархический формат позиционного 
обозначения. 

 

Компиляция проекта 
Необходимо компилировать проект после любых изменений, сделанных в комнате 

и/или в формате позиционного обозначения компонента, чтобы применить изменения. 
1. Компилируйте проект, выбрав Project>Compile PCB Project. Когда откомпилирован 

многоканальный проект, имеется по-прежнему только один лист, находящийся в редакторе 
схемном, однако теперь имеются вкладки, отображаемые вдоль нижней части листа схемы 
в окне проекта, одна для каждого канала. Имена вкладок соответствуют именам символа 
листа плюс номер канала, например, BANK_A. 

2. После компиляции проекта проект передаётся в редактор плат обычным путём 
Design>Update PCB. Процесс передачи автоматически создаёт класс компонентов для 
каждого листа схемы в проекте, комнату для каждого класса компонентов и группы 
компонентов в каждом классе в их комнате, готовые для размещения. 

3. После размещения и трассировки одного канала, укажите Design>Rooms>Copy 
Room Formats в редакторе плат для копирования результатов размещения и трассировки 
этого канала в другие каналы. 

 

Просмотр результатов настройки нумерации комнат и компонентов 
Для контроля назначенных многоканальных обозначений, можно просмотреть все 

компоненты, использованные во всех исходных документах схем в проекте, в терминах 
логических и физических позиционных обозначений. 

Для контроля позиционных обозначений, которые привязаны к компонентам в 
многоканальном проекте: 
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1. Укажите Project>View Channels для отображения диалога Project Components, 
который показывает логические и физические позиционные обозначения, связанные с 
каждым компонентом в исходных документах схем. 

  
Таблица демонстрирует ряд каналов, связанных с именем схемы в проекте. В примере 

выше, были использованы следующие установки для обозначений комнат и компонентов: 
смешанные имена пути и $Component_$ChannelPrefix$ChannelIndex. 

Каждый канал будет иметь обозначения, с добавленным номером канала, а компонент, с 
добавлением обозначения канала, например, обозначение С1 в Peak Detector – 
channel.SchDoc становится C1_PD1 для канала 1 до C1_PD32  для канала 32, когда он 
передан в плату. 

2. Нажмите на строке компонента для перехода к этому компоненту на исходной схеме. 
Компонент будет отображён с масштабированием и центрированием в главном окне 
проекта. Диалог сохраняется открытым, что позволяет переключаться на другие 
компоненты. 

3. Нажмите кнопку Component Report  для отображения диалога Report Preview, 
показывающего предварительный вид распечатки отчёта компонентов проекта. Нажмите 
Print для печати отчёта. Отобразится диалог Print. Нажмите ОК для передачи отчёта на 
принтер. 

4. Укажите Export из диалога Report Preview  для сохранения отчёта о компонентах 
проекта в файле, например, как широкоформатную таблицу (.xls) или .pdf. Сохраните файл 
и затем его можно будет открывать с помощью подходящей программы (например, 
Microsoft Excel или Adobe Reader) щелчком  Open Report. 

5. Нажмите  Close  для выхода из режима просмотра печати и нажмите ОК для 
закрытия диалога Project Components. 
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Проектирование печатных плат 

Это глава служит в качестве обзора этапов проектирования печатных плат: создание 
схемы, обновление проектной информации для платы и формирование выводных файлов 
для изготовления платы. Оно также рассматривает концепции интегрированных библиотек 
и библиотек проекта.  

Создание нового проекта  платы 
 
Проект в Altium Designer содержит связи со всеми документами и установками, 

относящимися к проекту. Файл проекта, например, xxx.PrjPCB, является текстовым файлом 
в кодировке ASCII, который содержит список документов проекта и сопутствующих 
выходных установок, например для распечаток и изготовления платы (САМ). Не связанные 
с проектом документы называются ‘свободными документами’. Связи листов схемы и 
конечных элементов, например, плат, ПЛИС, встроенного языка описания аппаратного 
обеспечения на быстродействующих ИС (VHDL) или библиотечным пакетом, также 
добавляются в проект. Как только проект откомпилирован, можно выполнить его 
верификацию, синхронизацию и проверку. Любые изменения в оригинальной схеме или в 
плате, обновляются в проекте при его компиляции. 

Процесс создания нового проекта одинаков для всех типов проекта.  Будем 
использовать проект платы в качестве примера. Сначала создадим файл проекта и затем 
создадим бланк схемы для добавления в новый пустой проект. Позже в этом руководстве 
создадим бланк платы и также добавим его в проект. 

В начале работы, создайте новый проект платы: 
1. Укажите из меню File>New>Project>PCB Project, или нажмите ЛК на Blank Project 

(PCB) в секции New панели Files. Если эта панель не отобразилась, нажмите на вкладке 
Files в нижней части панели Design Manager. 

      Как вариант, можно выбрать Printed 
Circuit Board design в секции Pick a Task на 
домашней странице (View>Home) и затем нажать 
ЛК на New Blank PCB Project. 

2. Отобразится панель Projects. Новый файл 
проекта PCB_Project1.prjPCB, добавлен здесь с 
признаком отсутствия документов (No Document 
Added).     

3. Переименуйте новый файл проекта (с расширением .PrjPCB)  по команде File>Save 
Project As. Укажите место для размещения и сохраните проект на жёстком диске, написав 
название Multivibrator в поле File Name, нажмите Save. 

 
После создания проекта создается схема для добавления в пустой файл проекта. Это 

будет схема нестабильного мультивибратора. 

Создание нового листа схемы 
Создайте новый лист схемы посредством следующих шагов: 
1.Укажите File>New>Schematic или нажмите Schematic Sheet в  секции New панели 

Files. Бланк листа схемы с именем Sheet1.schDoc отображается в окне проекта, а схема 
автоматически добавляется в активный проект. Лист схемы теперь в списке с заголовком 
Source Documents ниже имени проекта на вкладке Projects. 
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2.  Переименуйте новый файл схемы (с расширением .SchDoc) выбрав File>Save As. 

Укажите место для размещения и сохранение проекта на жёстком диске, напечатайте имя 
Multivibrator в поле File Name и нажмите Save. 

При открытии бланка листа схемы, будет выдана информация, что рабочая область 
изменена. Главная панель инструментов включает ряд новых кнопок, новые панели 
инструментов являются видимыми, панель меню включает новые элементы и отображается 
панель Sheet. Теперь работа ведется в редакторе схем. 

Имеется возможность персонифицировать многие элементы рабочей области. 
Например, можно переместить панели или персонифицировать команды меню и панели 
инструментов. 

Теперь можно добавить бланк схемы в проект перед началом работы по вводу схемы. 
Если листы схем, которые необходимо добавить в файл проекта, открыты, как свободные 
документы, нажмите ПК на имени проекта в панели Projects и выберите Add Existing to 
Project. Укажите имя свободного документа и нажмите Open. По другому, можно 
перетащить свободный документ в список документов проекта в панели Project.  Лист 
схемы теперь распечатан под названием Source Documents ниже проектного имени на 
вкладке Projects  и связан с файлом проекта. 

Установка опций листа схемы 
Первое, что необходимо сделать перед началом рисования схемы, установить 

соответствующие опции документов. Выполните следующие шаги. 
1.Из меню выберите Design>Document Option и будет открыт диалог Document 

Option. Для данного примера, единственное необходимое изменение состоит в установке 
размера листа в стандартный формат А4. На вкладке Sheet Option найдите поле Standard 
Styles. Нажмите стрелку рядом со списком для просмотра списка форматов листа. 

2.Выберите формат А4 и нажмите кнопку ОК для закрытия диалога и обновления 
размера листа. 

3.Для расширения документа до размера зоны просмотра снова, укажите View>Fit 
Document. 
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В Altium Designer можно активировать любое меню простым нажатием горячей 
клавиши этого меню (подчёркнутый символ в имени меню). Любые последовательности 
элементов меню будут также иметь горячие клавиши, которые вы можете использовать для 
активации элемента. Например, горячая клавиша для выбора элемента меню View>Fit 
Document – это нажатая клавиша V за которой следует клавиша D. Многие вложенные 
меню, такие как меню Edit>Deselect, можно вызвать непосредственно. Для активации 
элемента меню Edit>Deselect>All on Current Document, необходимо только нажать 
клавишу Х (для вызова меню Deselect напрямую) и затем клавишу А. 

Теперь мы установим общие настройки редактора схем. 
1. Укажите Tools>Schematic Preferences [клавиши T,P] для открытия диалога 

Preferences. Этот диалог позволяет установить глобальные настройки, которые затрагивают 
все листы схем для работы. 

2. Нажмите  Schematic>Default Primitives в дереве выбора (в левой части диалога), 
чтобы сделать его активной страницей и отметьте флажок Permanent. Нажмите кнопку ОК  
для закрытия диалога. 

3. Перед началом ввода схемы, сохраните этот лист схемы, выбрав File>Save 
[клавиши F,S]. 

Altium Designer имеет многоуровневую команду отмены (Undo), позволяющую 
отменять ряд предыдущих действий. Максимальное число шагов отмены задаётся 
пользователем и ограничено только доступной памятью компьютера. 

Формирование схемы 
Теперь можно начать формирование схемы. В этой главе будет использована схема, 

показанная на рисунке. 1. Эта схема содержит транзисторы 2N3904, формирующие 
самозапускаемый нестабильный мультивибратор. 

  
Рис. 1. Электрическая принципиальная схема нестабильного мультивибратора 

Размещение компонентов и загрузка библиотек 
Для манипулирования тысячами компонентов, содержащихся в библиотеках Altium 

Designer, Редактор схем предоставляет мощное средство поиска в библиотеках. Хотя 
требуемые для данного проекта компоненты расположены в установленной библиотеке, 
полезно знать, как производить поиск нужных компонентов в библиотеках. Выполните 
следующие шаги для размещения и добавления нужных библиотек для рассматриваемой в 
руководстве схемы. 

Во-первых, нужно выполнить поиск транзисторов, одного типа 2N3904. 
1. Нажмите на вкладке Library для отображения панели Libraries. 
2. Нажмите кнопку Search на панели Libraries, или укажите Tools>Find Component 

для открытия диалога Libraries Search. 
3. Убедитесь, что в рамке Scope помечен флажок Libraries on Path и что рамка Path 

содержит корректный путь к библиотекам. Если была использована директорию по 
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умолчанию в процессе инсталляции системы, этот путь будет C:\Program Files\Altium 
Designer 6\Library\. Нажмите на иконке 
папки для просмотра директории 
библиотек. Убедитесь, что флажок 
Include Subdirectories не отмечен (нет 
галочки) для этого примера. 

4. Необходимо разыскать все 
ссылки на 3904, поэтому введите *3904*  
в разделе запроса в верхней части 
диалога Libraries Search. Символ * это 
шаблон подстановки, используемый 
вместо возможных различных 
префиксов и суффиксов для различных 
изготовителей. 

5. Нажмите кнопку Search для 
запуска поиска. Результат поиска отображается на панели Library при успешном поиске. 

6.Нажмите имя компонента 2N3904 в библиотеке Miscellaneous Devices.Intlib для его 
выбора. Эта библиотека содержит символы для всех доступных для моделирования 
транзисторов BJT. 

7.Если был выбран найденный компонент в 
библиотеке, которая в настоящий момент не установлена, 
программа запросит установку этой библиотеки перед 
размещением компонента на схеме. Так как библиотека 
Miscellaneous Devices, нужная нам, уже установлена по 
умолчанию, то компонент готов для размещения. 

Добавляемая библиотека появится в выпадающем 
списке в верхней части панели Libraries. После выбора 
библиотеки в верхнем списке, компоненты этой 
библиотеки будут перечислены ниже. Затем можно 
использовать фильтр компонента для быстрого поиска 
компонента в библиотеке. 

Размещение компонентов на схеме 
Первыми размещаемыми на схеме компонентами 

будут 2 транзистора, Q1 и Q2. Для общей ориентировки по 
схеме, см. рис. 1. 

1. Укажите View>Fit Document [клавиши V и D] и 
убедитесь, что схема занимает всё окно. 

2. Убедитесь в отображении панели Libraries, 
щёлкнув вкладку Libraries. 

3. Q1 и Q2 являются BJT транзисторами, поэтому 
выберите библиотеку Miscellaneous Devices.Intlib из 
выпадающего списка библиотек вверху панели Libraries, 
чтобы активировать эту библиотеку. 

4. Используйте фильтр для быстрого обнаружения необходимого компонента. Символ 
* в шаблоне подстановки перечислит все обнаруженные в библиотеке компоненты. 
Установите фильтр *3904* в поле ниже имени библиотеки. Будет представлен список 
компонентов, которые содержат текст 3904 как часть имени компонента. 

5. Выберите 2N3904 в списке для его выбора, затем нажмите кнопку Place. Иначе 
можно дважды нажать ЛК на имени компонента. Курсор измениться на крестик, и контур 
транзистора будет перемещаться вместе с курсором. Вы теперь находитесь в режиме 
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размещения. При перемещении курсора в любое место, контур транзистора будет следовать 
за ним. 

6. Перед размещением секции на схеме, сначала отредактируйте ее свойства. При 
следовании транзистора за курсором, нажмите клавишу TAB. Это действие откроет диалог 
Component Properties для компонента. В данном диалоге будут показаны атрибуты, как 
показано ниже. 

  
7. В секции диалога Properties, установите значение первого позиционного 

обозначения, введя Q1 в поле Designator. 
8. Затем проверим посадочное место, которое будет использовано для представления 

компонента  на плате. В этом руководстве, используем интегрированные библиотеки, 
которые уже содержат рекомендуемые модели для посадочных мест и моделирования 
схемы. Убедитесь, что посадочное место BCY-W3/E4 уже содержится в списке моделей. 
Оставьте все другие значения полей по умолчанию и нажмите ОК для закрытия диалога. 

 
После описанных приготовлений можно разместить элементы на схеме. 
1. Переместите курсор (с присоединённым символом транзистора) в позицию 

транзистора несколько левее середины листа. После того, как удовлетворитесь позицией 
транзистора, нажмите ЛК или клавишу Enter для фиксации транзистора на листе схемы. 

2. Переместите курсор и вы обнаружите, что копия транзистора размещена на листе 
схемы, но курсор всё ещё находится в режиме размещения с контуром компонента. Это 
свойство системы позволяет разместить множество компонентов одинакового типа. Это 
позволяет расположить второй транзистор. Он такой же, как и первый, поэтому он не 
нуждается в редактировании атрибутов при его размещении. Altium Designer будет 
автоматически увеличивать позиционное обозначение, при размещении ряда компонентов. 
В этом случае, второй транзистор  после размещения получит позиционное обозначение Q2. 

3. Если вы внимательно рассмотрите схему на рисунке 1, то обнаружите, что второй 
транзистор Q2 нарисован зеркально относительно Q1. Для зеркального отображения 
транзистора под курсором, нажмите клавишу Х.  Это отображает компонент горизонтально 
(Для отображения по вертикали следует нажать клавишу Y). 

4. Поместите курсор в позицию для компонента правее Q1. Для более точного 
позиционирования, нажмите клавишу PAGEUP дважды для двукратного масштабирования. 
Теперь будут видны линии сетки. 
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5. После позиционирования узла, нажмите ЛК или нажмите Enter для размещения 
Q2. После его повторного копирования на схему, следующий транзистор будет плавать с 
курсором, готовый для его размещения. 

6. Так как были размещены все транзисторы, закончим режим размещения 
компонентов щелчком  ПК или нажатием клавиши ESC. Курсор примет вид стрелки. 

Используйте следующие клавиши для управления компонентом под курсором: 
- Y  отображает элемент вертикально 
- X  отображает элемент горизонтально 
- Клавиша Space (пробел) поворачивает элемент на 90 градусов 
 
Теперь разместим 4 резистора. 

1. На панели Libraries убедитесь, что активна библиотека Miscellaneous 
Devices.Intlib. 

2. Установите фильтр, введя res1 в поле фильтра ниже имени библиотеки. 
3. Нажмите Res1 в списке компонентов для его выбора, затем нажмите кнопку 

Place. Теперь под курсором будет плавающий символ резистора. 
Для редактирования атрибутов объекта, помещённого на схему, дважды нажмите ЛК 

на объекте для открытия диалога Component Properties. 
4. Нажмите клавишу TAB для редактирования атрибутов резистора. В секции 

диалога Properties, установите значение для первого позиционного обозначения компонента 
– введите R1 в поле Designator. 

5. Убедитесь, что имя посадочного места  AXIAL-0.3 находится в списке Models. 
6. Содержимое поля Comment схемного компонента задаётся в поле Comment РСВ 

компонента, обычно вы сюда вводите значение для резистора. Введите значение 100к в это 
поле для R1. 

Компоненты для моделирования могут содержать несколько атрибутов для 
моделирования (например, резистор имеет 1, BJT имеет 5, а MOSFET имеет 13), эти 
свойства задаются как параметры. Если нужно будет моделировать эту схему, тогда 
резистор должен быть задан как параметр, где имя это значение и значение – резистор. 

Если схема будет использована как для моделирования, так и для формирования 
шаблона платы, то вместо того, чтобы дважды вводить значение (в параметр, названный 
Value и затем  в поле Comment) Altium Designer поддерживает “косвенность”, свойство, 
которое переопределяет любую параметрическую строку текста в поле комментария. Если 
выбрать для отображения поле комментария как выпадающий список, то программа 
автоматически построит список всех текущих параметров, для варианта переопределения 
значения одного из них в поле комментария. 

7. Так как в данная схема не будет моделироваться, убедитесь, что флажок Visible 
для параметра Value очищен. 

8.  Нажмите клавишу пробела для поворота резистора на 90 градусов относительно 
его текущей ориентации. 

9. Установите резистор выше базы Q1 (см. схему на рисунке 1) и нажмите ЛК или 
нажмите Enter для размещения объекта. Не беспокойтесь о вводе соединения транзистора с 
резистором, которого пока ещё нет. Линии связи рисуются на следующем этапе. 

10. Теперь поместите другой 100к резистор выше базы Q2. Позиционное 
обозначение будет увеличено автоматически при фиксации второго резистора. 

11. Оставшиеся два резистора R3 и R4 имеют значение 1к, поэтому нажмите 
клавишу TAB для вызова диалога Component Properties, введите 1к в Comment и убедитесь, 
что флажок Visible для параметра Value очищен. Нажмите ОК для закрытия диалога. 

12. Поместите и закрепите R3 и R4 в соответствии со схемой. Нажмите ПК или 
нажмите ESC для выхода из режима размещения узлов. 

 
Теперь разместим два конденсатора. 
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1.Объект конденсатор также находится в библиотеке Miscellaneous Devices.Intlib, 
которая уже была выбрана на панели Library. 

2.Напечатайте сар в поле фильтрации компонента на панели Library. 
3.Нажмите на CAP в списке компонентов для его выбора, затем нажмите кнопку 

Place. Вы получите символ конденсатора под курсором. 
4.Нажмите клавишу TAB для редактирования атрибутов конденсатора. В диалоге 

Component Properties  установите Designator в С1, Comment в 20n, очистите флажок Visible 
для параметра Value и проверьте посадочное место – модель RAD-0.3, которое выбрано в 
списке Models. Нажмите ОК. 

Как и в случае с резистором, если необходимо моделировать эту схему, то есть 
необходимость в параметре Value со значением 20n, в этом случае можно задать ёмкость 
как значение параметра и затем использовать косвенное свойство для переопределения 
содержимого параметра значения в поле Comment. Так как вы не будете моделировать 
схему, убедитесь, что флажок Visible для параметра Value очищен. 

5.Позиционируйте и закрепите 2 конденсатора так же, как делали с другими частями 
схемы. 

6.Нажмите ПК или нажмите ESC для выхода из режима размещения. 
 
 Последним компонентом для размещения является соединитель, расположенный в 

библиотеке Miscellaneous Connectors.IntLib.  
1. Выберите Miscellaneous Connectors.IntLib в списке библиотек на панели Libraries. 

Нужный соединитель является двухконтактной розеткой, поэтому установим фильтр *2*. 
2. Выберите Header 2 из списка компонентов и нажмите кнопку Place. Нажмите TAB 

для редактирования атрибутов, установите Designator в Y1 и проверьте наличие модели 
посадочного места HDR1X2.  Параметр Value не нужен, так как вы хотели заменить этот 
компонент источником питания, при моделировании схемы. Нажмите ОК для закрытия 
диалога. 

3. Перед размещением соединителя, нажмите Х для горизонтального отображения, так 
как это его правильная ориентация. Нажмите для фиксации соединителя на схеме. 

4. Нажмите ПК или нажмите ESC  для выхода из режима размещения частей схемы. 
5. Сохраните схему выбором File>Save из меню [горячие клавиши F,S]. 
Теперь были размещены все компоненты. Отметим, что компоненты на рисунке 2 

расположены так, чтобы имелось достаточно места для проводов к каждому выводу  
компонента.  

Если необходимо переместить компонент, нажмите и удержите ЛК на графике 
компонента, затем перетащите мышку в новую позицию. 

 
Рис. 2. Схема с размещёнными компонентами 
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Прорисовка соединений на схеме 
1. Для получения хорошего обзора листа схемы, используйте клавишу PAGE UP для 

увеличения и PAGE DOWN для уменьшения. Можно также попытаться нажать клавишу 
CTRL и использовать колёсико мыши для масштабирования.  

2. Во-первых, соедините проводом резистор R1 с базой транзистора Q1 следующим 
образом. Укажите Place>Wire [P,W] из меню или нажмите инструмент Wire на панели 
инструментов для перехода в режим размещения соединения. Курсор изменится на крестик. 

3. Поместите курсор к нижнему выводу резистора R1. Когда вы окажитесь в 
правильной позиции, в позиции курсора красный появится маркер соединения (большая 
звёздочка). Она показывает, что курсор находится поверх электрической точки соединения 
компонента. 

4. Нажмите ЛК или нажмите Enter для фиксации первой точки соединения. 
Перемещайте курсор и увидите, что от позиции курсора назад к точке фиксации появляется 
линия соединения.  

5. Позиционируйте курсор так, чтобы он находился ниже R1 на уровне базы Q1. 
Нажмите ЛК или нажмите Enter для привязки проводника к этой точке. Проводник между 
первой и второй точками привязки будет размещён. 

6. Поместите курсор поверх базы Q1, пока не увидите изменение курсора на красный 
маркер соединения.  Нажмите ЛК или нажмите Enter  для подключения проводника к базе 
Q1. 

7. Заметим, что курсор сохраняет вид крестика, указывая на готовность размещения 
других проводников. Для окончательного выхода из режима размещения проводников и 
возврата к курсору в форме стрелки, нужно нажать ПК или нажать снова ESC – но пока не 
делайте этого. 

8. Теперь будем соединять проводниками C1 с Q1 и R1. Поместите курсор поверх 
левой точки подключения С1 и нажмите ЛК или нажмите Enter  для ввода нового 
проводника. Переместите курсор горизонтально до тех пор, пока он не перекроет 
проводник, соединяющий базу Q1 и R1. Появится маркер соединения. Нажмите ЛК или 
нажмите Enter для размещения сегмента проводника, затем нажмите ПК или нажмите ESC 
для указания о завершении прокладки проводника. Отметим, что два проводника 
автоматически соединяются. 

9. Проложите оставшиеся проводники, как показано на рисунке 3. 
 
Для графического редактирования линии соединения или любого другого 

графического объекта после его размещения, поместите курсор поверх объекта и нажмите 
ЛК. Всякий раз, когда провод пересекает точку подключения компонента, или 
заканчивается на другом проводнике, система будет автоматически создавать узел 
электрической цепи. При размещении проводников, помните о следующих моментах: 

- ЛК или Enter привязывает проводник к позиции курсора; 
- нажатие клавиши Space (пробела) удаляет последнюю точку привязки проводника; 
- после размещения последнего сегмента проводника, ПК или ESC завершает 

размещение проводника. Курсор сохранил форму крестика и можно начать прокладку 
другого проводника. 

- Повтор ПК или ESC закончит режим размещения. 
Проводники, которые пересекают конец вывода, будут подключены к этому выводу, 

даже если будет удален узел.  
  
Примечание. Проверьте соответствие схемы с рисунком 3 перед продолжением 

работы 
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Рис. 3. Полностью соединенная схема 

 
10. По завершении размещения всех проводников, нажмите ПК или ESC для 

выхода из режима размещения. Курсор примет форму стрелки. 
11. Если необходимо подвинуть размещённые компоненты  и перетащить все 

связанные с ним проводники, нажмите и удерживайте клавишу Ctrl в процессе 
перемещения компонентов или укажите Move>Drag. 

Цепи и метки цепей 
Все множество выводов компонентов, которые соединены между собой, теперь 

рассматривается как цепь. Например, одна цепь содержит базу Q1, один вывод R1 и один 
вывод C1. 

Для облегчения идентификации важных цепей в проекте, можно ввести метки цепей. 
Для размещения меток цепей на двух силовых цепях: 

1. Укажите Place>Net Label [P,N]. Появится плавающий точечный бокс на курсоре. 
2. Для редактирования метки цепи перед ее размещением, нажмите клавишу TAB для 

отображения диалога Net Label. 
3. Введите 12V в поле Net, затем нажмите ОК для закрытия диалога. 
4. Поместите метку цепи так, чтобы левая часть метки была выше 

проводника на схеме. Курсор примет вид красного перекрестья, если метка 
коснется проводника. Если перекрестье имеет серый цвет, это означает, что вы пытаетесь 
пометить вывод.  

5. После размещения первой метки курсор останется в режиме размещения меток, 
поэтому снова нажмите клавишу TAB для редактирования второй метки, перед её 
размещением. 

6.Напечатайте  GND в поле Net, нажмите ОК для закрытия диалога и разместите 
метку цепи. Нажмите ПК или ESC для выхода из режима размещения меток.  

7.Укажите File>Save [F,S] для сохранения вашей схемы. Сохраните также проект. 
    
Этим заканчивается процесс создания схемы, т.о. полностью была введена схема с 

помощью Altium Designer. Перед тем, как перейти от схемы к печатной плате, необходимо 
установите опции проекта. 

Установка опций проекта   
Опции проекта содержат следующие вкладки: Error Reporting (параметры ошибок 

проекта), Connection Matrix (матрицу связности), Class Generation (генератор классов), 
Comparator (настройки компаратора), ECO Generation (настройки генератора ЕСО), Options 
(опции списка связей и хранения выходных файлов), Multi-Channel (настройка форматов 
обозначения многоканальных компонентов), Default Prints (установки по умолчанию для 
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печати), Search Paths (настройка пути поиска) и Parameters (Дополнительные параметры 
проекта). Altium Designer использует эти установки при компиляции проекта. 

После компиляции проекта, законченный проект и электрические правила 
применяются для его верификации. После устранения ошибок, повторно компилированный 
схемный проект загружается в документ назначения, например, в плату, с помощью 
генератора ЕСО. Проектный компаратор позволяет обнаружить различия между исходными 
и целевыми файлами и произвести обновления в обоих направлениях (синхронизацию). 

Все касающиеся проекта операции, такие как выявление ошибок, сравнение 
документов и генерация ЕСО устанавливаются в диалоге Option for Projects (Project> 
Project Option). 

Выходные данные проекта, необходимые для сборки и изготовления, а также отчёты 
можно установить из меню опций File. Также можно установить опции рабочих файлов на 
вкладке Job Option (File>New> Output Job File). 

1.Укажите Project>Project Option. Появится диалог Option for Project. 

 
2.Установите касающиеся проекта опции в этом диалоге. Теперь можно сделать 

некоторые изменения в отчёте об ошибках, матрице соединений и вкладке компаратора. 

Контроль электрических параметров схемы 
Схема в Altium Designer – это более чем простой чертёж – она содержит информацию 

об электрической связности на схеме. Можно использовать информацию о связности для 
верификации проекта. При компиляции проекта, Altium Designer проверяет нарушения 
установленных правил на вкладках Error Reporting и Connection Matrix и все 
зафиксированные ошибки будут представлены на панели Messages. 

Настройки отчёта об ошибках 
Вкладка Error Reporting в диалоге Option for Project используется для установки 

правил выполнения схемы. Режим отчёта имеет уровни строгости контроля ошибок. Если 
необходимо изменить режим отчёта, нажмите на Report Mode рядом с нарушением, которое 
нужно изменить и укажите уровень строгости из выпадающего списка. В данном примере 
используются установки по умолчанию. 
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Установка матрицы связности 
Вкладка Connection Matrix (в диалоге Options for Project) отображает строгость типов 

ошибок, которые производятся при контроле электрических соединений в проекте, 
например, соединений между выводами, портами и межлистовыми соединителями. 
Матрица даёт графическое представление различных типов точек подключения на схеме и 
представляет их допустимость. 

Например, просмотрите надписи в правой стороне диаграммы матрицы и найдите 
Output Pin. Просмотрите этот ряд до пересечения с колонкой Open Collector Pin. Место их 
пересечения помечено оранжевым квадратиком, что говорит о том, что Output Pin 
(выходной вывод) соединённый с Open Collector Pin (с открытым коллектором) на схеме, 
будет генерировать условие ошибки при компиляции проекта. 

Можно установить каждый тип соединения с выбранным уровнем ошибки, например, 
не выводить в отчёт все фатальные ошибки. Нажмите ПК для просмотра опций меню для 
контроля всей матрицы. 

Для введения изменений в матрицу 
связности: 

1. В диалоге Option for Project  
нажмите на вкладке Connection Matrix. 

2.  Нажмите бокс, который 
является пересечением двух типов 
соединений, например, Output Sheet 
Entry и Open Collector Pin. 

3. Нажимайте ЛК до тех пор, пока 
бокс изменяет цвет ошибки, как это 
перечислено в легенде, например, 
оранжевый бокс указывает, что если 
такое соединение обнаружится, то будет 
формироваться ошибка.  

Данная схема содержит только 
пассивные выводы (у резисторов, 
конденсаторов и соединителей) и 
входные выводы (у транзисторов). 
Давайте  проверим, что будет, если 
матрица соединений обнаружит  
неподключённые пассивные выводы. 

1. Просмотрим метки находящиеся 
на строке Passiv Pin. Просмотрим 
поперечные метки колонок 
пересекающие Unconnected. Квадратик, 
где пересекаются эти записи, указывают условия ошибки, когда пассивный вывод 
обнаружен неподключённым в схеме. Цвет квадратика по умолчанию зелёный, который 
указывает, что отчёт не будет генерироваться. 

2.Прощёлкаем этот бокс пересечения до тех пор, пока он не станет жёлтым, а это 
будет генерировать предупреждение для неподключённых пассивных выводов, при 
компиляции проекта. Преднамеренно создадим пример этой ошибки для её проверки позже 
в этой главе. 

Установки компаратора 
Вкладка Comparator в диалоге Options for Project устанавливает, какие различия 

между файлами будут фиксироваться или игнорироваться при компиляции проекта. В этой 
главе, нет необходимости показывать различия между некоторыми свойствами, которые 
ссылаются только на иерархический схемный проект, такие как комнаты. Убедитесь, что не 
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случайно игнорируются компоненты, когда вы намеревались игнорировать классы 
компонентов. 

1.Нажмите вкладку Comparator и найдите Changed Room Definition, Extra Room 
Definition и Extra Component Classes в секции Differences Associated with Components. 

2.Укажите Ignore Differences из выпадающего списка в колонке Mode правее этих 
опций. 

 
После описанных настроек можно переходить к компиляции проекта и контролю 

ошибок. 

Компиляция проекта 
Компиляция проекта выполняет контроль соединений и обнаруживает ошибки 

выполнения электрических правил, после чего запускает отладочную среду. Мы уже имеем 
установленные (по умолчанеию) правила на вкладках Error Checking и Connection Matrix  в 
диалоге Option for Project.  

1.Для компиляции проекта мультивибратора, укажите Project>Compile PCB Project. 
2.Когда проект прошёл компиляцию, все обнаруженные ошибки будут отображены в 

панели Messages. Откройте эту панель для исправления ошибок (View>Workspace Panels> 
System>Messages). Компилированные документы будут перечислены на панели Navigator, 
совместно с иерархией, компонентами и цепями и моделью связей, которую можно 
просмотреть. 

3.Если схема выполнена корректно, то панель сообщений не будет содержать каких-
либо ошибок. Если же отчёт содержит ошибки, проверьте схему и добейтесь корректности 
всех проводников и соединений. Теперь умышленно введём ошибку в нашу схему и 
повторно компилируем проект: 

1.Нажмите вкладку Multivibrator.SchDoc в верхней части окна проекта для активации 
листа схемы. 

2.Нажмите в середине провода, который соединяет R1 с базой Q1. Появится маленькая 
квадратная ручка редактирования на каждом конце провода и отобразится в цвете выбора 
как точечная линия вдоль проводника, как признак его выбора. Нажмите клавишу DELETE 
для удаления проводника. 

3.Повторно откомпилируйте проект (Project>Compile PCB Project) для проверки 
наличия, каких либо ошибок.  Панель Messages будет отображать предупреждающие 
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сообщения, показывающие, что имеется неподключённый вывод на вашей схеме. Если же 
панель сообщений не отображается, укажите View>Workspace Panels>System >Messages.   

4. Дважды нажмите ЛК на панели сообщений или на ошибке, после чего появится 
окно Compile Error с детальной информацией о нарушениях. В этом окне вы можете нажать 
ЛК на ошибке и перескочить на объект с нарушением в схеме, для просмотра сути ошибки. 

Перед завершением этого раздела руководства, исправьте ошибку в схеме. 
1. Нажмите на вкладке листа схемы для его активации. 
2. Укажите Edit>Undo в меню [Ctrl+Z]. Предварительно удалённый проводник будет 

восстановлен. 
3. Для проверки успешности восстановления, повторно прокомпилируйте  проект 

(Project>Compile PCB Project), для проверки отсутствия ошибки. Панель Messages не 
должна показывать ошибку.  

4.Укажите View>Fit All Objects [V,F] из меню для восстановления вида схемы и 
сохраните безошибочный вариант схемы. 

5. Сохраните схему и также файл проекта. 
 
Теперь завершена и проверена схема, поэтому можно создавать плату. 

Создание новой платы 
 Перед тем, как передать проект из редактора схем в редактор плат, необходимо 

создать бланк платы с контуром платы (как минимум).  Самый простой путь для этого – 
использовать помощник создания бланка платы (PCB Board 
Wizard), который позволяет выбрать стандартный 
промышленный типоразмер платы или же создать свой 
собственный типоразмер платы. На любом этапе можно 
использовать кнопку Back (назад) для контроля или 
изменений предыдущего шага в помощнике. 

Для создания новой платы с помощью помощника, 
выполните следующие шаги: 

1.Создайте новую плату щелчком на PCB Board Wizard 
в секции New from Template в нижней части панели Files. 
Если эти опции не отображаются на экране, закройте 
несколько секций выше, щёлкая на иконке стрелок. 

2.Откроется PCB Board Wizard. Первым видимым 
экраном будет страница предисловия. Нажмите кнопку Next 
для продолжения. 

3. Установите единицы измерения в Imperial,  

 

т.е. 1000 mils = одному дюйму. 
4. Третья страница мастера 

позволяет выбрать контур платы. В 
этом руководстве мы введём свой 
собственный размер платы. Укажите 
Custom из списка контуров платы и 
нажмите Next.  

5. На следующей странице 
вводятся опции пользовательской 
платы. Для схемы этого 
руководства, будет создана плата 
размером 2 на 2 дюйма. Укажите 
Rectangular  и введите 2000 в поля 
Width и Heigth. Отмените Title 
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Block & Scale, Legend String и Dimension Lines. Нажмите Next для продолжения. 
6. Эта страница позволяет выбрать число слоёв для платы. Нам необходимы два 

сигнальных слоя без экранного слоя. Нажмите Next для продолжения. 
7. Выберите стили Переходных Отверстий (ПО) для использования в проекте с 

помощью Thruhole Vias и нажмите Next. 
8. Следующая страница позволяет установить опции технологии трассировки. 

Укажите опцию Through-hole component и установите число трасс между смежными 
Контактными Площадками (КП) в виде One Track (одна трасса). Нажмите Next. 

9.Следующая страница, Default Track and Via Size позволяет установить несколько 
правил проектирования, применимые к плате. Оставьте опции на этой странице в значениях 
по умолчанию. Для продолжения нажмите кнопку Next. 

10. Нажмите Finish для закрытия Wizard. Помощник создания плат теперь имеет всю 
информацию для создания новой платы. Панель Project редактора плат отобразит новое имя 
файла платы – PCB1.PcbDoc. 

 
11. Документ платы представляется в виде белого листа с размером по умолчанию и 

образом бланка платы (чёрная зона). Для его отключения укажите Design>Board Option и 
отмените Display Sheet в диалоге Board Options.   

Можно добавить свою собственную границу, сетку и заголовок из других шаблонов 
плат, которые прилагаются к Altium Designer. 

Для большей информации об использовании формы платы и шаблонов, см. 
оригинальное руководство Preparing the Board for Design Transfer. Для доступа к библиотеке 
документов Altium Designer и получения справочной информации нажмите F1. 

12. Теперь лист отключён, отобразите только вид платы выбором View>Fit Board 
[V,F]  
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13. Документы плат автоматически добавляются  к активному проекту и 
перечисляются в списке Source Documents ниже имени проекта на вкладке Projects.  
Переименуйте файл платы (с расширением .PcbDoc) с помощью File>Save As. Определите 
место, где необходимо поместить плату на жёстком диске, введите имя Multivibrator в поле 
File Name и нажмите Save. 

Добавление новой платы в проект 
Если плата, которую необходимо добавить в файл проекта была открыта как Free 

Document, нажмите ПК на файле проекта платы на панели Project и укажите Add Existing to 
Project. Укажите имя новой платы и нажмите Open. Плата теперь в списке Source Document 
ниже проекта на панели Project и привязана к проекту. Сохраните файл проекта. 

Передача проекта 
При передаче информации о схеме в новый бланк платы, убедитесь, что подключены и 

доступны все библиотеки, относящиеся  к схемам и плате.  Как  только будут установлены 
интегрированные библиотеки, посадочные места, использованные в этом руководстве по 
умолчанию, будут включены. После компиляции проекта и отображения ошибок в схеме, 
используйте команду Update PCB для генерации списка ЕСО, который передаст схемную 
информацию в плату. 

Обновление платы 
Для передачи схемной информации проекта в плату, выполните следующие действия: 
1. Откройте схему Multivibrator.SchDoc. 
2. Выполните Design>Update PCB Document (Multivibrator.SchDoc). Проект 

компилируется и появляется диалог Engineering Change Order. 

 
3. Нажмите Validate Changes.  Если все изменения допустимы, в столбце Status>Check 

появляется галочка. Если изменения недопустимы, закройте диалог, проверьте панель 
Message и устраните имеющиеся ошибки. 

4. Нажмите Execute Changes для передачи изменений в плату. По завершении данной 
операции, в столбце Status появляется галочка в разделе Done. 

5. Нажмите Close и проектируемая плата откроется с компонентами, готовыми для 
размещёния. Используйте горячие клавиши V, D (View Document), если в текущем обзоре 
не видны все компоненты имеющиеся на схеме. 

С помощью кнопки Report Dangles можно создать отчет ЕСО для распечатки. 
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Рис. 4. Компоненты рядом с платой, готовые для размещения. 

 

Проектирование плат 
Теперь можно начать размещение компонентов и трассировку платы. 

Настройка рабочей области редактора плат  
Перед началом размещения компонентов на плате необходимо установить настройки 

рабочей области редактора, в том числе сетки, слои и правила проектирования. 

Сетки 
Необходимо убедиться, что перед началом размещения компонентов корректно 

установлена сетка размещения. Все объекты, размещаемые на рабочей области платы, 
выравниваются по сетке, называемой Snap Grid. Эта сетка необходима для установки 
подходящей технологии трассировки платы. 

В данном руководство при создании схемы используются стандартные  компоненты (в 
английских единицах измерения), которые имеют минимальное значение в 100 мил. Мы 
установим дискретную сетку, как часть этого значения, скажем 50 или 25 мил, так что все 
КП компонентов будут размещены кратно этой сетки, т.е. попадать на точку сетки при 
размещении. Также и ширина трасс и зазоры на нашей плате имеют соответственно 12 и 13 
мил (эти значения используются по умолчанию в Мастере создания плат, позволяя иметь 
минимум 25 мил между параллельными сегментами трасс). Следовательно, наилучшее 
значение дискретной сетки (Snap Grid) должно быть 25 мил. 

Для установки дискретной сетки выполните следующие шаги: 
1. Укажите Design >> Board Option [D,O]  для открытия диалога Board Option. 
2. Установите значение Snap Grid и Component grid в 25 мил, используя 

выпадающий список или введя его значение. Отметим, что этот диалог используется также 
для задания сетки Electrical Grid. Эта сетка задаётся для размещения электрических 
объектов; она перекрывает сетку Snap Grid  и служит для захвата электрических объектов. 
Нажмите ОК для закрытия диалога. 

Так же, установим некоторые другие опции для облегчения размещения компонентов. 
1.Укажите Tools>Preferences [T,P] для открытия диалога Preferences. Нажмите PCB – 

General  в диалоговом дереве выбора (в левой части панели) для отображения страницы 
PCB – General.  Убедитесь, что отключена опция Snap to Center, на этой странице в секции 
Editing Option. Этим обеспечивается установка элемента в узел сетки своей базовой 
точкой. 
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2.  Нажмите PCB – Board Insight Display в дереве выбора Preference для активации 

страницы. В секторе Pad and Via Display Options этой страницы,  пометьте опции Pad 
Nets, Pad Numbers, Via Nets.  

3. В секторе Draft Thershold на странице Display, проверьте, что в поле String 
введено значение 4 и нажмите ОК для закрытия диалога Preferences. 

Настройки отображения слоёв и цветов экрана 
В нижней части рабочей области редактора плат расположен ряд вкладок слоёв. 

Редактор плат является многослойной средой, и большинство действий по редактированию 
выполняется на определённом слое. Укажите Design>Board Layers & Colors [L] для 
отображения диалога Board Layers & Colors, где можно добавлять, удалять и 
переименовывать, а также устанавливать цвета для слоёв. 

 
В редакторе плат имеется три типа слоёв: 
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• Электрические слои (Signal и Internal Layer ) – здесь предусмотрено 32 
сигнальных слоя и 16 экранных слоя. Электрические слои вводятся и удаляются из проекта 
в менеджере стека слоя, указывая Design >> Layer Stack Manager  для отображения этого 
диалога. 

• Механические слои – имеется 16 механических слоёв для задания контура платы, 
образмеривания размещения, включая любые механические детали, необходимые в проекте 
(радиаторы, крепеж). Эти слои могут быть выборочно включены для печати и генерации 
вывода в формате Gerber. Также можно добавлять, удалять и переименовать механические 
слои в диалоге Board Layer & Colors. 

• Специальные слои – сюда входят верхние и нижние экраны шелкографии, слои 
масок пайки и масок защитного покрытия, слои сверления, слои запретных зон 
(используемых для задания электрических границ), многослойности (используемых для 
многослойных КП и ПО), соединительных слоёв, слоёв индикации ошибок DRC, слои сеток 
и слои отверстий. Отображение этих специальных слоёв контролируется в диалоге Board 
Layer & Colors. 

 

Определение стека слоёв 
Руководство содержит простой проект и может быть выполнен на однослойной или 

двухслойной плате. Если проект более сложный, вы можете добавить слои в менеджере 
стека слоёв.  

1.Укажите Design>Layer Stack Manager [D,K] для отображения диалога Layer Stack 
Manager. 

 
2.Новые слои, и экраны добавляются ниже текущего выбранного слоя. Свойства слоя, 

такие как толщина и диэлектрические свойства используются для анализа целостности 
сигнала. Нажмите ОК  для закрытия диалога. 

Новая плата открывается со слоями, доступными для использования, поэтому можно 
отключать ненужные слои. Для этого выполните такие шаги: 

1.Нажмите клавишу L для отображения диалога Board layers & Colors. 
2.Нажмите Used On для отключения всех слоёв, кроме тех, которые имеют что-либо 

на них. 
3.Убедитесь, что слои Mask и слой Drill Drawing не отображаются, проверив, их 

галочки на кнопке Show, рядом с именем слоя. Нажмите OK  для закрытия диалога. 

Установка новых правил проектирования 
Редактор плат является средой с постоянным контролем установленных правил. Это 

означает, что во время работы с редактором плат и выполнения действий, меняющих 
проект, такие как ввод трасс, перемещение компонентов, или автоматическую трассировку, 
редактор проводит постоянный мониторинг каждого действия и контролирует нарушения  
установленных правил проектирования. При обнаружении нарушений ошибка немедленно 
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подсвечивается. Установка правил перед началом работы позволяет сосредоточиться на 
задачах проектирования, зная, что любые ошибки проекта будут замечены системой. 

Правила проектирования разделены на категории и далее разделены на типы. Эти 
правила затрагивают электрические, производственные требования и требования к 
размещению, трассировке и целостности сигналов. 

Для рассматриваемого примера необходимо установить новые правила 
проектирования для ограничения ширины прокладываемых трасс. Для этого, выполните 
следующие шаги: 

1. Так как плата является активным документом, выполните Design>Rules. 
2. Появится диалог PCB Rules and Constraints Editor. Каждая категория правил 

отображается на панели Design Rules (слева). Дважды нажмите на категории Routing для 
пополнения категорий и просмотра правил, касающихся трассировки. Затем дважды 
нажмите на Width для отображения доступных правил ширины. 

 
3. Нажмите один раз на правиле в панели Design Rules для его выбора. При этом в 

правой части диалога отображается обзор правил в верхней секции и ограничения в нижней 
секции. Эти правила могли быть приняты по умолчанию, либо установлены с помощью 
Board Wizard, когда  был создан новый документ платы. 

4. Нажмите правило ширины (Width) для отображения его пределов и ограничений. 
Это правило касается всей платы (Область действия правила = All). 
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Одним из мощных свойств системы установки правил проектирования в Altium 
Designer является то, что несколько однотипных правил может быть установлено для 
объектов разного типа. Точный набор объектов, на которые нацелено каждое правило, 
определяется областью действия правила (scope). Такие правила система использует в 
определённой иерархии для работы с учётом применения правила к каждому объекту. 

Например, можно иметь одно правило ограничения ширины для всей платы (означает, 
что трассы должны быть указанной ширины), а второе правило ограничения ширины для  
цепей питания (это правило перекрывает предыдущее правило) и третье правило, вводящее 
ограничение на определённое соединение с цепью земли (которое перекрывает оба 
предыдущих правила). Правила выполняются с учётом приоритета. 

В нашем случае имеем одно такое правило для всего проекта, затрагивающее всю 
плату (ширина = 12 мил). Теперь добавим новые правила для ширины цепей VCC  и GND 
(ширина = 25 мил). Для добавления этих ограничений, выполните следующие шаги: 

1. В категории Width, выбранной на панели Design Rule, нажмите ПК и укажите New 
Rules для добавления нового правила ширины только для цепи VCC. В списке правил 
появится новое правило с именем Width1. Выберите новое правило на панели Design Rules 
для изменения области действия правила и установки ограничения. 

2. Введите в поле Name название правила VCC или GND. Это имя повторится на 
панели Design Rules при завершении установки правила. 

3. Теперь установим область действия правила с помощью Query Builder, хотя это 
значение можно ввести непосредственно в окно Full Query, если применить правильный 
синтаксис. При более сложном запросе, нажмите кнопку Advanced и используйте Query 
Helper (помощник запросов). 

4.В данном случае запрос простой, поэтому после выбора Advanced нажмите кнопку 
Query Boulder для открытия диалога Building Query from Board. 

 
5. Нажмите  Add first condition и выберите Belongs to Net из выпадающего списка. В 

поле Condition Value раскройте выпадающий список и выберите цепь VCC. В окне Query 
Preview теперь появилась запись InNet (‘VCC’). 

6. Нажмите на Add another condition в расширенной рамке для добавления еще одной 
цепи. Укажите Belongs to Net и в выпадающем списке выберите GND. 

7. Измените текст правила нажатием на операторе ‘AND’ и затем выберите OR из 
выпадающего списка. Проверьте предварительный вид запроса: InNet (‘VCC) OR InNet 
(‘GND’). 

8. Нажмите ОК  для закрытия диалога Building Query from Board. Область действия 
правила в окне Full Query обновлена по новому запросу. 

9. В нижней секции окна PCB Rules and Constraints Editor измените поля Minimum, 
Preferred и Maximum на 25 мил нажатием ЛК на старом тексте ограничений (10 мил) и 
введите новые значения. Теперь новое правило установлено и будет сохранено при 
изменении другого правила на панели Design Rules или закрытии диалога. 
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10. Наконец, нажмите для редактирования основного правила с именем Width и 

убедитесь, что все поля минимума, максимума и рекомендуемого значения установлены в 
12 мил. Нажмите Close для закрытия диалога  PCB Rules and Constraints Editor. 

При ручной трассировке или при использовании автотрассировщика, все проводники 
будут иметь ширину 12 мил, за исключением цепей GND и 12V с шириной 25 мил. 

Размещение компонентов на плате 
Теперь можно размещать компоненты в определенные участки платы. 
1. Нажмите горячие клавиши V, D для масштабирования платы и компонентов. 
2. Для размещения соединителя Y1, поместите курсор на середине контура 

соединителя и нажмите ЛК. Курсор изменит вид на перекрестье и перепрыгнет в базовую 
точку этого элемента. Удерживая ЛК перемещайте мышку для транспортировки 
компонента. 

3. Поместите посадочное место в левой стороне платы (при этом следите, чтобы весь 
компонент находился в границе платы), как показано на рисунке 5. 
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Рис. 5. Компоненты, размещённые на плате 
Линии связи автоматически оптимизируются  при перемещении компонента. В этом 

случае можно использовать линии связи как руководство для оптимизации позиции и 
ориентации компонентов при их размещении. 

 
4. Когда компонент установлен на место, отпустите ЛК для его фиксации. Заметим, 

что линии связи перемещаются вместе с компонентом. 
5. Разместите остальные компоненты, используя размещение, показанное на рисунке 

5. При необходимости поворота компонента при его транспортировке, используйте 
клавишу пробела для получения линий связи, как на рисунке 5. Не забывайте о постоянной 
оптимизации линий связи при перемещении и развороте каждого компонента. 

 Надписи компонентов (позиционные обозначения, номинал, номера выводов) 
перемещаются раздельно – захватите текст для перемещения и нажмите клавишу пробела 
для его поворота. 

Altium Designer содержит мощный инструментарий для интерактивного размещения. 
Для примера рассмотрим команды размещения и выравнивания 4-х резисторов. 

1. Нажмите и удерживайте клавишу SHIFT, нажмите ЛК на каждом из этих 
резисторов для их выбора, или нажмите и перемещайте рамку выделения вокруг них. Серая 
рамка выделения будет отображаться вокруг каждого из выбранных компонентов в 
установленном цвете выделения. Для изменения цвета выделения, выполните 
Design>Board Layers & Colors [L] и поменяйте цвет Selection в списке System Colors. 

2. Нажмите ПК и укажите Align>Align. В диалоге Align Objects нажмите на Space 
Equally в рамке Horizontal  и нажмите Top в рамке Vertical. Теперь 4 резистора выровнены 
по вертикали и расставлены с равными промежутками по горизонтали. 

3. Нажмите ЛК в любом месте рабочей области для отмены выравнивания всех 
резисторов. 

 

Изменение посадочного места 
Теперь, после размещения компонентов, посадочные места конденсаторов выглядят 

слишком большими для данной платы. Необходимо заменить посадочное место 
конденсатора на меньшее по размеру. 

1. Во-первых, просмотрим новое посадочное место. Нажмите на панели Libraries и 
укажите в списке библиотек MiscelleniousDevices.IntLib.  Необходимо уменьшить 
радиальный тип посадочного места, поэтому напечатайте rad в поле Filter. Нажмите на 
кнопке «…» рядом с именем библиотеки и укажите Footprint для отображения посадочных 
мест, доступных в активной библиотеке.  Посадочное место RAD-0.1  будет подходящим. 

2. Дважды нажмите на конденсаторах и замените поле Footprint на RAD-0.1 в диалоге 
Component. Можно просто напечатать новое имя посадочного места или нажать кнопку 
«…» и выбрать посадочное место в диалоге Browse Libraries. Нажмите ОК  и новые 
посадочные места появятся на плате. Измените положение обозначений при 
необходимости. 

3. Плата должна теперь выглядеть так, как это показано на рисунке 6. 
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Рис. 6. Компоненты, размещённые на плате с новыми посадочными местами. 

Ручная трассировка платы 
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Трассировка является процессом прокладки трасс 
и введения ПО на плате для соединения компонентов. 
Altium Designer облегчает работу по трассировке, 
предоставляя обширный инструментарий трассировки, 
в том числе новый мощный топологический 
автотрассировщик Situs, который оптимально 
трассирует всю или часть платы одним касанием 
кнопки. 

Хотя автотрассировщик предоставляет лёгкий и 
мощный способ разводки трасс на плате, иногда 
возникают ситуации, когда необходим точный 
контроль над размещением трасс – или же 
необходимость трассировать плату вручную. В таком 
случае можно вручную оттрассировать всю или часть 
платы. В этом разделе руководства вся плата будет 
разведена вручную на одном слое, с размещением трасс 
на слое Bottom. 

 
Будем теперь размещать трассы на нижем слое 

платы, используя разветвленные линий связи. Трассы 
на плате выполняются из прямолинейных сегментов. 
Каждый раз при изменении направления начинается 
новый сегмент. Кроме того, Altium Designer создаёт 
трассы в вертикальном, горизонтальном или наклонном 
(под 45 градусов) направлении, позволяя получать 
профессиональный результат.  

1. Активируйте и просмотрите слой Bottom 
нажатием клавиши L для отображения диалога Board 
Layers & Color. Нажмите флажок Show рядом c Bottom 
Layer в секции Signal Layer. Нажмите ОК  и вкладка 
Bottom Layer отобразится в окне проекта. 

2. Укажите Place>Interactive Routing в меню 
[P,T]  или нажмите кнопку Interactive Routing. Курсор 

 



 

примет вид перекрестья, указывая режим интерактивной трассировки. 
3. Проверьте выбранную вкладку слоя, которая находится внизу рабочей области. 

Вкладка Top Layer должна быть текущей и активной. Для переключения на слой Bottom, 
без выхода из режима размещения трасс, нажмите клавишу * на цифровой клавиатуре. Эта 
клавиша переключает все доступные сигнальные слои. Эта же команда доступна при 
выполнении комбинации клавиш Ctrl+Shift+Scroll, только при этом перебираются все 
доступные слои, а не только сигнальные. Теперь должна быть активной вкладка Bottom 
Layer. 

4. Поместите курсор поверх самой большой КП на слое Bottom, со связью Р1. 
Нажмите ЛК или нажмите Enter для закрепления первой точки трассы. 

5. Переместите курсор на КП на слое Bottom резистора R2. Отметим, что трасса 
появилась. По умолчанию, трасса ограничена направлениями по горизонтали, вертикали 
или под углом 45 градусов. Также отметим, что трасса имеет два сегмента. Первый 
(начинающийся от стартовой КП) является сплошным голубым. Это сегмент трассы, 
который уже был зафиксирован. Второй сегмент (подключённый к курсору) называется  
“предполагаемым сегментом” и рисуется в виде контура. Этот сегмент показывает, где 
будет проложен следующий сегмент трассы, так что можно легко проработать путь обхода 
препятствия, используя допустимые ориентации. 

6. Расположите курсор в центре КП на нижнем слое у резистора R2 и нажмите ЛК или 
нажмите клавишу Enter. Отметим, что первый сегмент трассы голубой, указывающий, что 
он расположен на нижнем слое. Незначительно переместим курсор и заметим, что всё ещё 
имеется два сегмента, подключённые к курсору: сегмент голубого цвета, который будет 
размещён при следующем нажатии ЛК и контурный предполагаемый сегмент, для помощи 
в прокладке трассы. 

7. Переместите курсор на КП нижнего слоя R2. Вы получите сплошной голубой 
сегмент, проходящий от предыдущего сегмента к КП. Нажмите ЛК  для прокладки 
сплошного голубого сегмента.  Вы закончили трассировку первого соединения. 

8. Переместите курсор на КП резистора R3. Отметим, сплошной голубой сегмент 
сразу будет проложен к R3. Для фиксации сегмента нажмите ЛК. 

 
Вы можете обнаружить удобство использования большого перекрестья при прокладке 

трасс. Для изменения его размера, укажите Tools>Preferences. Выберите Large 90 из 
списка типов курсора на странице General в диалоге Preferences. 

 
9. Теперь поместите курсор на нижнюю КП резистора R4. Отметим, что сегмент не 

сплошной голубой, а показан контуром, как предполагаемый сегмент. Это потому, что 
каждый раз, при прокладывании сегмента трассы, режим переключается между началом 
ортогональных направлений и началом под 45 градусов. Текущий режим – это 45 градусов. 
Нажмите клавишу пробела для переключения в ортогональный режим. Теперь сегмент 
будет выводиться сплошным голубым. Нажмите ЛК или клавишу Enter для фиксации 
сегмента. 

10. Поместите курсор на резистор R1.  Теперь снова необходимо нажать пробел 
для переключения режима начала сегмента. Нажмите ЛК или клавишу Enter для фиксации 
сегмента. 

11. Завершим трассировку первой цепи. Нажмите ПК или клавишу ESC 
завершения размещения этой трассы. Курсор сохранит вид перекрестья, указывая, что он 
находится в режиме размещения и готов проложить следующую трассу. Нажмите клавишу 
END для перерисовки экрана и чтобы ясно увидеть результаты трассировки платы. 

12. Теперь можно трассировать  остальные проводники таким же образом. Рис. 7 
показывает плату, растрассированную вручную. 
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Рис. 7. Полностью растрассированная плата 

  
13. Сохраните проект [клавишами  F,S или Ctrl+S]. 

Указания для трассировки 
Во время интерактивной трассировки действуют следующие команды и комбинации 

горячих клавиш: 
• Нажатие ЛК (или Enter) окончательно вводит сегмент трассы. Контурный сегмент 

трассы  представляет предполагаемую структуру трассы. Размещённый сегмент трассы 
представляется в цвете слоя. 

• SPACEBAR - переключение между режимами ввода трасс по направлениям – 
ортогонально или под углом 45 градусов. 

• END - перерисовка экрана в любой момент работы с редактором плат. 
• V,F (View>Fit Board)  - перерисовка экрана и отображение всех объектов. 
• PAGEUP и PAGEDOWN - увеличение и уменьшение экрана с центрированием 

вокруг позиции курсора. Используйте колёсико мышки для панорамирования вверх и вниз, 
а с зажатой клавишей Shift - влево или вправо. Удерживайте клавишу Ctrl для 
масштабирования изображения с помощью колёсика мышки. 

• BAKCSPACE - отмена последнего сегмента трассы. 
• Нажмите ПК (или ESC) - завершение ввода трассы и для начала ввода новой. 
• Не возможно случайно соединить трассой КП, которые не имеют связности. Altium 

Designer постоянно анализирует связность платы и препятствует созданию неверных 
трассы или их пересечению. 

• Для удаления сегмента трассы нажмите ЛК на ней для выбора. Будет выделен 
сегмент, редактируемый вручную (остаток трассы будет подсвечен). Нажмите клавишу 
DELETE для удаления выбранного сегмента трассы. 

• Перетрассировка – просто введите новый сегмент трассы, и  после нажатия ЛК для 
завершения, старые сегменты трассы  будут удалены автоматически. 

• При завершении трассировки всех связей на плате, нажмите ПК (или ESC) для 
выхода из режима размещения трасс. Курсор примет вид стрелки. 

 164



 

Автоматическая трассировка платы 
 

Чтобы убедиться в простоте выполнения данной операции, выполните следующие 
действия: 

1.Во-первых, отмените ручную трассировку выполнением команды Tools>Un-Route> 
>All [U,A]. 

2.Выполните Auto Route>All. Появится диалог Situs Routing Strategies. Нажмите на  
Route All. На панели сообщений отобразится процесс автотрассировки. Трассировщик Situs  
позволяет получить результаты, сравнимые с работой опытного конструктора и, поэтому, 
он трассирует плату непосредственно в окне редактора РСВ, при этом нет необходимости 
предпринимать какие либо дополнительные усилия по экспорту или импорту файлов. 

3.Укажите File>Save [F,S] для сохранения результата. 
 
Отметим, что трассы, формируемые автотрассировщиком, выводятся в двух цветах: 

красном, что значит трасса на сигнальном слое Top и голубом – на слое Bottom. 
Используемые для трассировки слои указываются в правиле Routing Layers, которое 
установлено помощником (Wizard). Также можно заметить, что две цепи GND и VCC 
являются более широкими, так как они были установлены ранее. 

Не волнуйтесь, если трассировка в вашем проекте не точно соответствует рисунку 8. 
Если размещение компонентов несколько отличается, то и трассировка будет отличаться. 

  
Рис. 8. Автоматически растрассированная плата 

 
Так как с самого начала плата была определена как двухслойная в PCB Board Wizard, 

то и при ручной трассировке можно использовать верхний и нижний слои. Для этого, 
отмените проделанную трассировку платы по команде Tools>Un-Route>All [U,A]. Начните 
трассировку как ранее, и используйте клавишу «*» для переключения между слоями при 
прокладке трассы. Altium Designer будет автоматически вводить ПО, необходимые для 
перехода со слоя на слой. 

Верификация проекта платы 
Altium Designer обеспечивает гибкую среду для установки различных правил 

проектирования, что обеспечивает целостность проекта. Обычно, правила проектирования 
устанавливаются в начале работы, а затем проводится проверка соответствия проекта 
правилам при компиляции в конце процесса проектирования.  
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Ранее в руководстве были проверены правила для трассировки и добавлены новые 
правила для ширин трасс. Также отметили наличие ряда правил, установленных 
помощником (Board Wizard). 

Для проверки платы на предмет соответствия установленным правилам 
проектирования после трассировки, используется программа DRC (Design Rule Check - 
Контроль Правил Проектирования): 

1. Выберите Design>Board Layers and Colors [L] и убедитесь, что включена 
видимость (Show) рядом с опцией DRS Error Markers  в рамке System Colors, при этом 
будут подсвечены найденные ошибки. 

2. Укажите Tools>Design Rule Check из меню [T,D]. Как онлайновые, так и пакетные 
опции DRC настраиваются в диалоге Design Rule Checker. Нажмите на категории, 
например, Electrical, для просмотра правил этой категории. 

 
3. Оставьте все опции в значениях по умолчанию и нажмите кнопку Run Design Rule 

Check. Будет запущен DRC и открыт файл отчёта Multivibrator.DRC. Результат будет 
отображён в панели Messages. Перейдите к документу платы, и обратите внимание, что КП 
транзисторов подсвечены зелёным, указывая на обнаруженное нарушение правила. 

4. Просмотрите ошибку в панели Messages. Здесь представлен список всех 
обнаруженных в проекте нарушений. Отметим наличие четырёх нарушений в списке для 
правила Clearance Constraint. Описание показывает, что КП для транзисторов Q1 и Q2 
нарушили правило допустимых зазоров в 13 мил. 

5.Дважды нажмите ЛК  на ошибке в панели Messages для перехода к ней на плате. 
 
Обычно правила для зазоров устанавливаются до трассировки платы, с учетом 

технологии трассировки и физических свойств устройства. Давайте проанализируем 
ошибки, просмотрим текущие установленные правила и исправим эту ситуацию. 

Для нахождения реальных зазоров между КП транзисторов: 
1. Активируя плату, поместите курсор в центр транзистора и нажмите клавишу 

PAGEUP для увеличения. 
2. Укажите Reports>Measure Primitives [R,P]. Курсор примет вид перекрестья. 
3. Поместите курсор в центр левой КП транзистора и нажмите ЛК (или Enter). 

Поскольку курсор перекрывает как КП, так и подключённую трассу, выпадающее меню 
позволяет выбрать нужный объект. Выберите КП транзистора. 

4. Поместите курсор в центральную КП транзистора и нажмите ЛК (или Enter). 
Теперь выберите КП из выпадающего меню. В появившемся окне будет представлена 
информация, показывающая минимальное расстояние между краями КП, равное 10.63 мил. 
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5. Закройте информационное окно, затем нажмите ПК 
(или ESC) для выхода из режима измерения и затем 
используйте горячие клавиши [V,F] для масштабирования 
документа. 

Просмотрим теперь правила для зазоров. 
1. Укажите Design>Rules [D,R], для открытия диалога 

PCB Rules and Constraints Editor. Дважды нажмите ЛК на 
категории Electrical для отображения электрических правил в правой части диалога. 
Дважды нажмите ЛК на типе Clearance и затем выберите правило Clearance чтобы его 
открыть. Область внизу диалога будет  содержать единственное правило, указывающее, что 
зазор должен быть 13 мил. Зазор между КП транзисторов меньше, поэтому в отчёте и 
появилась ошибка. Теперь известно, что минимальной зазор между КП чуть больше 10 мил, 
поэтому установим правило только для КП транзисторов, равное 10 мил. 

2. Укажите тип Clearance в правой части панели, нажмите ПК и выберите New Rule 
для добавления нового правила для зазоров. 

3. Выберите новое правило Clearance_1. В рамке Constraints результирующей 
страницы установите Minimum Clearance в 10 мил. 

4. Нажмите Advanced (Query) и затем нажмите Query Helper для создания запроса из 
Membership Checks. Как вариант, просто введите следующий запрос в поле Query для 
первого объекта: 

HasFootprintPad (‘BCY-W3/E4’,’*’) 
Звёздочка (*) указывает любую КП на посадочном месте BCY-W3/E4. 
5. Сохраните состояние для второго объекта All и нажмите ОК. Нажмите Apply и 

затем ОК для закрытия диалога PCB Rules and Constraints Editor.  
6. После проделанных операций необходимо перезапустить DRC из диалога Design 

Rules Checker (Tools>Design Rule Check) нажатием кнопки Run Design Rule Check. Теперь 
не должно быть нарушений правил. 

7.Сохраните законченный проект и файлы проекта. 
 

Установка выходных документов проекта 
Выходные данные проекта, такие как распечатки и выходные файлы, устанавливаются 

в файлах Output Job, которые могут быть скопированы и вставлены в другие проекты и 
изменены по необходимости. С другой стороны, можно выбрать индивидуальные команды 
из меню File. 

1. Укажите File>New>Output Job File, выберите желаемый вывод для установки и 
дважды нажмите ЛК для редактирования установок этих файлов. Сделайте необходимые 
настройки и сохраните выходные рабочие файлы. 

2. Если необходимо выходные файлы сохранять в индивидуальные папки, в 
соответствии с типом выходного файла,  выполните Project>Project Option, нажмите на 
вкладке Option и включите Use separator folder for each output type и нажмите ОК. 

Распечатки 
После создания шаблона и завершения трассировки платы, необходимо вывести 

выходную документацию на печать. Эта документация может содержать производственные 
чертежи, содержащие данные для изготовления деталей плат и сборочные чертежи, 
определяющие размещение компонентов и порядок изготовления. 

Для изготовления этих чертежей Altium Designer включает инструментарий печати, 
который предоставляет полный контроль над этим процессом. Имеется возможность точно 
задать набор слоёв для вывода на печать, просмотреть чертежи и установить масштаб и 
ориентацию для предварительного просмотра, выводимого документа. 
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1. Укажите File>Print Preview из меню редактора плат. Редактор РСВ будет 
анализировать, и детализировать распечатку в окне предварительного просмотра. Нажмите 
Close. 

2. Укажите File>Print для передачи композиционного чертежа на принтер. 
3. Для изменения выбранного принтера и установки ориентации и масштаба страницы, 

необходимо выбрать File>Page Setup. Укажите принтер используемый по умолчанию и 
проверьте вид страницы, выводимой на печать. Из этого диалога также доступны 
расширенные опции печати. 

Производство выходных файлов 
Последней фазой процесса проектирования платы является генерация 

производственных файлов. В составе таких файлов предусматриваются Gerber-файлы, 
файлы для станков сверления (NC-Drill), файлы установки и распайки, файл спецификации 
и файлы контроля. Выходные производственные файлы могут быть установлены выбором 
File>New> >Output Job File или же эти файлы можно создать с помощью индивидуальных 
команд из меню File>Fabrication Output. Установки производственных документов 
сохраняются как  часть файла проекта. 

Генерация Gerber-файлов  
Каждый Gerber – файл соответствует одному слою физической платы – шаблону 

компонентов, сигнальному слою Top, сигнальному слою Bottom, слоям маски, пайки и т.д. 
Рекомендуется проконсультироваться с изготовителем плат для удовлетворения его 
требований перед генерацией Gerber-файлов  и файлов для станков сверления. 

Для создания производственных файлов платы, описанной в руководстве, выполним: 
1. Активируйте проект платы, после чего укажите File>Fabrication Outputs>Gerber 

Files. Появится диалог Gerber Setup. 

 
 

Если не нужно выводить файлы автоматически при их создании, укажите 
Project>Project Options, нажмите на вкладке Option и отключите опцию Open outputs 
after compile. 

2. Нажмите на вкладке Layers для выбора нужного слоя. Нажмите на Plot Layers и 
укажите Used On (все используемые). Нажмите ОК для установки других деталей по 
умолчанию. 

3. Формируются Gerber-файлы и открывается CAMtastic для отображения файлов. 
Файлы Gerber сохраняются в папке Project Outputs, которая создаётся автоматически в 
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папке, где размещены файлы проекта. Каждый файл имеет своё расширение, добавляемое к 
соответствующему имени файла, например, Multivibrator.GTO для слоя Top Overlay в 
формате Gerber. Все эти файлы добавляются в панели Project в папку Generated CAMtastic 
Documents. 

Формирования спецификации 
1. Для создания спецификации (Bill of Materials) нажмите ЛК на документе платы в 

панели PCB, Multivibrator.PcbDoc и выберите Reports>Bill of Materials. Откроется диалог 
Bill of Materials for PCB Document. 

 
2. Используйте этот диалог для формирования спецификации. Установите флажок 

Show рядом с колонкой, которую необходимо добавить отчёт. 
3. Укажите и перетащите заголовок колонки из All Column в Grouped  Column для 

группирования компонентов с этим заголовком в спецификации (BOM). Например, для 
группирования  колонки Footprint укажите Footprint в рамке All Columns и перетащите её в 
рамку Grouped Column. Список будет соответственно отсортирован. 

 
4. Нажмите ПК и выберите Report для отображения вида спецификации. Этот вид 

можно затем распечатать, используя кнопку Print или экспортировать в файловом формате, 
таком как .xls для Microsoft Excel, с помощью кнопки Export. После проделанных операций 
закройте диалог. 
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Заключение 
В этом руководстве представлены только некоторые мощные свойства Altium 

Designer. Были затронуты вопросы ввода схемы, проектирования и трассировки платы, но 
это только поверхностное описание возможностей системы. После начала эксплуатации 
Altium Designer, вы обнаружите массу свойств, которые делают работу проектировщика 
более лёгкой. Для демонстрации возможностей программного обеспечения был включён 
ряд примеров. Вы можете открыть эти примеры обычным образом с помощью File>Open и 
затем просмотреть папку \Program Files\Altium Designer 6\Examples.  В этой папке, наряду с 
примерами проектов плат можно обнаружить ряд вспомогательных подпапок с примерами 
уникальных свойств системы. 

Посмотрите содержимое папки Circuit Simulation для знакомства с возможностями 
аналогового и цифрового моделирования. Кроме примеров аналоговых устройств, которые 
демонстрируют различные проекты схем, таких как усилители и источник питания, 
имеются примеры смешанных схем, примеры математических функций и примеры, 
которые содержат линейно и нелинейно-зависимые источники и даже примеры ЭЛТ. 

C увеличение количества логических вентилей и частотных свойств схем, качество 
цифровых сигналов становится очень важным свойством. Altium Designer содержит 
усовершенствованные программы анализа целостности сигналов, которые позволяют 
выполнять анализ высококачественных плат.  Требования целостности сигналов, такие как 
полное сопротивление (импеданс), выбросы на фронтах, и петли задаются в установках для 
платы и затем проверяются при стандартном контроле выполнения правил. 

Если в проекте имеются цепи для более детального анализа, можно указать 
Tools>Signal Integrity для подключения к анализатору Signal Intergity, где можно 
проверить отражение (звон) сигнала и поперечные шумы в процессе моделирования. 
Результаты будут отображены в осциллографическом виде для представления формы 
сигнала, при этом можно получить все необходимые свойства в числовом виде. 
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Основы работы с библиотеками 

Концепции компонентов, моделей и библиотек 
 
Компоненты являются основными строительными блоками электронных изделий. При 

захвате проекта и реализации процесса каждый компонент нуждается в различных 
представлениях:  как логический символ на схеме (условное графическое обозначение – 
УГО), посадочное место на плате, описание в формате Space для моделирования, описание 
IBIS-модели для анализа целостности сигналов или трёхмерное описание для объёмного 
представления конечной платы. 

Для каждого компонента не обязательны все эти представления, но стартовой точкой 
является логический символ (УГО). Каждый компонент должен быть определён, как 
минимум, своим собственным именем в схемной библиотеке. Он может содержать выводы 
и графический символ в единственном или многосекционном виде, и даже иметь 
альтернативные опции отображения. Как таковой он может быть размещён в любом 
схемном проекте. Однако, до тех пор, пока в компонент не добавлены модели, его нельзя 
применить в любом практическом понимании. 

Определения 
Компонент:  общее наименование объекта, который может быть применён в проекте. 
Символ: общее наименование графического представления компонента, 

подготовленного для размещения на схеме. Символ может содержать графические объекты, 
которые, которые определяют внешний вид и выводы, которые определяют электрические 
точки подключения. 

Физический компонент: представляет компонент, который может быть смонтирован 
на плате. 

Логический символ: символика представления физического компонента, каким он 
должен выглядеть на схеме. 

Часть (секция): некоторые компоненты, такие как резисторные цепочки или реле, 
могут быть построены как серия отдельных секций (частей), которые, в свою очередь, 
могут быть размещены на схеме независимо (рассматриваются как многосекционный 
компонент). 

Модель:  представление компонента, который используется в некоторой 
практической сфере деятельности. 

Посадочное место: это наименование используется для модели, которая представляет 
компонент на заготовке печатной платы. Посадочное место группирует набор контактных 
площадок (КП) на плате  и  форму компонента (очертание корпуса), которое определяет 
часть платы, требуемую для монтажа и соединения физического компонента на плате. 

Библиотека:  файл, содержащий набор компонентов и набор моделей. 
Библиотека моделей: файл, содержащий набор моделей компонентов. 
Библиотека компонентов:  файл, содержащий набор схемных компонентов. 
Интегрированная библиотека: файл, содержащий набор схемных компонентов и их 

ассоциированные модели. 
Библиотека базы данных: библиотека компонентов,  где все символы имеют ссылки, 

модели связаны и параметрическая информация сохранена в базе данных на основе ODBC 
(open database connectivity – интерфейс связи с открытыми базами данных) или ADO 
(ActiveX Data Objects – набор компонентов ActiveX, используемых для доступа к БД, 
поддерживающим спецификацию OLE DB) или в виде широкоформатных таблиц Excel. 
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Основные понятия 
На схемной стадии, проект является набором компонентов, которые имеют 

логическую связность. Для тестирования или проведения проекта в жизнь, он нуждается в 
передаче в другую область проверки функционирования, такую как моделирование, 
формирование платы, анализ целостности сигналов и т.д. 

 
Рис. 1. Информация о разных вариантах представления компонента в файлах моделей. 

 
Каждый домен (область практической реализации компонента) требует некоторую 

информацию о компонентах, а также некоторые пути перераспределения этой информации 
касательно выводов символа. Некоторая часть из этой информации для домена размещается 
в файлах моделей, формат которых является обычно предопределённым. Например, модели 
IBIS, MDL (принцип минимальной длины описания) и CKT. Некоторая информация не 
содержится в файлах моделей, например, распределение выводов SPICE и данные списков 
цепей должны быть определены средствами системы. 

Отметим, что модели целостности сигналов IBIS и модели VRML (virtual reality 
modeling language –  язык моделирования виртуальной реальности) или IGES 3D 
(международный язык обмена графической информацией) должны быть импортированы в 
формат модели Altium Designer, перед тем, как их можно будет использовать. Модели IBIS 
импортируются непосредственно в диалоге Signal Integrity Model, который открывается при 
добавлении SI-модели в компонент. VRML и IGES модели должны быть импортированы в 
PCB3Dlib перед тем, как они могут быть добавлены в компонент схемы. 

Вся необходимая информация домена содержится внутри схемного компонента, 
который сохраняется с помощью отдельного интерфейса для каждой добавляемой модели. 
В сущности, комплектная модель является комбинацией распределённой информации 
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моделей, сохраняемой в компоненте, а информация о модели домена сохраняется в 
библиотеке моделей. 

 
Рис. 2. Связи в каждой модели и любое переопределение её, требует  

определения модели в соответствующем диалоге. 
 
Компоненты могут иметь модели для различных доменов, и могут также иметь 

несколько моделей доменов, одна из которых будет установлена как текущая модель. 

Типы библиотек 
В среде Altium Designer имеется 4 типа библиотек, которые могут быть использованы. 
Библиотеки моделей – модели для каждой области сохраняются в “хранилищах”, 

обычно называемых библиотеками моделей. В некоторых областях, таких как SPICE, где 
обычно одна модель хранится в одном файле, они также рассматриваются как отдельные 
файлы (*.MDL, *.CKT). В других областях, модели обычно группируются в библиотечные 
файлы, соответствующие заданной организации пользователя, такие как посадочные места, 
сгруппированные в библиотеки пакетного типа (*.PcbLib). 

Библиотеки символов – содержат схемные компоненты и интерфейс определения их 
моделей (*.SchLib). Каждый интерфейс определения модели привязан к своей 
соответствующей библиотеке моделей. 

Интегрированные библиотеки -  это набор библиотек символов, которые, вместе с 
их привязанными библиотеками моделей, ‘компилированы’ в интегрированную библиотеку 
(*.IntLib). Преимущество компиляции в интегрированную библиотеку состоит в том, что 
вся компонентная информация доступна в едином портативном файле. Интегрированные 
библиотеки не могут быть отредактированы без распаковки источников и перекомпиляции. 

Библиотеки базы данных -  библиотека, где все символьные ссылки, привязанные 
модели и параметрическая  информация хранится в базе данных на основе ODBC, ADO или 
в формате таблиц Excel. Каждая запись в базе данных представляет компонент, все 
сохраненные параметры, вместе со ссылками на модели. Запись может содержать ссылки на 
инвентарную ведомость или на другие корпоративные данные компонентов. 

При таком подходе схемные компоненты используются только как символы (они не 
имеют ссылок на модели, описанные в схемной библиотеки) с моделями (посадочными 
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местами или 3D моделями), сохраненными в стандартных библиотечных файлах 
посадочных мест, 3D компонентов и т.д.  

Интерфейсом библиотеки базы данных является документ с расширением *.DBLib, 
который описывает, какие поля базы данных требуются, и какие параметры компонентов 
они отображают. База данных DBLib подключается через панель Libraries подобно всем 
другим библиотекам системы. 

При выполнении действий по размещению, выполняемых с компонентами библиотеки 
базы данных, запись в базе данных проверяется, символ загружается из указанной схемной 
библиотеки, модели добавляются к любым указанным моделям, также как параметры. 

Привязка модели 
При добавлении модели к компоненту, имеется несколько опций, определяющих 

насколько сильно необходимо контролировать поиск данной модели. Хотя они значительно 
варьируются от одного типа модели к другому, диалог редактора модели в основном 
содержат такие опции: 

 
Любые – просматриваются все 
доступные библиотеки для 
подходящей  модели 
 

  
Имя библиотеки -  разыскиваются 
только библиотеки с этим именем для 
подходящей  модели 
 

 
  
Путь к библиотеке – разыскиваются 
только библиотеки с указанным 
именем в указанном месте для 
сравнимой модели 

 
  

Интегрированная библиотека - 
вытаскивается модель 
непосредственно из интегрированной 
библиотеки, используемой для 
размещения этого компонента. 
Интегрированная библиотека должна 
быть доступна в указанном месте  
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Управление библиотеками 
Каждый раз при выполнении операции, которая требует модели, система будет 

разыскивать её в указанном месте, в соответствии с критериями ссылки, описанными в 
предыдущем разделе. Например, при выполнении смешанного моделирования, модель 
SPICE, привязанная к каждому компоненту, отыскивается и используется программой 
моделирования XSPICE. Другим примером может быть передача проекта из схемного 
представления в плату. В этом процессе, посадочное место для каждого компонента должно 
быть передано и помещено на плату. 

В действительности поиска модели проводится в таких разделах, как: 
Библиотеки/модели проекта -  модели и библиотеки моделей могут быть добавлены 

в проект. Подобно всем файлам проекта, файлы моделей/библиотек только связывается с 
проектом, так что можно связать модель/библиотеку с несколькими проектами. Этот 
подход имеет преимущество в том, что модели доступны любому открытому проекту. А 
недостатком является то, что модели/библиотеки, которые сохранены в структуре папки 
проекта могут быть потеряны, если файлы проекта переместить с одного ПК на другой. 
Модели/библиотеки проекта доступны только при редактировании документа, который 
принадлежит текущему проекту. 

Установленные библиотеки –  эти библиотеки ассоциированы со средой Altium 
Designer. Компоненты в такой библиотеке доступны всем открытым проектам. 

Путь поиска проекта – модели/библиотеки могут стать доступными проекту при 
определении поискового пути в диалоге Option for Project. Каждый поисковый путь 
определяет папку и может содержать подпапки при активированной опции Recursive. Все 
обнаруженные модели и библиотеки, найденные по этому пути являются правильными. 
Отметим, что передача моделей при использовании поискового пути может быть 
медленной, при наличии в искомой папке большого числа файлов. 

Контроль доступных моделей/библиотек 
Набор моделей/библиотек, обнаруженный в определённом месте рассматривается как 

доступные библиотеки – означающий, что этот набор доступен для использования в этом 
проекте. 

Эти модели и библиотеки можно просмотреть в диалоге Available Libraries. 
Нажмите кнопку Libraries в одноименной панели или выполните 

Design>Add/Remove Library для открытия диалога. 
 

 
Рис. 3. Диалог Available Libraries показывает все модели/библиотеки,  

доступные в активном проекте 
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Общий порядок поиска 
Правилом является остановка поиска модели после её обнаружения. Для всех моделей, 

которые не привязаны к интегрированной библиотеке, поиск выполняться в таком порядке: 
• Библиотеки проекта 
• Установленные библиотеки 
• В соответствии с указанным путём поиска 
Этот порядок установлен в диалоге Available Libraries  слева направо. Фактически, 

после того, как доступные библиотеки могут быть упорядочены в этом диалоге сверху вниз, 
вся последовательность поиска является интуитивной и лёгкой для установки. 

Пока среда Altium Designer предлагает гибкий контроль над всеми местами 
расположения модели, она не требует от использования корректных расширений для 
каждого типа модели. Например, посадочное место нельзя обнаружить, если оно находится 
в файле с расширением *.lib или *.pcblib. Подобно этому, SPICE .subckt нельзя обнаружить, 
пока он представлен как *.ckt файл или SPICE.model в файле .mdl. Когда же поиск модели 
не удался, на панели Messages  появится сообщение об ошибке. 

Интегрированные библиотеки 
Интегрированные библиотеки являются специальным классом библиотек, когда 

схемный символ и все модели компилируются в единый файл. Преимуществом такой 
библиотеки является портативность и безопасность. Так как все модели представлены в 
интегрированной библиотеке, необходим только один файл для доступа к проекту. 
Компоненты или модели в интегрированной библиотеке не доступны для редактирования, 
пока библиотека не  декомпилирована (открыта IntLib для выделения исходных данных). 

Интегрированная библиотека создаётся путём: 
• Созданием интегрированного библиотечного пакета 
• Добавлением библиотечного схемного символа 
• Ссылками на требуемые модели из каждого символа компонента 
• Установкой опций проекта интегрированной библиотеки, содержащих место для 

выходных данных после компилирования 
• Компиляцией интегрированного библиотечного пакета для формирования 

интегрированной библиотеки (Name.IntLib) 
Если символ компонента получен из интегрированной библиотеки, тогда система 

будет только пытаться взять ссылочные модели из интегрированной библиотеки. Отметим 
попутно, что интегрированная библиотека должна быть доступна в указанном для поиска 
месте, когда система пытается получить модель. 

Для дополнительной информации об интегрированных библиотеках см. статью 
Enhanced Library Management Using Integrated Libraries. 

Для пошаговых инструкций по созданию библиотеки компонентов, созданию 
символов компонентов и ссылок на модели см. руководство Created Library Components. 

Для инструкций по созданию интегрированной библиотеки см. руководство Building 
an Integrated Library. 

 

Свойства компонента 
Базисным компонентом является символ. У системы Altium Designer нет жесткого 

требования обязательного соответствия уникально графического символа каждому 
компоненту, и при этом есть несколько подходов к ведению библиотек. 

Один символ для нескольких компонентов 
Один символ для каждого физического компонента (один символ – один корпус) – это 

идеально подходит для интегральной микросхемы, где каждый символ компонента 
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представлен как реальный физический компонент (корпус). Компонент должен содержать 
подходящие модели, такие как посадочное место, модель для анализа целостности сигнала 
и трёхмерную модель. 

Один символ для графически одинаковых компонентов удачно подходит для 
логически эквивалентных компонентов, но имеющих различные спецификации. Примером 
может быть логический вентиль, который доступен в различных логических семействах, 
таких как  74ACT32 и 74HC32. В этом случае символ компонента создаётся единожды, а 
для каждого требуемого эквивалентного компонента создается аналог (Alias). Аналоги 
компонента добавляются на панели SCH Library редактора схемной библиотеки. Аналоги 
компонентов представляют один компонент с несколькими именами. 

Один символ для разновидности компонента – полезен для дискретных компонентов, 
таких, как резисторы. Компонент может быть связан с множеством посадочных мест. 

Один компонент с несколькими графическими изображениями 
Система также поддерживает множество графических изображений для одного и того 

же компонента. Например, один заказчик, требует нарисовать символ компонента с 
помощью традиционного УГО, и другой требует нарисовать символ компонента в 
соответствии со специфическим стандартом. Для задания дополнительного графического 
представления одного компонента, добавьте новый режим символа компонента, либо из 
меню Tools  редактора библиотеки или с помощью панели инструментов Mode. 

 
Рис. 6. Используйте свойство Mode  для задания нескольких УГО  одного компонента. 

Нестандартные типы компонентов 
Не все компоненты предназначены для монтажа на плату, не все компоненты 

требуются для спецификации и не все элементы, которые монтируются на плату нуждаются 
в схемном представлении. Система поддерживает это через свойство Component Type,  
установленное в диалоге Component Properties (в библиотеке или на схеме). 

Например, наглядность и читабельность схемы можно улучшить включением 
платформы (огибающего контура) для установленного компонента, которая является 
проводами для платы. Если этот компонент не требуется для спецификации, тогда тип 
компонента может быть только графическим. Графический компонент не подвергается 
схемной электрической верификации, он не включается в спецификацию и не 
контролируется в плате для синхронизации. В этом случае тип компонента Component 
Type устанавливается как Graphical. 

   

 
Рис. 7. Установка типа компонента для специальных требований 
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Другим специфическим классом компонента могут быть контрольные точки – этот 
компонент требуется как на схеме, так и на плате, он должен проверяться в процессе 
синхронизации, но не требуется в спецификации. В этом случае Component Type  
устанавливается в  Standart (no BOM). 

Другим примером специального типа компонента может быть радиатор (теплоотвод) – 
обычно он не показывается на схеме (но может быть) и не требуется при схемной 
электрической верификации, но должен быть включен в Спецификацию. В этом случае тип 
компонента Mechanical. 

Для получения более подробной информации о свойствах различных типов 
компонентов нажмите F1  при открытом диалоге Component Properties. 

Параметры компонента 
Обычно имеется различная текстовая информация, которая должна быть включена в 

компонент. Она может содержать такие данные, как технические характеристики 
компонента (например, напряжение или допуск), покупные или стандартные детали, 
примечания конструктора или ссылки на спецификацию компонента. Эта информация 
добавляется в виде параметров компонента, либо при создании компонента в библиотечном 
редакторе после того, как он помещён на схему, либо автоматически в процессе 
размещения, когда извлекается из библиотечной БД. 

 

 
Рис. 8. Добавление параметров компонента. 

 
Для получения более подробной информации по связи компонента с БД, см. документ 

Linking Existing Components to Your Company Database. 
Для получения более подробной информации о библиотечной БД см. документ Using 

Components Directly from Your Company Database. 

Привязка данных к компоненту 
Иногда бывает так, что необходимо иметь доступ к документации компонентов 

проекта, например, к спецификации микросхем. Для выполнения этого, Altium Designer 
предоставляет два метода для привязки ссылок на информацию от компонента на листе 
схемы. Связность устанавливается через дополнение специфическими параметрами 
компонентов. 

Ссылка на одиночный документ – доступ по F1 
Для ссылки к одиночному документу, такому как спецификация компонента, с 

использованием клавиши F1 в качестве доступа, задается параметр HelpURL. Значение 
параметра фиксировано для документа и может содержать номер страницы в PDF. 
Например, значение HelpURL CR0118 FPGA Generic Library Guide.pdf#page=93  указывает 
ссылку на открытие  файла PDF  на стр. 93 при нажатой кнопке F1, и нахождении курсора 
либо поверх размещённого компонента, либо на его названии в панели Library. Ссылка 
может быть локальным документом (содержать путь), если документ не помещён в папку 
C:\Programm files\AltiumDesigner\Help, либо ссылка может быть на URL Интернета. Если же 
компонент не содержит параметр HelpURL, то по умолчанию обычно появляется справка 
по компоненту. 
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Ссылка на несколько документов – доступ по ПК 
 Это свойство доступно для определения или представления ссылок к одному или 

нескольким вспомогательным документам через контекстное меню при нажатии ПК, 
используя параметр ComponentLink. Можно задать несколько параметров ComponentLink. 
Для использования этого свойства, просто добавьте и настройте два параметра для каждой 
пары, как это приведено ниже: 

Рис. 9. Компонент может 
состоять из одной или 
нескольких секций. 

Первый параметр – используется для определения 
документа: 

Name = ComponentLinknURL 
Value = имя документа 
Значение параметра должно содержать полный 

путь, если документ не помещён в папку \Help при 
инсталляции. Укажите номер страницы в документе PDF, 
как было описано выше. 

Второй параметр – используется для определения 
связки, которая появляется в меню: 

 Name = ComponentLinknDescription 
Value = описание 
 Примечание: Для обоих параметров в паре, n – это 

целое значение, позволяющее задать множество пар 
параметров. Для каждой пары ComponentLink, убедитесь, 
что n является одинаковым для обоих вводимых 
параметров. 

Для доступа к указанной ссылке, нажмите ПК на 
размещенном компоненте в рабочей области. Запись для 
ссылки появляется в подменю References. 

Многосекционные компоненты 
В некоторых случаях является актуально представлять один физический компонент, 

используя несколько символов, например, каждый резистор в резистивной цепочке или 
катушку и контакты реле. 

Дополнительные секции добавляются или удаляются с помощью команд  в меню 
Tools редактора библиотек. Каждая секция рисуется индивидуально и добавляются выводы. 

Скрытые выводы 

 
Рис. 10. Для скрытых выводов свойство 
Connect To задаёт цепь, к которой этот 

вывод должен подключаться. 

 Выводы питания и земли компонента 
могут быть представлены видимыми, подобно 
любому другому выводу компонентному, или 
же они могут быть скрытыми. Скрытые 
выводы, имеющие электрический тип Power, 
автоматически подключаются к цепи, заданной 
свойством Connect To в диалоге Pin Properties. 

Для отображения невидимых силовых 
выводов при проектировании компонента 
активируйте опцию Show Hidden Pin в меню 
View  библиотечного редактора. 

 
Для пошаговых инструкций по созданию 

библиотеки компонентов, символов 
компонентов и ссылок на модели см. 
руководство Creating Library Components. 
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Использование интегрированных библиотек 
 
Схемные библиотеки позволяют присоединять такие модели компонентов, как 

посадочное место, средства моделирования и другие. Обычно, каждая из этих моделей связана 
ссылками с файлом, расположенным, где-либо вне схемной библиотеки. Посадочные места 
будут обнаружены в библиотечных файлах РСВ; модели компонентов (за некоторым 
исключением) содержатся в файлах моделей. Так что схемная библиотека помнит связи, т.е. 
содержит инструкции о том, где искать каждую присоединённую модель. 

Периодически Altium Designer нуждается в установлении точного местонахождения этих 
моделей – когда запускается обновление платы, например инструкции привязки будут 
сопровождаться для каждого текущего посадочного места в проекте. Поисковая 
последовательность для нужных моделей начинается с библиотек в текущем проекте, 
установленных библиотек РСВ, затем продолжается просмотром любого файла, 
обнаруженного в поисковом пути проекта. Управление этими исходными отдельными 
библиотеками находится полностью в руках разработчика, что означает, что Altium Designer 
не может дать каких-либо гарантий, что модели будут именно искомыми. Эти связки в 
схемных библиотеках являются неустойчивыми и легко разрушаются при решении 
ежедневных задач управления, таких как переименование папок на жёстком диске или при 
переназначении меток на центральном сервере. 

Преимущества интегрированных библиотек 
Altium Designer предлагает решение этой проблемы в виде интегрированных библиотек. 

Такая библиотека содержит не только схемную библиотеку (или библиотеки), она также 
содержит все ассоциированные библиотеки моделей, связывая их воедино. Если компонент 
взят из интегрированной библиотеки, система гарантирует обнаружение правильной модели, 
если она может просто разместить интегрированную библиотеку где это нужно. 

Так как компоненты и модели содержаться целиком в единственном файле .IntLib, эти 
библиотеки предлагают портативность разработчикам, которые выполняют эти работы 
совместно с другими рабочими станциями или с другими проектировщиками. Простая 
установка такого же, единственного файла на панели Libraries любого ПК с системой Altium 
Designer, будет означать, что связка компонент-модель будет сохраняться надёжно (в 
предположении, что компоненты были помещены в проект из этой интегрированной 
библиотеки). 

Эти библиотеки также проверяются на интеграцию при их компиляции. Это означает, 
что они проверены не только на доступность, но и на корректность определения выводов. 
Даже проектировщикам, желающим оставаться с одиночными файлами библиотек, следует 
компилировать их схемную часть в интегрированный библиотечный пакет, если только они 
уверены, что исходные компоненты будут отображены корректно в конечных моделях. После 
выполнения, они могут игнорировать созданную ими интегрированную библиотеку и 
сохранять размещение непосредственно из их схемных библиотек. 

Создание интегрированной библиотеки 
Для интегрированных библиотек не существует редактора документа. Они являются 

продуктом компиляции интегрированного библиотечного пакета, который является аналогом 
проектов платы или ПЛИС. Библиотечные файлы добавляются в интегрированный 
библиотечный пакет, так же как добавляются документы в любые другие проекты. 

Единственными документами, которые обязательно должны быть добавлены в пакет 
интегрированной библиотеки, являются схемные библиотеки.  Файлы, содержащие 
посадочные места, файлы для моделирования или другие модели могут быть помещены в 
любой области поиска – в пределах проекта, внутри файлов моделей в списке установленных 
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библиотек, или ниже в поисковых путях, указанных для пакета. То есть, желательная 
последовательность поиска: слева направо и сверху вниз, при просмотре списков в диалоге 
доступных библиотек (Available Libraries). 

Подобно любым другим проектам, компилятор для пакета интегрированной библиотеки 
будет генерировать список предупреждений и сообщений об ошибках. Разработчик будет 
получать предупреждения о любых не обнаруженных моделях, означающих, что  
сравниваемые имена не были обнаружены в пакете или по указанному пути. Дополнительно, 
будут показаны предупреждения о любых ошибках несоответствия, таких как наличие 
обозначений, для  контактных площадок (КП) в виде 1 и 2, в то время как реальное посадочное 
место имеет обозначение КП как A и K. 

Файл интегрированной библиотеки создаётся после компиляции пакета. Обратите 
внимание, что вы редактировать можно до тех пор, пока ведется работа с интегрированным 
библиотечным пакетом (.LibPkg), а не с реальным файлом интегрированной библиотеки 
(.IntLib).  Пока пакет не откомпилирован, интегрированная библиотека не существует. 

Панель Libraries 
Открытие в Altium Designer файла .IntLib предлагает на выбор один из двух вариантов. 

Либо перенести исходные документы из интегрированной библиотеки в новый 
интегрированный библиотечный пакет, либо добавить 
интегрированную библиотеку в список панели 
Libraries. Эта панель предлагает только прямой обзор 
собственно файла интегрированной библиотеки. 

Фактически эта панель создана для 
интегрированных библиотек. Отметим, что можно 
просматривать схемные библиотеки только в части 
символов компонентов, а библиотеки посадочных 
мест только в части посадочных мест компонентов. 
Однако интегрированные библиотеки могут 
просматриваться полностью, и просмотр компонента 
позволит увидеть привязанные к нему модели. 

Все присоединённые к компоненту модели 
представлены в виде списка для просмотра в панели 
Library. В этом списке представлены только 
обнаруженные модели; необходимо просмотреть 
панель Messages для уверенности в том, что все 
подключённые модели обнаружены и верны. 

Отметим, что в панели Libraries отсутствуют 
кнопки для редактирования, так как это окно только 
для просмотра интегрированной библиотеки. Это 
обеспечивает целостность интегрированной 
библиотеки – после того, как она сформирована, она 
не редактируема. Фактически для изменения 
интегрированной библиотеки нужно вернуться 
обратно в оригинальный библиотечный пакет, 
обновить исходные документы и заново его 
компилировать.  Если имя пакета или путь к нему не 
были изменены, тогда новая интегрированная библиотека заменит старую. 

Интегрированная библиотека это преднамеренно контролируемая среда, и поэтому 
предлагается возврат к исходным документам для внесения каких либо изменений. 
Альтернативой является ситуация, когда символы и модели можно модифицировать 
независимо в любой момент, без получения каких либо предупреждений, что они не будут 
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проверяться вплоть до формирования сигналов при моделировании или при обновлении 
платы. 

Размещение компонента из интегрированной библиотеки 
Панель Libraries содержит кнопку Place.  На этой панели могут присутствовать 

отсортированные библиотеки УГО, посадочных мест и интегрированные библиотеки, которые 
можно использовать как в схемном редакторе ,так и в редакторе плат. 

Все компоненты, взятые из интегрированной библиотеки, сопровождаются 
информацией, которая позволяет локализовать интегральную библиотеку позже. Так как 
схемная библиотека и интегрированная библиотека (с одинаковой модельной привязкой) 
могут содержать один и тот же компонент, то компоненты для размещения, заимствованные 
из каждой из них, ведут себя по разному при передаче их модельной информации. 
Компоненты, взятые из интегрированных библиотек, будут обращаться к оригинальной 
интегрированной библиотеке для получения их моделей, в то время как компоненты, взятые из 
схемных библиотек не будут иметь доступа к моделям, хранящимся в интегрированных 
библиотеках. 

Хранение доступных интегрированных библиотек 
Так как интегрированные библиотеки автоматически добавляются в список панели 

Libraries при их создании, а также и потому, что панель Libraries является только платформой 
для извлечения интегрированных компонентов для размещения,  эта панель является одним и 
единственным местом поиска требуемых файлов интегрированных библиотечных моделей. 
Если после размещения повторно инсталлировать исходную интегрированную библиотеку, то 
появляется предупреждение на панели Messages, с разъяснением, какие модели не могут быть 
найдены. 

В заключение отметим, что интегрированные библиотеки являются средством, 
защищающим связки между компонентами и их 
моделями. Эти компоненты получают статус 
привилегированных в момент передачи модели, 
для просмотра в интегрированной библиотеке  
связанных с ним моделей скорее, чем  выполнять 
более общий поиск. 

Дополнительно, интегрированные 
библиотеки предлагают транспортабельность и 
защищённость. Они не просто выполняют связи; 
они содержат библиотеки моделей в себе. 
Интегрированная библиотека может быть 
передана от одного проектировщика к другому, 
позволяя избежать недоразумений при изменении 
пути поиска библиотек. Избегайте нарушений в 
оригинальном пакете, такие, которые ведут к 
изменению ассоциаций, после чего потребуется 
регенерация исходных документов в 
интегрированной библиотеке. 

О путях поиска моделей см. статью 
Component, Model and Library Concepts. 

О создании компонентов, определении и 
добавлении моделей см. руководство Creating 
Library Components. 

О компиляции интегрированной библиотеки 
см. руководство  Building an Integrated Library. 
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Использование БД библиотек 
 
Altium Designer обеспечивает возможность для получения компонентов 

непосредственно из БД компании с помощью создания и использования библиотечной БД. 
Размещение происходит через панели Libraries,  после инсталляции библиотечной БД, 
действующей как обозреватель БД. 

После размещения, параметрическая информация проекта может быть 
синхронизирована между помещёнными компонентами и соответствующих им ссылкам на 
записи, используя команду Update Parameters From Database.  Полное обновление 
компонента – включая графический символ, ссылки на модели и параметры можно 
выполнить с помощью команды  Update From Libraries. 

Altium Designer предоставляет два метода связи от компонента к БД – используя либо 
файл Database Link (*.DBLink) или файл Database Library (*.DBLib). Модель предоставляет 
эффективные средства связности и хранения компонентов, использованных в проекте (или 
библиотеках) синхронизованных с данными, введёнными в БД. Это дает возможность 
помещения компонента непосредственно из БД – в сущности, получается создание 
компонента из информации, сохраненной для этого в соответствующей записи БД. 

Перед подробным описанием свойств  библиотеки БД,  стоит рассмотреть различие 
между двумя методами, в отношении их использования. 

Связанность с помощью файла  Database Link (*.DBLink) 
Используя этого метод, файл Database Link определяет связь между схемным 

компонентом и соответствующей записью в БД. Сравнение записи производится с 
помощью связывающего ключевого поля, которое может быть одиночным ключевым полем 
(например, номером секции компонента) или множеством ключевых полей (с помощью 
задания условия Where). 

С этим способом связи, информация о моделях и параметрах компонента должна быть 
предопределена как часть компонента библиотеки Altium Designer. Библиотечный 
компонент должен также включать необходимую информацию ключевого поля как часть 
его определения. После добавления этого определения в документ Database Link в  
библиотечный пакет или проект платы, можно синхронизовать информацию компанента 
(параметры) с содержимым полей в БД. 

Хотя каждый физический компонент, определённый в  каждой записи в БД, не 
нуждается в отображении на уникальный библиотечный компонент Altium Designer – 
многие компоненты в БД могут использовать один библиотечный символ – этот метод 
связности желательно использовать в режиме “Одна запись БД – один компонент Altium 
Designer”. Уникальный компонент Altium Designer может быть либо образцом, 
размещаемым на листе схемы, либо уникальным компонентом в компонентной библиотеке. 

С помощью организации БД в виде DBLink, происходит связывание файла Database 
Link с проектом. 

Для дополнительной информации о связывании существующих компонентов Altium 
Designer (помещённых на схеме или части библиотечных схемных компонентов) см. статью 
Linking Existing Components to Your Company Database. 

Связанность с помощью файла Database Library (*.DBLib) 
При использовании этого метода, файл Database Library также определяет связывание 

между схемным компонентом и соответствующей записью в БД. Здесь также, наличие 
соответствующей записи устанавливается с помощью ключевого поля записи, которое 
может быть единственным таким полем (например, номером записи) или множеством 
полей (с помощью задания условия Where). 
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С помощью этого метода связывания символа компонента, модельной и 
параметрической информации для компонента, запоминается как часть определения записи 
для этого компонента во внешней БД. Рассматриваемый схемный компонент (лежащий в 
основе компонентной библиотеки *.SchLib) является просто пустой оболочкой с 
определённым только символом. Здесь нет связанных моделей и не определены проектные 
параметры. 

Когда компонент помещён, создается его параметрическая и модельная информация, 
используя соответствующие поля в сравниваемой базе данных и в соответствии с 
задаваемым отображением. Один или несколько этих параметров будут использованы для 
сохранения обратной связи с БД согласно заданным критериям сравнения, активируя 
будущую синхронизацию после размещения.  

Этот метод связывания, благодаря его динамически созданным компонентам в момент 
размещения, сам по себе хорош, чтобы быть использованным в режиме “много записей в 
БД - один компонент Altium Designer”. 

В отличие от связывания БД в стиле DBLink, на основании чего файл DBLink должен 
быть подключён к проекту, файл DBLib не нуждается в добавлении в проект. 
Результирующая библиотека БД должна быть частью доступных библиотек – через панель 
Libraries. Вспомним, доступные библиотеки могут содержать библиотеки проекта, 
установленные библиотеки или библиотеки, обнаруженные по указанному пути поиска. 

Обычно файлы DBLib настраиваются в библиотечно-ориентированном режиме. 
Например, можно иметь единую номенклатуру параметров для всех резисторов в БД 
компании, но другую для конденсаторов и т.п. 

Создание БД библиотек 
Как отмечено, основой библиотечной БД является файл Database Library. Этот файл 

создаётся и управляется с помощью Altium Designer DatabaseLib Editor (Рис. 1). 
Для более полной информации о компонентах и библиотеках см. статью Component, 

Model and Library Concepts. 

 
Рис. 1. Редактор DatabaseLib 
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Редактор Database Lib становится активным, когда активным документом в главном 
проектном окне является файл *.DBLib. Создайте новый файл такого типа с помощью 
команды  File>New>Library>database Library. 

Подключение к внешней БД 
Таблица и преобразованные данные появятся в редакторе главного окна после 

успешного подключения активного файла Database Library к требуемой внешней БД. 
Соединение реализуется с помощью управления в разделе Source of Connection (Рис. 2). 

 

 
Рис. 2. Настройки подключения к внешней БД. 

 
Подключена может быть любая БД, обеспечивающая поддержку OLE DB (связь и 

внедрение объектов БД). Опции, представленные в этом участке окна используют OLE 
DB подключение к назначенной БД. Некоторые базы данных не могут предложить 
поддержку OLE DB. Однако, виртуально системы управления БД, используемые сегодня, 
могут быть доступны через интерфейс ODBC. Свойство библиотек БД использует 
провайдер Microsoft ODBC, который позволяет ADO (ActivecX Data Object) подключаться к 
любым исходным данным ODBC.  Результатом является возможность подключения к БД 
ODBC. Провайдер OLE DB для БД ODBC специфицируется как часть цепочки 
подключения. 
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Быстрое подключение для БД Access и Excel 
 Опция Select Database Type просто 

предлагает расширенный метод создания  
соединяющей цепочки, когда данная БД 
создана с помощью Microsoft Access или 
Microsoft Excel.  Используя эту опцию, 
выберите тип БД и затем просмотрите и 
выберите требуемый файл БД. 
Соответствующая соединяющая цепочка будет 
автоматически сформирована и введена в поле 
для опции Use Connection String. 

Так же может быть введен полный путь 
или можно выбрать для сохранения путь к 
файлу библиотеки БД. 

Построение соединяющей цепочки 
Если БД компании не является Access 

или Excel БД, и необходимо построить точную 
соединяющую цепочку, активируйте опцию 
Use Connection String и затем нажмите 
ассоциированную кнопку Build  справа. 
Появится диалог Data Link Properties (Рис. 3). 

Провайдер OLE DB – Microsoft Jet 4.0 – 
установлен по умолчанию на вкладке  
Provider  данного диалога и в результате окно открывается на вкладке Connection. Это 
провайдер по умолчанию, установлен для новых файлов Database Library и также 
используется для подключения файлов БД Access (*.mdb). Измените провайдер при 
необходимости. 

Рис. 3. Настройка соединений с внешней  
БД. 

С помощью вкладки  Connection  просто введите имя (включая путь) БД, к которой 
необходимо подключиться. Как вариант, используйте кнопку ‘…’ для открытия диалога, 
где можно найти и открыть требуемый файл. 

 
 Диалог  Data Link Properties является диалогом Microsoft и поэтому нажатие F1  или 

использование кнопки Help  предоставит доступ к файлу Microsoft data Link Help. Этот 
файл не является частью установленной документации Altium Designer. 

 
Если БД требует разрешения на регистрацию при входе, введите её как это требуется 

вместе с другими расширенными установками доступными на кладке Advanced. Вкладка 
All  обеспечивает суммарный листинг опций заданных связей, а также расширенные опции 
относительно выбранного провайдера OLE DB. Опции могут быть изменены по требованию 
этой вкладки. 

После того, как определены опции связи, можно проконтролировать правильность 
установленных соединений нажатием на кнопке Test Connection (на вкладке Connection). 
Успешное соединение будет подтверждено диалогом. 

Использование файла Data Link 
 Если исходные данные, к которым необходимо подсоединиться, описаны с помощью 

файла Microsoft Data Link (*.udl) активируйте третью опцию подключения -  Use Data Link 
File – и нажмите ассоциированною кнопку  Browse  для выбора требуемого файла. Файл 
Data Link  является по существу  местом хранения для цепочки связности. 
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 Процесс соединения 
 После задания связности с внешней БД текст кнопки Connect  становится чётким, 

сигнализируя о возможности продолжения работы со связностью. Если детали связности 
корректны, табличная и определяющая информация для целевой БД будет загружена в 
документ Database Library. Текст кнопки  Connect  изменится на Connected  и клавиша 
станет не активной. 

Если же имеются проблемы с деталями подключения, например, цепочка соединения 
выстроена некорректно или путь введён неверно, соединение будет не принято и появится 
сообщение, предупреждающее о таком факте (Рис. 4). 

 

 
Рис. 4. Информирование об ошибке подключения. 

 
Проверьте установленные связи и нажмите кнопку  Connect снова. После успешного 

начального соединения, и после сохранения файла Database Library, соединение будет 
выполнено автоматически каждый раз при открытии файла, тем самым, обеспечивая 
расположение заданной БД и имени файла без изменения. 

Если были изменены установки после подключения к БД, существующие 
подключения будут потеряны и текст на кнопке Connect будет заменён на Reconnect. 
Нажмите эту кнопку для переустановки соединения. 

Листинг таблицы БД 
 После успешного подключения к внешней БД будут загружены таблица и 

определяющие данные. В левой стороне окна перечисляются все таблицы, которые 
существуют в присоединённой библиотеке БД. Когда библиотека БД добавлена в список 
Available Libraries для просмотра на панели  Libraries, 
каждая таблица появится как отдельный библиотечный 
объект. Тем самым, хотя в действительности добавлена 
только одна библиотечная БД, на панели  Libraries 
можно увидеть несколько добавленных библиотек. 

Для большей информации см. Adding the Database 
Library. 

После того, как была выбрана одна запись 
таблицы в списке, её иконка изменяется с  на  для 
отличия этой записи. Таблица – со всеми её данными – 
появляется на вкладке Table Browser окна дисплея (Рис. 6). Она является не редактируемой 
копией таблицы и позволяет быстро просмотреть её содержимое, без вызова самой внешней 
БД. 

Рис. 5. Таблицы, существующие 
в подключённой БД. 
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Рис. 6. Просмотр исходных таблиц в подключённой БД. 

Определение критериев сравнения 
После того, как компонент извлечён из внешней БД, возникает необходимость в 

некоторых способах сохранения связей между этим компонентом и записью в БД, чья 
информация была использована для его создания. В сущности, необходимы 2 сравнения. 

Когда компонент извлечён, его параметрическая информация создаётся при установке, 
с помощью соответствующих полей в записи БД. Связность после размещения между 
схемным компонентом и записью в БД создаётся с помощью одного или нескольких из этих 
параметров. Область Field Setting главного окна дисплея (Рис. 7) позволяет определить 
критерии сравнения – либо это простое, единственное наведение справки, или более 
тщательное сравнение, используя условие Where. 

Критерии сравнения определяются на основе табличного вида. 

 
Рис. 7. Управление критериями сравнения после размещения. 

Одиночный ключ сравнения 
 Если опция  Single key lookup  активна (по умолчанию), становятся доступными и 

поля Database field  и Part parameter. Шаблон перечисляет все доступные имена полей (в 
заголовке колонки) в активной таблице БД. Так как параметры для схемного компонента 
добавляются после его размещения, поле  Part parameter  будет просто отражать выбор 
поля БД.  

Обычно, используемый ключ сравнения, использует уникальную идентификацию 
каждого компонента во внешней БД, такую как Part Number (номер части компонента). 
Выбранный ключ поля располагается на вкладке Field Mapping  в окне с помощью записи 
Design Parameter  и отображается серым цветом. 
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Рис. 8. Одиночный ключ, отображаемый с помощью номера секции (Part Number). 
 
При использовании свойства  Update Parameters From Database  в какой-нибудь 

стадии после извлечения, информация считывается из выбранного ключевого параметра в 
размещённых схемных компонентах и затем разыскивается в выбранном (ключевом) поле 
БД – по всем доступным таблицам. Когда происходит сравнение, информация из другой 
ячейки в этой записи родительской таблицы, может затем быть возвращена в отображаемые 
параметры в схемном компоненте. 

Расширенное сравнение – условие Where 
В то время как опция Single key lookup хорошо работает, при сравнении с 

уникальным номером секции или идентификатором, она не столь эффективна, когда 
сравниваются параметры, которые не уникальны, такие как резисторы или конденсаторы. В 
этом случае рекомендуется использование более мощного условия  Where, позволяющее 
определять несколько ключей для сравнения в порядке связи схемного компонента с его 
исходной записью в БД. 

В своей простейшей форме условие  Where  (записывается с использованием 
синтаксиса SQL) отражает выбранные записи, которые определяют единственный ключ 
просмотра. Например, если  Database field  было выбрано в виде Part Number – по 
умолчанию – поле Part parameter  будет 
автоматически установлено также в Part 
Number  и запись для условия Where  
может быть: 

[Part Number] = ‘{Part Number}’ 
Квадратные кнопки вокруг поля БД 

(табличная колонка) являются символами в 
кавычках, как они определены на вкладке  
Advanced  диалога database Connection  
(Рис. 9). Обратитесь к этому диалогу либо 
щелчком на кнопке Advanced в области 
окна  Source of Connection, или из главного меню Tools. 

Рис. 9. Ограничитель SQL 

Круглые скобки указывают, что записи, на которые имеются ссылки, являются 
параметрами проекта. Одиночные кавычки используют для определения параметров 
проекта в формате текстовой строки, в противоположность числам (без кавычек). 
Сравниваемые типы очень важны, так как язык SQL к этому очень чувствителен. 
Проектные параметры должны иметь тот же тип, как он указан в колонке БД. 

Используя стандартный синтаксис SQL, условие Where  затем можно расширить, с 
помощью нескольких записей, например: 

[Capacitance] = '{Capacitance}' AND [Tolerance] = {Tolerance} AND 
[Manufacturer] = '{Manufacturer}' 
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В этом случае единичная запись в необходимой таблице БД должна быть привязана, 
используя три различных проектных параметра. Отметим, что запись проектного параметра 
Tolerance не имеет кавычек. Это означает, что тип колонки в связанной таблице БД 
является числом, а не строкой текста. Используя стандартный синтаксис SQL, можно 
представить условие Where  как простое или как сложное, по желанию. 

При кавычках в таблице, указанные в кавычках используемые символы будут зависеть 
от используемой БД. Например, квадратные скобки применяются только в БД Microsoft 
Access, Excel c помощью ADO или MSSQL (поздние версии). MYSQL может использовать 
одиночные кавычки. Необходимость возникает только в кавычках для имен колонок в 
любой БД, если они содержат пробелы или зарезервированные слова (для этой БД). 
Просмотрите документацию  программного обеспечения вашей БД, чтобы знать какие 
символы кавычек в них используются (если они есть).  

Преобразование полей БД в параметры проекта 
Параметры проекта для компонентов, полученных из библиотеки БД, создаются или 

добавляются во время размещения. Какие параметры в действительности создаются, и 
какие опции используются для обновления их информации после размещения, используя 
команду Update Parameters From Database, определяются посредством преобразования и 
обновления информации, указанной в файле Библиотечной БД. Эти установки 
выполняются на вкладке Field Mapping  главного окна дисплея редактора DatabaseLib (Рис. 
10). 

Опции преобразования и обновления представлены на основе табличного вида. 
  

 
Рис. 10. Спецификации переопределения параметров и опций обновления. 

Переопределение моделей и параметров 
 Первые две колонки слева на вкладке Field Mapping позволяют контролировать, 

какая информация из БД должна переопределяться в моделях и параметрах компонентов. 
Колонка Database Field Name перечисляет все наименования полей (в колонке) в 

текущей активной таблице БД. Колонка Design Parameter определяет, как будет 
использовано каждое соответствующее поле в БД – либо оно используется в исходном 
схемном компоненте, связанное с определённой моделью, либо будет присоединено к 
компоненту, как переопределённый проектный параметр. 
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Первоначальное переопределение выполняется  автоматически при подключении к 
БД, при этом переопределяются все поля БД. 

Для тех полей, которые точно не нужно переопределять из БД, устанавливается запись 
Design Parameter  в [None]. Не затронутые поля БД выделяются на вкладке с помощью 

красной иконки с крестом . Переопределённые поля БД выделяются зелёной иконкой с 
галочкой  

Для быстрого переопределения не затронутых полей, Нажмите ЛК внутри ряда для 
этого поля и используйте горячие клавиши Ctrl+D. Отметим, что для переопределения 
модели будет необходимо произвести ручной выбор из ассоциированного выпадающего 
меню в столбце  Design Parameter. 

Модели 
 Если наименование поля БД представляет собой следующие зарезервированные 

имена, соответствующие переопределённые модельные записи будут автоматически 
установлены в поле Design Parameter: 

Footprint Ref -> [Footprint Ref] 
Footprint Path -> [Footprint Path] 
Footprint Ref n -> [Footprint Ref n] 
Footprint Path n -> [Footprint Path n] 
Library Ref -> [Library Ref] 
Library Path -> [Library Path] 
PCB3D Ref -> [PCB3D Ref] 
PCB3D Path -> [PCB3D Path] 
PCB3D Ref n -> [PCB3D Ref n] 
PCB3D Path n -> [PCB3D Path n] 
Неограниченное число ссылок на посадочные места и PCB3D модели можно 

специфицировать в таблице БД и переопределить в файл DBLib. В зарезервированных 
именах слева, n представляет положительное целое число, начиная с 2. 

Эти переопределения задают символьную и модельную информацию для компонента. 
Когда компонент помещён, схемный символ, описанный соответствующими записями  БД в 
поле Library Ref, будет извлечён из указанной схемной библиотеки. Посадочное место и 
информация о 3D модели, сохранённая в записи, будет добавлена к компоненту как 
связанное посадочное место или 3D модель соответственно. 

Запись [Library Ref] должна существовать в колонке Design Parameter – 
переопределённое в требуемое имя Database Field Name - в нужном порядке для 
возможности поместить компонент в эту таблицу из 
библиотеки БД. Если таблица БД содержит символьную 
ссылочную информацию с другим именем поля, 
например, [Library Ref], используйте доступный 
выпадающий список для этого элемента (Рис. 11). А 
также, если модельная ссылочная информация введена 
в БД с другим наименованием поля, возникает 
необходимость в ручном переопределении, выбирая 
соответствующую запись Design Parameter [Footprint Ref], [Footprint Ref n], [PCB3D Ref n] 
из выпадающего списка, для каждого поля поочерёдно. 

Рис. 11. Ручное переопределение 
модели. 

Библиотечные и модельные переопределения ([Library Path], [Footprint Path], [Footprint 
Path n], [PCB3D Path], [PCB3D Path n]) являются опциональными.  

Для большей информации см. Specifying Symbol and Model Search Path. 
 
Параметры 
Все другие имена полей БД будут автоматически переопределены для параметров 

проекта, с теми же именами. Например, если поле БД называется Tolerance, параметр 
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проекта с именем Tolerance будет переопределен в такое же. Возможно изменить имя для 
параметра проекта просто выбрав ячейку и введя новое имя напрямую. Оно будет являться 
проектным параметрическим именем, которое появится в компонентной области 
Parameters, связанным соответствующим диалогом, после чего оно будет помещено на 
схемном листе. 

Число полей данных, ассоциированных с компонентом в БД, может быть велико, 
например, все необходимые, добавленные как проектные параметры к компоненту, при его 
размещении на листе схемы. Многое из этой информации может потребоваться при 
генерации спецификации. Report Manager содержит опцию, которая позволяет добавлять 
параметрическую информацию в спецификацию (ВОМ), непосредственно из связанной БД 
– позволяя сократить общую информацию, которую можно “переносить” со схемного 
исходного документа.  

Для большей информации см. раздел Adding database Information Directly to a BOM. 

Опции обновления параметров 
Остальные колонки на вкладке Field Mapping (Рис. 10) позволяют определить 

действия, касающиеся параметров, при размещении компонентов из библиотеки БД 
впервые или при обновлении компонента после его размещения с помощью команды 
Update Parameters From Database. 

4 колонки представляют следующее: 
• Update Values – ячейка в этой колонке используется для определения действий, 

которые должны быть выполнены, если параметр существует как на листе схемы, так и в 
базе данных, но текущие значения различны. Укажите для обновления параметра 
размещённого компонента с его значением из БД, или не обновляйте его. Эта опция 
выполняется при использовании команды Update Parameters From Database, после 
размещения компонента. 

• Add To Design - ячейка в этой колонке используется для определения действий, 
которые должны быть выполнены, если параметр существует в БД, но не существует в 
размещённом компоненте. Вы можете указать Да/Нет для добавления параметра, только 
если он имеет значение, присвоенное ему в БД. Эта опция выполняется в обоих случаях – 
когда производится первоначальное размещение компонента из библиотеки БД и когда 
используется команда Update Parameters From Database, после размещения компонента. 

• Visible On Add – флажок в этой колонке используется для определения, будет ли 
вновь добавляемый параметр – как результат начального размещения или как результат 
обновления после размещения – сформирован как видимый для компонента на листе схемы 
(активен) или не видим (не активен). 

• Remove From Design - ячейка в этой колонке предлагает преобразовать поле Add to 
Design, например, что делать, если параметр обнаружен существующим для размещённого 
компонента, но его нет в БД. Можно выбрать вариант не удаления параметра вовсе, или же 
удалить его при отсутствии значения для него в БД. Эта опция работает, когда используют 
команду Update Parameters From Database,  после размещения компонента. 

 Вначале, поля Update Values, Add to Design  и  Remove From Design  для каждого 
переопределённого поля БД, будут установлены как запись Default, а опция Visible On Add  
будет не активирована, как это показано на рисунке 12. 
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Рис. 12. Спецификация опций параметра обновления. 

 
Рассмотрение рисунка 12 позволяет отметить 4 важных момента, касательно опций 

обновления: 
• Не переопределённые поля БД не будут иметь связанных опций обновления. 
• Переопределения на базе символа и модели не будут иметь связанных опций 

обновления, так как не имеют проектных параметров. 
• Ключевое поле (например, Part Number на рисунке 12) не будет иметь связанных 

опций обновления. Это поле редко используется для целей сравнения. 
• Установка Default вызывает 

опцию обновления, за которой следует 
соответствующее определение по 
умолчанию, как оно описано на вкладке 
Default Action (Рис. 13) диалога Database 
Library Option (Tools>Option). Этот 
диалог может также быть доступен 
нажатием по кнопке  Option из под ПК  в 
области  Field Setting  в главном окне. 

 
Четвёртый момент является 

полезным в том смысле, что он позволяет 
указать опции обновления из единого 
окна и затем концентрируется на этой 
позиции, когда определяет опции 
обновления для каждого 
переопределённого поля. Вот почему 
запись Default автоматически 
загружается в нужное поле обновления 
при переопределении поля БД для 
проектных параметров. 

При желании перекрыть установки по умолчанию для опций обновления, нажмите ЛК 
внутри нужного поля обновления на вкладке Field Mapping, а затем повторно нажмите ЛК 
для доступа к выпадающему списку доступных изменений обновления (Рис. 14). 

Рис. 13. Установленные по умолчанию опции 
параметра обновления 

 

 194



 

 
Рис. 14. Ручное перекрытие опции обновления параметра. 

 
Таким способом осуществляется полный контроль при обновлении проектных 

параметров. Можно установить во все поля Default и выполнить решения по требуемым 
обновлениям в диалоге Database Library Option,  установить каждое поле обновления 
индивидуально или образовать некую смесь – решение зависит целиком от разработчика. 
Для размещённых компонентов выполнить обновление, а по завершении использовать 
диалог Engineering Change Order. Если на этой стадии происходит нежелательное 
обновление, можно выбрать - не включать эти специфические изменения, соответственно 
при этом появляется возможность принять окончательное решение об обновлении 
проектных параметров. 

Определение путей поиска символа и модели 
Когда компонент помешен из библиотечной БД, его символ, переопределённый с 

помощью [Library Ref], выбирается из указанной схемной библиотеки (*.SchLib). Подобно 
этому любые ссылки на модели (посадочное место, PCB3D), описанные в БД, будут 
пребывать в файлах основной библиотеки посадочных мест (*.PcbLib) и библиотеки 3D 
моделей (*.PCB3Dlib). Пути к библиотеке могут быть точно заданы  в БД посредством: 

•  Вводом абсолютного пути к библиотеке (например, 
C:\DBLibs\Precision\SchLibs\Capasitors.SchLib) 

•  Вводом относительного пути к библиотеке (например, SchLibs\Capacitors.SchLib). 
Если были определены поля в БД в части информации о пути, эти поля необходимо 

переопределить в соответствующие проектные параметры – [Library Path], [Footprint path], 
[PCB3D Path] и т.д. (см. предыдущий 
раздел). 

Рис. 15. Определение путей поиска для библиотек 
символов и моделей. 

 Ввод путей – даже 
относительных – может быть слегка 
ограничен. При перемещении 
расположения библиотеки, 
необходимо соответственно и 
обновление таблицы БД. Свойства 
библиотечной БД обеспечивает 
возможность указать пути поиска 
библиотеки, как части файла 
библиотеки БД. Это позволяет 
задавать имя исходной библиотеки в 
БД или, что лучше, не указывайте 
его совсем. 

Пути поиска библиотеки 
задаются на вкладке  Symbol and 
Model Search Paths (Рис. 15) в 
диалоге Database Library Options 
(Tools>Options).  

Этот диалог может быть также 
доступен при нажатии кнопки 
Option в области главного окна Field 
Settings. 
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Для добавления пути в список, либо напечатайте путь непосредственно в доступном 
поле, либо нажмите кнопку  для доступа к диалогу Browse for Folder, где можно указать 
директорию, в которой находятся необходимые библиотечные файлы  (Рис. 16). 

 
После установки пути поиска, 

добавьте его в список путей поиска 
нажатием кнопки Add. Добавить 
можно как полный путь, так и 
относительный (относительно 
расположения файла DBLib). Для 
последнего варианта, убедитесь, что 
опция Add/Update As relative Path  
активна. 

Рис. 16. Выбор пути поиска. 

При непосредственном вводе, 
если указан некорректный путь 
(например, папка, которая не 
существует) ввод будет по-прежнему 
добавляться, но появится в списке как 

 иконка, для индикации, что это 
неверный путь поиска. 

Продолжите добавление путей 
поиска, как требуется. Если было 
обнаружено, что введен неверный 
путь, его нужно выделить в списке и 
либо нажать кнопку Remove, либо 
изменить определение пути и нажать 
кнопку Update. 

 
Размещение библиотечных файлов 
Пути поиска библиотек определяют, где можно обнаружить файлы библиотек и 

моделей, когда при размещении компонентов из библиотечной БД и когда разыскивается 
модель после размещения. Используемые специальные схемные символы, модели 
посадочных мест и трёхмерные модели компонентов, будут зависеть от установленного 
пути поиска библиотек и от возможного добавления специфичной библиотечной 
информации в БД. Поиск может происходить следующим образом: 

• Если в переопределённом поле пути существует полный путь к библиотеке символов 
или модели, используйте эту библиотеку и выделите символ или модель, указанные в 
соответствующем поле ссылки. 

• Если в переопределённом поле  пути существует относительный путь к библиотеке 
для символа или модели, используйте эту библиотеку и выделите символ или модель, 
указанный в соответствующем поле ссылки. 

• Если в переопределённом поле пути существует только имя библиотеки для символа 
или модели, используйте пути поиска для определения места первой библиотеки, которая 
соответствует заданному имени и которая содержит сравнимые символ или модель, 
указанные в соответствующем поле ссылки (указателя). 

• Если библиотечная информация не существует в БД, используйте пути поиска для 
определения места первой библиотеки, которая соответствует заданному имени и которая 
содержит сравнимые символ или модель, указанные в соответствующем поле ссылки 
(указателя). 

В двух последних сценариях, порядок путей поиска играет важную роль. Используйте 
кнопки Move Up  и Move Down  на вкладке Symbol and Model Search Paths  в диалоге  
Database Library Option для упорядочения списка путей поиска. 
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Размещение компонентов 
 
Подобно любой другой библиотеке, библиотека БД может быть добавлена как 

библиотека проекта или как установленная библиотека, что делает её доступной в других 
проектах, а не только в активном проекте. Как вариант, можете указать путь поиска папки, 
в которой помещён файл DBLib. Рисунок 17 иллюстрирует добавление библиотеки БД в  
список установленных библиотек. 

 
Рис. 17. Добавление библиотеки БД в список доступных для использования 

Просмотр компонентов БД 
После того, как библиотека БД добавлена в список доступных библиотек, компоненты 

в БД становятся доступными для просмотра через панель Libraries. Хотя добавлен был 
только один файл BDLib, каждая таблица в подключённой БД будет представлена, как 
отдельная библиотека. Верхняя часть списка на панели будет пополнена объектами в 
формате: 

LibraryName.DBLib – 
tableName. 

Рис. 18. Загруженная DBLib 

Каждая запись компонента на 
панели соответствует записи в этой 
особой таблице БД. Фактически, при 
просмотре загруженной библиотеки 
БД, панель Libraries ведёт себя 
подобно непосредственному 
браузеру БД. 

Символьная и модельная информация заполняется из нижележащих символьных и 
модельных библиотек, указанных с помощью подходящих полей БД (и содержащих любые 
заданные пути поиска). 

 197



 

По умолчанию, только поля Part Number и Library Reference отображаются в списке 
компонентов. Для ‘представления’ других полей таблицы БД, нажмите ПК на списке 
компонентов и укажите  Select Columns. Это откроет доступ к диалогу Select Parameter 
Column, из которого можно активировать отображение любого из дополнительных полей в 
этой таблице. 

Для дополнительной информации о панели 
Libraries, нажмите F1, когда курсор находится на 
панели. 

Поиск компонентов 
Подключенная внешняя БД, может содержать 

ряд таблиц, каждая с определенным числом записей 
компонентов. Сама возможность размещать 
компоненты непосредственно из БД это одна 
задача, и совсем другая – поиск расположения 
определенного компонента для целей размещения. 
Последняя - может эффективно управляться с 
помощью поисковых возможностей панели 
Libraries. Нажмите кнопку Search наверху панели 
для открытия диалога Libraries Search, где можно 
производить поиск компонентов в БД в 
единственной таблице установленного файла 
DBLib, или во всех таблицах в установленных 
файлах DBLib. Для активации поиска компонентов 
в БД, установите поле Search Type в Database 
Components. Появятся дополнительные опции 
поиска файлов библиотеки БД. Зоны диалога  Scope  
и  Path диалога становятся недоступными, так как 
их опции не подходят  для поиска библиотек БД. 

При поиске библиотек БД, возможности 
поиска по существу предлагают три уровня поиска 
– простой, запросы в стиле Altium Designer и запросы в стиле SQL. 

Рис. 19. Просмотр компонентов БД 

 

Рис. 21. Опции поиска в компонентной БД. 

Простой запрос 
 Это ‘грубый’ запрос, который возвращает все компоненты БД, обнаруженные в 

любой указанной таблице или во всех таблицах. Используйте доступное выпадающее поле 
(также рассматриваемое как обзор таблицы)  для выбора нужной таблицы, в которой будет 
вестись поиск требуемого компонента, или оставьте всю указанную область, выбрав 
<Search All Tables>. 

Результат запроса будет представлен на панели Libraries, если включен режим 
просмотра компонентов для данной панели. 

 
Нажмите кнопку Search  для начала поиска. Диалог Libraries Search  будет закрыт, а 

результаты поиска перечислены на панели Libraries. При поиске единственной таблицы, 
выпадающий список библиотек будет содержать запись Query Results.  При желании 
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просмотреть все таблицы, отдельные записи будут появляться в списке для каждой 
таблицы. Каждая запись в выпадающем списке будет иметь формат: 

Query Results – TableName  (n) 
Где n это число совпавших обнаруженных компонентов. 

 
Рис. 22. Результаты поиска в одной или во всех таблицах. 

Запросы в стиле Altium Designer 
Это точный поиск, который возвращает все компоненты БД, попавшие в рамки 

выражения запроса Altium Designer. Запрос можно адресовать к определенной таблице или 
ко всем таблицам. Используя выражения запроса можно значительно сузить поиск и тем 
самым минимизировать перечень возвращаемых по запросу элементов. Например, можно 
найти компоненты БД, со определенными ссылками или количеством выводов. Верхняя 
часть диалога Search Libraries (также рассматриваемая как окно редактора запроса) 
позволяет формировать фильтры записей логических запросов. Можно ввести запрос 
непосредственно в это поле. Рисунок 23 показывает пример такого поиска – поиск 
компонентов по всем таблицам, где будут возращены только совпадающие данные, 
указанные в выражении запроса, в данном случае все компоненты, поле Package Reference 
которых содержит текст VP41 и значение равно 6.8 nF. 

 
Рис. 23. Пример запроса в стиле Altium Designer. 

 

 199



 

После задания запроса и установки требуемых табличных границ, нажмите Search для 
обработки запроса. Результат будет представлен на панели  Libraries. Если поиск 
проводился по всем таблицам, результаты отдельных запросов будут доступны для каждой 
таблицы, где было обнаружено совпадение. 

Имеется возможность оказать помощь при создании запросов – Query Helper. Это 
может быть весьма полезным, если нет уверенности в синтаксисе запроса или возможных 
операторах запроса, которые необходимо использовать. Для использования помощника 
Query Helper, нажмите кнопку Helper в диалоге Libraries Search. После этого появится 
диалог Query Helper. 

 
Рис. 24. Использование Query Helper для формирования выражения запроса. 

 
Используйте верхнее окно диалога для ввода выражения запроса, используя 

доступные библиотечные и системные функции. Библиотечные функции содержат два 
подсписка: 

• Fields - все уникальные поля во всех таблицах в установленных библиотеках БД. 
• Tables - все табличные имена, обнаруженные во всех установленных библиотеках 

БД. 
 
Для получения более полной информации о языке запросов Altium Designer см. статью  

Introduction to the Query Language. 
Для получения более полной информации об использовании языка запросов, см. 

статью An Insider’s Guide to the Query Language. 
Для получения более полной информации о специфических ключевых словах в 

диалоге Query Helper, укажите поле ввода в списке и нажмите F1. 

Запрос поиска на языке SQL 
Этот уровень поиска также обеспечивает точный поиск на основе указанного 

выражения, но вместо использования языка запросов Altium Designer, необходимо ввести 
прямой SQL – запрос. Запрашивается только одна, определенная таблица, что 
поддерживается при использовании этого метода. 
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Если вы знакомы с SQL, то можно просто активировать опцию SQL Query и ввести 
выражение непосредственно в окне редактора запроса в диалоге Libraries Search. 

 

 
Рис. 25. Прямое определение запроса поиска в формате SQL. 

 
В качестве альтернативы, можно сформировать выражение с помощью языка запросов 

Altium, после чего активировать опцию SQL Query – запрос будет транслирован в формат 
SQL (Рис. 26). Для получения хороших результатов такой трансляции, перед активацией 
опции SQL Query убедитесь, что установленные границы таблицы являются набором 
определенных таблиц,. 

 
Рис. 26. Конвертация запроса Altium Designer в запрос в формате SQL. 
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 Размещение компонентов 
В необходимом листе схемы, открытом как активный документ, выберите компонент, 

который необходимо разместить из панели Library и либо нажмите кнопку Place или 
захватите и перетащите компонент непосредственно на лист. В этот момент имеют место 
следующие действия: 

• Извлекается схемный символ, описанный в записи БД 
• Привязываются ссылающиеся модели посадочного места и  3D 
• Параметры проекта описанные в файле DBLib добавляются (в соответствии с 

ассоциированными Add To Design  обновлёнными установками) к компоненту. 
После размещения, дважды нажмите ЛК на компоненте для доступа к диалогу его 

свойств (Рис. 27). В зоне диалога Parameters будут добавлены параметры проекта, в зоне 
Models - привязанные модели  и другую зону – Library Link. Эта зона представляет 
следующую информацию: 

• Файл родительской библиотеки БД (Library Name) 
• Определенную таблицу БД, в которой помещен компонент (Table Name) 
• Значение выбранного ключевого поля для этого компонента. Обычно это будет 

номер секции компонента (Design Item ID). 
Из окна свойств можно заменить выбранный компонент на другой, из этой же 

таблицы, нажав кнопку Choose. Это откроет диалог Browse Libraries, показывающий список 
всех компонентов в этой таблице. Фактически, можно выбрать компонент в другой таблице 
того же файла DBLib, или просмотреть его в другом файле DBLib в целом. Зона будет 
обновлена в соответствии с новой информацией для выбранного компонента БД. 

 
Рис. 27. Информация, добавленная к компоненту при размещении. 

Обеспечение синхронизации 
После размещения выбранный параметр ключевого поля используется для 

подтверждения того, что помещённый на схему компонент сохраняет свою связь с 
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соответствующей записью для этого компонента во внешней БД. Это означает, что на 
любом этапе в будущем, изменение в параметрической информации в БД может быть легко 
передано обратно к размещённому компоненту, для взаимной синхронизации. Обновление 
осуществляется по команде Update Parameters From Database, доступной из схемного 
редактора главного меню Tools. 

Хотя файл DBLib представляет одну или более библиотек на панели Libraries,  он 
является только исходным соединением и переопределением поля – а не библиотекой в 
действительном смысле слова. Это говорит о том, что команда Update From Libraries  
может быть также использована для обновления параметров компонентов, помещённых в 
DBLib, а также информации о моделях и графике, которая может быть изменена в 
ассоциированных библиотеках компонентов и моделей. 

 
Запуск этой команды приводит к диалогу Update Parameters From Database (Рис. 28). 

Используйте этот диалог для выбора и обновления схемных документов и типов 
компонентов. 

 

 
Рис. 29. Выбор обновлений на уровне параметров. 

 
После задания границ обновления, нажмите ОК. Поступит запрос к внешней БД для 

сравниваемых компонентов. Если имеется различие в параметрах размещённого 
компонента со сравнимой записью в БД, будет вызван диалог Select Changes (Рис. 29). 

 

 
Рис. 29. Выбор обновлений на уровне параметров. 

 
Этот диалог представляет список всех параметров, которые существуют в записях БД 

для размещённых схемных компонентов, попадающих в рамки заданных обновлений. 
Любые параметры, которые добавлены к 
компоненту после размещения, не будут 
представлены в списке. Диалог в первую 
очередь показывает предложенные обновления 
для выборки параметров размещённых 
компонентов для синхронизации их с БД, на 
основе действий по обновлению, заданные в файле DBLib. 

Рис. 30. Выявленные различия 
параметров. 
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Различающиеся параметры выделяются с помощью уникальной иконки, введенной в 
затронутою ячейку. Например, голубой треугольник в угле ячейки означает, что было 
обнаружено различие между параметрами размещённых компонентов и теми же 
параметрами в записи, подключенной БД. Таблица 2 содержит список различных состояний 
для ячейки в данном диалоге. 

Таблица 2. Состояние параметров ячейки. 
Состояние 
ячейки 

Описание 

 
Образец компонента на схемном листе и запись компонента в БД имеют 
одинаковые параметры и значения. Обновление не вызовет изменений. 

 Образец компонента на схемном листе и запись компонента в БД имеют 
одинаковые параметры, но не имеют присвоенных значений. Обновление не 
вызовет изменений. (Примечание: такое состояние ячейки не будет возможным, 
если для опции обновления Remove From Design установлено действие Remove 
only if blank in database). 

 
 Образец компонента на схемном листе и запись компонента в БД не содержит 
параметра. Обновление не вызовет изменений. 

 
Образец компонента на схемном листе и запись компонента в БД имеют 
одинаковые параметры, но различные значения. При обновлении будет 
присвоено значение из БД. 

 
Образец компонента на схемном листе и запись компонента в БД имеют 
параметр. На листе он имеет присвоенное значение, а в БД его нет. При 
обновлении будет принято значение из БД, в данном случае это не будет 
сделано. (Примечание: такое состояние ячейки не будет возможным, если для 
опции обновления Remove From Design  установлено действие Remove only if 
blank in database). 

 
Образец компонента на схемном листе не содержит параметра, но она есть в 
записи БД. При обновлении будет добавлен параметр к размещённому 
компоненту, со значением, показанным в ячейке. 

 
Образец компонента на схемном листе не содержит параметра, но он есть в 
записи БД. При обновлении будет добавлен параметр к размещённому 
компоненту, без начального присвоенного значения. (Примечание: такое 
состояние ячейки не будет возможным, если для опции обновления Remove 
From Design  установлено действие Remove only if blank in database). 
Образец компонента на схемном листе и запись компонента в БД имеют 
параметр. На листе он имеет присвоенное значение, а в БД его нет. При 
обновлении будет удалён параметр у размещённого компонента. Примечание: 
такое состояние ячейки не будет возможным, если для опции обновления 
Remove From Design  установлено действие Remove only if blank in database. 

 
Обнаружено различие между  значением параметра компонента на схемном 
листе и записью компонента в БД.  Предложенное обновление для значения в БД 
будет отвергнуто. Изменение не появится. 

 
Пример компонента на схемном листе не содержит параметра, но запись 
компонента в БД присутствует. Предложенное добавление  для обновления 
параметра на компоненте листа отвергается. Никаких обновлений не 
производится.  

 
Пример компонента на листе схемы и записи компонента в БД содержат 
параметр. На листе значение есть, а в БД отсутствует. Предложенное удаление 
обновления параметра из компонента на листе отклонено. Никаких обновлений 
не производится. Примечание: такое состояние ячейки не будет возможным, 
если для опции обновления Remove From Design  установлено действие Remove 
only if blank in database. 

Контроль в диалоге Select Parameter Change  позволяет полностью контролировать 
проводимые обновления и отказы от обновлений. Можно отвергнуть обновления для всех 
параметров у выбранных компонентов или для указанных параметров у одного компонента. 
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Для отказа от предложенного обновления определенного параметра укажите нужную 
ячейку и нажмите кнопку Reject Selected. Для проведения обновления нажмите кнопку 
Update Selected. Используйте диалог Engineering Change Order, который появляется для 
подтверждения и затем запустите обновление.  Если было обнаружено, что имеется 
обновление, которое не нужно обрабатывать, заблокируйте соответствующее изменение 
порядковой записи. 

 

 
Рис. 30. Запуск ECO для выполнения изменений 

Имеется возможность проверки правильности обновления параметров либо прогоном 
менеджера параметров (Tools>Parameter Manager), либо запросив параметры компонента 
в через диалог свойств или на панели SCH Inspector. 

 

 
Рис. 32. Верификация обновлений параметра 

Обновление информации о модели 
Ссылки на модели посадочных мест, 3D модели и фактически схемных символов 

самих на себя, могут быть изменены во внешней БД. Эти объекты не являются проектными 
параметрами, поэтому запуск команды Update Parameters From Database не может 
обнаружить каких либо изменений в них. Для моделей, любые изменения будут 
проявляться на заново размещаемых примерах действующих компонентов. Ранее 
размещённые компоненты будут сохранять предварительную информацию о модельной 
связности. 

Если была изменена ссылка схемного символа (поле БД, относящееся к записи 
проектного параметра [Library Ref] в файле DBLib) то необходимо отменить инсталляцию 
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файла DBLib из списка доступных библиотек и затем реинсталлировать их для внесения 
изменений. 

Если связанные схемные символы в подчинённой библиотеке компонентов (*.SchLib)  
изменены, например, в части графики, новая информация может быть передана 
компонентам, которые уже размещены, по команде Update From Libraries. Это также 
верно для изменений в связанных моделях в их ассоциированных модельных библиотеках. 

Двойная синхронизация – DBLib и DBLink 
Бывают проекты, где большинство размещённых секций привязаны к внешней БД, 

использующей файл DBLink. Проектные изменения могут проявиться в дополнительной 
схеме, компоненты для которой могут быть помещены, используя свойство библиотеки БД. 
Ассоциированный файл DBLib, может, вполне вероятно, указать на другую внешнюю БД.  

При использовании команды Update Parameters From Database, будут запрошены 
все связанные параметры для размещённых компонентов – во всех связанных БД, 
безотносительно к использованному методу связанности – и определены различия в этих 
параметрах, отображаемых в диалоге Select Parameters Change. 

Если использованы одинаковые поля в БД для сравнения как в файле DBLink, так и в 
файле DBLib, БД, привязанная к файлу DBLink будет просмотрена первой для сравнения, за 
которой последует БД, привязанная к файлу DBLib. Если компонент присутствует в обеих 
БД, вы можете подтвердить возможное соответствие и обновить неточные внешние записи. 

Добавление информации БД непосредственно в спецификацию (ВОМ)  
Исходная информация для BOM, в прошлом поступала из параметрической 

информации компонентов, размещённых в проекте. Но это может привести к потере 
информации, добавленной на схеме, если она использована только для ВОМ. Если 
компоненты были размещены из библиотеки БД, то генератор ВОМ имеет возможность 
выбирать любую другую информацию, которая добавлена не как параметры проекта в 
момент размещения. 

При конфигурировании спецификации с помощью Report Manager, просто 
активируйте опцию Include Parameters from Database. В листинге параметра, иконка  
будет использована для выделения параметра, который существует для одного или 
нескольких размещённых компонентов в связанной внешней БД. 

 
Рис. 33. Содержание дополнительной информации о компоненте, 

 которая существует только во внешней БД 
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Основные концепции разработки проекта на базе ПЛИС 
 
Это глава посвящена созданию простого схемного проекта, который на практике 

показывает полный процесс проектирования. Не будем пытаться здесь представить всю 
мощь смешанного схемного/HDL (VHDL или Verilog) проектирования высокого уровня в 
составе программного обеспечения. Для более подробного знакомства с процессом 
проектирования, см. множество примеров в папках \Altium Designer 6\Examples.  Папка 
\FPGA hardware содержит ряд проектов, которые не содержат процессоров. Папка \ FPGA 
Processor 32-bit, папка \Discrete Processor 32-bit и папка \Reference Designs содержат 
проекты на базе процессорных ПЛИС, некоторые из которых демонстрируют простое 
свойство или другие, которые содержат целые цифровые системы. 

Перед началом работы с руководством, подключите NanoBoard к параллельному 
порту ПК и включить плату в сеть с помощью выключателя. Убедитесь в установке 
инструментария Xilinx (web-редактор), который загружается из вебсайта (www.Xilinx.com). 

Пример использованный в этом руководстве называется Johnson Counter, показан на 
рисунке 1. Он может быть найден в папке c:\Program Files\Altium Designer 
6\Examples\Tutorials\ getting started with FPGA Design.. 

Johnson Counter или кольцевой счётчик (с перекрестной связью), является 
синхронизируемым счётчиком, где инвертированный выход последнего триггера  
подключён к входу первого триггера. При запуске, этот проект счётчика будет включать 
светодиоды (LEDs) последовательно («бегущие огоньки») на плате отладки NanoBoard. 
Позже в схему будет введена временная задержка для загрузки светодиодного дисплея, 
поэтому этот счётчик может индицировать смещение слева направо или наоборот.  

Важно отметить, что концепция схемы для цифровых проектов под управлением 
Altium Designer может отличаться от концепции платы.  Правила, необходимые для 
проектирования ПЛИС могут не соответствовать правилам для платы. 

 
 

Рис. 1. Схема счётчика 

Создание проекта ПЛИС 
Для начала работы с Altium Designer необходимо создать проект. Проект создаётся с 

помощью управления исходными инструментами, а генерация любых выходных данных 
является сравнительно простым делом. Для проектирования цифровой ПЛИС необходимо 
создать проект ПЛИС. 

Для этого: 
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1. Укажите File>New>Project>FPGA Project из меню или нажмите Blank Project 
(FPGA) в рамке New  панели Files. 

2. Панель Project отобразит новый проектный файл  FPGA _Project1.PrjFpg. 
3. Переименуйте новый файл проекта (с расширением 

*.PrjFpg), выбрав File>Save Project As.  Найдите на жёстком 
диске место для хранения проекта, введите имя 
Johnson_Counter.PrjFpg в поле File Name и нажмите Save. 

Стоит обратить внимание, что в именах проекта и 
документа используется символ подчёркивания вместо 
пробела, для исключения  ошибок синтеза в проекте ПЛИС. 
Затем создадим схему счётчика для добавления в файл 
проекта. 

Создание исходного документа схемы 
Проект ПЛИС поддерживает два типа исходных документов – схему и HDL. Можете 

использовать одновременно оба типа документов в проекте с использованием символов 
листа. Однако для проекта ПЛИС на верхнем уровне проекта должна быть использована 
схема. Это необходимо для поддержки интеграции ПЛИС-плата. 

Проект содержит несколько схем задержек для подключения дисплея на светодиодах 
LED на плате NanoBoard. Сначала создадим просто один лист схемы для счётчика. Затем 
переместим схему задержки на подчиненный лист, чтобы показать пример использования 
иерархической структуры. Наконец, заменим этот подчиненный лист на файл VHDL. 

Для создания одного документа схемы счётчика: 
1. Укажите File>New>Schematic, или нажмите Schematic Sheet в рамке New на панели 

Files. Бланк схемного листа с именем Sheet1.SchDoc отобразится в проектном окне. 
2. Переименуйте новый схемный файл с расширением .SchDoc выбором File>Save As. 

Найдите место для хранения схемы на жёстком диске, введите имя Johnson_Counter.SchDoc 
в поле имени файла и нажмите Save. 

При использовании символов схем можно смешивать VHDL, Verilog и схемные 
документы. В случае файлов HDL, входная информация на листе соответствует портам в 
документе HDL. 

Размещение компонентов на схеме 
Компоненты, необходимые для этой схемы можно обнаружить в групповой 

интегрированной библиотеке \Program Files\Altium designer 6\library\FPGA\FPGA 
Generic.IntLib. Эта библиотека  установлена по умолчанию и доступна из панели Libraries. 

Компоненты библиотеки FPGA Generic могут быть использованы в любом устройстве 
ПЛИС, которые поддерживает эта система. Кроме того, имеются специальные 
интегрированные библиотеки (*FPGA.INTLIB) с доступными от продавца примитивами 
(доступные изготовителю из папки \Program Files\Altium Designer 6\Library), 
ориентированные на специальные устройства, поэтому их применение может помешать 
транспортабельности проекта; используйте их только при реальной необходимости.  

 
См. руководство Building an Integrated Library  для дополнительной информации об 
использовании интегрированных библиотек. 

Теперь, начнём проектирование схемы счётчика. 
1. Укажите FPGA Generic.IntLib из выпадающего списка на панели Libraries. 
2. Выберите компонент SR8CLEDB на панели Libraries. Можно просмотреть панель 

Libraries, либо просмотрев список, либо введя имя SR8CLEDB (или часть имени) в окне 
редактора Masks ниже имени библиотеки, выберите компонент из списка и нажмите кнопку 
Place SR8CLEDB или просто перетащите выбранный компонент на схемный лист. 
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3. После этого курсор имеет привязанный  
компонент. Поместите компонент, нажав ЛК, в 
соответствующем месте схемы. Не стоит беспокоиться 
об установке корректного позиционного обозначения 
для этих компонентов, так как оно будем произведено 
автоматически на последнем этапе. 

4. Кроме этого в данном  проекте будут 
использованы 8-битная шина (J8B_8S), шесть 
инверторов (INV) один вентиль OR (OR2N2S) и два 
триггера (FJRC). Повторите указанные выше шаги для 
размещения этих компонентов, как показано на 
рисунке 2. 

5.Также проект нуждается в нескольких портах, 
которые взаимодействуют с соединителями NanoBoard. 
Они помещены в библиотеке FPGA NanoBoard Port-
Plugin.IntLib, доступной по умолчанию на панели 
Libraries. Поместите DIPSWITCH, TEST_BUTTON,  
CLOCK_REFERENCE  и LED из библиотеки, как 
показано на рисунке 2. Отметим, что эти компоненты 
имеют видимый параметр с именем ‘PinNumberDisplay, 
которые вначале читаются как ‘PXX’ для каждого 
вывода. Когда позже проект синтезируется в этом 
руководстве, эти параметры будут обновлены для 
отображения номеров выводов, когда эти цепи 
подключатся к назначенной ПЛИС. 

6. Наконец, добавьте позиционные 
обозначения с помощью Tools>Quiet Annotate или 
Tools>Force Annotate All.  Обозначения будут добавлены автоматически ко всем 
компонентам на схеме. 

 

Рис. 2.  Схема счётчика с размещёнными компонентами 

Добавление силовых портов 
Поместите 2 силовых порта GND. 
1. Укажите Place>Power Port или нажмите на иконке GND на панели инструментов 

Wiring. 
2. Нажмите TAB для отображения диалога свойств Power Port. Проверьте, что Net 

установлена в GND  и выберите стиль Bar  из выпадающего списка стилей. Нажмите ОК  и 
разместите порты GND. 

3. Нажмите ПК или нажмите ESC для выхода из режима размещения. 

 209



 

4. Кроме этого необходимо добавление шины портов питания D[7..0] в компоненте 
SR8CLEDB. Нажмите кнопку VCC Bus Power Port на панели инструментов Wiring. 
Нажмите TAB для отображения диалога свойств Power Port, замените имя цепи на 
GNDBUS[..] и проверьте установку стиля в Bar. Нажмите ОК  и нажмите пробел для 
поворота символа при его размещении. 

Создание соединений 
После размещения всех компонентов и портов, самое время ввести соединения. 

Имеется два способа проложить проводники на схеме – явный и неявный.  Явная прокладка 
проводников выполняется посредством физического соединения проводом двух объектов 
цепи. Неявные проводники создаются соединением, которые используют провода и метки 
цепей например, соединение, подразумевается если два проводника имеют одинаковые 
метки цепи, но на самом деле физически не связаны. 

Наш проект будет нуждаться как в проводниках, так и в шинах. Первыми разместим 
проводники. Помните, что нельзя путать проводники с линиями: проводники реализуют 
связность компонентов, а линии служат только как элементы чертежа. 

1. Для размещения проводника, укажите Place>Wire [P,W] и нажмите ЛК в точке 
схемы, где нужно начать проводник (обычно это порт или вывод компонента). Поместите 
курсор в следующую точку подключения проводника и снова нажмите ЛК. Продолжайте, 
пока не выполните соединения к другому порту или выводу компонента. Продолжайте 
прокладку проводников и нажмите ПК или нажмите ESC для выхода из режима 
размещения проводников. 

2. Проложите проводники схемы, как показано на рис. 3, при этом не забывайте 
вводить точки соединения в местах пресечения проводников на схеме. Если два проводника 
пересекаются, и точка подключения присутствует, то соединения этих двух проводников 
неявное. Если же подключение отсутствует, то нет и соединения. В этой схеме точки авто 
соединения будут появляться там, где проводники соединены.  

 

Рис. 3. Вид законченной схемы счётчика  

Размещение имен соединений  
Все проложенные выше проводники являются явными и технически не требуют меток 

для цепей. Однако всегда целесообразно иметь такие метки для всех цепей, что делает 
проект более простым для понимания и создаёт условия решения проблемы трассировки и 
взаимных ссылок более легкими. Для нанесения меток соединений: 

1. Укажите Place>Net Label  [P,N]. На курсоре появится рамка с меткой цепи. 
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2. Для редактирования метки цепи перед её размещением, нажмите клавишу TAB для 
отображения диалога Net Label. Введите имя цепи в поле Net, например, LEFT. Нажмите 
ОК. 

3. Поместите метку цепи так, чтобы левый нижний угол метки (горячая точка) 
касалась проводника. Курсор примет вид красного перекрестья, когда метка цепи касается 
проводника. 

4. Пометьте другие цепи. Схема ниже показывает размещение всех меток цепи. Они 
должны быть все уникальны и помечены в точном соответствии с рисунком 4. Нажмите  
ПК или ESC для выхода из режима размещения меток цепей. 

 

Рис. 4. Схема счётчика с добавленными метками цепей 

Использование шин 
Altium Designer поддерживает комплексное использование шин в проектах ПЛИС. 

Шины могут быть использованы не просто для обозначения группы сигналов, но и как 
распределение каждого сигнала в шине между конечными точками. При использовании 
шин, важно помнить, что на любом  выведенном сегменте шины всегда нужно ставить 
метку цепи. Также полезно знать, что подключения из шины к другому объекту всегда 
разрешаются слева направо и размерность шины в обоих объектах при подключении  
должна быть одинаковой. 

Для подключения порта LED  к SR8CLEDB создадим шину SQ[7..0] как показано на 
рисунке 5. 

1. Разместите шину, указанием Place>Bus [P,B] и введите шину, используя ту же 
технику размещения, которая 
использовалась при размещении 
проводников. 

Рис. 5. Добавление и номерация шин 

2. Поместите на шине метку 
цепи с именем SQ[7..0]. Шина без 
метки цепи, даже если она явно 
подключена, является весьма 
сомнительной, поскольку 
отсутствие метки цепи не позволяет 
чётко определить, как каждый 
элемент шины подключён к её 
конечной точке. 

3.Затем, можно добавить входы 
в шину, как показано на рисунке 5. 
Укажите Place>Bus Entry [P,U] и 
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поместите входы в шину от проводников 
SQ0  в шину SQ[7..0]. Используйте клавишу 
пробела во время размещения для поворота 
входов в шину, при необходимости. Нажмите 
ПК или ESC для выхода из режима 
размещения. 

Рис. 6.  Подключение переключателя порта 
DIP к J8b_8S с использованием шины 

4. Добавим другую шину для 
соединения DIP переключателя порта к 
секции компонента J8B_8S (как показано на 
рисунке 6).   

5. Сохраните схему и проект. 
Типичной ошибкой является использование стиля номерации шины для меток 

проводников (например, “[ ]”) на проводнике. В Altium Designer это недопустимо. 

Контроль проекта 
Перед тем как продолжить создание подчиненного листа для делителя частоты, 

необходимо проверить, что схема соответствует плану посредством компиляции проекта и 
прогона электрического и графического контролей, установленных на вкладке Error 
Checking диалога Option for FPGA Project (Project>Project Option). 

1. Укажите Project>Compile FPGA Project [имя_проекта]. На панели Messages будут 
автоматически появляться сообщения о любых ошибках или фатальных ошибках. 

2. Предупреждения будут также перечислены на панели Messages, нужно вручную 
активировать панель выбором вкладки System в нижней части окна проекта и указать 
Messages (или выбрать в меню View>Workspace Panels>System>Message). 

3. Дважды нажмите ЛК на любом сообщении об ошибке на панели Messages для 
отображения дополнительной информации об ошибке в диалоге Compile Errors. Виновный 
в ошибке объект будет увеличен и подсвечен на схеме. 

4. Исправьте все ошибки и повторно компилируйте проект для контроля. Сохраните 
файлы схемы и проекта. 

Настройка проекта 
Завершая проектирование счётчика, необходимо указать, какой чип ПЛИС будет 

использоваться в данном проекте, например, Xilinx Spartan IIE XC2S300E-6PQ208C на 
плате NanoBoard. Для этого необходимо ввести файлы конфигурации и ограничений. Файл 
Constraint определяет нумерацию выводов и имя устройства для использования чипа ПЛИС 
на плате NanoBoard. 

1. Укажите Project>Configuration Manager. Появится диалог Configuration manager 
for project. Нажмите на кнопке Add в рамке диалога Configuration и введите  имя 
конфигурации в диалоге New Configuration Name, например NB_SpartanIIE, и нажмите ОК. 
Имя конфигурации должно быть связано с конечной реализацией для лёгкой 
идентификации. 

2.Добавьте файл конфигурации в данный проект выбором кнопки Add в рамке 
Constraints и укажите NB1_6XC2S300E-6PQ208 в диалоге Choose Constraint files to add to 
Project. Файл ограничений находится в папке Altium Designer 6\Library\ПЛИС. Нажмите 
Open. 

3. Установите флажок конфигурации в диалоге Configuration Manager и нажмите ОК. 
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4. В проект добавляется папка с именем Setting и показывается файл ограничений, 
используемый в папке Constraints Files. 

5. Сохраните файл проекта. 

Ориентация на микросхему Altera Cyclone 
Если необходимо применять чип Altera Cyclone, тщательно установите его в плату 

NanoBoard. 
1. Добавьте новый файл конфигураций (Project>Configuration Manager) с именем, 

например Altera для проекта ПЛИС. 
2. Добавьте поставляемый файл Altera Constraints, C:\Program Files\Altium Designer 

6\Library\FPGA\NB1_6_EP1C12Q240.Constraint. Убедитесь, что выбрана конфигурация 
Altera. 

3. Продолжите в следующей рамке Using the Devices view to program the FPGA. 
Теперь конфигурация проекта Johnson Counter завершена и можно перейти к его 

реализации в ПЛИС. Остаток процесса проектирования можно поместить в Devices view. 
Для большей информации о конфигурации и ограничениях, см. статью Design 

Portability, Configuration and Constraints, а также Re-targeting the Design to the production 
board. 

Использование Devices View для программирования ПЛИС 
Обзор устройств (View>Devices View) позволяет следовать процессу (слева направо), 

для передачи программы в ПЛИС. В этом обзоре можно: 
• Компилировать проект (и проверить ошибки) 
• Синтезировать проект (создать список цепей в формате EDIF) 
• Построить (например, транслировать файл EDIF, переопределить проект в ПЛИС, 

разместить и трассировать ПЛИС, провести временной анализ и затем создать битовый 
файл, который используется как программа для ПЛИС). 

• Запрограммировать ПЛИС (загрузить битовый файл в дочернюю плату чипа ПЛИС, 
например, Xilinx Sparyan IIE). 

 
По завершении этой работы, можно запустить программу с помощью переключателей 

DIP на NanoBoard. Для загрузки в ПЛИС данного проекта: 
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1. Проверьте корректность подключения NanoBoard и включите её. В Devices View 
нажмите флажок Live и дождитесь зелёного цвета индикатора Connected. 

2. Нажмите Compile. При успешной компиляции красный индикатор станет зелёным. 
Если на панели предупреждений показана ошибка, вернитесь назад к схеме, исправьте 
ошибки, сохраните файл и повторно компилируйте его. 

3. Нажмите Synthesize.  Если синтез прошёл успешно, создастся папка Generated [имя 
конфигурации], которая содержит сформированные EDIF, VHDL и файл протокола синтеза. 
Использованная в этом примере конфигурация с именем Johnson отобразится в Devices 
View ниже иконки Spartan IIE. В процессе синтеза, исходные документы транслируются в 
промежуточные файлы в языке VHDL, которые затем синтезируются в EDIF, необходимый 
для инструментария Place&Route. Выявленные в процессе синтеза ошибки содержат 
промежуточные файлы, поэтому вернитесь к исходным файлам для уяснения любой 
проблемы. Дважды нажмите ЛК на ошибке в панели Messages, чтобы увидеть проблему в 
исходных документах и промежуточном файле VHDL. 

 Можно выполнить все стадии графика работ и включать текущую стадию нажатием 
иконки стрелки, расположенной слева кнопки стадий, например, нажатие этой иконки на 
кнопке Program FPGA запустит все предыдущие стадии по порядку. 

4. Нажмите Build. Этим обеспечится переход через несколько процессов, в конечном 
счете, создав битовый файл, который можно загрузить в ПЛИС. При этом кнопки, рядом с 
различными процессами, при успешном их завершении будут показаны зелёным. Кнопка  
Build станет зелёной, когда все необходимые процессы завершаются, и появляется диалог 
Result Summary. Нажмите Close для закрытия диалога. (В этом примере процесс Make 
FROM File не требуется).  

5. Нажмите Program FPGA для загрузки битового файла в дочерний чип Spartan. 
6. Когда процесс загрузки завершится, можно запустить программу с помощью 

клавиш переключения DIP на NanoBoard: 
• Переключатель 1 для отображения смещения LED влево 
• Переключатель 2 для отображения смещения LED вправо 
• Переключатель 3 для окончания программы. 
Нажмите кнопку Test/Reset ниже LED для повторного запуска программ. 
7. Индикатор LED мигнет при правильно составленной программе и больше не будет 

светиться. Это происходит потому, что по умолчанию счётчик установлен на частоту 50 
MHz, которую не улавливает глаз человека. Для того, чтобы индикатор отображал свою 
функцию (бегущие огоньки), заметные глазу человека, нужно добавить делитель в схему 
после проверки нормальной работы программы, используя аппаратурный инструмент. 

Контроль LED с помощью аппаратного инструмента 
Корректность работы программы можно проверить мониторингом выводов на 

реальной ПЛИС. Для этого не нужен осциллограф, вместо этого можно 
использовать Altium Designer’s JTAG Device Viewer для контроля этапа 
выводов на любой границе сканирования нужного устройства. 
Обозреватель доступен из инструментария Hard Devices для ПЛИС.  

1. Для открытия инструментария нажмите  ПК на иконке Spartan-
IIE  в рамке Hard Devices обозревателя устройств (Devices View) и из 
меню укажите Instrument. Появится Instrument Rack – Hard Devices. 
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2. Нажмите кнопку JTAG Viewer Panel для открытия JTAG Device Viewer 

 
3. Нажмите на флажке Hide Unassigned I/P Pins, затем флажок Live Update. 
4. Теперь просмотрите выводы на ПЛИС во время работы схема. Отметим, что иконки 

LED подсвечены рядом с портами LED во время работы схемы. Также можно увидеть, что 
соответствующие выводы на символе компонента и посадочного места также подсвечены, 
что означает активность вывода. 

Добавление подчиненного листа для делителя  
Так как NanoBoard работает с частотой 50 VHz по умолчанию, нужно добавить 6 

делителей частоты, которые делят на 10 (CDIV10DC50) в схему счётчика для замедления 
отображения индикации на LED. Создадим подсхему делителя счётчика, так как подсхема 
демонстрирует, как можно использовать иерархические проекты при программировании 
ПЛИС. 

1. Откройте Johnson_Counter.SchDoc и разместите символ листа схемы для 
представления подчиненного листа, где будет использован делитель счётчика (см. рисунок 
7). Укажите Place>Sheet Symbol. Нажмите TAB в процессе размещения и введите 
позиционное обозначение, например, U_Clock_divider и имя файла, например 
Clock_divider.SchDoc на вкладке Properties диалога Sheet Symbol. Нажмите ОК для 
закрытия диалога, затем укажите позицию символа листа и нажмите для его установки. 

2. Добавьте входы листа с именами CLK_REF и CLK_OUT в символе листа 
(Place>Add Sheet Entry)  типами Input и Output соответственно. 

 
Рис. 7. Схема счётчика с символом подчиненного листа для делителя частоты. 
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3. Создайте подчиненный лист указанием Design>Create Sheet from Symbol. 
Поместите курсор поверх нового символа листа и нажмите. В диалоге Confirm нажмите No, 
так как реверсировать направления ввода-вывода не нужно. Создастся новый документ 
схемы и откроется отображение портов CLK_REF и CLK_OUT, которые добавлены 
автоматически. 

4. Теперь поместите 6 секций делителя частоты, CDIV10DC50 из FPGA Generic.IntLib, 
как показано на рисунке 8. Опять же не стоит волноваться об установке позиционных 
обозначений; просто разместите секции компонента и укажите Tools>Annotate Quiet по 
завершении. 

Рис. 8. Clock_divider с размещёнными секциями компонента и портами. 
 
5. Сохраните файлы схемы и проекта. 
6. Повторно компилируйте проект для предотвращения ошибок. Отредактируйте 

ошибки при их наличии и сохраните проект. 
 

7. После компиляции, проверьте иерархию листа в 
проекте, просмотрев панель Project; проект теперь 
рассматривает подчиненный лист 
(Clock_divider.SchDoc) как потомок схемы 
Johnson_Counter. 

   
8. Перейдите к просмотру Devices и 

перепрограммированию ПЛИС, чтобы увидеть 
замедленный вариант, который теперь достаточен, 
чтобы увидеть  работу счётчика справа налево (DIP 
переключатель 1) или слева направо (DIP 
переключатель 2). 

Добавление VHDL-файла делителя частоты 
Теперь подставим файл VHDL вместо 

схемой делителя частоты с учётом  
подчиненного листа в проекте ПЛИС. Этот 
VHDL файл теперь замедлил темп счётчика. 
Файл VHDL связан со схемой при 
использовании символа листа. Таким же образом 
можно использовать файл Verilog. 

1. Добавьте файл VHDL в проект нажатием 
на имени проекта ПЛИС в панели Project и 
укажите Add Existing Project. Выберите файл 
VHDL Clock_divider.VHD из диалога Choose 
Documents to Add Project. Этот файл доступен из 
папки Altium Designer 
6\Examples\Tutorials\Getting started with FPGA. 

Рис. 9. Файл  Clock_divider.VHD 

При создании нового файла VHDL, 
нажмите ПК на имени проекта ПЛИС и укажите 
Add New to Project>VHDL Document, введите 
следующий код, показанный на рисунке 9 и 
сохраните документ. 
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2. Теперь создадим символ листа из нового файла VHDL для замены старого, который 
ссылается схему подчиненного листа Clock_divider.SchDoc. Открыв схему 
Johnson_Counter.SchDoc, создайте новый символ листа выбрав Design>Create Sheet Symbol 
from Sheet. Укажите Clock_divider.VHD из диалога Choose Document to Place и нажмите 
ОК. Символ листа появляется как плавающий с курсором элемент. Нажмите TAB для 
отображения диалога свойств Sheet Symbol. Нажмите на вкладке Parameters для проверки 
того, что параметр VHDLEntity добавлен. Убедитесь, 
что опция Visible помечена и нажмите ОК. Нажмите в 
позиции символа листа на схеме счётчика ниже символа 
листа для Clock_divider.schdoc. 

Если файл VHDL содержит несколько входов, 
определите параметр VHDLENTITY, указав, какой 
объект вы хотите показать. 

3. Удалите символ листа для Clock_divider.schdoc и 
переместите символ листа для Clock_divider.VHD в его место на схеме. Проверьте 
правильность соединения проводниками. 

 
Рис. 10. Размещённый символ листа Clock_divider.VHD н. 

4. Сохраните схемный документ. 
5. Удалите  файл Clock_divider.schdoc из проекта ПЛИС, нажав ПК на имени 

документа в панели Project, и выберите Remove from Project. Он больше не нужен, так как 
был добавлен файл VHDL. Сохраните файл проекта ПЛИС. 

6. Наконец, убедитесь, что частота работы теперь ниже из-за задержки в файле VHDL, 
перейдите к синтезу, компоновке и программированию чипа ПЛИС. Если ПЛИС успешно 
запрограммирован, можно запустить счётчик, используя переключатели, как это делалось 
ранее. 
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Разработка встроенного программного обеспечения 
 
Эта глава предполагает, что разработчики знакомы с  C/ассемблером и имеете основные 

понятия о встроенном программировании. Она содержит обзор инструментов TASKING, 
доступным в Altium Designer. Здесь описано, как можно добавить, создать и редактировать 
исходные файлы во встроенном проекте и как скомпоновать встроенное приложение. 

Примером использования этого руководства является программа на С. Другие примеры 
содержатся в папке \Program Files\Altium Designer 6\Examples\FPGA Processors. 

С помощью встроенного программного обеспечения TASKING в Altium Designer можно 
написать, компилировать, ассемблировать и скомпоновать приложения для нескольких целей, 
таких как TSK5x/TSK52x, TSK80x, TSK165x, PowerPC, TSK3000, MicroBlaze и ARM. Рис. 1 
показывает все компоненты цепочки инструментов TASKING с входными и выходными 
файлами. 

Компилятор С, ассемблер и отладчик являются ориентированно зависимыми, в то время 
как компоновщик и библиотеки являются ориентированно независимыми. Имена в формате 
шрифта bold в следующей рисунке являются управляемыми именами инструментов. Замените 
target (цель) одним из поддерживаемых целевых имён, например, cppc является компилятором 
C для PowerPC, с3000 является компилятором С для TSK3000, as165x является ассемблером и 
т.д.  

 
Следующая таблица содержит список файлов, используемых в цепочке TASKING. 
 

Расширение Описание 
 Исходные файлы 

.c Исходные файлы на языке С, входные для компилятора С 
.asm Ассемблерный исходный файл, ручное кодирование 
.lsl Скомпонованный файл 

 Генерируемые исходные файлы 
.src Ассемблерный исходный файл, генерируемый компилятором С, не 

содержащий макросы 
 Объектные файлы 

.obj Перемещаемый объектный файл, генерируемый ассемблером 
.lib Архив объектных файлов 
.out Перемещаемый скомпонованный выходной файл 
.abs Абсолютный объектный файл IEEE-965 или ELF/DWARF 2, генерируемый 

локальной частью компоновщика 
.hex Абсолютный Intel Hex объектный файл 
.sre Абсолютный Motorola S-record объектный файл 

 Списочные файлы 
.lst Ассемблерный списочный файл 

.map Файл карты компоновщика 
.mcr MISRA C файл отчёта 
.mdf Файл определения памяти 

 Файлы ошибок 
.err Файл ошибок компиляции 
.ers Файл ошибок компилирования 
.elk Файл ошибок компоновщика 

Таблица 1. Расширения файлов 
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Рис. 1. Обзор цепочки инструментов 
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Создание встроенного проекта 
Для начала работы с Altium Designer, во-первых, нужно создать проект. Проект  делает 

управление исходными документами и любыми генерируемыми выходными данными 
сравнительно лёгким. Для встроенного программного обеспечения, необходимо создание 
проекта Embedded Software (встроенное программное обеспечение). 

Для создания нового такого проекта: 
1. Выберите File>New>Project>Embedded Project из 

меню, или нажмите Blank Project (Embedded) в рамке New 
панели Files. Если эта панель не отображается, нажмите на 
вкладке Files в нижней части панели Design Manager. 

С другой стороны, можете выбрать Embedded Software 
Development в рамке Pick a task домашней страницы Altium 
Designer (View>Home) и затем выбрать New Blank Embedded 
Software Project. 

2.   Откройте панель Project. Новый проектный файл 
Embedded Project1.PrjEmb присутствует здесь без добавленных документов. 

3. Переименуйте новый файл проекта (с расширением .PrjEmb) выбрав File>Save Project 
As.  Откройте директорию, в которой необходимо сохранить проект на жёстком диске, введите 
GettingStarted.PrjEmb в поле имени файла и нажмите Save. 

Добавление новых исходных файлов в проект 
Если нужно добавить в проект новый исходный файл (на языке С, ассемблере или простой 

текстовый файл), сделайте следующее: 
1. В панели Project нажмите ПК на GettingStarted.PrjEmb и укажите Add New to Project>C 

File. Новый С исходный файл Source1.C добавляется в проект Embedded Software в папке с 
именем Source Documents на панели Projects. Откроется текстовый редактор, готовый для  
ввода.  

2. Введите  требуемый исходный код. Для этого руководства введите следующий код: 
 #include <stdio.h> 
 void main(void) 
 { 
  printf(”Hello World!\n”); 
 } 
3. Сохраните исходный файл командой File>Save As. Просмотрите жёсткий диск и 

выберите место для исходного файла, введите имя hello.c в поле имени файла и нажмите Save.  
4. Сохраните проект нажатием ПК на GettingStarted.PrjEmb в панели Project и укажите 

Save Project. 
 Теперь проект выглядит так: 

 

Добавление существующих исходных файлов в проект 
Если необходимо добавить существующий исходный файл в проект, выполните 

следующее: 
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1. В панели Project нажмите ПК на имени проекта и укажите Add Existing to Project. 
Появится диалог Choose Documents to Add to Project.  

2. Найдите файл, который необходимо добавить в данный проект и нажмите Open. 
3. Исходный файл добавляется в проект и появляется в списке на панели Projects. Дважды 

нажмите ЛК на имени файла для его просмотра или редактирования в текстовом редакторе. 
4. Сохраните проект (нажмите ПК на имени проекта на панели Project и укажите Save 

Project). 

Установка опций встраиваемого проекта 
Встраиваемый проект в Altium designer имеет набор встраиваемых опций, связанных с ним. 
После добавления файлов в проект, и записи приложения (например, Hello.C в данном 

примере), следующими шагами в процессе построения встроенного приложения являются: 
• Выбор конфигурации (отражающиеся в связанной инструментальной цепочке) и 

выбор целевого процессора 
• Выбор опций  инструментов в цепочках, таких как опции С-компилятора, 

ассемблера и компоновщика. (Различные конфигурации инструментальных цепочек могут 
иметь различные наборы опций). 

Выбор целевого процессора  
Для встроенного проекта, сначала необходимо определить конфигурацию и тип 

процессора: 
1. На панели Project нажмите ПК на GettingStarted.PrjEmb и укажите Project Options. 

Как вариант, укажите Project>Project Options в меню. 
Появится диалог Option for Embedded Project. 

 
2. На вкладке Compiler Option, укажите Configuration (например, TASKING 

TSK51x/TSK52x). 
3. В левой части панели раскройте запись Processor Definition. 
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4. В правой части панели раскройте запись General и установите Select processor для 

корректного целевого процессора (например, TSK51A). 
5. Щелкните ОК для подтверждения нового целевого процессора. 

Установка опций инструмента 
Встроенные опции можно установить общие для всех файлов в проекте и так же можно 

установить специальные файловые опции. 
Установка расширенных проектных  опций 
1. На панели Project нажмите ПК на GettingStarted.PrjEmb и укажите Project Options. 

Как вариант, укажите Project>Project Options в меню. 
      Появится диалог Option for Embedded Project. 
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2. В левой части панели раскройте запись C Compiler. Эта запись содержит несколько 
страниц, где можно переназначить установки С компилятора. 

3. В правой части панели, установите опции для желательных значений. Сделайте это 
для всех страниц. 

4. Повторите шаги 2 и 3 для других инструментов, таких как ассемблер и компилятор. 
5. Нажмите ОК для подтверждения новых установок. 
 
На основе опций встроенного проекта, Altium Designer создаёт так называемые makefile, 

которые он использует для построения встроенного приложения. 
На странице Miscellaneous для каждого входа инструмента, поле Command line options 

показывает, как установки транслировать в опции командной строки. 

Установка опций для индивидуального документа 
1. На панели Projects нажмите ПК на hello.C и укажите Document Option. Как вариант, 

укажите Project>Document Option из меню. Появится диалог Option for Document. 
Шаги 2-5 повторяют аналогичные для расширенных проектных опций. Вкладка Files With 

Option в диалоге Option for Embedded Project показывает, какие файлы имеют отличные 
установки. Если нажать ПК на файле этой вкладки, меню предоставит функции для 
копирования опций из и в другие индивидуальные файлы. 

Формирование  встроенного приложения 
 
Теперь проект готов к формированию встроенного приложения 
1. Укажите Project>Compile Embedded Project GettingStartrd.PrjEmb.  Построитель 

программ TASKING компилирует, ассемблирует, компонует и помещает файлы во встроенный 
проект, который является устаревшим или который был изменён в процессе предварительного 
построения. Результирующий файл является абсолютным объектным файлом GettingStarted.abs. 

2. Результаты построения можно просмотреть на панели Output 
(Panels>System>Output). 

 

Компиляция единственного исходного файла 
Если нужно компилировать единственный исходный файл: 
1. Нажмите ПК на файле (hello.c) для компиляции и укажите Compile Document hello.c. 

Как вариант, можно открыть файл в текстовом редакторе и укажите Project>Compile Document 
hello.c. 

2. Откройте панель сообщений для просмотра любых ошибок, которые могут появиться 
при компиляции указанием View>Workspace Panel>System>Messages на вкладке Panels. 

3. Исправьте любые ошибки в исходных файлах. Сохраните исходные файлы. 

Повторная компоновка всего приложения 
Если нужно скомпоновать встроенное приложение из эскиза, независимо от штампа 

времени и даты, можно выполнить рекомпиляцию: 
1. Укажите Project>Compile Embedded Project GettingStartrd.PrjEmb .  
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2.  Построитель программ TASKING компилирует, ассемблирует, компонует и 
помещает файлы во встроенный проект. 

Теперь можно отладить результирующий абсолютный объектный файл GettingStarted.abs. 

Отладка встроенного приложения 
Когда имеется построенное  встроенное приложение, можно начать отладку абсолютного 

объектного файла с помощью моделирования. 
Для начала отладки, имеется одна или несколько исходных строк для управления: 
• Выберите один исходный уровень или уровень опций  пошаговых инструкций  

(Debug>Step Into, Step Over) для пошагового выполнения исходного файла или укажите 
Debug> Run для прогона моделирования. 

Голубая строка указывает текущую выполняемую команду 
Для просмотра большей информации об элементах, таких как регистры, локальные метки, 

памяти или точки остановки, откройте различные рабочие панели: 
• Выберите View>Workspace Panels>Embedded >> (a_panel). 
Для завершения сессии отладки: 
• Укажите Debug>Stop Debugging. 

Задание точек остановки 
Когда открыт исходный встроенный файл, можно установить точки остановки. Маленькие 

голубые точки указывают, где можно поставить точки остановки: 
• Нажмите на левом крае рядом с исходной строкой программы для введения или отмены 

точки остановки. 
Точка остановки маркируется красным кружком с крестом. 
Для изменения свойств точек остановки: 
• Для изменения точки остановки, нажмите ПК на ней и укажите Breakpoint Properties... 
Для активации или отмены точки остановки: 
• Включите точку остановки и укажите Disable Breakpoint (или Enable Breakpoint, если 

она отменена) 
Отменённая точка остановки маркируется зелёным цветом. 
Панель точки остановки даёт обзор всех (отключённых) точек остановки и их свойств: 
• Укажите View>Workspace Panels>Embedded>Breakpoints. 

Вычисление выражений 
Имеется возможность проверить значение выражения на панели Evaluate. 
1. Укажите View>Workspace Panels>Embedded>Evaluate для открытия панели 

Evaluate. 
2. В поле редактирования введите выражение, которое нужно вычислить и нажмите 

Evaluate. Выражение и его значение появятся ниже на панели Evaluate.  Для постоянного 
слежения за выражением, необходимо установить watch: 

3. Укажите Add Watch 
Новое выражение и его значение появляются на панели Watch. 
Альтернатива: Укажите Debug>Add Watch;  введите выражение и нажмите ОК. 
Способность вычисления выражения сильно зависит от общей отладочной информации в 

объектном файле. На успешность отладки также влияет уровень оптимизации. 
 

Просмотр памяти 
Имеется возможность просматривать содержимое памяти. Можно открыть несколько окон 

памяти. Но помните, что нужно находиться в режиме отладки. Тип окна памяти, которое можно 
открыть, зависит от выбранного целевого процессора. 
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Откроем  для примера программное окно памяти: 
1. Укажите View>Workspace Panels>Embedded>Program Memory. 
Откроется окно памяти программы, показывающее содержание кодов в памяти. 
2. В поле редактирования можно указать адрес, с которого нужно начать просмотр. 
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Переход в Altium Designer из Protel 99SE 
 
Protel 99 SE использует  проектную базу данных или DDB для хранения проектных 

файлов. Altium Designer хранит файлы на жёстком диске и теперь содержит концепцию Project. 
99E Import Wizard (добавленный в сервис пакет 2) предоставляет контроль и обзор процесса 
импортирования проектной базы данных 99SE в Altium Designer. 

 
Protel 99 SE сохраняет все проектные документы в пределах единой проектной базы 

данных. База данных действует как контейнер памяти, а также как способ, с помощью которого 
проектировщик может группировать связанные с проектом файлы. 

Нет жёстких и широких требований, что же хранится в проектной базе данных, или как 
могут быть сгруппированы проектные документы в папки в пределах DDB. Некоторые 
проектировщики используют единственную DDB для каждого проекта платы, другие сохраняют 
все варианты проекта в единственной DDB, в то время как третьи сохраняют все проекты плат 
для одного продукта в единственной DDB. 

В Altium Designer все проектные файлы сохраняются на жёстком диске. Базисом каждого 
проекта, созданного в Altium Designer, является проектный файл. В этой среде поддерживается 
множество типов проектов, в том числе: 

• Проекты платы (*.PrjPcb) 
• Проекты ПЛИС (*.PrjFpg) 
• Встроенные проекты (*.PrjEmb) 
• Ядра проектов (*.PrjCor) 
• Интегрированные библиотеки (*.LibPkg) 
• Подлинники проектов (*.PrjScr) 
 
Не касаясь подлинников проектов, фундаментальным требованием является то, чтобы 

каждый проект, был ориентирован на одну реализацию – например, проект платы содержал все 
исходные данные, требуемые для определения единственной платы, а проект ПЛИС был 
осуществлён на единственной ПЛИС. Сам по себе проектный файл является ASCII файлом, 
который хранит проектную информацию, такую как связующие звенья с документами, которые 
являются проектом, выходными установками, установками компиляции, установками контроля 
ошибок и т.д. 

Выше уровня проекта, Altium Designer использует Design Workspace (Группа проектов). 
Эта группа (.DsnWrk) используется для объединения связанных проектов вместе, так, чтобы вы 
могли использовать Design Workspac для всех проектов одного клиента, все платы в одном 
продукте и т.п. Когда вы открываете Design 
Workspac, все проекты, которые входят в эту 
рабочую область появляются на панели Projects. 

Рис. 1. Переопределение объектов из 99 
SE в эквивалентные объекты Altium 

Designer. 

На рисунке 1 показано переопределение по 
умолчанию из проектной базы данных 99 SE в 
эквивалентные объекты в Altium Designer; для DDB 
создаётся создается группа проектов, для каждой 
папки создается проект платы, которая содержит 
файл платы и Library Package для каждой папки, 
которая содержит только библиотеки. В процессе 
импорта, вы имеете возможность изменить все 
переопределения, за исключением DDB для группы 
проектов. 

Чтобы Altium Designer позволял 
непосредственно редактировать любые отдельные 

 226



 

схемы, платы, HDL или любые другие проектные файлы, для выполнения любых операций 
проектного типа, таких как обновление платы из схемы или распечатки всех схем в проекте, вы 
должны открыть проект. 

Protel 99 SE системные файлы Windows также могут импортироваться. Используйте Import 
Wizard 99 SE таким же путём, как вы можете это делать с Access Database DDB. 

Импортирование проектной базы данных 99 SE 
Для импорта базы данных 99 SE, укажите File>Import Wizard из меню. Затем выберите 

99SE DDB Files из списка импорта на второй странице помощника. Процесс импорта требует, 
чтобы все файлы, проекты и группы проектов, которые были открыты как текущие, должны 
быть закрыты. Если это не случилось, вы получите предупреждение, чтобы это сделать сначала. 

Import Wizard может быть использован для импорта единственной DDB, или он может 
быть использован для импорта DDB в папке, но эта статья основана на импорте единственной 
DDB. 

Помощник выполняет следующие шаги: 
1. Выделяет файлы из базы данных в номинированной папке на жёстком диске. 

Любая структура в пределах базы данных будет создана вновь на жёстком диске. Все файлы в 
базе данных будут выделены, независимо от того, являются они частью проектной структуры 
или нет. 

2. Конвертирует схемную документацию в файл текущего формата (если эта опция 
активна). 

3.  Добавляет распознаваемые расширения файлов ко всем файлам схем и плат. 
Altium Designer использует расширения файлов для распознавания документов при 
редактирования. Для схемы, таким расширением 
должны быть Sch, SchDoc или оригинальные DOS 
схемные S01, S02 и так далее. Если имеется схема 
внутри DDB, которая не имеет расширения, .SchDoc 
будет добавлено к имени файла. Отметим, что это не 
прервёт иерархию, компилятор Altium Designer будет 
автоматически выявлять эту ситуацию и выполнять 
проектную иерархию и связанность. Отметим, что 
файлы без стандартных расширений Altium не будут 
автоматически переименованы. 

Рис. 2. Пример импорта DDB. 
Отметим имя группы проектов 
наверху. Оно будет таким же, как и 
оригинальное имя DDB. 

4.  Создаёт проектный файл для каждого 
номинированного проекта, типа PrjPcb (проект 
платы) или LibPkg (пакетная библиотека) и добавляет 
правильные проектные файлы. 

5.  Создаёт группу проектов (DsnWrk)  и 
добавляет все созданные проекты для неё. 

6. Открывает группу проектов. При 
открытии группы проектов, в ней будут отображаться 
Проекты Altium Designer, которые были построены. 
Рис. 2 показывает результат импорта проекта Z80 
микропроцессора, который помещён в папку Protel 99 
SE\Examples. 

 

Создание проекта или проектов Altium Designer 
Так как работа ведется на страницах помощника, то стоит обратить внимание, что на 

странице Set Import Option задается вопрос, как формировать проект и предлагается два 
варианта: 
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o Create one Altium Designer project for each DDB –  укажите эту опцию, если для 
каждого проекта платы используется один DDB . 

o Create one Altium Designer project for each DDB folder – укажите эту опцию, если 
DDB проект содержит более чем один проект платы. 

 
Выберите тот вариант, который больше подходит для использованного проекта DDB. Это 

настройка очень удобна для дальнейшей настройки структуры проекта  в окне  Review Project 
Creation следующего шага помощника. 

 
Рис. 3. Используйте опции Review Project Creation для точного контроля, преобразования 

файлов в проект Altium Designer. 
 
На странице Review Project Creation показаны предположения, которые помощник 

использует, когда он будет создавать проекты на основе содержимого DDB. Выделите время для 
настройки этих опций для уверенности достижения лучших результатов в конце процесса 
импорта. 

Ручное добавление и удаление файлов в проектах 
После окончания работы помощника, Altium Designer представит проекты и их документы, 

как показано на рисунке 4. Отметим, что иерархия схемных проектов не будет отображена, пока 
проект не будет откомпилирован в первый раз; это рассматривается позже в данном разделе. 

Если после импорта было обнаружено, что некоторые документы не совсем корректно 
присвоены проекту, используйте следующие способы для корректирования: 

• Перенесите файл из одного проекта в другой, захватив его нажатием ЛК и перетаскивая 
по структуре проекта, или включите его в оба проекта удерживая Ctrl,  при перетаскивании. 

• Удалите документ из проекта нажатием ПК и выбором Remove from Project в 
контекстном меню. 

• Добавьте недостающие файлы, нажатием ПК на файле проекта и выбрав Add Existing to 
Project из контекстного меню. Помните, что документ должен иметь соответствующее 
расширение файла для его распознавания как файла Altium Designer. 

• Для добавления нового файла в проект, нажмите ПК на имени проекта и укажите Add 
New to Project из контекстного меню. 
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Рис. 4. Пример Z80 DDB сразу после импорта. Заметим, что начальная DDB имел два проекта 

РСВ сохранённых в базе данных и каждый становится проектом Altium Designer. 
 

Поддержка проектов Protel 99 в Altium Designer 
 

Изменение формата файла 
Форматы файлов схемы и платы, библиотек символов и посадочных мест отличаются от 

форматов, используемых в Protel 99 SE. 
Формат файлов схемы и библиотеки символов можно открыть и использовать 

непосредственно в Altium Designer, но система запросит о необходимости конвертировать их 
каждый раз перед их сохранением. 

Файлы плат 99 SE должны быть конвертированы в формат файла Altium Designer перед 
тем как они будут доступны для редактирования. Каждый раз при открытии старого формата 
платы, будет запущен помощник (PCB Import Wizard). 

Ниже рассматриваются типичные случаи импорта различных объектов и различных 
подходов, на которые стоит обратить внимание. 

Компоненты 
Компоненты играют большую роль в версиях DXP. Они теперь поддерживают 

неограниченное число параметров компонентов, и содержат улучшенные модели определений и 
систему связности, такие как возможность визуального обзора посадочных мест. 

Дважды нажмите ЛК на редактируемом компоненте и сможете обнаружить, что текстовые 
поля и поля секций компонента конвертированы в параметры. В то время как 99 SE 
поддерживает до 8-ми текстовых полей и 16 секций компонента, Altium Designer не имеет 
ограничений по числу вводимых параметров. 
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Параметры могут быть использованы для любых целей в проекте Altium Designer. Они 
могут также быть связаны с базой данных компании, с помощью документа DbLink. Параметры 
могут быть включены в отчёт, генерируемый из проекта. Добавьте документ OutJob в проект и 
конфигурируйте механизм отчёта для формирования отчёта в требуемом выходном формате. 
Параметры также могут быть использованы для связи с таблицами Excel или с сайтом 
Интернета. 

Библиотеки 
Altium Designer имеет исчерпывающее решения для манипулирования библиотеками. Так 

же как поддержание традиционных библиотек независимых схемных символов и посадочных 
мест, Altium Designer также поддерживает новые интегрированные библиотеки, которые 
упаковывают символы и все модели в единственный  компилированный файл.  

В отличии от 99SE, где используемые компоненты доступны ограниченным списком 
установленных библиотек, в Altium Designer любые библиотеки, которые являются частью 
проекта автоматически доступны и поддерживается поиск секций всех моделей. 

Поиск по установленным библиотекам осуществляется в последовательности их 
расположения в диалоге Available Libraries. Этот диалог также показывает, что проектные 
библиотеки доступны и что пути поиска проекта определены. Заметим, что процесс поиска для 
компонентов и моделей в пространстве трёх различных позиций соответствует порядку вкладок 
в этом диалоге. 

 
Рис. 5. Диалог Available Libraries показывает все доступные библиотеки и файлы моделей в 

активном проекте. Порядок поиска – слева направо и сверху вниз. 
 

Ссылки и уникальные идентификаторы 
Как в 99 SE, так и в Altium Designer, уникальные идентификаторы (Unique ID или UID) 

имеют значения, которые позволяют объектам схем и плат сохранять взаимные ассоциации, 
когда их позиционные обозначения компонентов модифицированы в одном редакторе.  

Стоит отметить, что все ссылки между компонентами схемы и платы изменяются, при 
импорте проекта 99 SE. Переустановка ссылок UID является лёгкой, но должна быть выполнена 
на основе позиционных обозначений. 

Во-первых, установите значения UID со стороны схемы, указав Tools>Convert>Reset 
Component Unique IDs  из меню схемного редактора. Затем со стороны платы, подберите пары 
компонентов с посадочными местами в диалоге Component Links (Project>Component Links в 
меню редактора плат). Полная синхронизация базы данных 99 SE может быть выполнена таким 
образом за два нажатия ЛК. Во-первых, добавьте пару сравнимых обозначений (при корреляции 
по умолчанию), а затем выполните обновление. 
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Основное различие между Altium Designer и 99 SE является в том, что ссылки не являются 
предпосылкой для синхронизации. Если, например, пропустить последовательность, описанную 
выше и просто попытались прогонять команды обновления/импорта в проекте платы, который 
был импортирован в Altium из 99 SE, то будет выдано сообщение, что синхронизация с 
помощью UID нарушена, но можно работать по соответствующим позиционным 
обозначениями. Присвоение одинаковых значений UID для схемных компонентов и посадочных 
мест является единственным путём для создания устойчивых ссылок между ними. 

Область действия идентификаторов цепей 
После импорта может быть уместным присвоить область действия идентификации 
определенной цепи в схемном проекте. По умолчанию, такие установки в Option for Project  
будут автоматическими (на основе содержания проекта). Это означает, что если проект 
содержит любые символы листов с входами в лист внутри, эти границы будут установлены для 
иерархии (sheet entry <-> port connections). Если проект содержит порты, но нет входов на лист, 
тогда границы будут установлены для плоского проекта (only ports global). Если же проект 
содержит и входы на лист, и порты, тогда метки цепей становятся глобальными. 

Если не нужно использовать автоматическое определение, то можете просто присвоить 
индивидуальные ограничения, применённые в проекте, независимо от его содержимого. Такой 
порядок рекомендован для проектов 99 SE, который использует глобальный диапазон для 
портов и для меток цепей, в результате чего эти границы недоступны для их автоматического 
определения в Altium Designer. 

Отметим, что Altium Designer также поддерживает плоские проекты, без использования 
схемного листа верхнего уровня. Для исследования этой опции, попытайтесь удалить верхний 
лист из плоского проекта и рекомпилировать его. Панель Navigation в Altium Designer покажет 
структуру соединений в проекте, где можно легко исследовать проектную связность. 

Помощник импорта плат  
При первом открытии унаследованной платы в Altium Designer, помощник импорта (Import 

Wizard) поможет выполнить присвоения для контура платы, разбивки экранов и 
конвертирование определенных правил. 

Контур платы 
Все проекты платы в Altium Designer требуют изображения контура платы. Так как в 

ранних версиях Protel этого не требовалось, оно должно быть добавлено на плату, после 
импорта из предварительных версий. 

Import Wizard предлагает вам 2 опции: прямоугольную форму, охватывающую все 
компоненты на плате или более точный контур платы, на основе формы, определённой в 
проекте. При выборе последней опции, механические слои, и слои зон запрета будут 
проанализированы по их виду, которые могут создавать форму для контура платы. Какая бы 
опция не была выбрана, будут представлены предварительные участки предполагаемой формы 
платы. Если ни одна из них не являются корректной, то будет выбрана опция прямоугольника, и 
далее нужно будет использовать опцию меню Design>Board Shape для настройки  формы платы 
в Altium Designer. Форма платы определяет физическое пространство платы и определяет 
контур как препятствие для внутренней металлизации (экранов). Поскольку экраны имеют 
негативное отображение, контур платы создаёт тонкую зону (без металлизации) между краем 
платы и металлизированным экраном, препятствуя коротким замыканиям между краем платы 
при её изготовлении. Эти трассы недоступны для прямого редактирования на экранных слоях, 
но форма платы может быть переопределена в Altium Designer в любой момент и  препятствия 
будут переопределены соответственно.  
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Разбивка экранов 
В Altium Designer изменен способ разделения экранов. Первоначально, каждая область 

раздельных экрана помещалась как  замкнутый регион (по существу пустой полигон) на 
внутреннем экранном слое. В отличие от этого, разделенный экран в различных областях в 
Altium Designer получается разрывом (зоны свободной меди) с помощью линий, дуг и 
заливками на экранном слое. Каждый раз при завершении процесса на экранном слое, экран 
анализируется, и определяются все изолированные участки. Двойное нажатие ЛК на участке 
привязывает его к цепи. Эти разорванные участки не принадлежат одному или другому 
разделенному полигону; проекты в Altium Designer больше не требуют перекрытых или точно 
выровненных сегментов трасс вдоль смежных размещённых экранов. Altium Designer также 
поддерживает задание вложенных разделенных участков полигона. 

Из этого правила имеется одно исключение – Import Wizard РСВ позволяет управлять в 
режиме наследования разделенного экрана. При этом рекомендуется только выбрать этот 
режим, если вы столкнулись с проблемами импорта экранов в проект, или если плата содержит 
разделенные  экраны, которые потребуют дальнейшего редактирования в ранних версиях. 
Позднее можно конвертировать проект в режим экрана Altium Designer; между тем, новые 
разделенные экраны должны быть помещены как замкнутые границы на внутренних экранах. 

При конвертировании проекта с помощью этого нового метода, вы получите возможность 
упростить задание разделенного экрана. Это не обязательное действие, так как наследуемые 
разделенные экраны будут, тем не менее, работать в Altium Designer, но они могут содержать 
излишние линии, которые сделают плату технологически более сложной, что нежелательно. 
Более лёгкий способ обновить определения разделенного экрана  99 SE в Altium Designer – 
добавить новый экранный слой, затем растрассировать существующий участок на новом экране. 
После этого, выберите все объекты на старом экранном слое и удалите их. После того, как цепи, 
связанные с этим слоем будут отсоединены, слой может быть удалён из стека слоёв. Наконец, 
проверьте, что присвоенные  цепи для каждого отделённого региона присвоены корректно, либо 
дважды нажмите ЛК на каждом участке полигона, либо используйте редактор Split Plane на 
панели РСВ. 

Маршруты  
Линии связи, которые были заданы между определенными КП в 99 SE должны быть 

переопределены в Altium Designer, поэтому переключите панель РСВ Altium Designer в режим 
редактора From-To чтобы выполнить это. 

Правила проектирования 
 
Другое изменение в Altium Designer касается границ правил проектирования, которые 

теперь определяются с помощью запросов. Все установленные правила будут корректно 
импортированы, но область действия, которая была первоначально создана как серия 
диалоговых вкладок и выпадающих вариантов, будет отображаться как простой запрос, такой 
как InNet(GND). Для задания правил относящихся ко всей плате, вид по умолчанию может быть 
сохранён. 

Когда проект платы из любого предыдущего формата Protel открывается в Altium Designer, 
эта конверсия правил будет появляться автоматически, и будет сохранена приоритетность 
правил (для разрешения случаев, в которых они перекрываются). Эта новая система, 
объединённая с возможностью контроля прецедентов правил, предлагает значительно больший 
контроль специфических требований к проекту платы. 

Специальные правила конвертации 
Некоторые старые версии Protel не позволяют установки КП, для преодоления общих 

правил увеличения размера маски, означающее, что некоторые старые проекты могут иметь 
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правила расширения маски или пайки, которые нацелены только на единственную КП. 
Помощник импорта будет обнаруживать любые такие правила в проекте и предложит 
конвертировать их в установку для КП, таким образом, упрощая набор правил проектирования. 
С другой стороны, помощник предложит создать новое правило отключения ПО от экранов, так 
как некоторые старые версии Protel не разрешают соединения через экран. 

Ссылки и конфигурации моделей для систем моделирования  
Специальные поля в компонентах 99 SE зарезервированы для данных моделирования. 

Когда эти поля содержат данные для моделирования, Altium Designer транслирует их значения в 
пакет моделей для этого компонента. 

В 99 SE  все модели были собраны в SimulationModels.ddb, создаваемого при инсталляции. 
С другой стороны, Altium Designer позволяет включать модель в проект, или определять путь 
для проекта, если модели предварительно сохранены в определенном месте. Другой подход 
состоит в построении интегрированных библиотек, при этом модели компилируются в 
интегрированный библиотечный файл совместно с символом, посадочным местом или любыми 
другими моделями, связанными с компонентами. 

Поскольку для связи схемного компонента с моделью,  компоненты 99 SE используют 
заданный путь к модели, самый лёгкий способ сохранить работы по моделированию из 99 SE в 
Altium Designer состоит в экспорте всех папок и моделей из базы данных моделей 99 SE в папку 
\Altium Designer 6\Library\. 

Altium Designer поддерживает ссылки моделей, используя полный путь. Когда схема 99 SE 
с готовыми для моделирования компонентами в ней, импортируется, связь моделей 
автоматически передаётся в поле Full Path Model Location в Altium Designer. Altium Designer 
включает внутренний контроль для всегда активной папки \Altium Designer 6\Library\, когда 
разыскивается полный путь к расположению моделей, чтобы убедиться, что проект 99 SE будет 
использовать при моделировании модели компонентов из их нового места расположения. 

В 99 SE установки в диалоге Analysis Setup сохраняются в файле конфигураций (.cfg) в базе 
данных. Когда Altium Designer впервые моделирует проект, если специальные установленные 
параметры не были конфигурированы, то скорее всего будет использован конфигурационный 
файл .cfg.  При сохранении нового проект Altium Designer, установки моделирования будут 
записаны в проектный файл и старый файл .cfg станет излишним. 

Для полной информации по схемному моделированию, см. файл Defining & running Circuit 
Simulation analyses. 

 

Мультиканальные проекты  
Данные проекты плат, требуют наибольшего внимания. 
В 99 SE, многоканальные проекты были реальным материалом для создания копий листа, 

которые затем повторно аннотируют и упоминают для  отдельных листовых символов. Теперь, 
когда Altium Designer позволяет корректно ссылаться на те же листовые символы многократно, 
возникает необходимость в модификации схемы. Во-первых, удалите все кроме одной копии 
подчиненных листов из проекта. Затем, обновите соответствующие листовые символы с 
определёнными именами, но все ссылающиеся на один оставшийся порождённый лист.  

Разумная стратегия, состоит в удалении всех, кроме единственного листового символа для 
каждого канала, и замене его поля для имени в соответствии с синтаксисом команды Repeat. 
Таким образом, ряд каналов может быть модифицирован в любой момент простым изменением 
только одного поля. Команды повторения можно также применить к цепям; для примера 
смотрите проект Multi-Channel Mixer.PrjPcb. 

Имеется много свойств, касающихся многоканального проекта, содержащих возможность 
передачи канальной информации для шаблона платы, размещения и трассировки одного канала, 
а затем программы повторения и трассировки всех других каналов. Для более полной 
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информации о работе с мультиканальным проектом, см. руководство Creating a Multi-channel 
Design. 

 

Вывод данных проекта 
Файлы  99 SE CAM Manager (.cam) и Power Print Configuration (.ppc) не распознаются 

системой Altium Designer, поэтому выходные данные необходимо реконфигурировать для 
импортируемых проектов. 

В Altium Designer, имеется два подхода к конфигурированию выходной информации: 
установкой заданий с помощью меню редакторов схем и плат и сохраняемых в файле проекта, 
или же можно добавить  выходной файл работы (.OutJob) в проект (нажмите ПК на файле 
проекта и укажите Add New to Project из контекстного меню). Добавить в проект можно любое 
число файлов выходных документов (Output job), и конфигурировать для них установки печати 
и САМ. При добавлении нового файла OutJob в проект, он будет содержать ряд установок 
работы по умолчанию. Они все могут быть удалены выбором их (Ctrl+A) и нажатием клавиши  
Delete. 

Передача проекта обратно в 99 SE  
Как редактор схемы, так и редактор плат поддерживают сохранение схемы, библиотеки 

символов, платы и бинарные файлы РСВ в формате V4 (99 SE). Данные, которые нельзя 
передать обратно, содержат: 

• Новые объекты схемы, включая примечания, маски компиляции, параметрические 
установки объектов и межлистовые соединители. 

• Новые объекты платы, включая сплошную заливку полигонов (старые стили штриховки 
полигона могут быть переданы), контуры платы, размерные цепи и сложные стеки КП. 

•  Правила проектирования, которые невозможно обратно переопределить в проектные 
правила 99 SE. 

• Раделенные определения экранов (Altium Designer вычисляет раделенныеучастки на 
основе объектов, размещённых на экранных слоях; невозможно использовать пустые полигоны 
для создания разделенного участка). 
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Переход в Altium Designer из P-CAD 2006 
 
Выбор Altium Designer - это переход на платформу, предлагающую единственное, 

унифицированное приложение, которое содержит все технологии и возможности, 
необходимые для комплектной разработки электронного изделия. Но перед началом 
проектирования электронного изделия, возникает необходимо передать существующие 
наработки схем, плат и, что наиболее существенно, библиотек P-CAD в среду Altium 
Designer. Разделы данной главы помогут быстро освоить отличие основ проектирования и 
дадут определения ключевых отличий подходов Altium Designer от P-CAD. 

Передача проекта P-CAD  
Начало работы состоит в трансляции файлов P-CAD ASCII с расширением PCB, SCH и 

LIA (библиотека), которые невозможно не облегчить с помощью помощника импорта в 
Altium Designer. Помощник импорта снимает головную боль, организуя и анализируя файлы 
и предлагая множество деталей и установок для структуры проекта, переопределения слоёв, 
именования посадочных мест и так далее. Полная гибкость обнаруживается на всех страницах 
помощника, где пользователю предлагается как минимум или как максимум контроль всех 
файлов, перед  выполнением действительной трансляции. 

Трансляция файла 
Файлы в помощнике импорта транслируются следующим образом: 
• Файлы плат P-CAD (*.pcb) будут транслироваться в файлы платы Altium Designer 

(*.pcbdoc). 
• Файлы схем P-CAD (*.sch) будут транслироваться в файлы схем Altium Designer  

(*.schdoc). 
• Эти два типа файлов будут сгруппированы в проекты платы Altium Designer (*.prjpcb), 

которые будут созданы автоматически. 
Файлы библиотек P-CAD (*.lia) транслируются следующими способами: 
• Библиотеки, которые содержат информацию о корпусе будут транслированы  в 

исходный файл библиотеки посадочных мест (*.pcblib). 
• Библиотеки, которые содержат информацию о символе, будут транслированы  в 

исходный файл библиотеки символов (*.schlib). 
• Библиотеки, которые содержат как корпусную, так и символьную информацию, будут 

транслироваться в оба библиотечных файла (*.pcblib) и(*.pcblib). 
Транслированные библиотеки P-CAD  автоматически группируются в интегрированные 

библиотечные проекты. Однако они автоматически не транслируются как Altium Designer 
интегрированные (компилированные) библиотеки. Для создания интегрированной 
библиотеки из интегрированного библиотечного проекта, нужно сделать это вручную на 
панели Project  через командный процесс Compile Project. 

Использование Import Wizard для файлов P-CAD 
Помощник импорта Import Wizard доступен из меню File. Просто выберите это 

командное меню для вызова помощника, как показано ниже на рисунке 1. Меню ПК мышки 
доступно для дальнейшего контроля всего трансляционного процесса на каждой странице 
помощника. 
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Рис. 1. Вид запущенного помощника Import Wizard из меню File. 

 

Среда Altium Designer 
Возможно, единственное значительное отличие, сразу бросающееся в глаза, является то, 

что одно приложение используется для создания и редактирования всех проектных файлов, 
независимо от типа файла (схема, плата и т.д.). В дальнейшем нет необходимости 
переключаться между различными приложениями, когда необходимо перейти от просмотра 
файла платы к схеме. Среда Altium Designer предлагает полную комплектную среду всех 
областей проекта – от захвата схемы до генерации выходных данных платы и разработки 
ПЛИС. Этот интегрированный подход является очень удобным, но имеет существенные 
различия для разновидностей шаблона платы, которые являются первичным инструментом 
разработчика плат относительно возможностей захвата. 

Имеется некоторая базисная терминология, которую необходимо знать, для того, чтобы 
комфортно ориентироваться с самого начала работы. 

Работа с документами  
В P-CAD  все проектные работы начинают в рабочей области, логической рабочей зоны 

проекта. Здесь может быть множество схемных проектов (известных как листы) в пределах 
единого схемного проектного файла P-CAD. В Altium Designer однако, логическая схемная 
зона начинается с документа и он является эквивалентом только одного схемного листа для 
файла документа, что является важным концептуальным отличием, которое надо помнить. 

Здесь также может быть несколько проектных документов различных типов, в 
зависимости от существа проекта. Начиная работу, большинство пользователей P-CAD будут 
заинтересованы в документах схемы и платы, поскольку они являются файлами, в которые 
будут транслированы их проекты (см. рис. 2). 

Новые типы документов схем и плат могут быть легко созданы на панели Files  или в 
меню File>New. 

Рабочие панели 
Многие элементы среды  первоначально являются интуитивно понятными 

пользователям P-CAD и помогут быстро начать эксплуатацию системы. Например, панель 
Projects выглядит аналогично панели Design Manager из P-CAD, хотя она более глобальна и 
проектно-ориентирована, не ограничиваясь только проектными данными. С помощью этой 
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панели возможна работа со специальными 
редакторами документов, таким как схемный редактор, 
или при контроле проекта на более глобальном, 
системном  уровне. 

 
Рис. 2. Файлы проектов P-CAD 
немедленно отображаются после 
трансляции на панели Project. 

После открытия и активации документов в 
пределах различных редакторов, вы отметите, что 
ресурсы и доступные панели динамически изменяются; 
элементы меню, доступные панели и панели 
инструментов будут быстро изменяться в соответствии 
с типом редактируемого документа. Необходимо на 
начальном этапе ознакомится с методами доступа к 
этим панелям, управлении, группировании и контроле 
режимов отображения для увеличения продуктивности 
представленных в системе свойств. 

  
Все документы проекта и сгенерированные 

выходные файлы, включая транслированные файлы 
проектов P-CAD, сохраняются как индивидуальные 
файлы на жёстком диске. Файлы проекта могут быть 
открыты либо как индивидуальные документы, либо 
как проекты, с помощью меню команд File>Open, или 
с помощью панели Files. 

Необходимо помнить, что в Altium Designer 
имеется только один файл документа для каждого 
схемного листа проекта, в отличие от идеологии P-
CAD, где имеется множество листов, содержащихся в 
одном проектном файле! 

Панель Project 
Altium Designer, подобно P-CAD, также отличается возможностями управления 

проектом, но имеются концептуальные различия, которые необходимо чётко понимать. 
Подход Altium Designer к управлению проектом состоит в том, что все проектные документы 
(схемы, платы, библиотеки и т.д.) привязаны к одному файлу проекта, для управления и 
доступа к определённым проектным свойствам, таким как проектная верификация, сравнение 
и синхронизация. Представление структуры проекта в Altium Designer через панель Projects, 
обеспечивает высокую прозрачность и полный обзор всего, необходимого для проекта. 
Проектный файл, который показан на панели Project, содержит связи для всех документов в 
проекте, а также любые другие задания проектного уровня. 

Storage Manager 
Altium Designer отличается совершенной панелью управления историей (Storage 

Manager), которая обеспечивает глобальное управление файлами проекта. Этот менеджер 
можно вызвать в любой момент времени нажатием кнопки  System в нижней части 
прикладного окна и указанием Storage Manager  из появившегося выпадающего меню. 

 

 237



 

 
Рис. 3. Панель  

Панель Storage Manager является много-функциональной и может быть использована 
для различных действий из общих ежедневных функций управления файлами, управления 
резервными копиями файлов, для контроля версий, как это видно из рисунка 3. 

Можно обратиться к файлу Welcome to the Altium Designer Environment для входа в 
Altium Designer и обзора его уникальной и унифицированной среды. Здесь представлен 
иллюстрированный и ясный подход по использованию панелей Workspace, Storage Manager и 
многое другое. 

Панель Navigation – непосредственная навигации по документам 
 Так как одновременно может быть открыто много документов проекта и открытых 

проектов, Altium Designer предоставляет панель Navigation для поиска определённых 
проектов, в которых возникает необходимость. 
Так как всё интегрировано в единый пакет, не 
требуется много усилий для переключения к 
другому приложению (например, для перехода 
от платы к схеме). Панель инструментов Navigation (см. рисунок 4) доступна для помощи в 
непосредственной навигации по документам проекта и может быть доступна в любой момент 
из любого редактора документов. 

Рис. 4. Панель инструментов Navigation 

 

Просмотр документов 
Поле в левой части панели позволяет просмотреть любую директорию, документ в сети 

или локальное хранилище данных непосредственно, а также любую страницу в Интернете. 
Поиск и предварительный просмотр документов легко использовать с помощью клавиш 
стрелок для перехода туда и обратно, подобно браузеру в Интернете. 

 

 Интегрированная навигация по домашней странице 

 Нажмите кнопку Go to Home Page  в верхней части окна для доступа к 
интегрированной домашней странице, где находятся доступные страницы интерактивной 
поддержки, как показано на рисунке 5. 
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Рис. 5. Навигационная домашняя страница 

Избранное 
Список Избранное (Favorites), который можно создать и использовать. При первой 

инсталляции Altium Designer этот список пуст. С помощью доступа к панели Favorites  на 
вкладке  System в строке статуса, можете создать, организовать и реализовать список 
избранных документов, который может включать связи с любой директорией или с 
документом в сети или в локальном хранилище, а также доступ к любой Интернет странице. 
Избранные ссылки также могут сохранять вид документов проекта (включая уровень 
масштабирования), поэтому можно переходить назад и вперёд между видами схемы и платы – 
что неоценимо в большом проекте. 

 

Оперативный доступ к справке 
Для более подробной информации о панели Favorites, а также ко многим другим темам в 

Altium Designer, откройте панель Knowledge Center с помощью кнопки Help в строке статуса. 
Укажите на любой объект или раздел приложения, и пока эта панель активна, будет доступна 
динамическая справка. Кроме того, контекстно-зависимая справка также доступна при 
нажатии клавиши F1 на любой панели. 
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Проектно-ориентированное конструирование  
Стартовой точкой для каждой создаваемой в Altium Designer конструкции является 

проект. Эта простая и важная концепция – проект в Altium Designer представляет собой набор 
проектных документов, чей состав определён его назначением. Например, схема и плата в 
наборе выходных файлов проекта платы требуется для изготовления единственной печатной 
платы, в то время как схема и HDL в наборе файлов проекта требует программу для одной 
ПЛИС. Проектный файл содержит все эти проектные документы, которые формируют 
собственно проект. 

Altium Designer поддерживает ряд различных типов проектных файлов, включая проект 
платы, ПЛИС, встраиваемые проекты, проекты ядра, интегрированные библиотеки и проекты 
скриптов. 

 Панель Project  
 В Altium Designer все элементы, 

относящиеся к проекту и связанные с проектной 
документацией, должны быть легко доступными 
и управляемыми из одного источника. Панель 
Projects  одна из наиболее часто используемых 
панелей в ежедневной работе, так как именно 
она позволяет производить редактирование 
проекта, изменять опции отображения проекта, 
изменять последовательность документов в 
проекте и даже желательные варианты 
представления  этой панели в любое время. В 
Altium Designer имеется возможность 
устанавливать и конфигурировать опции проекта 
в любое время для управления всеми 
проектными документами и их взаимодействия. 

Рис. 6. Нажатие ПК показывает все 
проектно-связанные команды меню 

Каждый из транслируемых файлов будет 
появляться на панели Projects, со своими 
собственными увязанными проектами, 
автоматически созданными для них. Контекстно-
зависимое командное меню, которое 
обеспечивает доступ ко всем командам 
редактирования доступно с помощью выбора 
файла проекта и затем нажатия ПК (Рис. 6). 

  
См. заметки в файле Project Essentials  для 

ознакомления со всеми основными 
создаваемыми типами проектных файлов, 
добавлений и удалений проектов из проекта, 
установления опций проекта, а также понимания 
различных типов проектов и даже группирования 
проектов вместе для управления крупными 
проектами, которые охватывают множество 
технологий. 

 

Компиляция – основа работы Altium Designer  
Компиляция является краеугольным камнем среды  в Altium Designer и 

фундаментальным отличием от P-CAD. Компиляция является процессом, который позволяет 
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использовать многие мощные свойства проекта и может быть выполнена над 
транслированной из P-CAD схемой или даже просто списком цепей. Компиляция может 
также затронуть другие типы документов, таких как библиотека документов. 

После компиляции все сведения из схемного проекта преобразуются во внутреннюю 
структуру данных, которые затем могут быть использованы для многих посткомпиляционных 
операций, таких как сравнение и выявления различий между схемами, управлением 
параметрами, параметрической навигации в проекте и многое другое. 

Верификация проекта  
Достоинством получения результатов компиляции проекта в Altium Designer является 

встроенная система отчёта об ошибках. Она является полностью конфигурируемой для нужд 
пользователя и может быть выполнена перед компиляцией проекта. Просто нажмите ЛК либо 
на проектном файле и введите команду Project Option  или через меню Project. 

Здесь вкладка Error Reporting позволяет полностью конфигурировать все ошибки и 
предупреждения, которые будут выявлены при прогоне, перед реализацией компиляции, как 
это показано на рисунке 7.  

Более полное описание всего цикла разработки можно получить, прочитав Overview of 
Electronic Product Development in Altium Designer. 

 

 
Рис. 7. Вкладка отчёта об ошибках в диалоге Project Option 

Связность – она уже в проекте 
Altium Designer поддерживает идентификаторы цепей и контролирует их, что позволяет 

установить параметры связанности любым желательным способом. Поскольку Altium 
Designer поддерживает многолистовые проекты, он предлагает дополнительные 
преимущества для помощи в облегчении организации проектов, не важно, больших или 
сложных. Даже если просто требуется легкий способ для нескольких инженеров работать над 
одним и тем же проектом в одно и тоже время, или гибкий способ для передачи проекта на 
печать, теперь это легко реализовать. 
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Необходимо лишь разрешить структурные отношения листов, и тип связанности, 
желательные для каждого отдельного проекта. Если ведется работа с файлами P-CAD SCH, 
это выполняется автоматически в процессе трансляции. 

Синхронизация проекта  
Синхронизация проекта полностью интегрирована в Altium Designer без необходимости 

передачи списка цепей. Синхронизация является двунаправленной между схемой и платой, 
позволяя производить аннотационные изменения и обновлять свойства компонентов. Всё это 
можно выполнить во время обновления, без экспорта или импорта информации о цепи. 

Кроме того, важной и фундаментальной предпосылкой Altium Designer является то, что 
установка проектной связности передаётся из схемы к плате.  Если же сделать изменение 
связности в противоположном направлении (от платы к схеме) то будет сформирован отчёт и 
эти изменения можно, затем выполнить вручную на схеме. 

 

Схемный символ – основа компонента 
Каждый опытный пользователь P-CAD имеет своё мнение о фундаментальной 

концепции, когда символ в Altium Designer является  компонентом. Небольшое сравнение 
поможет увидеть разницу между двумя моделями соответствующих систем для лучшего  
понимания. 

 
Рис. 9. Компоненты P-CAD имеют единственный графический символ и 

 один или несколько посадочных мест  
В P-CAD все логические и электрические данные, которые находятся в компоненте, 

могут быть просмотрены в Library Executive в диалоге Pins View. Сваппирование выводов и 
логических частей компонентов, соответствие вывода символа ножке микросхемы, вместе с 
электрическими и логическими данными выводов являются единственной доступной 
информацией о компоненте. Поскольку информация относится в первую очередь к выводам и 
в известной степени ограничена, имеются  присущие этому ограничения по числу способов, 
когда компоненты P-CAD могут быть представлены в процессе проектирования. Компоненты 
в Altium Designer, с другой стороны, содержат больше информации и она более гибкая в 
терминах её представления. 
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Рис. 10. Символы в Altium Designer могут иметь множество корпусов и 255 вариаций 

символа 
 
В Altium Designer логический символ принимает на себя функцию существенно 

начальной точки компонента. Он может быть первоначально задан минимальным, как имя в 
схемной библиотеке, в котором могут быть добавлены выводы и любые графические 
символы или альтернативные графические отображения, необходимые для выполнения 
проекта. Такая гибкость позволяет компоненту быть представленным различным образом в 
процессе проектирования. Он может быть не только логическим символом на схеме, но также 
быть посадочным местом на плате или даже как SPICE описание для моделирования. 

Фундаментальные сведения о создании компонентов, их свойствах, и базисные 
отношения между компонентами, моделями и концепции библиотеки пояснены в разделе 
Концепции компонентов, моделей и библиотек. 

  

Новый подход к иерархии проекта 
Настоящий иерархический проект поддерживается в Altium Designer и постоянно 

доступен для просмотра с помощью панели Projects. Возможны многие взаимоотношения 
между проектными листами и их соответствующими идентификаторами цепей и могут быть 
отмоделированы здесь – но  легче  это определить посредством представления первого листа 
как родительского и затем представления символа листа как подчиненного. Принимая во 
внимание эту идею, дерево просмотра иерархии  делает его лёгким для навигации и 
получения общей картины проекта (см. иерархию Digdemo ниже на рисунке 11). 

Многоканальный проект 
В Altium Designer поддерживается не только многоуровневая иерархия, но также 

поддерживается многоканальный проект, концепция которого может оказаться новостью для 
многих пользователей P-CAD. Многоканальный проект касается одинаковых каналов, 
применённых в проекте несколько раз. Канал необходимо нарисовать только однажды как 
отдельный схемный подчиненный лист и включить в проект. 

Имеется несколько многоканальных проектов, которые представлены как демо-файлы в 
Altium Designer, которые можно просмотреть для знакомство с концепцией. Multichannel 
Mixer   и Peak Detector представляют собой два превосходных проекта, находящихся в папке 
\Examples\Reference Design. 
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Полное руководство, которое показывает, как 

создавать многоканальный проект в редакторе схем, 
включая использование подчиненных листов, символов 
листа и команду Repeat  можно найти в руководстве 
Creating a Multi-channel Design. 

Рис. 11. Иерархический проект 
легко просматривается в виде 

дерева 

 

Библиотеки 
Altium Designer поддерживает работу прямо от 

исходного символа или библиотек моделей, идеально 
подходящую, когда схема и плата спроектированы 
разными организациями. Имеются также 
Интегрированные библиотеки, термин, используемый 
как Altium Designer и P-CAD, тем не менее, имеют 
существенные различия, на базе соответствующих 
концептуальных моделей, которые обсуждались ранее. 

 
В сфере P-CAD, интегрированная библиотека 

содержит корпусную и символьную информацию. 
Компоненты в этих библиотеках имеют логические 
обозначения выводов и данные выводов, специфичных 
для этого типа компонентов. Компонент даёт символам 
и корпусам взаимосвязь; корпуса и символы не 
содержат какую-либо логическую информацию, такую 
как значения обозначения вывода, так как они 
представляют только графическое представление. 
Графика корпуса сохраняется отдельно. 

 
Интегрированная библиотека в Altium Designer подобна библиотеке P-CAD, где 

исходный символ, посадочное место и вся другая информация (например, SPICE и другие 
модельные файлы) компилируются в единый файл.  В процессе компиляции производится 
просмотр заданных отношений, корректность отношений между моделями и символами и 
группировка их в единую интегрированную библиотеку. Однако в отличие от P-CAD, этот 
файл нельзя непосредственно редактировать в Altium Designer, обеспечивая 
транспортабельность и безопасность. 

В интегрированных библиотеках, поставляемых с Altium Designer, около 72000 
компонентов, из которых можно в любое время выделить исходные библиотеки. 

Типы библиотек 
В среде Altium Designer имеются три типа используемых библиотек: модельные, 

схемные и интегрированные. 

Модельная 
Эти библиотеки содержат модели для каждого представления компонента, при этом 

каждое модельное поле деятельности сохраняется в отдельном “модельном контейнере”, 
называемыми модельными библиотеками. В похожих сферах, будет содержаться одна модель 
на файл и они рассматриваются как модельные файлы (*.mdl, *.ckt). В других проектных 
сферах, модели обычно группируются в библиотечные файлы, соответствующие группе 
применения, например, как посадочные места группируются в библиотеки пакетного типа 
(*.PcbLib). 
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Схемная 
Эти библиотеки содержат исходные схемные компоненты и их модельные 

интерфейсные определения (*.SchLib). 

Интегрированные 
Они представляют набор интегрированных библиотек, которые вместе с *.SchLib 

связанными модельными библиотеками, компилируются в один файл, называемый 
интегрированной библиотекой (*.IntLib). 

Основы управления библиотеками 
Всегда имеется возможность просмотреть исходную библиотеку символов и посадочных 

мест сразу после трансляции на панели Project. Интегрированные библиотеки транслируются 
не автоматически. Однако они будут автоматически сгруппированы в проекты 
интегрированных библиотек. Для создания интегрированной библиотеки из 
интегрированного библиотечного проекта, необходимо сделать это вручную с панели Project 
через команду Compile Project в меню и ПК (как это предварительно показано на рисунке 6), 
когда была выбрана исходная библиотека. 

Для дальнейшего обсуждения вопросов управления библиотекой см. статью  Enhanced 
Library Management Using Integrated Libraries. 

 

Проектирование печатной платы 
Полное руководство, которое освещает все основы передачи проекта платы, включая 

типичные моменты и многое другое можно обнаружить в Getting Started with PCB Design или 
разделе «Проектирование печатных плат (PCB)» данного руководства 

Помощник создания печатной платы 
Перед тем как передать проект из схемного редактора в редактор плат, необходимо 

иметь бланк платы, как минимум, с контуром платы. Помощник создания печатных плат 
(PCB Board Wizard) позволяет легко создать основу проекта платы, используя многие 
промышленные стандартные типоразмеры плат, а также создать собственные 
пользовательские типоразмеры плат. 

PCB Board Wizard доступен из панели Files в рамке New from template. На любой 
стадии можно использовать кнопку Back для изменения настроек помощника. 

Единицы измерения и сетка размещения 
Все опции для сетки размещения, единиц измерения, позиции листа и отображение 

обозначений полностью настраиваются в данной системе. При активном документе платы в 
главном окне проекта (для этого и всех последующих контекстно-зависимых диалогов) 
выберите из главного меню команды Design>Board Option [горячие клавиши D,O]  для 
открытия диалога Board Option. 

Настройки редактора плат 
Настройки, которые облегчают позиционирование компонентов, такие как Online DRC, 

Snap to Center. Настройки выделения могут быть обнаружены в диалоге Preferences для 
документов плат. Укажите Tools>Preferences [горячие клавиши T,P] из главного командного 
меню для открытия диалога Preferences. 
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Слои платы и цвета 
Укажите Design>Board Layers and Colors [горячая клавиша L] из главного командного 

меню, где можно просмотреть, добавить, удалить, переименовать и установить цвета для 
слоёв. Обратите внимание, что можно легко перемещаться между слоями в проекте простым 
выбором вкладки слоя в нижней части главного окна проекта. 

Менеджер стека слоев 
Слоями можно легко управлять и просматривать (теперь в 3D) с помощью диалога Layer 

Stack Manager.  Этот диалог легко доступен из главного командного меню Design>layer Stack 
Manager [горячие клавиши D,K]. 

Некоторые другие полезные горячие клавиши на цифровой клавиатуре, в том числе + и 
– циклически обходят все видимые слои, а * для циклического обхода только сигнальных 
слоёв. 

Полный обзор списка горячих клавиш, доступных для использования в Altium Designer, 
ранжированные для использования на уровне среды, и связанные с определённым редактором 
документа, можно найти в документе справки Shortcut Keys. 

Правила проектирования 
Редактор плат является мощной и динамичной правило - ориентированной средой. Это 

означает, что можно работать в редакторе плат и выполнять операции по изменению проекта 
(такие как размещение трасс, смещение компонентов, или трассировку платы), при этом 
редактор постоянно контролирует каждое действие и проверяет их на предмет соответствия 
правилам проектирования при компиляции. При наличии ошибки он немедленно оповещает 
об этом. 

Находясь в документе платы, как в активном документе, укажите Design>Rules  из 
главного командного меню для  вызова диалога PCB Rules and Constraint Editor, как показано 
ниже на рисунке 12. 

 
Рис. 12.  Редактор правил и ограничений 
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Одним из мощных свойств системы правил проектирования в Altium Designer является 
то, что можно задать множество правил одинакового типа, ориентированных на различные 
объекты. Это новая концепция для пользователей P-CAD, позволяющая определять иерархию 
применения правил к объектам проекта. Точная установка объектов, на которые правила 
ориентированы, задаётся таким правилом. Иерархия правил является задаваемой 
пользователем, т.е. приоритет устанавливается так, как правила отображаются на рисунке 12. 

Интерактивная трассировка 
Как и в P-CAD, здесь перед началом трассировки необходимо иметь активным 

сигнальный слой. Активируйте слой, с которого хотите начать работу нажатием клавиши L 
для отображения диалога слоёв платы и расцветок. Включите опцию Show  для активации 
слоя – также как это делалось в P-CAD. После доступности сигнального слоя вкладка для 
этого отобразится в главном окне проекта. нажмите вкладку Layer внизу рабочей области для 
перевода его в ткущий или активный слой, готовым для трассировки. 

Interactive Routing в Altium Designer может быть вызван либо командой Place в главном 
меню, выбрав команду Interactive Routing или же простым выбором кнопки  на панели 
инструментов Wiring. 

Следующие указания помогут быстро научиться выполнять размещение трасс (многие 
из них знакомы пользователям P-CAD): 

• Нажатие ЛК (или Enter) – помещает начальную или конечную вершину трассы. 
Размещённые сегменты трасс будут иметь цвет слоя. 

• Клавиша Пробела -  позволяет переключаться между начальными и конечными 
режимами для помещённой трассы. 

• SHIFT+Пробел – позволяет изменить режим угла для текущей трассы 
• END – позволяет перерисовать экран в любой момент 
• V, F – перерисовывает экран с захватом всех объектов (View Extent) 
• PAGEUP, PAGEDOWN - позволяет увеличивать или уменьшать изображение и 

центрировать позицию курсора. Колёсико мышки поможет панорамировать влево или вправо, 
удерживая клавишу Ctrl, а без Ctrl – панорамировать вверх – вниз. 

• Backspace - отменяет последний сегмент трассы. 
• ПК  или ESC – завершает трассу. 
• SHIFT+R - циклически обходит 3 режима обхода препятствия для интерактивного 

трассировщика: обойти, оттолкнуть или игнорировать препятствие. 
 

Установка выходных данных проекта 
Установка всех выходных данных проекта теперь связана с единственным интерфейсом 

– OutputJobs Editor (редактором выходных работ), предлагающий значительные 
преимущества над проектной средой P-CAD. Поскольку он базируется на документе, он 
предлагает удобства транспортабельности между многими и различными проектами. 
Возможно, что вы можете определить ваш файл Output Job однажды, со всеми 
существенными конфигурациями, без их периодической переустановки. 

 

Редактор выходных работ 
Редактор OutputJobs позволяет вам определять и управлять Выходными Рабочими 

Конфигурациями (*.OutJob). Файл Output Job позволяет вам задать ваши проектные выводные 
конфигурации – сборка, изготовление, отчёты, перечни цепей и т.д. все в одном месте. Вы 
можете создать даже множество Output Job файлов и добавлять их в ваш проект для создания 
отдельных выходных сборок из выводных данных для изготовления. 

Помощь для Редактора OutputJobs является контекстно-зависимой, и становится 
доступной только когда активным документом является файл *.OutJob. Вы можете создать 
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новый файл этого типа для любого активного проекта используя либо команду  
File>New>Output Job File (как показано на фигуре 13) или щёлкнув ПК на проекте в панели 
Projects  и указав Add New to Project>Output Job File  из появившегося выпадающего меню. 

 
Рис. 13. Рабочий выходной файл изготовления для одного проекта. 

 
Файл Выходной Работы разделяется на ряд категорий, которые отражают функции 

выводимых данных. Сюда входят Assembly, Documentation, Fabrication, Netlist, и Report 
Outputs. Вы должны познакомиться с тем, как он конфигурируется. 

Исчерпывающий  технический обзор для установки и настройки  ваших выводных 
данных для редактора OutputJobs можно обнаружить в Output Editor Reference. Вы можете 
открыть его нажатием клавиши F1, когда курсор находится поверх открытого OutJob. 
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